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Preface

This preface describes the purpose, audience, organization, and conventions of
this guide, and provides information on how to obtain related documentation.

The preface covers these topics:
e Purpose, page xvii
e Audience, page xviii
e Organization, page xviii
e Related Documentation, page xix
e Conventions, page xx
e Obtaining Documentation, page xxi
e Documentation Feedback, page xxii
e Cisco Product Security Overview, page xxii
e Obtaining Technical Assistance, page Xxiv

e Obtaining Additional Publications and Information, page xxvi

Purpose

The Bulk Administration Tool User Guide provides instructions for using the Bulk
Administrative Tool (BAT).
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Ml Audience

Audience

This document provides information for network administrators and engineers
who are responsible for managing the Cisco CallManager system. Administering
BAT requires knowledge of telephony and IP networking technology.

Organization

Table 1 provides the chapter layout of the guide.

Table 1

Layout of BAT Tool User Guide

Chapter

Description

Chapter 1, “Introducing the Bulk
Administration Tool (BAT)”

Provides an overview of BAT.

Chapter 2, “Installing the BAT
Application”

Describes the installation, upgrade, and uninstallation
procedures for BAT and the Tool for Auto-Registered Phone
Support (TAPS).

Chapter 3, “Working with Phones and IP
Telephony Devices”

Describes how to add phones, phones and users, computer
telephony integration (CTI) ports, and CTI ports and users
in batches rather than adding each device or combination
individually. Also describes how to add or update lines,
phone services, and speed dials and how to update and
delete phones.

Chapter 4, “Working with Users”

Describes how to add, update, and delete batches of users.

Chapter 5, “Working with Cisco IP
Manager Assistant”

Describes how to add, update, or delete Manager Assistant
Associations.

Chapter 6, “Working with User Device
Profiles”

Describes how to add, update, or delete User Device
Profiles.

Chapter 7, “Working with Gateways and
Ports”

Describes how to add, update, or delete Cisco VG200
gateways and ports, and how to add or delete Foreign
Exchange Station (FXS) ports for Cisco Catalyst 6000
analog interface modules. Also describes how to create a
gateway directory number template for use with FXS ports.

] Bulk Administration Tool User Guide
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Related Documentation W

Table 1 Layout of BAT Tool User Guide (continued)

Chapter 8, “Working with Client Matter |Describes how to add, update, or delete Client Matter
Codes and Forced Authorization Codes” |Codes and Forced Authorization Codes

Chapter 9, “Working with Call Pickup Describes how to add, update, or delete call pickup groups.

Groups”

Chapter 10, “Working with the Export Describes how to use the export utility.
Utility”

Chapter 11, “Generating Reports” Describes how to use and generate reports.

Chapter 12, “Working with the Tool for |Describes how to install, configure, and use TAPS.

Auto-Registered Phones Support”

Chapter 13, “Troubleshooting BAT and  |Describes some common scenarios for bulk transaction log

TAPS” files and provides an explanation and resolution for various
error messages that you may encounter while working with
BAT or TAPS.

Appendix A, “Text-Based CSV Files” Describes how to create text-based files for the devices and

users for bulk transactions. Also provides example of file
formats for different scenarios.

Related Documentation

Refer to the following documents for further information about related
Cisco IP telephony applications and products:

Cisco CallManager Administration Guide

Cisco CallManager System Guide

Release Notes for Cisco CallManager Release
Installing Cisco CallManager Release

Cisco CallManager Serviceability Administration Guide
Cisco CallManager Serviceability System Guide

Cisco CallManager Security Guide

Hardware Configuration Guide for the Cisco VG200
Software Configuration Guide for the Cisco VG200

[ oL-8661-01
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Hl Conventions

e Cisco VG248 Analog Phone Gateway Software Configuration Guide
e Cisco IP Phone Administration Guide for Cisco CallManager

e Cisco CallManager Features and Services Guide

e Troubleshooting Guide for Cisco CallManager

e C(Cisco IP Manager Assistant User Guide

Conventions

This document uses the following conventions:

Convention Description

boldface font Commands and keywords are in boldface.

italic font Arguments for which you supply values are in italics.
string A nonquoted set of characters. Do not use quotation

marks around the string or the string will include the
quotation marks.

screen font Terminal sessions and information the system displays
are in screen font.

boldface screen Information you must enter is in boldface screen font.

font

Notes use the following conventions:

Note = Means reader take note. Notes contain helpful suggestions or references to
material not covered in the publication.

Timesavers use the following conventions:

Timesaver  Means the described action saves time. You can save time by performing the
action described in the paragraph.

Bulk Administration Tool User Guide
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Tip

A

Obtaining Documentation

Tips use the following conventions:

Means the information contains useful tips.

Cautions use the following conventions:

Caution

A

Warning

Means reader be careful. In this situation, you might do something that could
result in equipment damage or loss of data.

Warnings use the following conventions:

This warning symbol means danger. You are in a situation that could cause
bodily injury. Before you work on any equipment, you must be aware of the
hazards involved with electrical circuitry and familiar with standard practices
for preventing accidents.

Obtaining Documentation

Cisco.com

Cisco documentation and additional literature are available on Cisco.com. Cisco
also provides several ways to obtain technical assistance and other technical
resources. These sections explain how to obtain technical information from Cisco
Systems.

You can access the most current Cisco documentation at this URL:
http://www.cisco.com/univercd/home/home.htm

You can access the Cisco website at this URL:
http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

[ oL-8661-01
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Ml Documentation Feedback

Ordering Documentation

You can find instructions for ordering documentation at this URL:
http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm
You can order Cisco documentation in these ways:

e Registered Cisco.com users (Cisco direct customers) can order Cisco product
documentation from the Ordering tool:

http://www.cisco.com/en/US/partner/ordering/index.shtml

e Nonregistered Cisco.com users can order documentation through a local
account representative by calling Cisco Systems Corporate Headquarters
(California, USA) at 408 526-7208 or, elsewhere in North America, by
calling 800 553-NETS (6387).

Documentation Feedback

You can send comments about technical documentation to bug-doc @cisco.com.

You can submit comments by using the response card (if present) behind the front
cover of your document or by writing to the following address:

Cisco Systems

Attn: Customer Document Ordering
170 West Tasman Drive

San Jose, CA 95134-9883

We appreciate your comments.

Cisco Product Security Overview

This product contains cryptographic features and is subject to United States and
local country laws governing import, export, transfer and use. Delivery of Cisco
cryptographic products does not imply third-party authority to import, export,
distribute or use encryption. Importers, exporters, distributors and users are
responsible for compliance with U.S. and local country laws. By using this
product you agree to comply with applicable laws and regulations. If you are
unable to comply with U.S. and local laws, return this product immediately.

Bulk Administration Tool User Guide
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Cisco Product Security Overview

A summary of U.S. laws governing Cisco cryptographic products may be found
at: http://www.cisco.com/wwl/export/crypto/tool/stqrg.html. If you require
further assistance please contact us by sending email to export@cisco.com.

Cisco provides a free online Security Vulnerability Policy portal at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.ht
ml

From this site, you can perform these tasks:
e Report security vulnerabilities in Cisco products.
e Obtain assistance with security incidents that involve Cisco products.
e Register to receive security information from Cisco.

A current list of security advisories and notices for Cisco products is available at
this URL:

http://www.cisco.com/go/psirt

If you prefer to see advisories and notices as they are updated in real time, you
can access a Product Security Incident Response Team Really Simple Syndication
(PSIRT RSS) feed from this URL:

http://www.cisco.com/en/US/products/products_psirt_rss_feed.html

Reporting Security Problems in Cisco Products

Cisco is committed to delivering secure products. We test our products internally
before we release them, and we strive to correct all vulnerabilities quickly. If you
think that you might have identified a vulnerability in a Cisco product, contact
PSIRT:

¢ Emergencies—security-alert@cisco.com

An emergency is either a condition in which a system is under active attack
or a condition for which a severe and urgent security vulnerability should be
reported. All other conditions are considered nonemergencies.

¢ Nonemergencies—psirt@cisco.com

In an emergency, you can also reach PSIRT by telephone:
e 1877 228-7302
e 1408 525-6532

[ oL-8661-01
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M Obtaining Technical Assistance

e

Tip We encourage you to use Pretty Good Privacy (PGP) or a compatible product to
encrypt any sensitive information that you send to Cisco. PSIRT can work from
encrypted information that is compatible with PGP versions 2.x through 8.x.

Never use a revoked or an expired encryption key. The correct public key to use
in your correspondence with PSIRT is the one linked in the Contact Summary
section of the Security Vulnerability Policy page at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.ht
ml

The link on this page has the current PGP key ID in use.

Obtaining Technical Assistance

For all customers, partners, resellers, and distributors who hold valid Cisco
service contracts, Cisco Technical Support provides 24-hour-a-day,
award-winning technical assistance. The Cisco Technical Support Website on
Cisco.com features extensive online support resources. In addition, Cisco
Technical Assistance Center (TAC) engineers provide telephone support. If you
do not hold a valid Cisco service contract, contact your reseller.

Cisco Technical Support Website

The Cisco Technical Support Website provides online documents and tools for
troubleshooting and resolving technical issues with Cisco products and
technologies. The website is available 24 hours a day, 365 days a year at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support Website requires a Cisco.com
user ID and password. If you have a valid service contract but do not have a user
ID or password, you can register at this URL:

http://tools.cisco.com/RPF/register/register.do
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Submitting a Service Request

Using the online TAC Service Request Tool is the fastest way to open S3 and S4
service requests. (S3 and S4 service requests are those in which your network is
minimally impaired or for which you require product information.) After you
describe your situation, the TAC Service Request Tool automatically provides
recommended solutions. If your issue is not resolved using the recommended
resources, your service request will be assigned to a Cisco TAC engineer. The
TAC Service Request Tool is located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests or if you do not have Internet access, contact the
Cisco TAC by telephone. (S1 or S2 service requests are those in which your
production network is down or severely degraded.) Cisco TAC engineers are
assigned immediately to S1 and S2 service requests to help keep your business
operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
EMEA: +32 2 704 55 55
USA: 1800 553 2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity

To ensure that all service requests are reported in a standard format, Cisco has
established severity definitions.

Severity 1 (S1)—Your network is “down,” or there is a critical impact to your
business operations. You and Cisco will commit all necessary resources around
the clock to resolve the situation.

Severity 2 (S2)—Operation of an existing network is severely degraded, or
significant aspects of your business operation are negatively affected by
inadequate performance of Cisco products. You and Cisco will commit full-time
resources during normal business hours to resolve the situation.
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Severity 3 (S3)—Operational performance of your network is impaired, but most
business operations remain functional. You and Cisco will commit resources
during normal business hours to restore service to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product
capabilities, installation, or configuration. There is little or no effect on your
business operations.

Obtaining Additional Publications and Information

Information about Cisco products, technologies, and network solutions is
available from various online and printed sources.

e (Cisco Marketplace provides a variety of Cisco books, reference guides, and
logo merchandise. Visit Cisco Marketplace, the company store, at this URL:

http://www.cisco.com/go/marketplace/

e The Cisco Product Catalog describes the networking products offered by
Cisco Systems, as well as ordering and customer support services. Access the
Cisco Product Catalog at this URL:

http://cisco.com/univercd/cc/td/doc/pcat/

e (isco Press publishes a wide range of general networking, training and
certification titles. Both new and experienced users will benefit from these
publications. For current Cisco Press titles and other information, go to Cisco
Press at this URL:

http://www.ciscopress.com

e Packet magazine is the Cisco Systems technical user magazine for
maximizing Internet and networking investments. Each quarter, Packet
delivers coverage of the latest industry trends, technology breakthroughs, and
Cisco products and solutions, as well as network deployment and
troubleshooting tips, configuration examples, customer case studies,
certification and training information, and links to scores of in-depth online
resources. You can access Packet magazine at this URL:

http://www.cisco.com/packet

® iQ Magazine is the quarterly publication from Cisco Systems designed to
help growing companies learn how they can use technology to increase
revenue, streamline their business, and expand services. The publication
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identifies the challenges facing these companies and the technologies to help
solve them, using real-world case studies and business strategies to help
readers make sound technology investment decisions. You can access iQ
Magazine at this URL:

http://www.cisco.com/go/igmagazine

Internet Protocol Journal is a quarterly journal published by Cisco Systems
for engineering professionals involved in designing, developing, and
operating public and private internets and intranets. You can access the
Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

World-class networking training is available from Cisco. You can view
current offerings at this URL:

http://www.cisco.com/en/US/learning/index.html
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CHAPTER 1

Introducing the Bulk Administration
Tool (BAT)

The Bulk Administration Tool (BAT), a web-based application, performs bulk
transactions to the Cisco CallManager database. BAT lets you add, update, or
delete a large number of similar phones, users, or ports at the same time. When
you use Cisco CallManager Administration, each database transaction requires an
individual manual operation, while BAT automates the process and achieves faster
add, update, and delete operations.

You can use BAT to work with the following types of devices and records:

Add, update, and delete Cisco IP Phones including voice gateway chalice
(VGC) phones, computer telephony interface (CTI) ports, and H.323 clients

Add, update, and delete users

Add, update, and delete Cisco IP Manager Assistant (IPMA) managers and
assistants

Add, update, and delete User Device Profiles

Add, update, and delete ports on a Cisco Catalyst 6000 FXS Analog Interface
Module

Add or delete Cisco VG200 analog gateways and ports
Add or delete Forced Authorization Codes

Add or delete Client Matter Codes

Add or delete Call Pickup Groups
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You can also work with these devices in combination with the user information.
For example, when you add CTI ports and users, BAT allows you to “Enable CTI
Application Use.” This saves time when you are adding users who have
applications that require a CTI port, such as Cisco IP SoftPhone.

An optional component of BAT, the Tool for Auto-Registered Phones Support
(TAPS), further reduces the manual labor that is involved in administering a large
system. When you need to add a large block of new phones, you can use BAT to
add the devices with dummy media access control (MAC) addresses instead of
entering each MAC address in the data input file. After the phones are installed,
the phone users or the administrator can call the TAPS directory number, follow
the voice prompts, and download the correct user device profiles for their phones.
For more information about the TAPS tool, see Chapter 12, “Working with the
Tool for Auto-Registered Phones Support.”

Use the following topics to understand how to use BAT:
e BAT Data Input Files, page 1-2
e BAT Configuration Process, page 1-3
e Using the BAT Application, page 1-14

BAT Data Input Files

Every device includes a multitude of individual attributes, settings, and
information fields that enable the device to function in the network and provide
its telephony features. Many devices have the same attributes and settings in
common, while other values, such as the directory number, are unique to a user or
to a device. To condense the BAT data input file contents, BAT uses templates for
settings that devices usually have in common.

For bulk configuration transactions on the Cisco CallManager database, the BAT
process uses two components: a template for the device type and a data file in
comma separated value (CSV) format that contains the unique values for
configuring a new device or updating an existing record in the database. The CSV
data file works in conjunction with the device template.

For instance, when you create a bulk transaction for a group of Cisco IP Phones,
you set up the CSV data file that contains the unique information for each phone,
such as the directory number and MAC address. In addition, you set up or choose
the BAT template that contains the common settings for all phones in the
transaction, such as a Cisco IP Phone 7960 template.

Bulk Administration Tool User Guide
m. 0L-8661-01 |




| Chapter1

Introducing the Bulk Administration Tool (BAT)

BAT Configuration Process W

Additional Information
See the “Related Topics” section on page 1-20.

BAT Configuration Process

BAT uses a multistep process to prepare the bulk configuration transaction. BAT
uses a wizard interface to guide you through the configuration tasks. The BAT
process includes these tasks:

1. Set up the template for data input.

2. Define a format for the CSV data file.

3. Collect the data for each device in the bulk transaction.

4. Validate the data input files with the Cisco CallManager database.
5. Insert the devices into the Cisco CallManager database.

Using the BAT Wizard

The BAT wizard provides step-by-step procedures for all the BAT tasks. When
you start BAT, the main window displays with the following menu options at the
top:

e Configure
e Applications
e Help

From the Configure menu, you can access the wizard window by choosing one of
these device or configuration options:

e Phones

e Users

e Manager/Assistants

e User Device Profiles

e Gateways

e Forced Authorization Codes
e Client Matter Codes

e Pickup Group

[ oL-8661-01

Bulk Administration Tool User Guide ]



Chapter1 Introducing the Bulk Administration Tool (BAT) |

H BAT Configuration Process

e TAPS (optional, when installed)

After you choose a device or configuration option, the wizard displays a list of
configuration tasks that is specific to that option. For example, when you choose
Phones, the following list of tasks displays:

e Insert Phones—Add new phones.
e Update Phones—Locate and modify existing phones.
e Delete Phones—Locate and delete phones.

e Export Phones—Locate and export specific phone records or all phone
records.

e Update Lines—Locate and modify lines on existing phones.

¢ Add Lines—Add new lines to existing phones.

e Reset/Restart Phones—Locate and reset or restart phones.

e Insert Phones with Users—Add new phones and users.

e Generate Phone Reports—Generate customized reports for phones.

e CAPF Configuration—Locate and modify/delete existing CAPF
configuration

After choosing the configuration task, the wizard provides a list of steps that is
specific to the task. For example, to guide you through the task, Insert Phones, the
wizard displays the following steps:

Step 1: Add, view, or modify existing phone templates.
Step 2: Create the CSV data file.

Step 3: Validate phone records.

Step 4: Insert phones.

When you choose a step from the task list, you open a configuration window such
as the Phone Template Configuration window. The configuration window
provides the entry fields for defining a template.

Additional Information
See the “Related Topics” section on page 1-20.
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Using BAT Templates

As the first task in the BAT configuration process, you set up a template for the
devices that you are configuring. You specify the type of phone or device that you
want to add or modify, and then you create a BAT template that has features that
are common to all the phones or devices in that bulk transaction.

You can create BAT templates for the following types of device options:

e Phones: All Cisco IP Phone models and Cisco ATA 186, Cisco VGC phones,
CTI ports, and H.323 clients.

e Gateways: Cisco VG200 and ports for the Cisco Catalyst 6000 FXS Analog
Interface Module

e User Device Profiles: Cisco IP Phone 7900 series and Cisco SoftPhone

Define a BAT template by specifying values in the template fields that will be
common to all the devices in the bulk transaction. The BAT template fields require
similar values to those that you enter when you are adding a device in

Cisco CallManager Administration.

Prior to creating the BAT template, make sure settings such as device pools,
locations, calling search spaces, button templates, and softkey templates have
already been configured in Cisco CallManager Administration. You cannot use
BAT to create new settings or button templates in Cisco CallManager
Administration.

After you create a BAT template, you save it with a name. Later in the
configuration process, you associate the template name with the CSV data file.
The system stores the templates, so they are reusable for future bulk transactions.
For example, you can configure a Cisco IP Phone 7960 template with a specific
button template and calling search space and then configure another

Cisco IP Phone 7960 template with a different button template and the Extension
Mobility feature enabled. When you need to add a large number of phones with
the same configuration, you can reuse the existing BAT template.

Master Phone Templates

When you are adding a group of phones that have multiple lines, you can create a
master phone template that provides multiple lines and the most common values
for a specific phone model. You can use the master template to add phones that

have differing number of lines, but do not exceed the number of lines in the master
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phone template. For example, you can create a master phone template for a Cisco
IP Phone 7960 that has eight lines. You can use this template to add phones that
have one line, two lines, or up to eight lines.

Additional Information
See the “Related Topics” section on page 1-20.

Working with CSV Data Files

The CSV data file contains the unique settings and information for each individual
device, such as its directory number, MAC address, and description. Make sure
that all phones and devices in a CSV data file are the same phone or device model
and match the BAT template. The CSV data file can contain duplicates of some
values from the BAT template. Values in the CSV data file override any values that
were set in the BAT template. You can use the override feature for special
configuration cases.

Overriding Template Values Example

If you want most of the phones in the bulk transaction to be redirected to a
voice-messaging system, you can set the Call Forward Busy (Internal/External)
(CFB) and Call Forward No Answer (Internal/External) (CFNA) fields to the
voice-messaging number. However, if a few phones in the bulk transaction need
to be redirected to a secretary instead of to a voice messaging system, you can
specify the secretary’s directory number in the Call CFB and CFNA fields in the
CSV data file. Most of the phones will use the CFB and CFNA values from the
BAT phone template, but certain phones will use the secretary’s directory number
as specified in the CSV data file.

The CSV data file for phones can contain multiple directory numbers. Keep in
mind that the number of directory numbers that are entered in the CSV data file
must not exceed—but can be less than— the number of lines that are configured
in the BAT phone template, or an error will result.

Use the following topics to understand the different types of CSV data files:
e (CSV Data Files for Adding New Devices, page 1-7
e (CSV Data Files to Update Existing Devices, page 1-7
e Customizing File Formats for CSV Data Files, page 1-8
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CSV Data Files for Adding New Devices

When you are adding new devices to the system, you can use the Microsoft Excel
spreadsheet that was designed to use with BAT. The BAT spreadsheet assists you
with the following features:

e Data file templates with macros for the different devices
e Customized file format definition

e Support for multiple phone lines

e Record error checking

e File conversion to CSV format

When you are creating new records, use the BAT spreadsheet, which is named
BAT.xlt, because the data gets validated automatically when you export to the
CSV format. For more information about using the BAT spreadsheet, see “Using
the BAT Spreadsheet for Gathering Data” section on page 1-11.

For experienced BAT users who are comfortable with working in a CSV formatted
file, you can use a text editor to create a CSV data file by following the sample
text file that is provided on the device insert task window. For more information
about text-based CSV data files, see Appendix A, “Text-Based CSV Files.”

Additional Information
See the “Related Topics” section on page 1-20.

CSV Data Files to Update Existing Devices

To modify or update existing phones and devices, you need to locate the records
for these devices. BAT provides two methods for locating phones, gateways, and

device profiles. You can search by using a customized query or by using a custom
file.

Customized Queries

BAT provides a window for defining your query criteria. You can choose the
specific device model and/or choose criteria from a list of device details and a list
of line details. To locate all devices of a specific device model, such as

Cisco IP Phone 7912, you choose the model but add no other criteria for the
search. You get the records for all the Cisco IP Phones 7912 that are configured
in the database.
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Custom Files

When no common attribute to use for a query exists, BAT provides the custom file
option. A custom file includes device names or directory numbers. You can build
a custom text file by putting each record on a separate line. The search gives you
all the records that match the criteria.

Exported Files

When you need to move a group of phones, you can use the export utility. You use
the export utility to extract existing records from the Cisco CallManager database
to move them into a CSV data file. When you move phones, use the option, Export
Phones with the All Phone Details. This option generates an export file that
contains records with all the information, including the device attributes, line
attributes, and services, that is associated with that phone. You can also export
phone records with specific details when phones have similar line configurations
and you want to use a template. For more information about using the export
utility to update devices, see Moving Records from one Cisco CallManager
Server to Another, page 10-2

Related Topics
e (CSV Data Files for Adding New Devices, page 1-7

e Customizing File Formats for CSV Data Files, page 1-8

Customizing File Formats for CSV Data Files

CSV data files comprise a string of device attributes and information in a comma
separated value (CSV) format. To insert data records into the Cisco CallManager
database, ensure that each data file is in the CSV format. In earlier releases of
BAT, the CSV file had a fixed format with two options:

e Default format—CSYV files that have a fixed and limited number of attributes
and settings for each device.

e All details format—CSV files that are created by using the export utility and
include all attributes and settings for each device.

The first row of every CSV data file shows the file format by displaying the name
of each field that the CSV file includes. The file format information makes it
easier to locate the entry for a specific field in the CSV data file. For instance, in
the following sample CSV file, USER ID represents the fifth field in the header,
and the fifth field in the CSV file for the phone shows “johns.”
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Sample CSV Data File with the Default File Format:

NUMBER OF LINES,MAC ADDRESS,DESCRIPTION, LOCATION,USER ID,DIRECTORY
NUMBER, DISPLAY, LINE TEXT LABEL, FORWARD BUSY EXTERNAL, FORWARD NO ANSWER
EXTERNAL, FORWARD NO COVERAGE EXTERNAL, FORWARD BUSY INTERNAL, FORWARD NO
ANSWER INTERNAL, FORWARD NO COVERAGE INTERNAL,CALL PICKUP GROUP, SPEED
DIAL NUMBER, SPEED DIAL LABEL

1,1231123245AB,SEP1231123245AB,Dallas, johns, 9728437154,9728437154,Mike
,9728437172,9728437196,9728437127,9728437154,9728437178,9728437189,Mar
keting, 1230000000, Helpdesk

Now, you can customize the file format for the CSV data file by using the File
Format Configuration window. You can add attributes to your file format that are
also in the BAT template. This allows you to override the template entry with a
specific attribute for a device. For instance, you can choose the route partition
attribute for your file format and enter different partitions for each phone in the
CSV data file.

From this window, you can choose specific attributes from Device fields and Line
fields

The following device attributes always remain in each file format:
e Number of Lines
¢ MAC Address

e Description

Ensure that the Number of Lines is the first item in every phone CSV data file.

The File Format Configuration dialog box makes it easy to choose the device
attribute in the Device Field box and click an arrow to move the attribute into the
Selected Device Field box. You can select multiple attributes at the same time by
holding down the Ctrl key.

You can rearrange the order of the device attribute fields and line attribute fields
in the file format by using the Up and Down arrows. You can select an attribute
and then click the Up arrow to move the item closer to the first record or click the
down arrow to move the item further away from the first record. You cannot move
line attributes before device attributes or change the order of speed dials.
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e

Tip You can customize a CSV file format so it matches the arrangement of your
employee phone information that is stored in another database. This method
simplifies exporting data between a company database and the
Cisco CallManager database.

Sample CSV Data File with the Customized File Format:
Device fields—MAC Address, Description, Device Pool, Calling Search Space

Line fields—Directory number, Partition, Line Text Label (moved to position
after directory number in file)

The File Format does not include speed-dial codes. Speed-dials can be chosen by
selecting the Include Speed Dials in the CSV Format check box.

NUMBER OF LINES,MAC ADDRESS,DESCRIPTION,DEVICE POOL,CSS,DIRECTORY
NUMBER, LINE TEXT LABEL, PARTITION,

1,2234900AEF01, SEP2234900AEF01,DP_1,CSS_Restricted,
9725098827, Lobby Phone, Partl

Associating the File Format with the CSV Data File

When you are using a text editor to create a CSV data file, you can create a
customized file format and then enter values in the same order as specified by that
file format. Before inserting the text-based CSV data file that uses the customized
file format, you must associate the file format name with the CSV data file. You
can associate only one file format with a CSV data file.

Use the Add File Format window to choose the name of the CSV data file
<CSVfilename>.txt from the File Name drop-down list. Next, you choose your
file format from the File Format Name drop-down list. The data in the CSV data
file must match the custom file format that you have chosen.

Additional Information
See the “Related Topics” section on page 1-20.
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Using the BAT Spreadsheet for Gathering Data

Tip

The BAT spreadsheet simplifies the creation of CSV data files. You can add
multiple devices and view the records for each device in a spreadsheet format. It
allows you to customize the file format within the spreadsheet and provides
validation and error checking automatically to help reduce configuration errors.
The BAT spreadsheet includes tabs along the bottom of the spreadsheet for access
to the required data input fields for the various devices and user combinations in
BAT.

The CSV data file works in combination with the BAT template. For example,
when you choose the Phone tab in the BAT spreadsheet, you can leave Location,
Forward Busy Destination, or Call Pickup Group blank. The values from the BAT
phone template get used for these fields; however, if you specify values for
Forward Busy Destination or Call Pickup Group, those values override the values
for these fields that were set in the BAT phone template.

When BAT is installed, the Microsoft Excel file for the BAT spreadsheet gets
placed on the publisher database server; however, you probably do not have
Microsoft Excel running on the publisher database server. You must copy the file
from the publisher database server to the local machine on which you plan to
work.

To copy the file to a local machine, use a floppy disk or a mapped network drive,
and open the path C:\CiscoWebs\BAT\ExcelTemplate\ on the publisher database
server. Copy the file BAT.xIt file to a local machine where Microsoft Excel is
installed.

To use the BAT spreadsheet to create a CSV data file, locate and double-click the
BAT.xIt file. You must choose to “enable macros” when you open the BAT
spreadsheet.

The spreadsheet displays a set of columns with attribute headings that specify the
BAT field names, whether the field is a required or optional, and the maximum
number of characters that are allowed in the field.

Tabs for every device display along the bottom of the spreadsheet. When you click
the tab for the type of device with which you want to work, the columns adjust to
display all relevant fields for the chosen device. For example, to add phones and
users all at once, click the tab that is marked Phones-Users.
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Note

Next, define the file format for the CSV data file by clicking the Create File
Format button. You can use the Field Selection dialog box to choose items and
their order in your CSV data file. When you click Update, the columns in the
spreadsheet adjust to your new file format.

In the first row, enter data for a device in all mandatory fields and any relevant
optional fields. You enter data in a new row for each device.

The system treats blank rows in the spreadsheet as “end of file” markers and
discards subsequent records.

After all device records are completed, you export the BAT spreadsheet data to the
CSV file format that BAT must use to perform the bulk transaction with the
Cisco CallManager publisher database.

If you enter a comma in one of the fields, BAT.xIt encloses that field entry in
double quotes when you export to BAT format.

The system saves the CSV formatted file as a text file to the C:\XLSDataFiles\
folder or to another folder that you choose. The file name format follows:

<tabname><timestamp>.txt

where <tabname> represents the type of device input file that you created (such
as phones, user device profiles), and <timestamp> represents the precise date and
time that the file was created.

Next, you must move the converted CSV data file (CSV format version) back to
the Cisco CallManager publisher database server where BAT can access the CSV
data file. Using a mapped network drive or floppy disk, copy the
<tabname><timestamp>.txt file from the C:\XLSDataFiles\ folder to the
appropriate folder under C:\BATFiles\ on the publisher server.

Additional Information
See the “Related Topics” section on page 1-20.
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Validating the BAT Data Input File

In the next task in the BAT Wizard, you use the Validate File option. In this task,
you choose the name of the CSV data file and the BAT template for the device or
the model when you have a CSV data file with all details. You have these options
for how records are validated:

Specific Details—For validating records that follow the Default or Custom file
format.

All Details—For validating records from a file that was generated with the export
utility by using the All Details option.

When you choose Validate, the system runs a validation routine to check for errors
against the publisher database. These checks include the following items:

¢ Fields, such as description, display text, and speed-dial label that do not have
a dependency on a database table, use valid characters.

e (Cisco CallManager shows that groups, pools, partitions, and other referenced
attributes are already configured.

e Number of lines that are configured on a device matches the device template.
(Only for Specific Details)

Validation does not check for the existence of a user or for mandatory/optional
fields that are BAT defined, such as the dummy MAC address.

After the transaction completes, choose View Latest Log File to see a log file that
displays the devices that could not be validated successfully and the error code.
For more information on log files, see Chapter 13, “Troubleshooting BAT and
TAPS.”

Additional Information

See the “Related Topics” section on page 1-20.

Inserting the BAT Data Input File

When the data input file has passed validation, you are ready to use the Insert
window to add the device records into the Cisco CallManager publisher database.
During this task, you choose the name of the data input file, the BAT template for
the device, and the model, if applicable. You have these options for how records
are validated:
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A

Specific Details—For inserting records that use a customized file format.

All Details—For inserting records from a file that was generated with the export
utility by using the All Details option.

After you click Insert, a message displays that advises you of approximately how
long it will take to insert the records into the Cisco CallManager database. You
can cancel the transaction if you feel that it may cause performance degradation.

Caution

Use BAT only during off-peak hours. Otherwise, bulk transactions could affect the
Cisco CallManager performance, and call processing may be adversely affected.

If you clicked OK, a Transaction Status window displays. Click the Show Latest
Status button to see the transaction in progress.

N

Note If any line information for a phone record fails, BAT does not insert that
phone record.

When the transaction completes, Click View Latest Log File to see a log file that
indicates the number of records that were added and the number of records that

failed, including an error code. For more information on log files, see the “BAT

Log Files” section on page 13-1.

When you start a BAT transaction and notice a degradation in Cisco CallManager
performance, you can stop the transaction. For instructions on how to use the tool
to stop a BAT transaction when it is in progress, see the “Stopping BAT
Transactions” section on page 1-19.

Additional Information

See the “Related Topics” section on page 1-20.

Using the BAT Application

The following topics provide information about the BAT application and how to
start and use it:

e Specifications, page 1-15

e Accessing Cisco CallManager Administration and BAT, page 1-16
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e Starting BAT, page 1-16

¢ Logging On to BAT, page 1-17

e Navigating in BAT, page 1-17

e Using Online Help, page 1-18

e Stopping BAT Transactions, page 1-19
e BAT Configuration Process, page 1-3
e BAT Data Input Files, page 1-2

Specifications

The following specifications apply to BAT Release 5.2(1):
e BAT Release 5.2(1) is compatible with Cisco CallManager Release 4.2.

e BAT supports Lightweight Directory Access Protocol (LDAP) including
Cisco CallManager DC Directory (DCD), Microsoft Active Directory (AD),
and Netscape Directory Server.

e BAT Release 5.2(1) is compatible with Customer Response Solutions (CRS)
Version 4.0 for use with TAPS.

¢ BAT Release 5.2(1) implements Secure HyperText Transfer Protocol
(HTTPS) for BAT/TAPS pages to ensure that the configuration changes that
are made through them are secure. The BAT installation process sets the
security setting on BAT virtual directory.

¢ You must install BAT on the same server as the publisher database for
Cisco CallManager.

e The BAT application, along with the Tool for Auto-Registered Phones
Support (TAPS) application, uses approximately 53 MB of disk space for the
applications and the online documentation. (BAT uses 11 MB and TAPS uses
42 MB.)

e TAPS uses approximately 1 MB of disk space on the Cisco Customer
Response Solutions (CRS) server.

Only Cisco CallManager system administrators require access to BAT; however,
end users can use TAPS when instructed to do so by the system administrator.
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Additional Information
See the “Related Topics” section on page 1-20.

Accessing Cisco CallManager Administration and BAT

BAT, a web-based application, requires the use of a web browser. The
Cisco CallManager Administration and BAT programs support the following
Microsoft Windows operating system browsers:

e Netscape Communicator 4.X; BAT does not support the use of Netscape 6.0
or later.

e Microsoft Internet Explorer 5 or 6

Cisco recommends that you access the BAT and Cisco CallManager
Administration programs from a PC that is not the same machine as the web server
or Cisco CallManager server.

A

Caution A web browser, a resource-intensive application, can consume large amounts of
system memory and CPU cycles. When the web browser takes resources away
from Cisco CallManager, it adversely affects call processing. Possible
consequences of using the browser on the same machine as the web server and
Cisco CallManager include delayed dial tone and dropped calls.

From any user PC in your network, you can browse into a server that is running
Cisco CallManager Administration and BAT to log on with administrative
privileges.

Note  When a large number of users log on to BAT, performance can suffer. Try to limit
the number of users and administrators that are logged on simultaneously.

Starting BAT

You can start BAT by using one of the following methods:
e From Cisco CallManager Administration, choose Application > BAT.

e From the Start menu, choose Start > Programs > Cisco CallManager 4.2>
Bulk Admin Tool > BAT 5.2(1).
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e Double-click the BAT desktop icon.

You can also access BAT by browsing into Cisco CallManager Administration
from a remote PC. Open Cisco CallManager Administration and choose
Application > BAT.

Logging On to BAT

When you start BAT, a prompt asks for user ID and password. Log on with a user
ID and password that have administrator rights on the machine.

The BAT application does not depend on the Multilevel Administration (MLA)
feature in Cisco CallManager Administration

Navigating in BAT

After you log on to BAT, the main window displays with the following menu
options at the top:

e Configure
e Applications
e Help

The Configure menu gives you access to configuration tasks for the following
device types and the TAPS tool, if installed:

e Phones
e Users
e Manager/Assistants
e User Device Profiles
e Gateways
e Forced Authorization Codes
e Client Matter Codes
e Pickup Group
e TAPS (optional)
The Applications menu gives you direct access to the following options:

e Install Plugins
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e Update Plugin URL
e (Cisco CallManager Administration
e (Cisco CallManager Serviceability
The Help menu provides the following Help information:
e Contents and Index
e For this page
e About Bulk Administration Tool

Additional Information
See the “Related Topics” section on page 1-20.

Using Online Help

To access BAT online help, choose the Help menu. The Help menu provides two
help features:

¢ Contents and Index—Opens the BAT help file and allows you to browse for
information or search the index.

¢ For This Page—Opens the help directly for the window that you are
currently viewing. You can still browse the remainder of the help or use the
index.

Online help provides a multivolume system that allows you to access several
different help systems, all from the same window. You can also access a
comprehensive search engine and index.

Additional Information
See the “Related Topics” section on page 1-20.

Finding the BAT Version

To find the current version of BAT, choose Help > About Bulk Administration
Tool > Details.

To find the current version of BAT from Cisco CallManager Administration,
choose Help > Component Versions.
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Step 2

Using the BAT Application

If BAT is not currently installed, you can find the version of BAT that is available
with Cisco CallManager without installing it. To do this

Download the BAT application from the Cisco CallManager Install Plugins
window.

Right-click the file BulkAdministrationTool.exe, choose Properties, and then
choose Product Version.

Additional Information
See the “Related Topics” section on page 1-20.

Stopping BAT Transactions

Note

BAT provides a tool to stop BAT transactions that are in progress. This capability
can prove useful when you start a BAT transaction, then notice a degradation in
Cisco CallManager performance, and want to stop the transaction. You can
always run the BAT transaction later when there is less impact to

Cisco CallManager performance. You might want to stop BAT if you realize that
the wrong transaction has been started or if you need to make additional changes
before running the transaction.

You can access the Stop BAT function only from the publisher database server.

To stop BAT, choose Start > Programs > Cisco CallManager 4.2 >
Bulk Admin Tool > Stop BAT.

The BAT transaction halts. View the log file for details about how many BAT
processed records passed or failed. See the “BAT Log Files” section on page 13-1
for information on log files.

Stop BAT does not stop export transactions that are in progress.

Additional Information
See the “Related Topics” section on page 1-20.
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Related Topics

e BAT Data Input Files, page 1-2
e BAT Configuration Process, page 1-3
e Using the BAT Application, page 1-14
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CHAPTER

Installing the BAT Application

This chapter provides information about installing, upgrading, and uninstalling
BAT. You must install BAT on the same server as the publisher database for
Cisco CallManager.

The Tool for Auto-Registered Phones Support (TAPS), an optional component of
BAT, also works with BAT. TAPS gets installed separately from BAT on both the
Cisco CallManager publisher server and the Cisco Customer Response System
(CRS) applications server. See the “Installing TAPS” section on page 12-5 for
installation instructions for TAPS.

During BAT installation or reinstallation on the publisher database server, the
setup program halts the following services:

e IIS Administration
e World Wide Web publishing
e FTP publishing

These services automatically restart when the installation is complete.

You cannot install or upgrade BAT by using Windows Terminal Services. You
must install BAT directly from the Cisco CallManager server.

Additional Information
See the “Related Topics” section on page 2-5.
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Upgrading BAT

You can upgrade to BAT Release 5.2(1) from any 5.0(x) and 5.1(x). Template
migration occurs with upgrades from BAT Release 5.0(x) and 5.1(x) (and any
intermediate release) to Release 5.2(1).

BAT automatically migrates existing BAT templates. Although default values are
provided, product-specific configuration for phones and gateways remains blank
during migration. For example, an existing BAT template that was created for
FXO trunks on a Cisco VG200 gateway would migrate, so it contains the new
fields that are provided in BAT Release 5.2(1), such as Common Profile, but any
new Product Specific Configuration fields, that may appear Cisco VG200
gateways, remain blank. Fields in which you already provided data, such as device
pool and calling search space, contain the original data after migration.

Note  BAT does not support backward template migration. Keep in mind that if you have
installed BAT Release 5.2(1) and you reinstall an earlier BAT release, no template
migration occurs.

BAT data files in comma separated value (CSV) format do not migrate during an
upgrade. Follow the instructions in the “Installing BAT” section on page 2-2 to
upgrade to BAT Release 5.2(1).

Note  If you are currently using BAT Release 3.0(3), you can upgrade to Release 5.2(1),
but the upgrade provides no template migration.

Additional Information
See the “Related Topics” section on page 2-5.

Installing BAT

Before You Begin
The following prerequisites apply to the BAT installation for BAT Release 5.2(1):

e Make sure that you are installing BAT on the server that is running the
publisher database for Cisco CallManager.
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Step 2
Step 3
Step 4

Step 5

Step 6

Step 7
Step 8

Installing BAT W

e Install BAT directly on the Cisco CallManager server; do not use Terminal
Services.

Use the following procedure to install BAT.

Procedure

Log on with administrator privileges to the system that is running the publisher
database for Cisco CallManager.

Choose Applications > Install Plugins. The Install Plugins window displays.
Find Cisco Bulk Administration Tool and double-click the setup icon.

A standard Windows dialog box appears. You must choose whether to copy the
BAT install executable to your system or to run it from the current location.

If an existing version of BAT is detected on the server, a prompt asks you to
confirm the reinstallation or upgrade. To reinstall BAT or to upgrade from a
previous version, click OK.

The Welcome screen displays. Click Next, and the Current Settings window
displays.

To install to the default location C:\CiscoWebs\BAT), click Next. BAT installs to
C:\ciscowebs\BAT\. You cannot change this path. The Start Copying Files
window displays. Setup begins copying files.

The Setup Complete window displays. You have successfully installed BAT.

To close Setup, click Finish.

Additional Information
See the “Related Topics” section on page 2-5.

Moving the BAT Spreadsheet to a Workstation That Has
Microsoft Excel

During the BAT installation process, the installation program puts the BAT Excel
spreadsheet file in the following default location on the publisher database server:
C:\CiscoWebs\BAT\ExcelTemplate.
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Because you are unlikely to have Microsoft Excel installed on the publisher
database server, copy and paste the Excel spreadsheet file that is named BAT.xIt
to a workstation where you have Microsoft Excel installed. Use the BAT
spreadsheet at this workstation to create the BAT data files.

Uninstalling BAT

Note

Step 1

Step 2

Step 3

Use the following steps to uninstall BAT or use Add/Remove Programs in the
Control Panel.

The uninstall program for BAT 5.2(1) removes the BAT application and the BAT
Excel spreadsheet that is stored in the C:\CiscoWebs\BAT\ExcelTemplate\ folder.
The uninstall program does not remove any BAT data files or BAT templates that
you created and saved to the C:\BATFiles or C:\CiscoWebs\BAT\Templates\
folders.

If you uninstall BAT and then install the newer version of BAT, none of your
previous templates can migrate to the newer version. You must upgrade BAT to
migrate templates to the new BAT release.

Use the following procedure to uninstall BAT.

Procedure

On the server that is running the publisher database for Cisco CallManager,
choose Start > Programs > Cisco CallManager 4.2 > Bulk Admin Tool >
Uninstall BAT.

A dialog box requests confirmation of the uninstall request.
To uninstall BAT, click OK or Cancel to exit the uninstaller.
The IIS Admin service stops, files are deleted, and the IIS Admin service restarts.

To exit the uninstaller, click OK.
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A
Note  Beginning with BAT release 5.1(1), BAT and TAPS have separate install and
uninstall programs.

Additional Information
See the “Related Topics” section on page 2-5.

Related Topics

e Upgrading BAT, page 2-2
e Installing BAT, page 2-2
e Uninstalling BAT, page 2-4
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Working with Phones and IP
Telephony Devices

BAT gives the administrator a fast and efficient way to add, update, or delete large
numbers of phones in batches, rather than performing individual updates through
Cisco CallManager Administration. You can use BAT to work with the following
types of phones:

e Cisco IP Phones (all models)

e CTI ports

e H.323 clients

e (Cisco VGC virtual phones and Cisco VGC phones

The following topics provide information about using BAT to work with phones
and other IP telephony devices:

e Adding Phones, page 3-2

e Updating Phones, page 3-58

e Using Phone Export, page 10-3

e Updating Lines, page 3-69

e Adding Lines to Existing Phones and UDPs, page 3-78
e Deleting Phones, page 3-84

e Resetting or Restarting Phones, page 3-87

e Configuring CAPF, page 3-90

¢ Adding New Phones with Users, page 4-22
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e Generating Reports for Phones, page 11-1

Adding Phones

Step 1
Step 2

Step 3

Step 4
Step 5

When you use BAT to add phones and other IP telephony devices to the
Cisco CallManager database, you can add multiple lines, services, and speed dials
for each phone. You can also add CTI ports and H.323 clients.

You have two options for creating a CSV data file for phones:
e Use the BAT spreadsheet (BAT.xIt) and export the data to the CSV format.
e Use a text editor to create a text file in CSV format (for experienced users).

Use the following steps to add phones and IP telephony devices in bulk.

Choose Configure > Phones. The Phones Options window displays.

Choose Insert Phones and click Next. The Steps to Insert Phones window
displays.

Choose Add, view, or modify phone templates and click Next.

The Phone Template Configuration window displays. See the “Using BAT Phone
Templates” section on page 3-3 for information about configuring phone
templates.

Choose Create the CSV data file and click Next.

Choose the option that you will use to create the CSV data file and use the steps
for that option.

BAT Spreadsheet for Phones, CTI Ports and H.323 Clients

Open the BAT spreadsheet and create the CSV data file. See “Using the BAT
Spreadsheet to Create a CSV Data File for Phones” section on page 3-39

Text Editor to Create the CSV Data File
a. Choose Add, view, or modify file formats and click Next.

The File Format Configuration window displays. See the “Using a Text Editor
to Create the CSV Data File for Phones” section on page 3-50 for information
about configuring file formats for CSV data file.
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Step 6

Step 7

Adding Phones W

b. Use a text editor and create the CSV data file for phones that follows the file
format that you want to use. For more information about creating a text-based
CSV file, see “Creating a Text-Based CSV File for Phones” section on
page A-2

c. Choose Associate file format with the CSV data file and click Next.

The Add File to Format window displays. See the “Associating the File
Format with the CSV Data File” section on page 3-54 for information about
associating file formats.

Choose Validate phone records and click Next.

The Validate Phones window displays. See the “Validating Phone Records”
section on page 3-55 for information about validating phone records.

Choose Insert Phones and click Next.

The Insert Phones window displays. See the “Inserting Phones into
Cisco CallManager” section on page 3-56 for information about inserting phone
records into the Cisco CallManager database.

Additional Information

See the “Related Topics™ section on page 3-93.

Using BAT Phone Templates

Use BAT phone templates to define the common phone attributes to add a group
of new phones. Prior to creating the template, make sure phone settings such as

device pool, location, calling search space, button template and softkey templates
have already been configured in Cisco CallManager Administration. You cannot
create new settings in BAT.

Use these topics to work with BAT Phone Templates:
e Creating a New BAT Phone Template, page 3-4
e Adding or Updating Lines in a BAT Template, page 3-4
e Copying a BAT Phone Template, page 3-8
e Deleting Templates, page 3-9
e Field Descriptions for a BAT Phone Template, page 3-9
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Creating a New BAT Phone Template

Step 1

Step 2

Step 3

Step 4

Step 5
Step 6

Use this procedure to create the phone template. After you create a phone
template, you can add lines, services, and speed dials. Use the following
procedure to create a phone template.

Procedure

In the Phone Templates Configuration window, click Add a new Phone
Template.

In the Phone Template Name field, enter a name for the template. The name can
contain up to 50 alphanumeric characters. Example: Sales_7960.

From the Device Type drop-down list, choose the phone model, Cisco IP Phones,
Cisco VGC virtual phones and Cisco VGC phones, CTI port, or H.323 client for
which you are creating the template.

After you choose the device, the Phone Templates Configuration window
refreshes with fields and default entries for the chosen device type.

In the Device Information area, enter the phone settings that this batch has in
common. See Table 3-1 for field descriptions. Some phone models and device
types do not have all the attributes that the table lists.

After you have entered all the settings for this BAT phone template, click Insert.

When the status indicates that the transaction has completed, scroll down to the
Line Details area to add line attributes.

Adding or Updating Lines in a BAT Template

To add one or more lines to the BAT template or to update existing lines, follow
this procedure. The button template in use for this BAT template determines the
number of lines that you can add or update. You can create a master phone
template that has multiple lines. Then, you can use the master template to add
phones with a single line or up to the number of lines in the master template. See
the “Master Phone Templates” section on page 1-5 for more information.
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Step 2

Step 3

Step 4

Step 5
Step 6
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Procedure

In the Phone or User Device Profile Template Configuration window, choose the
template for which you want to add line(s).

Scroll down to the bottom of the template and click Add Line.
A popup window displays.

N

Note  The maximum number of lines that display for a BAT template depends
on model and button template that you chose when you created the BAT
phone template.

Enter or choose the appropriate values for the line settings that are described in
Table 3-2. Keep in mind that all phones or user device profiles in this batch will
use the settings that you choose for this line. Treat all fields as optional.

Click Insert and Close.

BAT adds the line to the phone template configuration, and the popup window
closes.

Repeat Step 2 through Step 4 to add settings for any additional lines.

For some Cisco IP Phone models, you can add Cisco IP Phone services and speed
dials to the template. See these topics for the procedures:

¢ Adding or Updating IP Services in a BAT Template, page 3-5
e Adding or Updating Speed Dials in a BAT Template, page 3-6

Adding or Updating IP Services in a BAT Template

N

Note

You can subscribe Cisco IP Phone services to the Cisco IP Phone models that
include this feature.

You can bulk subscribe users or phones to IP services with common service
parameters but not to IP services with unique service parameters.
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Step 1

Step 2

Step 3

Step 4
Step 5
Step 6
Step 7
Step 8
Step 9
Step 10

Procedure

In Phone or User Device Profile Template Configuration window, choose the
template for which you want to add service(s).

Click Subscribe/Unsubscribe Services in upper, right corner of the window.

A popup window displays. In this window, you can subscribe to Cisco IP Phone
services that are available.

In the Select a Service box, choose a service to which you want all phones to be
subscribed. The Service Description box displays details about the service that
you choose.

Click Continue.

In the Service Name field, modify the name of the service if required.

To associate these phone services to the phone template, click Subscribe .
To add more services, repeat Step 3 through Step 6.

To add all the services to the template, click Update.

Close the popup window.

You can add speed dials to the template by continuing to the “Adding or Updating
Speed Dials in a BAT Template” section on page 3-6.

Adding or Updating Speed Dials in a BAT Template

Step 1

Step 2

You can add and update speed dials in the BAT template.

You can designate speed dials for phones and Cisco VGC phones if the Phone
Button Template provides speed-dial buttons

Procedure

In the Phone or User Device Profile Template Configuration window, choose the
template for which you want to add speed dial(s)

Click Add/Update Speed Dials in the upper, right corner of the window.
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Step 3

Step 4
Step 5

Step 6
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A popup window displays. In this window, you can designate speed-dial buttons
for Cisco IP Phones and expansion modules. The phone button template in use for
this BAT template determines the number of available speed-dial buttons.

In the Speed Dial Settings for Phone area, enter the phone number, including any
access or long-distance codes, in the Speed Dial Number field.

In the Label field, enter a label that corresponds to the speed-dial number.

In the Speed Dial Settings not associated with a button area, you can set
abbreviated speed dials for applicable IP phone models by repeating Step 3 and
Step 4.

Click Update and Close.

BAT inserts the speed-dial settings in the template, and the popup window closes.

Additional Information

See the “Related Topics™ section on page 3-93.

Viewing or Modifying BAT Phone Templates

Step 1

Step 2

Step 3
Step 4

Use this procedure to view or modify an existing phone or user device profile
template. You can add or update lines, services, and speed dials.

Procedure

In the Phone Template Configuration window, choose an existing template from
the list of templates. The template details display in the template fields.

Add, change, or remove settings in the template. See “Field Descriptions for a
Phone Template” section on page 3-10 for more information.

After you have modified the settings to update the template, click Update.

If you want to update other attributes, choose one of the following procedures:
¢ Adding or Updating Lines in a BAT Template, page 3-4
¢ Adding or Updating IP Services in a BAT Template, page 3-5
e Adding or Updating Speed Dials in a BAT Template, page 3-6
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Copying a BAT Phone Template

~

Note

Step 1

Step 2

Step 3
Step 4
Step 5

Step 6

You can copy the properties of a phone template into a new phone template when
you want to change only a few fields.

The new template that you create must be the same device type as the original
template, such as Cisco IP Phone model 7960.

Use the following procedure to copy an existing BAT phone template.

Procedure

In Phone Template Configuration window, choose the template that you want to
copy from the Phone Templates column. The chosen template details display in
the Phone Template Configuration window.

Verify that this is the template that you want to copy and click Copy.

The template reproduces and creates a copy. The copy duplicates all the values
that were specified in the original template.

In the Phone Template Name field, enter a new template name, up to 50
alphanumeric characters.

Update the fields as needed for the new template. See “Field Descriptions for a
Phone Template” section on page 3-10 for information.

Click Insert. The template that is added to BAT displays in the Phone Templates
column on the left.

Click Add Line to set line attributes, if applicable. See the “Adding or Updating
Lines in a BAT Template” section on page 3-4 for more information. You can also
define services and speed-dial buttons.

Additional Information
See the “Related Topics” section on page 3-93.
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Deleting Templates

Step 1

Step 2

Step 3

Step 4

You can delete BAT templates when you no longer require them. Use this
procedure to delete a template.

Procedure

In the The Steps to Insert Phones window, choose Add, view, or modify phone
templates and click Next. The Phone Templates Configuration window displays.

In the Phone Templates column on the left, click the template that you want to
delete. The details for the chosen template display in the Template Configuration
window.

Verify that this is the template that you want to delete and click Delete.
A message displays that asks you to confirm the delete operation.

To delete the template, click OK. The template name disappears from the list of
phone templates.

Additional Information
See the “Related Topics” section on page 3-93.

Field Descriptions for a BAT Phone Template

Table 3-1 provides descriptions of all possible fields that display when you are
adding a BAT phone template for all IP telephony devices. For related
information, refer to “Related Topics” section on page 3-93.

Some device types do not require all the phone settings.

Some fields display the values that were configured in Cisco CallManager
Administration.

In the BAT user interface, field names that have an asterisk require an entry. Treat
fields that do not have an asterisk as optional.
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Table 3-1 Field Descriptions for a Phone Template

Field Description
Owner User ID Enter a user ID for the primary phone user.
Device Pool Choose the device pool for this group of phones/ports.

For devices, a device pool defines sets of common
characteristics, such as region, date/time group,
Cisco CallManager group, and calling search space for
auto-registration.

Common Profile Choose the Common Profile from the drop-down list
box. For more configuration information, refer to
Cisco CallManager Administration Guide.

Calling Search Space |Choose the calling search space for this group of
phones/ports.

A calling search space specifies the collection of Route
Partitions that are searched to determine how a dialed
number should be routed.

AAR Calling Search Choose the appropriate calling search space for the
Space device to use when it performs automated alternate
routing (AAR). The AAR calling search space
specifies the collection of route partitions that are
searched to determine how to route a collected
(originating) number that is otherwise blocked due to
insufficient bandwidth.

Media Resource Group |Choose the media resource group list (MRGL) for this
List group of phones/ports.

An MRGL specifies a list of prioritized media resource
groups. An application can choose required media
resources from the available ones according to the
order that is defined in the MRGL.

User Hold Audio Choose the user hold audio source for this group of
Source phones/ports.

The user hold audio source identifies the audio source
from which music is played when a user places a call
on hold.
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Table 3-1 Field Descriptions for a Phone Template (continued)

Field Description

Network Hold Audio  |Choose the network hold audio source for this group of
Source IP phones or ports.

The network hold audio source identifies the audio
source from which music is played when the system
places a call on hold, such as when the user transfers
or parks a call.

Location Choose the appropriate location for this group of IP
phones or ports.

The location specifies the total bandwidth that is
available for calls to and from this location. A location
setting of None means that the locations feature does
not keep track of the bandwidth that this

Cisco IP Phone consumes.

AAR Group Choose the automated alternate routing (AAR) group
for this device. The AAR group provides the prefix
digits that are used to route calls that are otherwise
blocked due to insufficient bandwidth.

Set AAR Group to <None> to prevent rerouting
blocked calls.

User Locale Choose the country and language set that you want to
associate with this group of IP phones.

This choice determines which cultural-dependent
attributes exist for this user and which language
displays for the user in the Cisco CallManager user
windows and phones.

Network Locale Choose the network locale that you want to associate
with this group of phones.

The Network Locale comprises a set of tones and
cadences that Cisco gateways and phones use when
communicating with the PSTN and other networks in a
specific geographical area.
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Table 3-1 Field Descriptions for a Phone Template (continued)

Field

Description

Device Security Mode

From the drop-down list box, choose the mode that you
want to set for the device:

e Use System Default—The phone uses the value
that you specified for the enterprise parameter,
Device Security Mode.

e Non-secure—No security features exist for the
phone. A TCP connection opens to
Cisco CallManager.

e Authenticated—Cisco CallManager provides
integrity and authentication for the phone. A TLS
connection using NULL/SHA opens.

¢ Encrypted—Cisco CallManager provides
integrity, authentication, and encryption for the
phone. A TLS connection using AES128/SHA
opens

Note  This field displays only if the phone model
supports authentication or encryption.

Signal Packet Capture
Mode

From the drop-down list box, choose the mode that you
want to set for signal packet capture:

¢ None—Choose None if you do not want to specify
a mode.

e Real-Time Mode—Use this mode for real-time
signal packet capture.

e Batch Processing Mode—Use this mode for batch
processing signal packet capture mode.

Packet Capture
Duration

Enter the time for packet capture in minutes. You can
enter a maximum duration of 300 minutes. The default
duration specifies 60 minutes.
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Table 3-1 Field Descriptions for a Phone Template (continued)

Field Description

Built In Bridge Enable or disable the built-in conference bridge for the
barge feature by using the Built In Bridge drop-down
list box (choose On, Off, or Default).

For more configuration information, refer to the Barge
and Privacy Features in the Cisco CallManager
Features and Services Guide.

Privacy For each phone that wants Privacy, choose Or in the
Privacy drop-down list box.

For more configuration information, refer to Barge and
Privacy Features in the Cisco CallManager Features
and Services Guide.

Device Mobility Mode |Turn the Device Mobility feature on or off for this
device.

Click View Current Settings to display the current
values of these device mobility parameters:

e (Cisco CallManager Group

e Roaming device pool

e Location

e Region

e Network Locale

e AAR Group

¢ AAR Calling Search Space

e Device Calling Search Space
e Media Resource Group List
e SRST

For more configuration information, refer to
Cisco CallManager Features and Services Guide.

Retry Video Call as Check this check box to retry a video call as an audio
Audio call.
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Table 3-1

Field Descriptions for a Phone Template (continued)

Field

Description

Ignore Presentation
Indicators (Internal
Calls Only)

Check this check box to ignore presentation indicators
in an internal call.

Logged into Hunt
Group

Check this check box if you are logged into a hunt
group. Leave this field unchecked if you want to logout
of all the hunt groups to which your phone belongs.

Phone Button Template and

Expansion Module Template Information

Phone Button Template

Choose the button template for all phones in this
group. Button templates determine the button identity
(line, speed dial) and the button location on the phone.
Button templates include the expansion modules.

Softkey Template Information

Softkey Template

Choose the softkey template to be used for all phones
in this group.

Expansion Module Informat

ion

Module 1

Choose the expansion module if installed in the phone.

Module 2

Choose the expansion module if installed in the phone.

Firmware Load Information

Phone Load Name

Enter the custom phone load, if applicable.

Note  Any value thatis entered in this field overrides

the default value for the chosen model.

Module 1 Load Name

Enter the firmware load for the first Cisco IP Phone
Expansion Module, if applicable. Leave this field
blank to use the default load.

Module 2 Load Name

Enter the firmware load for the second Cisco IP Phone
Expansion Module, if applicable. Leave this field
blank to use the default load.

Cisco IP Phone - External Data Locations

Information

Enter the help text URL for the information button for
Cisco IP Phones.
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Table 3-1 Field Descriptions for a Phone Template (continued)

Field Description

Directory Enter the URL of the directory server for
Cisco IP Phones.

Messages Enter the voice-messaging access pilot number for
Cisco IP Phones.

Services Enter the URL for the services menu for

Cisco IP Phones.

Authentication Server |Enter the URL that the phone uses to validate requests
that are made to the phones web server. If you do not
provide an authentication URL, the advanced features
on the Cisco IP Phone models that require
authentication will not function. Leave this field blank
to accept the default setting.

By default, this URL accesses a Cisco IP Phone User
Options window that was configured during
installation.

Proxy Server Enter the host and port (for example,
proxy.cisco.com:80) that are used to proxy HTTP
requests for access to non-local host addresses from
the phones HTTP client.

If the phone receives a URL such as www.cisco.com in
a service and the phone is not configured in the
cisco.com domain, the phone uses the proxy server to
access the URL. If the phone is configured in the
cisco.com domain, the phone accesses the URL
without using the proxy because it is in the same
domain as the URL.

Leave this field blank to accept the default setting.

Idle Enter the URL of the XML service that will appear as
the idle display on the Cisco IP Phone LCD screen
when the phone has not been used for the time that is
specified in the Idle Time field. For example, you can
display a logo on the LCD screen when the phone has
not been used for 5 minutes. Leave this field blank to
use the default value.
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Table 3-1 Field Descriptions for a Phone Template (continued)

Field Description

Idle Timer Enter the seconds that you want to elapse before the
phone displays the URL that is specified in the Idle
field. Leave this field blank to use the default value.

MultiLevel Precedence and Preemption (MLPP) Information

MLPP Indication If available, this setting specifies whether a device
capable of playing precedence tones will use the
capability when it places an MLPP precedence call.

From the drop-down list box, choose a setting to assign
to this device from the following options:

e Default—This device inherits its MLPP
indication setting from its device pool.

e Off—This device does not send indication of an
MLPP precedence call.

e On—This device does send indication of an
MLPP precedence call.

Note Do not configure a device with the following
combination of settings: MLPP Indication is
set to Off while MLPP Preemption is set to
Forceful.
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Table 3-1 Field Descriptions for a Phone Template (continued)

Field

Description

MLPP Preemption

If available, this setting specifies whether a device that
is capable of preempting calls in progress will use the
capability when it places an MLPP precedence call.

From the drop-down list box, choose a setting to assign
to this device from the following options:

e Default—This device inherits its MLPP
preemption setting from its device pool.

e Disabled—This device does not preempt calls in
progress when it places an MLPP precedence call.

e Forceful—This device preempts calls in progress
when it places an MLPP precedence call.

Note Do not configure a device with the following
combination of settings: MLPP Indication is
set to Off while MLPP Preemption is set to
Forceful.

MLPP Domain (e.g.,
"0000FF")

Enter a hexadecimal value for the MLPP domain
associated with this device. Must be blank or a value
between 0 and FFFFFF.

Certification Authority Prox

y Function (CAPF) Information (These parameters display

only for devices with the capability to support authentication or encryption.)

Certificate Operation

From the drop-down list box, choose the Certification
Operation that you want to perform from the following
options:

¢ No Pending Operation—No pending
Certification Operation lists for this device.
Choosing this option disables the remaining CAPF
fields.

e Install/Upgrade—Install or upgrade a
Certification Operation.

¢ Delete—Delete a Certification Operation

¢ Troubleshoot—Troubleshoot a Certification

Operation.
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Table 3-1 Field Descriptions for a Phone Template (continued)

Field

Description

Authentication Mode

From the drop-down list box choose the
Authentication Mode for this device from the
following options:

e By Authentication String—You can enter the
authentication string in the Authentication string
text box or get a system-generated string

e By Null String—This mode uses a null string

e By Existing LSC—This mode Uses the (Local
Significant Certificate) LSC setting

e By Manufacture Installed Certificate—This mode
uses the manufacture-installed certificate.

Authentication String

If Authentication Mode is By Authentication String,
enter the Authentication String. Alternately, to get a
system-generated string, click Generate String.

Key Size (Bits)

From the drop-down list box, choose the
authentication key size for the device. The default key
size specifies 1024 bits.

Operation Completes
By

Enter the date by which the Certification Operation
will complete. The date format specifies YYYY: MM:
DD: HH. The default completion date specifies 10
days from the current system date.

Extension Mobility (Device

Profile) Information

Enable Extension
Mobility Feature

Check this check box to enable the extension mobility
feature. Extension mobility allows a user to log in and
out of a Cisco IP Phone. Refer to the

Cisco CallManager Features and Services Guide for

more information about extension mobility.
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Table 3-1 Field Descriptions for a Phone Template (continued)

Field

Description

Log Out Profile

Choose the profile that a phone should load when an
extension mobility user logs out. You must configure
logout profiles in Cisco CallManager Administration.

Use Current Device Setting—This choice creates an
autogenerated device profile as the default device
profile.

Select a User Device Profile—This choice assigns a
user device profile, which has already been defined,
that becomes the default device profile for this device.

The chosen user device profile gets loaded onto the
device when no user is logged in.

Product-Specific Configuration

Disable Speakerphone

Check this check box to disable the speakerphone for
all phones that are added by using this BAT template.

Disable Speakerphone
and Headset

Check this check box to disable the speakerphone and
headset for all phones that are added by using this BAT
template.

Forwarding Delay

Choose Enabled if you want the port to wait a few
seconds prior to forwarding a call. The default
specifies to Disabled.

PC Port

Choose Enabled or Disabled to control the PC port on
phones that have internal switches. Use the port
labeled “10/100 PC” on the back of the phone to
connect a PC or workstation to the phone, and share a
single network connection.

Settings Access

Choose Enabled or Disabled to control whether the
user has access to phone settings or not.

Gratuitous ARP

Choose Enabled or Disabled to control gratuitous ARP.

PC Voice VLAN
Access

Choose Enabled or Disabled to control access to a PC
voice VLAN.

Video Capabilities

Choose Enabled or Disabled to control video
capabilities access.
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Table 3-1 Field Descriptions for a Phone Template (continued)

Field Description

Auto Line Select Choose Enabled or Disabled to allow automatic line
selection on the phone.

H.323 Device Information

Signaling Port The value designates the H.225 signaling port that this
device uses.

The default value specifies 1720. Valid values include
1 through 65535.

Retry Video Call as This check box applies only to video endpoints that
Audio receive a call. If this phone receives a call that does not
connect as video, the call tries to connect as an audio
call.

By default, the system checks this check box to specify
that the sending device should immediately retry a
video call that does not connect as an audio call prior
to sending the call to call control for rerouting.

If you uncheck this check box, a video call that fails to
connect as video fails to call control. At this point, call
control reroutes the call within the route list. If
Automatic Alternate Routing (AAR) is configured and
enabled, call control also reroutes the call between
route lists.

Wait for Far End H.245 |By default, the system keeps this check box checked to
Terminal Capability specify that Cisco CallManager should initiate

Set capabilities exchange. This check box specifies that
the Cisco CallManager needs to receive the far-end
H.245 Terminal Capability Set before it sends its
H.245 Terminal Capability Set.

H.323 Information

Outgoing Caller ID For incoming calls to the phone, enter the pattern, from
Pattern 0 to 24 digits, that you want to use for caller ID.
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Field Descriptions for a Phone Template (continued)

Field

Description

Calling Party Selection

Choose one of the following options to specify which
directory number is sent:

Originator—Send the directory number of the
calling device.

First Redirect Number-—Send the directory
number of the redirecting device.

Last Redirect Number—Send the directory
number of the last device to redirect the call.

First Redirect Number(external)—Send the
directory number of the redirecting device.

Last Redirect Number(external)—Send the
directory number of the last device to redirect the
call.

Calling Party
Presentation

Choose whether the central office transmits or blocks
caller ID:

Choose Allowed if you want the central office to
send caller ID.

Choose Restricted if you do not want the central
office to send caller ID.

Default displays the caller ID unless the caller ID
was restricted in a previous level in the call stream.

Display IE Delivery

Check the check box to deliver the display information
element (IE) in SETUP and CONNECT messages for
the calling and called party name delivery service.
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Table 3-1 Field Descriptions for a Phone Template (continued)

Field Description

Redirecting Number IE |Check this check box to include the Redirecting
Delivery—Outbound |Number IE in the outgoing SETUP message from the
Cisco CallManager to indicate the first redirecting
number and the redirecting reason of the call when the
call is forwarded.

Uncheck the check box to exclude the first redirecting
number and the redirecting reason from the outgoing
SETUP message.

Use Redirecting Number IE for voice-messaging
integration only. If your configured voice-messaging
system supports Redirecting Number IE, check the

check box.
Redirecting Number IE |Use Redirecting Number IE when you are integrating
delivery—Inbound a voice-messaging system that supports Redirecting
Number IE.

Check this check box to accept the Redirecting
Number IE in the incoming SETUP message to the
Cisco CallManager.

Uncheck the check box to exclude the Redirecting
Number IE in the incoming SETUP message to the
Cisco CallManager.
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Table 3-1 Field Descriptions for a Phone Template (continued)

Field Description
Media Termination Use this field to indicate whether a media termination
Point Required point (MTP) is used to implement features that H.323

does not support (such as hold and transfer).

Check the Media Termination Point Required check
box if you want to use a media termination point to
implement features. Uncheck the Media Termination
Point Required check box if you do not want to use a
media termination point to implement features.

Use this check box only for H.323 clients and those
H.323 devices that do not support the H.245 empty
capabilities set or if you want media streaming to
terminate through a single source.

If you check this check box to require an MTP and this
device becomes the endpoint of a video call, the call
works as audio only.

Gatekeeper Information

Gatekeeper Name Choose the gatekeeper for the gatekeeper-controlled
H.323 device from the drop-down list box.

Note If you do not choose the device, the system
disables the E.164, Technology Prefix, and
Zone fields.

Note  You cannot change the device to a
gatekeeper-controlled phone if more than one
directory number is configured for the device.
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Table 3-1 Field Descriptions for a Phone Template (continued)

Field Description

Technology Prefix Enter the technology prefix to eliminate the need for
entering the IP address for every Cisco CallManager
system when configuring the gw-type-prefix
command. For example, you can enter 1#* in this field
if you can use the following gw-type-prefix command
on the gatekeeper:

gw-type-prefix 1#* default-technology.

Note  You must enter a value in this field for a
gatekeeper-controlled H.323 client. You can
enter only numbers (0-9) and special
characters # and * in this field.

Zone On the Gatekeeper, enter the specific zone with which
Cisco CallManager will register. The zone specifies
the total bandwidth that is available for calls between
this zone and another zone.

Note  You must enter a value in this field for a
gatekeeper-controlled phone. You can enter
only letters, numbers, spaces, dashes, dots, and
underscores in this field.

Gatekeeper Controlled |Check this check box to configure the H.323 client
H.323 Client gatekeeper as a controlled gatekeeper.

Note  To continue configuring the BAT phone template, go to the “Creating a New BAT
Phone Template” section on page 3-4

Field Descriptions for Adding a Line to a BAT Template

Table 3-2 provides descriptions of all possible fields that display when you are
adding a line in a BAT phone template. For related information, refer to “Related
Topics” section on page 3-93

Some device types do not require all the phone settings.
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Some fields display the values that were configured in Cisco CallManager
Administration.

In the BAT user interface, field names that have an asterisk require an entry. Treat
fields that do not have asterisk as optional.

Table 3-2 Field Descriptions for Adding a Line to a BAT Template

Field Description

Directory Number

Partition Choose a route partition to which the directory
number belongs.

Note The directory number can appear in more
than one partition.

Directory Number Settings

Voice Mail Profile Choose this parameter to make the pilot number the
same as the directory number for this line. This
action proves useful if you do not have a
voice-messaging server that is configured for this
phone.

Calling Search Space Choose partitions that are searched for numbers that
are called from this directory number.

Note Changes cause an update of Pickup Group
Names that are listed in the Call Pickup
Group field. The setting applies to all
devices that are using this directory number.

AAR Settings
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Table 3-2  Field Descriptions for Adding a Line to a BAT Template (continued)

Field

Description

AAR Voice Mail

The settings in this row of fields specify treatment of
calls for which there is insufficient bandwidth to
reach the destination. These calls are handled by
automated alternate routing (AAR) and are routed to
the AAR Destination Mask or Voice Mail.

Check this check box to use settings in the Voice
Mail Profile Configuration window.

Note  When this check box is checked,
Cisco CallManager ignores the settings in
the Coverage/Destination box and Calling
Search Space.

AAR Destination Mask

Use this setting instead of the external phone number
mask to determine the AAR Destination to be dialed.

AAR Group

Choose the automated alternate routing (AAR)
group for this device. The AAR group provides the
prefix digits that are used to route calls that are
otherwise blocked due to insufficient bandwidth.

Set AAR Group to <None> to prevent rerouting
blocked calls.

AAR Keep Call History

This field determines if the AAR part of the call will
be present in the Call Forwarding History.

— If you choose “Remove this destination
from the call forwarding history,” then the
AAR leg of the call is not present in the call
history.

— If you choose “Retain this destination in the
call forwarding history,” then the AAR leg
of the call will be present in the Call
History.

User Hold Audio Source

Choose the music on hold audio source to be played
when the user presses HOLD to place a call on hold.
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Table 3-2  Field Descriptions for Adding a Line to a BAT Template (continued)

Field

Description

Network Hold Audio
Source

Choose the music on hold audio source to be played
when the system places a call on hold while the user
transfers a call or initiates a conference or call park.

Auto Answer

Choose one of the following options to activate the
Auto Answer feature for this directory number:

e Auto Answer Off <Default>
e Auto Answer with Headset
e Auto Answer with Speakerphone (Intercom)

Note  Make sure that the headset or speakerphone
is not disabled when you choose Auto
Answer with Headset or Auto Answer with
Speakerphone.

Call Forward and Pickup Setti

ngs

Forward All Voice Mail

Check this check box if you want calls to forward to
the number that you chose in the voice-mail profile.

Checking this check box makes the Forward All
Destination field and Forward All Calling Search
Space check box not relevant.

Forward All Destination

Enter the directory number to which all calls are
forwarded.

Note The setting applies to any dialable phone
number, including an outside destination
unless restricted, and to all devices that are
using this directory number.

Forward All Calling
Search Space

Choose the calling search space to use when calls are
forwarded to the specified destination.

Note This setting applies to all devices that are
using this directory number.
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Table 3-2  Field Descriptions for Adding a Line to a BAT Template (continued)

Field

Description

Forward Busy Internal
Voice Mail

Check this check box if you want calls from an
internal number forwarded to a number that you
chose in the voice-mail profile.

Checking this check box makes the Forward Busy
Internal Destination field and Calling Search Space
check box not relevant.

Forward Busy Internal
Destination

Enter the directory number to which an internal call
is forwarded when the line is in use.

Note  This setting applies to any internal dialable
phone number and to all devices that are
using this directory number.

Forward Busy Internal
Calling Search Space

Choose the calling search space to use when internal
calls are forwarded to the specified destination.

Note This setting applies to all devices that are
using this directory number.

Forward Busy External
Voice Mail

Check this check box if you want calls from an
external number forwarded to a number that you
chose in the voice-mail profile.

Checking this check box makes the Forward Busy
External Destination field and Calling Search Space
check box not relevant.

Forward Busy External
Destination

Enter the directory number to which an external call
is forwarded when the line is in use.

Note  This setting applies to any dialable external
phone number, including an outside
destination unless restricted, and to all
devices that are using this directory number.

Forward Busy External
Calling Search Space

Choose the calling search space to use when external
calls are forwarded to the specified destination.

Note This setting applies to all devices that are
using this directory number.
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Table 3-2  Field Descriptions for Adding a Line to a BAT Template (continued)

Field Description
Forward No Answer Check this check box if you want calls from an
Internal Voice Mail internal number forwarded to the number that you

chose in the voice-mail profile.

Checking this check box makes the Forward No
Answer Internal Destination field and Calling
Search Space check box not relevant.

Forward No Answer Enter a directory number to which an internal call is
Internal Destination forwarded when the phone is not answered.

Note  This setting applies to any internal dialable
phone number and to all devices that are
using this directory number.

Forward No Answer Choose the calling search space to use when internal
Internal Calling Search  |calls are forwarding to the specified destination. The
Space setting displays only if it is configured in the system.

Note This setting applies to all devices that are
using this directory number.

Forward No Answer Check this check box if you want calls to forward to
External Voice Mail an external number that you chose in the voice-mail
profile.

Checking this check box makes the Forward No
Answer Externally Destination field and External
Calling Search Space check box are not relevant.

Forward No Answer Enter a directory number to which an external call is
External Destination forwarded when the phone is not answered.

Note  This setting applies to any external dialable
phone number, including an outside
destination unless restricted, and to all
devices that are using this directory number.
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Table 3-2  Field Descriptions for Adding a Line to a BAT Template (continued)

Field Description

Forward No Answer Choose the calling search space to use when external
External Calling Search |calls are forwarding to the specified destination. The
Space setting displays only if it is configured in the system.

Note  This setting applies to all devices that are
using this directory number.

Forward No Coverage Check this check box if you want calls from an
Internal Voice Mail internal number forwarded to the number that you
chose in the voice-mail profile.

Checking this check box makes the Forward No
Answer Destination field and Calling Search Space
check box not relevant.

Forward No Coverage Enter an directory number to which an internal call
Internal Destination is forwarded when the phone has no coverage.

Note  This setting applies to any internal dialable
phone number and to all devices that are
using this directory number.

Forward No Coverage Choose the calling search space to use when internal
Internal Calling Search  |calls are forwarding to the specified destination. The
Space setting displays only if it is configured in the system.

Note This setting applies to all devices that are
using this directory number.

Forward No Coverage Check this check box if you want calls from external
External Voice Mail number forwarded to the number that you chose in
the voice-mail profile.

Checking this check box makes the Forward No
Answer Destination field and Calling Search Space
check box not relevant.
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Table 3-2  Field Descriptions for Adding a Line to a BAT Template (continued)

Field

Description

Forward No Coverage
External Destination

Enter a directory number to which an external call is
forwarded when the phone has no coverage.

Note This setting applies to any dialable phone
number, including an outside destination
unless restricted, and to all devices that are
using this directory number.

Forward No Coverage
External Calling Search
Space

Choose the calling search space to use when external
calls are forwarding to the specified destination. The
setting displays only if it is configured in the system.

Note This setting applies to all devices that are
using this directory number.

Forward Unregistered
Internal Voice Mail

The settings in this row specify the forwarding
treatment for internal calls that are routed to a
directory number with no registered devices.

Check the Voice Mail check box to use settings in the
Voice Mail Profile Configuration window.

Note = When this check box is checked,
Cisco CallManager ignores the settings in
the Coverage/Destination box and Calling
Search Space. When this check box is
checked for internal calls, the system
automatically checks the Voice Mail check
box for external calls. If you do not want
external calls to forward to the
voice-messaging system, you must uncheck
the Voice Mail check box for external calls.
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Table 3-2  Field Descriptions for Adding a Line to a BAT Template (continued)

Field

Description

Forward Unregistered
Internal
Coverage/Destination

Enter any dialable phone number, including an
outside destination.

Note

When you enter a coverage/destination value
for internal calls, the system automatically
copies this value to the
Coverage/Destination field for external
calls. If you want external calls to forward to
a different destination, you must enter a
different value in the Coverage/Destination
field for external calls.

Forward Unregistered
Calling Search Space

Choose calling search space from the drop-down list
menu. This setting applies to all devices that are
using the directory number chosen above.

Note

When you choose a Calling Search Space for
internal calls, the system automatically
copies this setting to the Calling Search
Space setting for external calls. If you want
external calls to forward to a different
calling search space, choose a different
setting in the Calling Search Space for
external calls.

] Bulk Administration Tool User Guide

0L-8661-01 |



| Chapter3 Working with Phones and IP Telephony Devices

Adding Phones W

Table 3-2  Field Descriptions for Adding a Line to a BAT Template (continued)

Field

Description

Forward Unregistered
External Voice Mail

The settings in this row specify the forwarding
treatment for external calls that are routed to a
directory number with no registered devices. Specify
the following values:

Check the Voice Mail check box to use settings in the
Voice Mail Profile Configuration window.

Note  When this check box is checked,
Cisco CallManager ignores the settings in
the Coverage/Destination box and Calling
Search Space. When this check box is
checked for internal calls, the system
automatically checks the Voice Mail check
box for external calls. If you do not want
external calls to forward to the
voice-messaging system, you must uncheck
the Voice Mail check box for external calls.

Forward Unregistered
External
Coverage/Destination

Enter any dialable phone number, including an
outside destination.

Note  When you enter a coverage/destination value
for internal calls, the system automatically
copies this value to the
Coverage/Destination field for external
calls. If you want external calls to forward to
a different destination, you must enter a
different value in the Coverage/Destination
field for external calls.
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Table 3-2  Field Descriptions for Adding a Line to a BAT Template (continued)

Field

Description

Forward Unregistered
External Calling Search
Space

Choose calling search space from the drop-down list
box. This setting applies to all devices that are using
the directory number chosen above.

Note  When you choose a Calling Search Space for
internal calls, the system automatically
copies this setting to the Calling Search
Space setting for external calls. If you want
external calls to forward to a different
calling search space, choose a different
setting in the Calling Search Space for

external calls.

No Answer Ring
Duration

Enter the number of seconds to allow the call to ring
before forwarding the call to the Forward No
Answer Destination.

Call Pickup Group

Choose a Pickup Group Name to specify the call
pickup group, which can answer incoming calls to
this directory number by dialing the appropriate
pickup group number.

Multilevel Precedence and Pr

eemption Alternate Party Settings

Target (Destination)

Enter the number to which MLPP precedence calls
should be directed if this directory number receives
a precedence call and neither this number nor its call
forward destination answers the precedence call.

Values can include numeric characters, pound (#),
and asterisk (*).

Calling Search Space

From the drop-down list box, choose the calling
search space to associate with the alternate party
target (destination) number.
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Table 3-2  Field Descriptions for Adding a Line to a BAT Template (continued)

Field Description
No Answer Ring Enter the number of seconds (between 4 and 30)
Duration after which an MLPP precedence call will be

directed to the alternate party of this directory
number if this directory number and its call
forwarding destination have not answered the
precedence call.

Leave this setting blank to use the value that is set in
the Cisco CallManager enterprise parameter,
Precedence Alternate Party Timeout.

Line Settings for This Phone

Line Text Label Use this field only if you do not want the directory
number to show on the line appearance. Enter text
that identifies this directory number for a line/phone
combination.

Suggested entries include boss’s name, department’s
name, or other appropriate information to identify
multiple directory numbers to secretary/assistant
who monitors multiple directory numbers.

External Phone Number |Enter the phone number (or mask) that is sent for
Mask Caller ID information when a call is placed from this
line.

You can enter a maximum of 24 numbers and “X”
characters. The Xs represent the directory number
and must appear at the end of the pattern. For
example, if you specify a mask of 9728 13XXXX, an
external call from extension 1234 displays a caller
ID number of 9728131234.
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Table 3-2  Field Descriptions for Adding a Line to a BAT Template (continued)

Field

Description

Maximum Number of
Calls

You can configure up to 184 calls for a line on a
device in a cluster, with the limiting factor being the
device. As you configure the number of calls for one
line, the calls available for another line decrease.

The default specifies 4. If the phone does not allow
multiple calls for each line, the default specifies 2.

For CTI route points, you can configure up to 10,000
calls for each port. The default specifies 5000 calls.

Use this field in conjunction with the Busy Trigger
field.

Busy Trigger

This setting, which works in conjunction with
Maximum Number of Calls and Call Forward Busy,
determines the maximum number of calls to be
presented at the line. If maximum number of calls is
set for 50 and the busy trigger is set to 40, then
incoming call 41 gets rejected with a busy cause (and
will get forwarded if Call Forward Busy is set). If
this line is shared, all the lines must be busy before
incoming calls get rejected.

Use this field in conjunction with Maximum Number
of Calls for CTI route points. The default specifies
4500 calls.
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Table 3-2  Field Descriptions for Adding a Line to a BAT Template (continued)

Field

Description

Message Waiting Lamp
Policy

Use this field to configure the handset lamp
illumination policy. Choose one of the following
options:

e Use System Policy (The directory number refers
to the service parameter “Message Waiting
Lamp Policy” setting.)

e Light and Prompt
e Prompt Only

e Light Only

e None

Setting applies only to the current device unless you
check the check box at right (called Update Shared
Device Settings) and click the Propagate selected
button. (The check box at right displays only if other
devices share this directory number.)

Ring Setting (Phone Idle)

Choose the ring setting for the line appearance when
an incoming call is received and no other active calls
exist on that device. Choose one of the following
options:

e Use system default
e Disable

e Flash only

e Ring once

e Ring
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Table 3-2  Field Descriptions for Adding a Line to a BAT Template (continued)

Field

Description

Ring Setting (Phone
Active)

Choose the ring setting that is used when this phone
has another active call on a different line. Choose
one of the following options:

e Use system default
e Disable

e Flash only

e Ring once

¢ Ring

e Beep only

Call Pickup Group Audio
Alert Setting (Phone
Idle)

From the drop-down list box, choose the type of
audio notification for call pickup that is provided
when the phone is idle. Select one of the following
options:

e Use System Default

e Disable

¢ Ring Once

Call Pickup Group Audio
Alert Setting (Phone
Active)

From the drop-down list box, choose the type of
audio notification for call pickup that is provided
when the phone is in use. Select one of the following
options:

e Use System Default

e Disable

e Beep Only

Forwarded Call Information Display for this Device

Caller Name

Check this check box to include the caller’s name in
the display when a forwarded call is received.
Default leaves this check box checked.

Redirected Number

Check this check box to include the redirected
number in the display when receiving a forwarded
call.
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Table 3-2  Field Descriptions for Adding a Line to a BAT Template (continued)

Field Description

Caller Number Check this check box to include the caller’s number
in the display when receiving a forwarded call.

Dialed Number Check this check box to include the dialed number in
the display when a forwarded call is received. The
default setting leaves this check box checked.

To complete the procedure, go to the “Adding or Updating Lines in a BAT
Template” section on page 3-4

Using the BAT Spreadsheet to Create a CSV Data File for Phones

Step 1
Step 2
Step 3

Step 4

When you are adding new phones or IP telephony devices to the system, you can
use the Microsoft Excel spreadsheet that was designed to use with BAT. The
spreadsheet has macros that automatically adjust the options for the selected
devices. You can define the file format within the spreadsheet, and the BAT
spreadsheet uses the data file formats to display the fields for the CSV data file.

Use the following procedure to create the CSV data file by using the BAT
spreadsheet for adding new phones and other IP telephony devices.

For information about installing and using the BAT spreadsheet, see the “Using
the BAT Spreadsheet for Gathering Data” section on page 1-11.

Procedure

To open the BAT spreadsheet, locate and double-click the BAT.xIt file
When prompted, click Enable Macros to use the spreadsheet capabilities.

To display the phones options, click the Phones tab at the bottom of the
spreadsheet.

Choose a radio button for one of the following device types:

e Phones
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e CTI Port

e H.323 Client

e VGC Virtual Phone
e VGC Phone

The spreadsheet displays options that are available for the chosen device. For
example, when you choose Phones, fields for the number of phone lines and the
number of speed dials display.

N

Note  The device type that you select determines the validation criteria for data
in the BAT spreadsheet.

Step5  To choose the device and line fields that you can define for each phone, click
Create File Format. The Field Selection popup window displays.

Step 6 To choose the device fields, click a device field name in the Device Field box, and
then click the arrow to move the field to the Selected Device Fields box.

A CSV data file must include Number of Lines as the first field, MAC
Address/Device Name, and Description; therefore, these fields always remain
selected.

L

Tip You can select a range of items in the list by holding down the Shift key.
To select random field names, hold down the Ctrl key and click field
names.

Step7  Click aline field name in the Line Field box and click the arrow to move the field
to the Selected Line Fields box.

e

Tip You can change the order of the items except the first field, Number of
Lines, in the Selected Line and Device boxes. Choose an item and use the
up arrow to move the field closer to the beginning of the list, or the down
arrow to move the item to the end of the list.

Step8  Click Create to modify the CSV data file format. A message asks whether you
want to overwrite the existing CSV format.
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Step 10

Step 11

Step 12

Step 13
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Click OK. New columns for the selected fields display in the BAT spreadsheet in
the order that you specified.

Scroll to the right to locate the Number of Phone Lines box. The number of lines
that you specify here must not exceed the number of lines that are configured in
the BAT template.

A
Note  When you insert a CSV data file, the number of lines on phones must not

exceed the number of lines in the BAT phone template, or you receive an
error.

For phones, VGC phones, and VGC virtual phones, you must enter the number of
speed-dial buttons in the Number of Speed Dials box. After you enter the number,
columns display for each speed-dial number.

~

Note  When you insert the data records, do not exceed the number of speed dials
that are configured in the BAT template, or an error will result when the
CSV data file and BAT phone template are inserted.

Enter data for an individual phone on each line in the spreadsheet. Complete all
mandatory fields and any relevant optional fields. Each column heading specifies
the length of the field and whether it is required or optional. Table 3-3 describes
all the phone fields in the BAT spreadsheet.

If you did not enter the MAC address for each phone, check the Create Dummy
MAC Address check box.

When you choose the dummy MAC address option, you can update the phones
later with the correct MAC address by manually entering this information into
Cisco CallManager Administration or by using the TAPS tool. See the
“Introducing TAPS” section on page 12-2 for more information about TAPS.

N

Note If you are adding CTI ports, the dummy MAC address option gives a
unique device name to each CTI port in the form of the dummy MAC
addresses.

Do not use the dummy MAC address option for H.323 clients, VGC
phones, or VGC virtual phones.
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Step 14

Note

To transfer the data from the BAT Excel spreadsheet into a CSV formatted data
file, click Export to BAT Format.

The system saves the file to C:\XLSDataFiles\ or to your choice of another
existing folder on your local workstation under the following filename:

<tabname><timestamp>.txt

where <tabname> represents the type of input file that you created, such as
phones, and <timestamp> represents the precise date and time that the file was
created.

~

Note If you enter acomma in one of the fields, BAT.xIt encloses that field entry
in double quotes when you export to BAT format.
If you enter a blank row in the spreadsheet, the system treats the empty
row as the end of the file. The system does not convert data that is entered
after a blank line to the BAT format.

Note A CSV filename with a comma (for example, abcd,e.txt) does not get
created. Instead the file will exist separately as abcd.txt and e.txt and,
because both do not exist, BAT will fail to insert the files. To avoid this
problem, ensure the CSV file names do not contain commas.

You must copy the CSV data file to the Cisco CallManager publisher database
server, so BAT can access the CSV data file. By using a floppy disk or a mapped
network drive, copy the CSV data file from C:\XLSDataFiles\ (or the folder where
you chose to store the file) to the C:\BATFiles\Phones\Insert\ folder on the
publisher database server.

For information on how to read the exported CSV data file, click the link to View
Sample File in the Insert Phones window in BAT.

Additional Information
See the “Related Topics” section on page 3-93.
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Field Descriptions for Phones in the BAT Spreadsheet

Table 3-3 provides des
device and line details

criptions of the phone fields that are available for adding
in a CSV data file. For related information, refer to

“Related Topics” section on page 3-93.

Table 3-3 Phone Field Descriptions for the BAT Spreadsheet

Field

Description

Device Fields (Mandatory Fields)

Number of Lines

Enter the number of lines for this phone. The number can
be fewer than the number of lines in the BAT template,
but it cannot exceed the specified number of lines.

MAC Enter the MAC address for phones, VGC virtual phones,
Address/Device and VGC phones. Enter a unique identifier (Device
Name Name) for the CTI port or H.323 client. You can check
the Create Dummy MAC Addresses check box to
automatically generate unique device identifiers.
Description Enter a description such as “Conference Room A” or

“John Smith” that identifies the phone or device.

Device Fields (Optional F

ields)

Location

Enter the appropriate location for this group of IP phones
or ports.

The location specifies the total bandwidth that is
available for calls to and from this location. A location
setting of None means that the locations feature does not
keep track of the bandwidth that this Cisco IP Phone
consumes. Leave this field empty if you provided a
location in the BAT phone template.

Device Pool

Enter the device pool for this group of phones/ports.

A device pool defines sets of common characteristics for
devices, such as region, date/time group,
Cisco CallManager group, and calling search space for

auto-registration.
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Table 3-3 Phone Field Descriptions for the BAT Spreadsheet (continued)

Field Description

Calling Search Space |Enter the calling search space for this group of
phones/ports.

A calling search space specifies the collection of Route
Partitions that are searched to determine how a dialed
number should be routed.

AAR Calling Search |Enter the appropriate calling search space for the device
Space to use when it performs automated alternate routing
(AAR). The AAR calling search space specifies the
collection of route partitions that are searched to
determine how to route a collected (originating) number
that is otherwise blocked due to insufficient bandwidth.

Media Resource Enter the media resource group list (MRGL) for this
Group List group of phones/ports.

An MRGL specifies a list of prioritized media resource
groups. An application can choose required media
resources from the available ones according to the order
that is defined in the MRGL.

User Hold Audio Enter the user hold audio source that this group of IP
Source phones or CTI ports should use.

The user hold audio source identifies the audio source
from which music is played when a user places a call on

hold.
Network Hold Audio |Enter the network hold audio source that this group of IP
Source phones or CTI ports should use.

The network hold audio source identifies the audio
source from which music is played when the system
places a call on hold, such as when the user transfers or
parks a call.
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Table 3-3 Phone Field Descriptions for the BAT Spreadsheet (continued)

Field Description

User Locale Enter the country and language set that you want to
associate with this group of IP phones.

This choice determines which cultural-dependent
attributes exist for this user and which language displays
for the user in the Cisco CallManager user windows and
phones.

Network Locale Enter the network locale that you want to associate with
this group of phones.

The Network Locale comprises a set of tones and
cadences that Cisco gateways and phones use when
communicating with the PSTN and other networks in a
specific geographical area.

Softkey Template Enter the softkey template to be used for all phones in
this group.

Phone Load Name Enter the custom phone load, if applicable.

Note  Any value that is entered in this field overrides
the default value for the chosen model.

Value does not apply for CTI ports.

E.164 Choose the E.164 address that is registered with the
gatekeeper.

Note  Ensure the H.323 client is configured as a
gatekeeper-controlled device.

Note  You must enter a value in this field for a
gatekeeper-controlled H.323 client. You can
enter only numbers (0-9) and special characters #
and * in this field.

User ID Enter the user ID for the phone user.
Line Fields (Optional)

Directory Number Enter the directory number, up to 24 digits and special
characters, for the phone.
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Table 3-3 Phone Field Descriptions for the BAT Spreadsheet (continued)

Field Description
Partition Enter a route partition to which the directory number
belongs.

Note  The directory number can appear in more than
one partition.

Line Text Label Enter text that identifies this directory number for a
line/phone combination.

Note The default language specifies English

Voice Mail Profile Enter this parameter to make the pilot number the same
as the directory number for this line. This action proves
useful if you do not have a voice-messaging server that is
configured for this phone.

Line Calling Search |Enter partitions that are searched for numbers that are
Space called from this directory number.

Note  Changes cause an update of Pickup Group
Names that are listed in the Call Pickup Group
field. The setting applies to all devices that use
this directory number.

AAR Group Enter the automated alternate routing (AAR) group for
this device. The AAR group provides the prefix digits
that are used to route calls that are otherwise blocked due
to insufficient bandwidth.

Set AAR Group to <None> to prevent rerouting blocked

calls.
Line User Hold Enter the music on hold audio source to be played when
Audio Source the user presses Hold and places a call on hold.

Line Network Hold |Enter the music on hold audio source to be played when
Audio Source the system places a call on hold while the user transfers
a call or initiates a conference or call park.

Forward All Enter the directory number to which all calls should be
forwarded. To use the BAT phone template entry, leave
this field blank.
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Table 3-3 Phone Field Descriptions for the BAT Spreadsheet (continued)

Field Description
Forward Busy Enter the directory number to which calls coming from
External an external number should be forwarded when the phone

is busy. To use the BAT phone template entry, leave this
field blank.

Forward No Answer
External

Enter the directory number to which calls coming from
an external number should be forwarded when the phone
is not answered. To use the BAT phone template entry,
leave this field blank.

Forward No
Coverage External

Enter the directory number to which calls coming from
an external number should be forwarded when the phone
does not have coverage. To use the BAT phone template
entry, leave this field blank.

Forward Busy
Internal

Enter the directory number to which calls coming from
an internal number should be forwarded when the phone
is busy. To use the BAT phone template entry, leave this
field blank.

Forward No Answer
Internal

Enter the directory number to which calls coming from
an internal number should be forwarded when the phone
is not answered. To use the BAT phone template entry,
leave this field blank.

Forward No
Coverage Internal

Enter the directory number to which calls coming from
an internal number should be forwarded when the phone
does not have coverage. To use the BAT phone template
entry, leave this field blank.

Display

Enter the text that you want to display on the called
party’s phone display, such as the user name (John
Smith) or phone location (Conference Room 1).

Note  If this field is left blank the system uses the value
that is entered in the Directory Number field.

Note The default language specifies English.

Call Pickup Group

Choose a Pickup Group Name to specify the call pickup
group, which can answer incoming calls to this directory
number by dialing the appropriate pickup group number.
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Table 3-3 Phone Field Descriptions for the BAT Spreadsheet (continued)

Field Description
External Phone Enter the phone number (or mask) that is sent for Caller
Number Mask ID information when a call is placed from this line.

You can enter a maximum of 24 numbers and “X”
characters. The Xs represent the directory number and
must appear at the end of the pattern. For example, if you
specify a mask of 9728 13XXXX, an external call from
extension 1234 displays a caller ID number of
9728131234.

No Answer Ring
Duration (CFNA)

Enter the number of seconds to allow the call to ring
before forwarding the call to the Forward No Answer
Destination.

Target Destination
(MLPP)

Enter the number to which MLPP precedence calls
should be directed if this directory number receives a
precedence call and neither this number nor its call
forward destination answers the precedence call.

Values can include numeric characters, pound (#) ,and
asterisk (*).

Calling Search Space
(MLPP)

From the drop-down list box, choose the calling search
space to associate with the alternate party target
(destination) number.

No Answer Ring
Duration (MLPP)

Enter the number of seconds (between 4 and 30) after
which an MLPP precedence call will be directed to this
directory number’s alternate party if this directory
number and its call forwarding destination have not
answered the precedence call.

Leave this setting blank to use the value that is set in the
Cisco CallManager enterprise parameter, Precedence
Alternate Party Timeout.
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Table 3-3 Phone Field Descriptions for the BAT Spreadsheet (continued)

Field Description

Maximum Number |You can configure up to 200 calls for a line on a device
of Calls in a cluster, with the limiting factor being the device. As
you configure the number of calls for one line, the calls
available for another line decrease.

The default specifies 4. If the phone does not allow
multiple calls for each line, the default specifies 2.

For CTI route points, you can configure up to 10,000
calls for each port. The default specifies 5000 calls. Use
this field in conjunction with the Busy Trigger field.

Busy Trigger This setting, which works in conjunction with Maximum
Number of Calls and Call Forward Busy, determines the
maximum number of calls to be presented at the line. If
maximum number of calls is set for 50 and the busy
trigger is set to 40, then incoming call 41 gets rejected
with a busy cause (and will get forwarded if Call Forward
Busy is set). If this line is shared, all the lines must be
busy before incoming calls get rejected.

Use this field in conjunction with Maximum Number of
Calls for CTI route points. The default specifies 4500
calls.

Alerting Name This name represents the name that displays during an
alert to a shared directory number. For non-shared
directory numbers, during alerts, the system uses the
name that is entered in the Display field.

~

Note  To complete the procedure, go to the “Using a Text Editor to Create the CSV Data
File for Phones” section on page 3-50.
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Using a Text Editor to Create the CSV Data File for Phones

You can create the CSV data file by using lines of ASCII text with values
separated by commas. The comma separated values (CSV) file provides textual
information in tabular form. For more information about text-based CSV files for
phones, see the “Creating a Text-Based CSV File for Phones” section on

page A-2.

Use one of these file format options to identify the device and line fields within
the CSV data file:

¢ Default Phone—Contains a predetermined set of phone device and line fields.

¢ Simple Phone—Contains basic device and line fields for phones.

¢ Custom—Contains device and line fields that you choose and order yourself.
You cannot modify or delete the Simple Phone or Default Phone file formats.

The following topics provide information about configuring file formats for CSV
data files that are created by using a text editor.

e (Creating a File Format, page 3-50

e Copying a File Format, page 3-52

e Modifying a File Format, page 3-52

e Deleting a File Format, page 3-53

e Associating the File Format with the CSV Data File, page 3-54
¢ Creating a Text-Based CSV File for Phones, page A-2

Note  When you use the BAT spreadsheet to create the CSV data file, you can create the
file format within the spreadsheet. When you use a text editor to create the CSV
data file, you need to create a file format or use the simple or default file format.
You enter the values in the text-based file in the same order as specified in the file
format.

Creating a File Format

To create your file format for the text-based CSV data file, use the following
procedure.
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Tip
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Tip

Step 6

Step 7
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Procedure

In the Create CSV data file window, below the Text Editor area, choose Add,
view, or modify file formats and click Next. The File Format Configuration
window displays.

Click Add a new File Format. The File Format Information fields clear.
In the File Format Name field, enter a name for this custom format.

Under Device Fields, choose the device field names that you want to define for
each phone. In the Device Field box, click a device field name and click the arrow
to move the field to the Selected Device Fields box.

A CSYV data file must include Number of Lines, MAC Address/Device Name, and
Description; therefore, these fields are always selected.

You can select several random field names in the list by holding down the Ctrl key,
and then clicking the arrow to select them together. You can select a range of items
by using the Shift key.

Click line field names in the Line Field box and click the arrow to move the fields
to the Selected Line Fields box.

You can change the order of the items in the Selected Line Fields and Selected
Device Fields boxes. Select an item and then use the up arrow to move the field
closer to the beginning of the list or the down arrow to move it to the end of the
list.

If you want to include the fields for the speed-dial details, check the Include
Speed Dials in the CSV Format check box

To save your custom file format, click Insert. The name of the file format displays
in the File Format Names list on the left.

Additional Information

See the “Related Topics™ section on page 3-93.
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Copying a File Format

To copy an existing format for the CSV data file, use the following procedure.

Procedure

Step 1 In the Create CSV data file window, below the Text Editor area, choose Add,
view, or modify file formats and click Next. The File Format Configuration
window displays.

Step2  In the File Format Name list, choose a file format that you want to copy. The file
format details display in the fields.

Step3  To make a copy of the chosen file format, click Copy.

Step 4 In the File Format Name field, enter a new name for the copied format.

Step5 Modify the copied format by using one of these methods:

* Add new fields by choosing them from the Device Fields or Line Fields box,
and then clicking the arrow to move the chosen fields into the Selected Device
Field or Selected Line Fields box.

e Remove selected fields by choosing them from the Selected Device Fields or
Selected Line Fields box, and then clicking the arrow to move the chosen
fields into the Device Field or Line Fields box.

¢ Change the order of the fields by choosing a field name in the Selected Device
Field or Selected Line Fields box and using the up or down arrow to change
its location.

Step6  After making your changes, click Insert to save the copied file format with
changes in the list.

Additional Information
See the “Related Topics” section on page 3-93.
Modifying a File Format

To modify an existing file format for the CSV data file, use the following
procedure. You can modify custom formats only.
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Procedure

In the Create CSV data file window, below the Text Editor area, choose Add,
view, or modify file formats and click Next. The File Format Configuration
window displays.

In the File Format Name list, choose a file format that you want to modify. The
file format details display in the fields.
Modify the copied format by using one of these methods:

e Add new fields by choosing them from the Device Fields or Line Fields box,
then clicking the arrow to move the chosen fields into the Selected Device
Field or Selected Line Fields box.

e Remove fields by choosing them from the Selected Device Fields or Selected
Line Fields box, then clicking the arrow to move the selected fields into the
Device Field or Line Fields box. You cannot remove the required fields:
Number of lines, MAC address, and description.

e Change the order of the fields by choosing a field name in the Selected Device
Field or Selected Line Fields box and using the up or down arrow to change
its location.

After making your changes, click Update to save the changes to the file format.

Additional Information
See the “Related Topics” section on page 3-93.

Deleting a File Format

Step 1

To delete an existing file format for the CSV data file, use the following
procedure.You can delete only custom formats.

Procedure

In the Create CSV data file window, below the Text Editor area, choose Add,
view, or modify file formats and click Next. The File Format Configuration
window displays.
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Step 2

Step 3

In the File Format Name list, choose a file format that you want to delete. The file
format details display in the fields. Verify that this is the file that you want to
delete.

To remove the file format from the File Format Name list, click Delete. A message
asks you to confirm that you want to delete the file format. Click OK to continue.
The system removes the file format name from the list.

Additional Information
See the “Related Topics” section on page 3-93.

Associating the File Format with the CSV Data File

Step 1

Step 2

Step 3

Step 4

When you used a text editor to create the CSV data file, you created a file format
for entering values in the text-based file. You entered values in the text file in the
order that the file format specified

After the CSV data file is completed, you need to associate the file format with
the text-based CSV data file. After associating the file format with the CSV file,
the names for each field display as the first record in the CSV data file. You can
use this information to verify that you entered the values for each field in the
correct order.

To add the file format with the text-based CSV data file, use the following
procedure.

Procedure

In the Create CSV data file window, below the Text Editor area, choose Associate
file format with the CSV data file and click Next. The Add File Format window
displays.

In the File Name field, choose the text-based CSV file that you created for this
transaction.

In the File Format Name field, choose the file format that you created for this type
of bulk transaction.

To associate the matching file format with the CSV data file, click Add.
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To view the CSV data file with the file format as the first record, click the View
File link. Check that the entered values correspond to the field names in your CSV
data file.

Additional Information
See the “Related Topics™ section on page 3-93.

Validating Phone Records

Step 1

Step 2

Step 3

When you choose Validate Phones, the system runs a validation routine to check
that the CSV data file and BAT phone template have populated all required fields,
such as device pool and locations. The validation also checks for discrepancies
with the publisher database.

Before You Begin

e You must have a BAT phone template for the devices that you are adding. You
can use a master phone template with multiple lines to add phones that have
a single line or several lines. See the “Master Phone Templates” section on
page 1-5 for more information.

* You must have a data file in comma separated variable (CSV) format that
contains the unique details for the phones or other IP telephony devices.

To validate your CSV data file phone records, use the following procedure .

Procedure

In the Steps to Insert Phones window, choose Validate Phone Records and click
Next. The Validate Phones window displays.

In the File Name field, choose the CSV data file that you created for this specific
bulk transaction.

Choose the Insert option that corresponds to your CSV data file:

e Specific Details—If you are validating phone records that use a customized
file format.

e All Details—If you are validating phone records from an exported phones file
that was generated by using the All Details option. Skip to Step 5.
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Step 4

Step 5

Step 6

Step 7

In the Phone Template Name field, choose the BAT phone template that you
created for this type of bulk transaction.

For the All Details option, you must choose the Model of IP telephony device.
BAT displays only the models that are currently in the Cisco CallManager
database.

To verify the chosen CSV data file with the publisher database, click Validate.
The validation routine records errors in a log file.

When validation completes, click View Latest Log File to see a log file that lists
the devices with discrepancies and the error code. For more information on log
files, see the “BAT Log Files” section on page 13-1.

Additional Information
See the “Related Topics” section on page 3-93.

Inserting Phones into Cisco CallManager

Step 1

Step 2

Step 3

To add phones, Cisco VGC phones, CTI ports, or H.323 clients into the
Cisco CallManager database, use the following procedure.

Before You Begin
¢  You must have a BAT phone template for the devices that you are adding.

*  You must have a data file in comma separated value (CSV) format that
contains the unique details for the phones or other IP telephony devices.

e Before you insert phones, validate the phone records.

Procedure

In the Steps to Insert Phones window, choose Insert Phones and click Next. The
Insert Phones window displays.

In the File Name field, choose the CSV data file that you created for this specific
bulk transaction.

To enable the use of applications such as Cisco IP SoftPhone, check the Enable
CTI Application Use check box (for CTI ports only).
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Step 6

Step 7

Adding Phones W

Choose the Insert option that corresponds to your CSV data file:

¢ Specific Details—If you are inserting phone records that use a customized
file format.

e All Details—If you are inserting phone records from an exported phone file
that was generated by using the All Details option. Skip to Step 6.

In the Phone Template Name field, choose the BAT phone template that you
created for this type of bulk transaction.

N

Note  When you are inserting a file that was generated with the export utility,
use the appended suffixes to guide you in choosing a phone template with
the correct line configuration. The export utility appends a numerical
suffix_n for each line that is configured on a phone. For example, an
export file with the name “sales_7960_1_3.txt” indicates that all phone
records in this file have lines 1 and 3 configured.

If you did not enter individual MAC addresses in the CSV data file, you must
check the Create Dummy MAC Address check box.

If you are adding CTI ports, the dummy MAC address option provides a unique
device name for each CTI port in the form of dummy MAC addresses.

This field automatically generates dummy MAC addresses in the following
format: XXXXXXXXXXXX
where X represents any 12-character, hexadecimal (0-9 and A-F) number.

e If you do not know the MAC address of the phone that will be assigned to the
user, choose this option. When the phone is plugged in, a MAC address
registers for that device.

e If you supplied MAC addresses or device names in the data input file, do not
choose this option.

You can update the phones or devices later with the correct MAC address by
manually entering this information into Cisco CallManager Administration or by
using TAPS. See the “Introducing TAPS” section on page 12-2 for more
information about TAPS. Skip to Step 7.

For the All Details option, you must choose the Model of IP telephony device.
BAT displays all the phone models that are currently supported in
Cisco CallManager.

Click Insert to insert phone records.
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Step 8

Step 9

A message displays that tells you the approximate time that is required to insert
the records into the Cisco CallManager database. You can cancel if the transaction
might cause performance degradation.

To insert the phones, click OK or to cancel the transaction, click Cancel.

If you clicked OK, a Transaction Status window displays. To see the transaction
in progress, click the Show Latest Status button.

~

Note If any line information for a phone record fails, BAT does not insert that
phone record.

When the transaction completes, click View Latest Log File to see a log file that
shows the number of records that were added and the number of records that
failed, including an error code. For more information on log files, see “BAT Log
Files” section on page 13-1.

Additional Information
See the “Related Topics” section on page 3-93.

Updating Phones

To update phone settings, such as changing or adding the device pool or calling
search space for a group of similar phones, use the Update Phones option. You can
locate the existing phone records by these two methods:

e Using Query to Update Phones, page 3-58
e Using a Custom File to Update Phones, page 3-60

Using Query to Update Phones

To create a query to locate phones to update, use the following procedure.
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Step 2

Step 3

Step 4

Step 5

Step 6
Step 7

Step 8
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Procedure

Choose Update Phones and click Next. The Update Phones Options window
displays.

Choose Use query and click Next. The Update Phones (Step 1 of 2) window
displays.

S

Note  You can update all phones by not specifying a query. Skip to the
“Choosing the Update Parameters” section on page 3-61.

In Select Phones to Query drop-down list box, choose the field to query, such as
Model or Directory Number.

In the second drop-down list box, choose the search criteria, such as begins with,
contains, or is empty.

In the search field list box, choose or enter the value that you want to locate. For
example, you can choose the model name from the list, or enter a range of
directory numbers.

To add the defined filter to the query, click Add To Query.

You can click AND or OR to add multiple filters and repeat Step 3 through Step
6 to further define your query.

)

Note  You cannot perform multiple queries when Directory Number is used in
the first drop-down list box; that is, AND or OR do not act as valid
operators with Directory Number.

Click View Query Results to check that the query includes the information that
you need.

If you make a mistake, click the Clear Query button to remove the query; then,
return to Step 3 and restart.

To complete the procedure for updating phones, continue to the “Choosing the
Update Parameters” section on page 3-61.
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Using a Custom File to Update Phones

To create a custom file to search for phones to update, use the following
procedure.

Before You Begin
1. Identify the devices that you need to update.

2. Create a text file that lists one of these options on a separate line
— MAC addresses and device names
— Directory numbers

S

Note  You can have MAC addresses and device names in the same custom file,
but directory numbers must be in a separate custom file.

3. Save the text file in the C:\BATfiles\Phones\Query\Update\ folder with a
unique name.

To update phones by using a list of phones in a custom file, use the following
procedure.

Procedure

Step 1 Choose Update Phones and click Next. The Update Phones Options window
displays.

Step2  Choose Use a custom file and click Next. The Update Phones (Step 1 of 2)
window displays.

Step3  In the Select phones where drop down list box, choose the type of custom file that
you have created: Device Name (includes MAC addresses) or Directory Number.

Step 4 In the list of custom files, choose the filename of the custom file for this update.
The type of custom file displays with the file name under View Query Result.

Step5  To test the custom file. A message displays the query results from using this
custom file, you can click View Query Result.
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If the query results are not what you expected, you can change the custom file
selections.

To complete the procedure for updating phones, continue to the “Choosing the
Update Parameters” section on page 3-61.

Choosing the Update Parameters

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

After you have defined the query or custom file to search for phones, use this
procedure to choose parameters and define values for updating phones.

Procedure

In the Update Phones window, click Next. The Update Phones (Step 2 of 2)
window displays and shows the type of query that you chose. If you want to
change the type of query, click Back.

Specify the setting that you want to update for all the records that you have
defined in your query or custom file. You can choose multiple parameters to
update. See the “Field Descriptions for Updating Phones” section on page 3-62
for descriptions of parameters.

In the Value field for the checked parameter, enter the new value or choose a value
from the list box.

In the Reset/Restart Phones area, check one of the following choices:
¢ Don’t Reset/Restart devices—To reset/restart devices at a later time.
¢ Reset devices—To reset (power-cycle) the phones
¢ Restart devices—To reset phones without power-cycling

To apply the updates to the records, click Update.

A message displays that tells you the approximate time required to update the
records in the Cisco CallManager database. You can cancel if the transaction
might cause performance degradation.

To update the phones, click OK or to cancel the transaction, click Cancel.

If you clicked OK, a Transaction Status window displays. To see the transaction
in progress, click the Show Latest Status button .
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A
Note  If any line information for a phone record fails, BAT does not update that
phone record.

Step7  When the transaction completes, click View Latest Log File to see a log file that
shows the number of records that were changed and the number of records that
failed, including an error code. For more information on log files, see “BAT Log
Files” section on page 13-1

Additional Information
See the “Related Topics” section on page 3-93.

Field Descriptions for Updating Phones

Table 3-4 provides descriptions for all possible fields that display when you are
updating phones. Some device types do not require all the phone settings.

Values that appear in some fields display from Cisco CallManager. You must
configure these values by using Cisco CallManager Administration.

Table 3-4 Field Descriptions for Update Phones

Field Description
Description Enter a description that makes the device easy to
recognize.

Phone Load Name Enter the custom phone load, if applicable.

Note  Any value that is entered in this field overrides
the default value for the chosen model and
specifies the custom software for a Cisco IP
Phone.
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Table 3-4 Field Descriptions for Update Phones (continued)

Field Description

Device Pool Choose the device pool to which this group of
phones/ports should belong.

A device pool defines sets of common characteristics for
devices, such as region, date/time group,

Cisco CallManager group, and calling search space for
auto-registration.

Calling Search Space |Choose the calling search space to which this group of
phones/ports should belong.

A calling search space specifies the collection of route
partitions that are searched to determine how a dialed
number should be routed.

Location Choose the location to which this group of phones/ports
should belong.

A location indicates the remote location that is accessed
by using restricted bandwidth connections.

Information Enter the help text URL for the information button .
Directory Enter the URL of the directory server.

Messages Enter the voice-messaging access pilot number.
Services Enter the URL for the services menu.

Authentication Enter the URL that the phone uses to validate requests
Server that are made to the phones web server. If you do not

provide an authentication URL, the advanced features on
Cisco IP Phones that require authentication will not
function. Leave this field blank to accept the default
setting.

By default, this URL accesses a Cisco IP Phone User
Options window that was configured during installation.
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Table 3-4 Field Descriptions for Update Phones (continued)

Field Description

Proxy Server Enter the host and port (for example,
proxy.cisco.com:80) that are used to proxy HTTP
requests for access to non-local host addresses from the
phones HTTP client.

If the phone receives a URL such as www.cisco.com in a
service and the phone is not configured in the cisco.com
domain, the phone uses the proxy server to access the
URL. If the phone is configured in the cisco.com domain,
the phone accesses the URL without using the proxy
because it is in the same domain as the URL.

Leave this field blank to accept the default setting.

Idle Enter the URL to display on the Cisco IP Phone window
when the phone has not been used for the time that is
specified in the Idle Time field. For example, you can
display a logo on the window when the phone has not
been used for 5 minutes. Leave this field blank to use the
default value.

Idle Timer Enter the seconds that you want to elapse before the
phone displays the URL that is specified in the Idle field.
Leave this field blank to use the default value.

User Hold Audio Choose the user-hold audio source for this group of
Source phones or ports.

The user-hold audio source plays music when a user
places a call on hold.

Network Hold Audio |Choose the network hold audio source that this group of
Source IP phones or CTI ports should use.

The network-hold audio source plays music when the
system places a call on hold, such as when the user
transfers or parks a call.
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Table 3-4 Field Descriptions for Update Phones (continued)

Field Description
Media Resource Choose the media resource group list (MRGL) to which
Group List this group of phones/ports should belong.

An MRGL specifies a list of prioritized media resource
groups. An application can choose required media
resources among the available ones according to the
priority order that is defined in the MRGL.

Extension Mobility |Choose 0-Off if you want to disable this feature or
choose 1-On to enable this feature.

Extension mobility allows a user to log in and out of a
Cisco IP Phone. Refer to the Cisco CallManager
Features and Services Guide for more information about
extension mobility.

User Locale Choose the country and language set that you want to
associate with this user.

This choice determines which cultural-dependent
attributes exist for this user and which language displays
for the user in the Cisco CallManager user windows and
phones.

Network Locale Choose the network locale that you want to associate
with this user.

The Network Locale comprises a set of tones and
cadences that Cisco gateways and phones use when they
are communicating with the PSTN and other networks in
a specific geographical area.

IP Servicesl Use Cisco CallManager Administration to choose any
services that have been configured.

IP Services2 Use Cisco CallManager Administration to choose any
services that have been configured.

Note Using BAT, you cannot update more than 2 IP
services in one transaction.
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Table 3-4 Field Descriptions for Update Phones (continued)

Field Description

MLPP Indication If available, this setting specifies whether a device that is
capable of playing precedence tones will use the
capability when it places an MLPP precedence call.

From the drop-down list box, choose a setting to assign
to this device from the following options:

e Default—This device inherits its MLPP indication
setting from its device pool.

e Off—This device does not send indication of an
MLPP precedence call.

e On—This device does send indication of an MLPP
precedence call.

Note Do not configure a device with the following
combination of settings: MLPP Indication is set
to Off while MLPP Preemption is set to Forceful.

MLPP Preemption If available, this setting specifies whether a device that is
capable of preempting calls in progress will use the
capability when it places an MLPP precedence call.

From the drop-down list box, choose a setting to assign
to this device from the following options:

e Default—This device inherits its MLPP preemption
setting from its device pool.

e Disabled—This device does not preempt calls in
progress when it places an MLPP precedence call.

e Forceful—This device preempts calls in progress
when it places an MLPP precedence call.

Note Do not configure a device with the following
combination of settings: MLPP Indication is set
to Off while MLPP Preemption is set to Forceful.

MLPP Domain (e.g., |Enter a hexadecimal value for the MLPP domain
"0000FF") associated with this device. Must be blank or a value
between 0 and FFFFFF.
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Table 3-4 Field Descriptions for Update Phones (continued)

Field

Description

AAR Calling Search
Space

Choose the appropriate calling search space for the
device to use when it performs automated alternate
routing (AAR). The AAR calling search space specifies
the collection of route partitions that are searched to
determine how to route a collected (originating) number
that is otherwise blocked due to insufficient bandwidth.

Device Security
Mode

From the drop-down list box, choose the mode that you
want to set for the device:

e Use System Default—The phone uses the value that
you specified for the enterprise parameter, Device
Security Mode.

e Non-secure—No security features exist for the
phone. A TCP connection opens to
Cisco CallManager.

¢ Authenticated—Cisco CallManager provides
integrity and authentication for the phone. A TLS
connection that uses NULL/SHA opens.

¢ Encrypted—Cisco CallManager provides integrity,
authentication, and encryption for the phone. A TLS
connection that uses AES128/SHA opens

Note  This field applies only if the phone model
supports authentication or encryption.

Ignore Presentation
Indicators

Check this check box if the system must ignore
presentation indicators.

Remove Duplicate IP
Services from all
Phones and Device
Profiles

Check this check box to remove duplicate IP Phone
Services. If you check this check box, the system
removes the duplicate service subscriptions from phones
and User Device Profiles. The IP system deletes Services
based on the IP Service name.

Disable
Speakerphone

Check this check box to disable the speakerphone.
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Note

Table 3-4 Field Descriptions for Update Phones (continued)

Field

Description

Disable
Speakerphone and
Headset

Check this check box to disable the speakerphone and
headset

Forwarding Delay

Use this field to enable or disable forwarding delay.
Choose enable when you want the port to wait a few
seconds before forwarding a call.

PC Port

Use this field to enable or disable the PC port on phones
that have internal switches. Users can connect a PC or
workstation to the phone by using the port labeled
“10/100 PC” on the back of the phone.

Setting Access

Use this field to choose whether the user has access to
phone settings. The options include Enabled and
Disable.

Gratuitous ARP

Choose Enabled or Disabled to control gratuitous ARP.

PC Voice VLAN
Access

Choose Enabled or Disabled to control access to a PC
voice VLAN.

Video Capabilities

Choose Enabled or Disabled to control video capabilities
access.

Auto Line Select

Choose Enabled or Disabled to allow automatic line
selection on the phone.

Web Access

Choose Enabled or Disabled to allow web access on the
phone.

To complete the procedure, go to “Choosing the Update Parameters” section on

page 3-61.
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Updating Lines

Note

Step 1

Step 2

Step 3

Step 4

Step 5
Step 6

To update line attributes for a specific group of devices or user device profiles, use
the Update Lines option. Lines for a phone and a user device profile get updated
at the same time when both are part of the query result.

When a phone is deleted from the Cisco CallManager database, the directory
number remains in the database. To manage these orphan directory numbers, you
can use the Update Lines option to search for unassigned directory numbers and
delete or update these directory numbers.

To update lines, use the following procedure.

Procedure

Choose Update Lines and click Next. The Update Lines (Step 1 of 2) window
displays.

N

Note  You can update all lines by not specifying a query. Skip to the “Field
Descriptions for Updating Lines” section on page 3-71.

In the Select lines where drop-down list box, choose the field to query such as
Directory Number, Line Partition, or Unassigned DN.

~

Note  To locate and delete orphaned directory numbers, use “unassigned DN.”

In the second drop-down list box, choose the search criteria such as begins with,
contains, or is empty.

In the search field list box, choose or enter the value that you want to locate. For
example, you can choose the Line Partition from the list or enter a range of
directory numbers.

To add the defined filter to the query, click Add To Query.

To further define your query, you can click AND or OR to add multiple filters and
repeat Step 2 through Step 5.
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Step 7
Step 8

Step 9

Step 10

Step 11

Step 12

Step 13

A
Note  You cannot perform multiple queries when Directory Number is used in

the first drop-down list box, because AND or OR do not act as valid
operators with Directory Number.

To display the records that are going to be affected, click View Query Result.

Click Next. The Update Lines (Step 2 of 2) window displays and shows the type
of query that you chose at the top. If you want to change the type of query, click
Back.

Specify the setting that you want to update for all the records that you have
defined in your query. You can choose multiple parameters to update. See the
“Field Descriptions for Updating Lines” section on page 3-71 for descriptions of
the parameters.

In the Value field for the checked parameter, enter the new value or choose a value
from the list box.

To apply the updates to the records, click Update.

A message displays that tells you the approximate time that is required to update
the records in the Cisco CallManager database. You can cancel if the transaction
might cause performance degradation.

To update the phones, click OK or to cancel the transaction, click Cancel.

If you clicked OK, a Transaction Status window displays. To see the transaction
in progress, click the Show Latest Status button.

~

Note If any information for a line record fails, BAT does not update that line
record.

When the transaction completes, Click View Latest Log File to see a log file that
shows the number of records that were changed and the number of records that
failed, including an error code. For more information on log files, see the “BAT
Log Files” section on page 13-1.

Additional Information
See the “Related Topics” section on page 3-93.
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Field Descriptions for Updating Lines

Table 3-5 provides the field descriptions for updating line details.

Values that display in some fields display from Cisco CallManager. You must
configure these values by using Cisco CallManager Administration.

Table 3-5 Field Descriptions for Updating Line Details

Field Description

Line Partition Choose a partition. A partition indicates the route partition
to which the directory number belongs.

Note The directory number can appear in more than
one partition.

Calling Search Space |Choose the partitions that are searched for numbers that
(Line) are called from this directory number.

Note Changes cause an update of the Pickup Group
Names that are listed in the Call Pickup Group
field. The setting applies to all devices that are
using this directory number.

Calling Search Space |Choose the calling search space to use when a call is
Forward All forwarded to the specified destination.

Note This setting applies to all devices that are using
this directory number.

Forward All Enter the directory number to which all calls are
Destination forwarded.

Note  This setting applies to any dialable phone
number, including an outside destination unless
restricted, and to all devices that are using this
directory number.

Forward All to Voice |Check this check box to forward all calls to the number
Mail that you chose in the voice-messaging profile.

Checking this check box makes the values in the Forward
All Destination field and Calling Search Space check box
not relevant.
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Table 3-5 Field Descriptions for Updating Line Details (continued)

Field Description
Calling Search Space |Choose the calling search space to use when a call from
Forward Busy an external number is forwarded to the specified
External destination.

Note This setting applies to all devices that are using

this directory number.

Calling Search Space |Choose the calling search space to use when a call from
Forward Busy an internal number is forwarded to the specified
Internal destination.

Note  This setting applies to all devices that are using

this directory number.

Forward Busy
Destination External

Enter the directory number to which a call that is coming
from an external number is forwarded when the line is in
use.

Note This setting applies to any dialable phone
number, including an outside destination unless
restricted, and to all devices that are using this

directory number.

Forward Busy
Destination Internal

Enter the directory number to which a call that is coming
from an internal number is forwarded when the line is in
use.

Note This setting applies to any dialable phone
number, including an outside destination unless
restricted, and to all devices that are using this

directory number.

Forward Busy to
Voice Mail External

Check this check box to forward calls from an external
number to the number that you chose in the
voice-messaging profile when the line is in use.

Checking this check box makes the values in the Forward
Busy Destination field and Calling Search Space check
box not relevant.
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Table 3-5 Field Descriptions for Updating Line Details (continued)

Field

Description

Forward Busy to
Voice Mail Internal

Check this check box to forward calls from an internal
number to the number that you chose in the
voice-messaging profile when the line is in use.

Checking this check box makes the values in the Forward
Busy Destination field and Calling Search Space check
box are not relevant.

Calling Search Space
Forward No Answer
External

Choose the calling search space to use when a call from
an external number is forwarded to the specified
destination. The setting displays only if it is configured
in the system.

Note  This setting applies to all devices that are using
this directory number.

Calling Search Space
Forward No Answer
Internal

Choose the calling search space to use a call from an
internal number is forwarded to the specified destination.
The setting displays only if it is configured in the system.

Note This setting applies to all devices that are using
this directory number.

Forward No Answer
Destination External

Enter the directory number to which a call that is coming
from an external number is forwarded when the phone is
not answered.

Note This setting applies to any dialable phone
number, including an outside destination unless
restricted, and to all devices that are using this
directory number.

Forward No Answer
Destination Internal

Enter the directory number to which a call that is coming
from an internal number is forwarded when the phone is
not answered.

Note  This setting applies to any dialable phone
number, including an outside destination unless
restricted, and to all devices that are using this
directory number.

[ oL-8661-01

Bulk Administration Tool User Guide ]



Chapter3  Working with Ph and IP Telephony Devices

M Updating Lines

Table 3-5 Field Descriptions for Updating Line Details (continued)

Field

Description

Forward No Answer
to Voice Mail
External

Check this check box to forward unanswered calls from
an external number to the number that you chose in the
voice-messaging profile.

Checking this check box makes the values in the Forward
No Answer Destination field and Calling Search Space
check box are not relevant.

Forward No Answer
to Voice Mail

Check this check box to forward unanswered calls from
an internal number to the number that you chose in the

Internal voice-messaging profile.
Checking this check box makes the values in the Forward
No Answer Destination field and Calling Search Space
check box are not relevant.

Calling Search Space |Choose the calling search space to use when a call from

Forward No an external number is forwarded to the specified

Coverage External

destination. The setting displays only if it is configured
in the system.

Note This setting applies to all devices that are using
this directory number.

Calling Search Space
Forward No
Coverage Internal

Choose the calling search space to use when a call from
an internal number is forwarded to the specified
destination. The setting displays only if it is configured
in the system.

Note This setting applies to all devices that are using
this directory number.

Forward No
Coverage
Destination External

Enter the directory number to which a call that is coming
from an external number is forwarded when the phone
does not have coverage.

Note  This setting applies to any dialable phone
number, including an outside destination unless
restricted, and to all devices that are using this
directory number.
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Table 3-5 Field Descriptions for Updating Line Details (continued)

Field Description
Forward No Enter the directory number to which a call that is coming
Coverage from an internal number is forwarded when the phone

Destination Internal

does not have coverage.

Note This setting applies to any dialable phone
number, including an outside destination unless
restricted, and to all devices that are using this
directory number.

Forward No
Coverage to Voice
Mail External

Check this check box to forward calls from an external
number to the number that you chose in the
voice-messaging profile when the phone does not have
coverage.

Checking this check box makes the values in the Forward
No Answer Destination field and Calling Search Space
check box are not relevant.

Forward No
Coverage to Voice
Mail Internal

Check this check box to forward calls from an external
number to the number that you chose in the
voice-messaging profile when the phone does not have
coverage.

Checking this check box makes the values in the Forward
No Answer Destination field and Calling Search Space
check box are not relevant.

Calling Search Space
Forward on Failure
External/Internal

(CTI ports only) Choose the calling search space to use
when a call from an internal or external call is forwarded
to the specified destination. The setting appears only if it
is configured in the system.

Note  This setting applies to all devices that are using
this directory number.

Forward on Failure
Destination
External/Internal

(CTI ports only) Enter the directory number to which a
call coming from an internal or an external number
should be forwarded when a phone or CTI application
fails.
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Table 3-5 Field Descriptions for Updating Line Details (continued)

Field

Description

Forward on Failure
to Voice Mail
External/Internal

(CTI ports only) Check this check box to forward failed
calls from external or internal numbers to the number
that you chose in the voice-messaging profile.

Call Forward No
Answer Ring

Enter the number of seconds (between 1 and 300) to
allow the call to ring, before forwarding the call to the

Duration destination number entered in the Forward No Answer
Destination field.
Note Leave this field blank to use the value that is set
in the Cisco CallManager service parameter,
Forward No Answer Timer.
User Hold Audio Choose the music on hold audio source that plays when
Source the user presses the Hold button or softkey to put a call
on hold.
Network Hold Audio |Choose the music on hold audio source that plays when
Source the system places a call on hold such as when user

transfers a call or initiates a conference or call park.

Auto Answer

Choose this parameter if you want all lines that are
updated here to use the auto answer feature. With auto
answer, Cisco CallManager automatically answers calls
when a headset is in use. A zip tone plays to alert the user
that an incoming call connected.

Voice Mail Profile

Choose this parameter to make the pilot number the same
as the directory number for this line. This choice proves
useful if you do not have a voice-messaging server that is
configured for this phone.

Ring Setting When
Idle

Choose the type of ring for an incoming call on a phone.

Ring Setting when
Active

Choose the type of ring for an incoming call on a phone,
which is used when this phone has another active call on
a different line.

Call Pickup Group
Name

Choose a Pickup Group Name to specify the call pickup
group, which can answer incoming calls to this directory
number by dialing the appropriate pickup group number.
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Table 3-5 Field Descriptions for Updating Line Details (continued)

Field Description

AAR Group Choose the automated alternate routing (AAR) group for
this device. The AAR group provides the prefix digits
that are used to route calls that are otherwise blocked due
to insufficient bandwidth.

Set AAR Group to <None> to prevent rerouting blocked
calls.

Target (Destination) |Enter the number to which MLPP precedence calls
MLPP should be directed if this directory number receives a
precedence call and neither this number nor its call
forward destination answers the precedence call.

Values can include numeric characters, pound(#), and
asterisk (*).

MLPP Calling From the drop-down list box, choose the calling search
Search Space space to associate with the alternate party target
(destination) number.

MLPP No Answer Enter the number of seconds (between 4 and 30) after
Ring Duration which an MLPP precedence call will be directed to this
directory number’s alternate party if this directory
number and its call forwarding destination have not
answered the precedence call.

Leave this setting blank to use the value that is set in the
Cisco CallManager enterprise parameter, Precedence
Alternate Party Timeout.

External Phone Enter the phone number (or mask) that is sent for Caller
Number Mask ID information when a call is placed from this line.

You can enter a maximum of 30 numbers and “X”
characters. The Xs represent the directory number and
must appear at the end of the pattern. For example, if you
specify a mask of 972813XXXX, an external call from
extension 1234 displays a caller ID number of
9728131234.
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Table 3-5 Field Descriptions for Updating Line Details (continued)

Field Description

Maximum Number |You can configure up to 184 calls for a line on a device
of Calls in a cluster, with the limiting factor being the device. As
you configure the number of calls for one line, the calls
available for another line decrease.

The default specifies 4. If the phone does not allow
multiple calls for each line, the default specifies 2.

For CTI route points, you can configure up to 10,000
calls for each port. The default specifies 5000 calls.

Use this field in conjunction with the Busy Trigger field.

Busy Trigger This setting, which works in conjunction with Maximum
Number of Calls and Call Forward Busy, determines the
maximum number of calls to be presented at the line. If
maximum number of calls is set for 50 and the busy
trigger is set to 40, then incoming call 41 gets rejected
with a busy cause (and will get forwarded if Call Forward
Busy is set). If this line is shared, all the lines must be
busy before incoming calls get rejected.

Use this field in conjunction with Maximum Number of
Calls for CTI route points. The default specifies 4500
calls.

S

Note  To complete the procedure, go to the “Updating Lines” section on page 3-69.

Adding Lines to Existing Phones and UDPs

You can add lines to a group of existing phones or user device profiles in the
Cisco CallManager database. When you use the template to add new lines, you
cannot change phone services or speed dials. BAT ignores those fields on the
template when you add lines to existing devices.

Bulk Administration Tool User Guide
m. 0L-8661-01 |




| Chapter3 Working with Phones and IP Telephony Devices

Step 1
Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

Step 8

Adding Lines to Existing Phones and UDPs

To add lines to existing phones or user device profiles, use the following
procedure.

Before You Begin

e You must have a BAT template for this transaction. See the “Adding or
Updating Lines in a BAT Template” section on page 3-4.

e You must have a CSV data file for this transaction. See the “Using the BAT
Spreadsheet to Add Lines to Existing Phones” section on page 3-80 for
information.

Procedure

Choose Add Lines and click Next. The Steps to Add Lines window displays.

If you need to create a new template or modify an existing one for this transaction,
choose Add, View, or Modify Phone Template.

Choose Add Lines to existing phones or device profiles. The Add Lines window
displays.

In the File Name field, choose the CSV data file that you created for this bulk
transaction.

If you are changing the phone settings for existing phones in the template, check
the Override the existing configuration check box. The user device profile
information also gets updated when this check box is checked.

In the Select Templates area, choose one of the following options:
e To add lines to phones, choose Phone Template.

In the Template Name field, choose the BAT phone template to use for this
bulk transaction.

e To add lines to a User Device Profile, choose User Device Profile Template.

In the Template Name field, choose the User Device Profile template to use
for this bulk transaction.

Click Add. A message displays that advises you of approximately how long it will
take to add the records to the Cisco CallManager database. You can cancel the
transaction if you feel that it may cause performance degradation.

When the transaction completes, check the Status message. BAT displays a status
completed or failed message.
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Step 9

To display the log file that BAT generated, you can click the View Latest Log File
link. The log file displays the number of lines that were successfully added. For
more information on log files, see the “BAT Log Files” section on page 13-1.

Additional Information
See the “Related Topics™ section on page 3-93.

Using the BAT Spreadsheet to Add Lines to Existing Phones

Step 1
Step 2
Step 3
Step 4

Step 5

To create the CSV data file by using the BAT spreadsheet for adding lines to
existing phones, use the following procedure.

For information about installing and using the BAT spreadsheet, see the “Using
the BAT Spreadsheet for Gathering Data” section on page 1-11.

Procedure

To open the BAT Spreadsheet, locate and double-click the BAT.xIt file.
When prompted, click Enable Macros to use the spreadsheet capabilities.
To display the fields, click the Add Lines tab at the bottom of the spreadsheet.

Enter data for an individual phone on each line in the spreadsheet. Complete all
mandatory fields and any relevant optional fields. Each column heading specifies
the length of the field and whether it is required or optional. Table 3-6 describes
the fields for adding lines in the BAT spreadsheet.

To transfer the data from the BAT Excel spreadsheet into a CSV formatted data
file, click Export to BAT Format.

The system saves the file to C:\XLSDataFiles\ or you can use Browse to save your
file in another existing folder on your local workstation. The filename is

<tabname>#<timestamp>.txt

where <tabname> represents the type of input file that you created, such as
phones, and <timestamp> represents the precise date and time that the file was
created.
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~

Note If youenter acomma in one of the fields, BAT.xIt encloses that field entry
in double quotes when you export to BAT format.

If you enter a blank row in the spreadsheet, the system treats the empty
row as the end of the file. The system does not convert data that is entered
after a blank line to the BAT format.

You must copy the CSV data file to the Cisco CallManager publisher database
server so BAT can access the CSV data file

Step6  Using a floppy disk or a mapped network drive, copy the CSV data file from
C:\XLSDataFiles\ (or the folder that you chose to store the file) to the
C:\BATFiles\AddLines folder on the publisher database server:

Note  For information on how to read the exported CSV data file, click the link to View
Sample File in the Insert Phones window in BAT.

Additional Information
See the “Related Topics” section on page 3-93.

Field Descriptions for Adding Lines By Using the BAT
Spreadsheet

Table 3-6 provides the field descriptions when you are adding lines by using the
BAT spreadsheet.
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Table 3-6 Field Descriptions for Adding Lines by Using the BAT Spreadsheet

Field Description

MAC Address Enter the MAC address for phones, VGC virtual phones,
and VGC phones. Enter a unique identifier for CTI ports
and H.323 clients.

Line Index Enter a number between 1 and 34 for the line index of a
phone.

Directory Number Enter a directory number, up to 24 numerals and special
characters, for this line.

Display Enter the text that you want to display on the called
party’s phone display, such as the user name (John
Smith) or phone location (Conference Room 1).

Note  If this field is left blank the system uses the value
that is entered in the Directory Number field.

Note  The default language specifies English.

Line Text Label Enter text that identifies this directory number for a
line/phone combination.

Note The default language specifies English

Forward Busy Enter the directory number to which a call that is coming
External from an external number is forwarded when the line is in
use.

Note  This setting applies to any dialable phone
number, including an outside destination unless
restricted, and to all devices that are using this
directory number.

Forward No Answer |Enter the directory number to which a call that is coming
External from an external number is forwarded when the phone is
not answered.

Note This setting applies to any dialable phone
number, including an outside destination unless
restricted, and to all devices that are using this
directory number.
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Table 3-6 Field Descriptions for Adding Lines by Using the BAT Spreadsheet

Field

Description

Forward No
Coverage External

Enter the directory number to which a call that is coming
from an external number is forwarded when the phone
does not have coverage.

Note This setting applies to any dialable phone
number, including an outside destination unless
restricted, and to all devices that are using this
directory number.

Forward Busy
Internal

Enter the directory number to which a call that is coming
from an internal number is forwarded when the line is in
use.

Note  This setting applies to any dialable phone
number, including an outside destination unless
restricted, and to all devices that are using this
directory number.

Forward No Answer
Internal

Enter the directory number to which a call that is coming
from an internal number is forwarded when the phone is
not answered.

Note  This setting applies to any dialable phone
number, including an outside destination unless
restricted, and to all devices that are using this
directory number.

Forward No
Coverage Internal

Enter the directory number to which a call that is coming
from an internal number is forwarded when the phone
does not have coverage.

Note  This setting applies to any dialable phone
number, including an outside destination unless
restricted, and to all devices that are using this
directory number.

Call Pickup Group

Enter a Pickup Group Name to specify the call pickup
group, which can answer incoming calls to this line by
dialing the appropriate pickup group number.
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Deleting Phones

To delete a group of phones or other IP telephony devices from the
Cisco CallManager database, use these procedures.

To access the Delete option, choose Configure > Phones. In the Phone Options
window, choose Delete Phones and click Next. You can locate existing phone
records by these two methods:

e Using Query to Delete Phones, page 3-84.
e Using a Custom File to Delete Phones, page 3-86

Using Query to Delete Phones

To delete phones by creating a query to locate the phone records, use the following
procedure.

Procedure

Step 1 In the Delete Phones Options window, choose Use query and click Next. The
Delete Phones window displays.

A

Caution  If you do not specify a query, you will delete all phones.

Step2 In Select Phones to Query drop-down list box, choose the field to query such as
Model or Directory Number.

N

Note If you choose Unasssigned DN in the Select Phones to Query drop-down
list box, then the selected unassigned Directory Numbers will be deleted.

Step3  In the second drop-down list box, choose the search criteria such as begins with,
contains, or is empty.

Step 4 In the search field list box, choose or enter the value that you want to locate, such
as the model name from the list or directory number range.

Step5  To add the defined filter to the query, click Add To Query.
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Step6  To add multiple filters, you can click AND or OR and to further define your query,
repeat Step 2 through Step 5.

S

Note  You cannot perform multiple queries when Directory Number or
Unassigned DN is used in the first drop-down list box; thatis, AND or OR
do not act as valid operators with Directory Number.

Step7  To check that the query gives the results that you need, click View Query Results.

~

Note  Ensure that you have located the correct phones to delete. Because the
delete action is final, you cannot retrieve deleted records.

If you make a mistake, click the Clear Query button to remove the query; then,
return to Step 2 and restart.

A

Caution  If you do not enter any information in the query text box, the system deletes all
phone records. Because the delete action is final, you cannot retrieve deleted
records.

Step 8 To delete the records, click Delete.

Step9 A message displays that advises you of approximately how long it will take to
delete the records from the Cisco CallManager database. You can cancel the
transaction or click OK to continue.

Step10  To display the log file that BAT generated, you can click the View Latest Log File
link. The log file displays the number of phones that were deleted and the number
of records that failed, including an error code. For more information on log files,
see the “BAT Log Files” section on page 13-1.

Additional Information
See the “Related Topics™ section on page 3-93.
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Using a Custom File to Delete Phones

Note

Step 1
Step 2
Step 3

Step 4

A

You can create a custom file of phones that you want to delete by using a text
editor. You can have MAC addresses and device names in the same custom file,
but you cannot have directory numbers in the same file. You need to create
separate files—one file that contains the device names and MAC addresses and
another file that contains the directory numbers.

You cannot delete phones with shared lines by using a custom file.

Before You Begin

1. Create a text file that lists one of these details for the phones that you want to
delete:

— Device names and MAC addresses
— Directory numbers
2. Put each item on a separate line in the text file.

3. Save the custom file with a <filename.txt> to this folder:
C:\BATfiles\Phones\Query\Delete\

To delete phones that are listed in a custom file, use the following procedure.

Procedure

In the Delete Phones Options window, choose Use a custom file and click Next.
The Delete Phones window displays.

In Select Phones where drop-down list box, choose the field that you used in the
custom file, either Device Name or Directory Number.

In the Custom file where drop-down list box, choose the filename for the custom
file.

To check that the query includes the information that you need, click View Query
Results.

Caution

If no information is entered into the query text box, the system deletes all phone
records.
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Step 5
Step 6

Step 7

Resetting or Restarting Phones W

To delete the records, click Delete.

A message displays that advises you of approximately how long it will take to
delete the records from the Cisco CallManager database. You can cancel the
transaction or click OK to continue.

To display the log file that BAT generated, you can click the View Latest Log File
link. The log file displays the number of phones that were deleted and the number
of records that failed, including an error code. For more information on log files,
see “BAT Log Files” section on page 13-1.

Additional Information
See the “Related Topics” section on page 3-93.

Resetting or Restarting Phones

You can reset or restart devices without updating any attributes. Use this
procedure if a problem arises, and you must reset or restart the phones with a bulk
transaction.

To access the Reset/Restart option, choose Configure > Phones. In the Phones
Options window, choose Reset/Restart Phones and click Next. You can choose
between two methods to locate phones:

e Using Query to Reset or Restart Phones, page 3-87
e Using a Custom File to Reset or Restart Phones, page 3-89

Using Query to Reset or Restart Phones

Step 1

To reset or restart phones by creating a query to locate the phones, use the
following procedure.

Procedure

In the Reset/Restart Phones Options window, choose Use query and click Next.
The Reset/Restart Phones window displays.
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Step 2
Step 3
Step 4

Step 5
Step 6

Step 7

A

~

Note  To reset or restart all phones, do not specify a query filter. Skip to Step 8.

In Select Phones to Query drop-down list box, choose the field to query such as
Model or Directory Number.

In the second drop-down list box, choose the search criteria such as begins with,
contains, or is empty.

In the search field list box, choose or enter the value that you want to locate, such
as the model name from the list or directory number range.

To add the defined filter to the query, click Add To Query .

To add multiple filters, you can click AND or OR and to further define your query,
repeat Step 4 through Step 7.

N,

Note  You cannot perform multiple queries when Directory Number is used in
the first drop-down list box; that is, AND or OR do not act as valid
operators with Directory Number.

Click View Query Results to check that the query includes the information that
you need.

If you make a mistake, click the Clear Query button to remove the query; then,
return to Step 4 and restart.

Caution

Step 8

If no information is entered into the query text box, the system resets or restarts
all phones.

Click one of the following options:
¢ Reset—To reset (power-cycle) the phones
¢ Restart—To reset phones without power-cycling

A message displays that advises you of approximately how long it will take to
reset or restart the phones. You can cancel the transaction or click OK to continue.
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Resetting or Restarting Phones W

To display the log file that BAT generated, you can click the View Latest Log File
link. The log file displays the number of phones that were reset or restarted. For
more information on log files, see the “BAT Log Files” section on page 13-1.

Additional Information
See the “Related Topics™ section on page 3-93.

Using a Custom File to Reset or Restart Phones

Step 1

Step 2

Step 3

Step 4

You can create a custom file of phones that you want to reset or restart by using a

text editor. You can use either device names or directory numbers in the custom
file.

Before You Begin

1. Create a text file that lists one of these details for the phones that you want to
reset or restart:

— Device names
— Directory numbers
2. Put each item on a separate line in the text file.

3. Save the custom file with a <filename.txt> to this folder:
C:\BATfiles\Phones\Query\Update\

To reset or restart phones by using a custom file, use the following procedure.

Procedure

In the Reset/Restart Phones Options window, choose Use a custom file and click
Next. The Reset/Restart Phones window displays.

In Select Phones where drop-down list box, choose the item that you used in the
custom file, either Device Name, or Directory Number.

In the Custom file where drop-down list box, choose the filename for the custom
file that you created.

Click View Query Results to check that the query includes the information that
you need.
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A

Caution

Step 5

Step 6

If no information is entered into the query text box, the system resets or restarts
all phones.

Click one of the following:
¢ Reset—To reset (power-cycle) the phones
e Restart—To reset phones without power-cycling

A message displays that advises you of approximately how long it will take to
reset or restart the phones. You can cancel the transaction or click OK to continue.

You can click the View Latest Log File link to display the log file that BAT
generated. The log file displays the number of phones that were reset or restarted.
For more information on log files, see the “BAT Log Files” section on page 13-1.

Additional Information
See the “Related Topics” section on page 3-93.

Configuring CAPF

Step 1

Step 2

Certification Authority Proxy Function (CAPF) identifies a Windows NT service
that is used to issue new certificates to individual devices when a new request is
received. You can upgrade or delete the Locally Significant Certificate (LSC).
You can also upgrade certificates for supported CAPF devices in bulk.

Use the following procedure to access the CAPF Configuration option.

Procedure

In the Bulk Administration Tool (BAT), choose Configure > Phones. The
Phone Options window displays.

In the Phone Options window, choose CAPF Configuration and click Next.
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Additional Information
See the “Related Topics” section on page 3-93.

Upgrading LSC

Step 1

Step 2
Step 3
Step 4

Step 5
Step 6

Step 7

A

You can upgrade or delete the Locally Significant Certificate (LSC) by creating a
query to search for phones that have common attributes. Use the following
procedure to upgrade or delete LSCs.

Procedure

In the CAPF Configuration Options window, choose Upgrade LSC and click
Next. The Upgrade LSC (Step 1 of 2) window displays.

~

Note  Toupgrade or delete LSC for all phones, do not specify a query filter. Skip
to Step 8.

In Select Phones Where drop-down list box, choose the field to query such as
Device Type, Device Security Mode or LSC Status.

From the second drop-down list box, choose the search criteria such as begins
with, contains, or is empty.

In the search field list box, choose or enter the value that you want to locate, such
as the device name from the list or LSC status.

To add the defined filter to the query, click Add To Query.

To add multiple filters, you can click AND or OR and to further define your query,
repeat Step 2 through Step 5.

Click View Query Results to check that the query includes the information that
you need.

If you make a mistake, click the Clear Query button to remove the query, return
to Step 2, and redo the procedure.

Caution

If no information is entered into the query text box, the system updates LSC for
all phones.
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Step8  Click Next. The Upgrade LSC (Step 2 of 2) window displays.

Step9  From the Certificate Operation drop-down list box, choose Upgrade LSC or
Delete LSC.

Step10  Specify the setting that you want to update or delete for all the records that you
have defined in your query or custom file. You can choose multiple parameters to
update or delete.

Step 11 In the Select parameters to Update area, choose the Authentication Mode from the
drop-down list box, from the following options:

e By Authentication String
e By Null String
e By Existing Certificate (Precedence to LSC (Locally Significant Certificate)

¢ By Existing Certificate (Precedence to MIC (Manufactured Installed
Certificate)

Step12 If you chose By Authentication String in Step 11, you can choose to generate a
unique authentication string for each device by checking the check box.

Step13  If you do not check the Generate unique authentication string for each device
check box, enter the authentication string in the text box or click Generate String
to let the system generate an authentication string.

N

Note If authentication string is entered or generated through Step 12, the
system applies to all the devices that are chosen through the query.

Step14 From the Key Size drop-down list box, choose the key size. The default key size
specifies 1024 bits.

Step15 In the Operation Completes By field, enter the date by which the Certification
Operation is expected to complete. The date format for this field specifies YYYY:
MM: DD: HH

Step16  Click one of the following options:
¢ Reset Phones—To reset (power-cycle) the phones (Default)
¢ Restart Phones—To reset phones without power-cycling
e Do not Reset/Restart Phones—To not to reset or restart phones

Step17 Click Update.
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A message that advises you of the approximate time that is required to update or
delete LSC for the phones displays. Cancel the transaction or click OK to
continue.

Additional Information
See the “Related Topics™ section on page 3-93.

Related Topics

¢ Adding Phones, page 3-2

e Updating Phones, page 3-58

e Updating Lines, page 3-69

e Adding Lines to Existing Phones and UDPs, page 3-78
e Deleting Phones, page 3-84

e Resetting or Restarting Phones, page 3-87

e Adding New Phones with Users, page 4-22

¢ Configuring CAPF, page 3-90

e Using Phone Export, page 10-3

e Generating Reports for Phones, page 11-1

¢ Introducing TAPS, page 12-2

e BAT Log Files, page 13-1

e Creating a Text-Based CSV File for Phones, page A-2
e Phone CSV Data File Formats, page A-3
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CHAPTER I

Working with Users

You can use BAT to add a group of new users and to associate users to phones and
other IP Telephony devices. You can update or delete a group of existing users in
the Cisco CallManager Lightweight Directory Access Protocol (LDAP) Directory
on a Cisco CallManager server

This chapter describes working with users.

Use the following topics to manage user records and to work with user
combinations, such as phones and users or CTI ports and user records in the
Cisco CallManager LDAP directory:

Adding Users, page 4-2

Updating Users, page 4-10

Deleting Users from Cisco CallManager, page 4-16
Exporting User Records, page 10-11

Resetting Passwords and PINs, page 4-19

Adding New Phones with Users, page 4-22
Generating Reports for Users, page 11-6
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Adding Users

To add users to the Cisco CallManager LDAP Directory in bulk, you must
perform these steps:
1. Create a comma separated values (CSV) data file to define individual values
for each user that you want to add.
— See the “Using the BAT Spreadsheet to Create the CSV Data File for
Users” section on page 4-2.

— For information about creating a text-based CSV data file for users, see
the “Creating a Text-Based CSV File for Users” section on page A-11.

2. Use BAT to insert the users to the Cisco CallManager directory. See the
“Inserting Users to Cisco CallManager” section on page 4-6.

~

Note  When you are adding users who have applications that require a CTI port,
such as Cisco IP SoftPhone, BAT can associate CTI ports to existing
users.

Additional Information
See the “Related Topics” section on page 4-28.

Using the BAT Spreadsheet to Create the CSV Data File for Users

You can provide details for adding new users to the Cisco CallManager directory
in the BAT spreadsheet and convert it a CSV data file.

For information about installing and using the BAT spreadsheet, see the “Using
the BAT Spreadsheet for Gathering Data” section on page 1-11.

To create the CSV data file for adding new users in bulk, use the following
procedure.

Procedure

Step 1 To open the BAT spreadsheet, locate and double-click BAT.xIt file.
Step2  When prompted, click Enable Macros to use the spreadsheet capabilities.
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Step 3 To add users, click the Users tab at the bottom of the spreadsheet.

Step4  Complete all mandatory fields and any relevant optional fields. Each column
heading specifies the length of the field and whether it is required or optional.

In each row, provide the information as described in Table 4-1. If a user has
multiple devices, the device name field should be repeated, once for each device.

Table 4-1

Field Descriptions in BAT Spreadsheet for Adding Users

Field

Description

First Name

Enter the first name, up to 50 characters, of the
phone user.

Last Name

Enter the last name, up to 50 characters, of the phone
user.

User ID

Enter the user ID , from 1 to 30 characters, for the
user of this phone.

Password

Enter the password, up to 20 characters, that the user
needs to access the Cisco IP Phone Configuration
window.

You must specify the Password either in the CSV
data file or by using the BAT user interface during
file insertion. If you want to apply individual
passwords for each user or groups of users, specify
the password information in the CSV data file. If you
want to use a default password for all users, provide
the default password when you insert the users in
BAT.

Manager

Enter manager user ID, up to 30 characters, for the
user of this phone.

Department

Enter the department number, up to 30 characters,
for the user of this phone.
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Table 4-1 Field Descriptions in BAT Spreadsheet for Adding Users (continued)

Field

Description

PIN

Enter the personal identification number (PIN) , up
to 20 numerals, to be used for extension mobility.

You must enter a PIN either in the CSV data file or
by using the BAT user interface during file insertion.
If you want to apply individual PINs for each user or
groups of users, specify the PIN in the CSV data
file.To use a default PIN that all users can use,
provide default PIN when you insert the users in
BAT.

User Device Profile

Enter the user device profile for this user and device,
up to 50 characters. You can choose the user device
profile from the list of existing UDPs in

Cisco CallManager Administration that appears in
BAT.

User Locale

Enter the language and country set that you want to
associate with this user. Your choice determines
which cultural-dependent attributes exist for this
user and which language displays in the

Cisco CallManager user windows and phones.

Controlled Device
Namel

Enter the name, up to 50 characters, for the phone or
device that you want to associate with this user.

Directory Number

Enter the directory number, up to 50 numerals for the
primary extension (usually Line 1) for the phone.

Controlled Device Name
2

Enter the name, up to 50 characters, for any
additional phones that you want to associate with
this user.

Note  You must complete the Controlled Device
Namel field first and then add more
Controlled Device Name entries.

Step5  To enter additional device names that will be associated to a new user, click the
Add More Devices button .
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Step 6

Note

Adding Users W

Note  You can associate all devices, including CTI ports, ATA ports, and H.323
clients, with a user.

Note  To associate auto-generated device profiles to new users using BAT, BAT
administrators can enter the ADP name in the xIt, in User Device Profile
column.

Click Export to BAT Format to transfer the data from the BAT Excel spreadsheet
into a CSV formatted data file.

The system saves the file to C:\XLSDataFiles\ or use Browse to save the file to
another existing folder. The filename is:

<tabname>#<timestamp>.txt

where <tabname> represents the type of input file that you created, such as
phones, and <timestamp> represents the precise date and time that the file was
created.

~

Note If youenter acomma in one of the fields, BAT.xIt encloses that field entry
in double quotes when you export to BAT format.

If you enter a blank row in the spreadsheet, the system treats the empty
row as the end of the file. Data that is entered after a blank line does not
get converted to the BAT format.

You must copy the CSV data file to the Cisco CallManager publisher database
server, so BAT can access the data file. Using a floppy disk or a mapped network
drive, copy the data file from C:\XLSDataFiles\ (or the folder in which you chose
to store the file) to the following folder on the publisher database server:

C:\BATFiles\Users\Insert Users\

For information on how to read the exported CSV data file, click the link to View
Sample File in the Insert Users window in BAT.
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Additional Information
See the “Related Topics” section on page 4-28.

Inserting Users to Cisco CallManager

A

To add a group of users to the Cisco CallManager directory, use the following
procedure.

Before You Begin

You must have a CSV data file that contains the user names, controlled device
names, and directory numbers. You can create the CSV data file by using one of
these methods:

e BAT spreadsheet that is converted to CSV format

e Export utility that produces an export file of user data

Caution

Note

Step 1
Step 2

BAT does not check whether the device name that is included in the CSV data file
exists in the Cisco CallManager database. By not performing this validation, BAT
can associate non-CTI controlled devices to users which results in an incorrect
association.

If you are inserting files that are generated with the export utility, insert the files
in descending order based on the _MgrLevel# suffix, where # is 1 through 20.
Insert the file with the _user suffix last to ensure that the user record for a manager
exists prior to use of the User ID for a manager in the Manager User ID field.

Do not insert exported CSV data files from a Cisco CallManager server that is
using a directory type that differs from the directory type that the new
Cisco CallManager server uses.

Procedure

Choose Configure > Users. The User Options window appears.

Choose Insert Users and click Next. The Insert Users page displays.
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Step 3

Step 4

Step 5

Step 6

Adding Users W

In the File Name field, choose the CSV data file that you created for this bulk
transaction.

If the CSV data file was created by using the export utility, check the File created
with Export Users check box.

N

Note

You

Be aware that when you export a file of existing users from DC Directory
(DCD) or Netscape Directory Service (NDS), the password and PIN fields
are encrypted in the exported CSV data file. When exporting users from
Active Directory, the password does not get exported and the PIN appears
in cleartext.

can check the following check boxes to enable these features. BAT does not

disable these features if the user has already enabled them.

~

Note

The export utility puts all users who have the same settings for the
following features in the same file.

The appended suffix for the export file identifies the settings for this
group of users. Use the appended suffixes as a guide for choosing the
correct settings. For information, see the “Using User Export” section on
page 10-10.

Enable Authentication Proxy Rights—To allow users to log on to a phone
on behalf of someone else. Users who have authentication proxy rights
enabled act as the single point of authentication through which all users
connect for extension mobility. You must perform further configuration in
Application Administration on the Cisco CRS server.

Enable CTI Application Use—To enable applications such as the
Cisco IP SoftPhone for all users (applies to CTI ports).

Call Park Retrieval Allowed—To enable Call Park Retrieval for all users.

Enable Calling Party Number Modification—To allow an application such
as Cisco Emergency Responder (CER) to change the calling number when
initiating a feature request.

In the User Default Values area, provide the following information if it is not
included in the CSV data file.
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Password—Enter the password, up to 20 characters, that users should
provide when they log on to the Cisco IP Phone User Options window. You
should only specify a value here when you want to specify the default
password for access to the Cisco IP Phone User Options window and when
you have not already specified individual passwords for each user in the CSV
data file.

a~

Note  You must specify Password and PIN values, either in the CSV data
file or during the file insertion process.

~

Note  Password values that are specified in the CSV data file take
precedence over any values that you enter here.

Confirm Password—Reenter the password.

PIN—Enter the PIN, up to 20 characters, that users should provide when they
log in to a Cisco IP Phone for extension mobility. Use this field to specify the
default PIN for extension mobility and the PIN for when you have not
specified individual PINs for each user in the CSV data file. PIN values in the
CSV data file take precedence over values that you enter here.

N

Note  For users that were configured in Cisco CallManager prior to
release 3.1, exported user records have a blank PIN. When inserting
these users, enter a default PIN.

Confirm PIN—Reenter the PIN.

User Locale—Choose the language and country set that you want to
associate with this user. Your choice determines which cultural-dependent
attributes exist for this user and which language displays in the

Cisco CallManager user windows and phones.

User Device Profile—Enter the user device profile for this user and device.
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Step 7

Step 8

Step 9
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~

Note  The User Device Profile, Controlled Device Name, and Directory Number
should already exist in the Cisco CallManager database.

BAT does not check whether the device name that is included in the CSV
data file exists in the Cisco CallManager database. By not performing this
validation, BAT can associate non-CTI controlled devices to users which
results in an incorrect association.

Click Insert.

A message displays that advises you of approximately how long it will take to
insert the records to the Cisco CallManager directory. You can cancel the
transaction if you feel it may cause performance degradation.

To insert users, click OK or click Cancel to cancel the transaction.

If you clicked OK, a Transaction Status window displays. To see the transaction
in progress, you can click the Show Latest Status button.

When the transaction completes, check the Status message. BAT displays a status
completed or failed message.

You can click View Latest Log File to see a log file that indicates the number of
records that are added and the number of records that failed, including an error
code and description for the failure. For more information on log files, see the
“BAT Log Files” section on page 13-1.

S

Note  To insert users who are their own managers, insert the user in BAT and
then from CCMAdmin page set the manager as himself or herself.

A

Note  BAT enables CTI Super Provider by default for all new users.
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Note  When you are inserting users by using an exported BAT file, you might
get errors stating “User ID already exists” for some users that were
exported in more than one file. For example, a list of first line managers
and a list of users might both include the same manager user ID.

Additional Information
See the “Related Topics” section on page 4-28.

Updating Users

To update existing user information that is in the Cisco CallManager LDAP
Directory, in a bulk transaction, you must perform these steps:
1. Create a comma separated values (CSV) data file to define individual values
for each user that you want to update.
— See the “Using the BAT Spreadsheet to Create a CSV Data File for
Updating Users” section on page 4-11.
— For a text-based CSV file, see the “Updating Users File Format” section
on page A-13.

A

Note  To keep values or settings that were previously stored in the
Cisco CallManager directory, see the‘Retaining Stored Values”
section on page 4-11.

2. Use BAT to insert the updated user records that are in the Cisco CallManager
directory. See the Updating Users in Cisco CallManager, page 4-13.

Additional Information
See the “Related Topics” section on page 4-28.
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Retaining Stored Values

Step 1
Step 2
Step 3

Step 4
Step 5

Step 6

When you are updating user records, you might want to keep values or settings for
a user that were previously stored in the Cisco CallManager directory. You can
use a symbol such as“#” for fields where the value must be retained. In following
example CSV data file, the # tells BAT to keep the Manager field the same as the
one that was previously entered in the DC directory.

userid, #,department, ,,123456789012,

To identify the value to use to retain a stored value, use the following procedure.

Procedure

Choose Configure > Users. The User Options window appears.
Choose Update Users and click Next. The Update Users page displays.

Notice the Value for fields to be ignored box. When you insert the CSV data file
with the updated user values, you must enter the symbol that you used to retain
values in this box.

Decide what symbol you want to use for retaining values.

Enter this value that is in the Value for fields to be ignored box into the BAT
spreadsheet box.

Use this symbol in BAT spreadsheet fields for any values that you want to retain.

Additional Information
See the “Related Topics” section on page 4-28.

Using the BAT Spreadsheet to Create a CSV Data File for
Updating Users

To create the CSV data file for updating a group of existing users, use the
following procedure.
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Procedure

Step1  Locate and Double-click BAT.xIt file to open the BAT spreadsheet.
Step2  When prompted, click Enable Macros to use the spreadsheet capabilities.

Step3  To add user information, click the Update Users tab at the bottom of the
spreadsheet .

Step4  Complete all mandatory fields and any relevant optional fields. Each column
heading specifies the length of the field and whether it is required or optional. Use
Table 4-2 for descriptions of the BAT spreadsheet fields.

Table 4-2  Field Descriptions in the BAT Spreadsheet for Updating Users

Field Description

User ID Enter the user ID, from 1 to 30 characters, for the
user of this phone.

Manager Enter manager user ID, up to 30 characters, for the
user of this phone.

Department Enter the department number, up to 50 characters,
for the user of this phone.

User Device Profile Enter the user device profile, up to 50 characters, for
this user and device. You can choose the user device
profile from the list of existing UDPs in

Cisco CallManager Administration that appears in
BAT.

User Locale Enter the language and country, up to 50 characters,
set that you want to associate with this user. Your
choice determines which cultural-dependent
attributes exist for this user and which language
displays in the Cisco CallManager user windows and

phones.
Controlled Device MAC |Enter the MAC address, 12 characters, for the phone
Address that you want to associate with this user.
Directory Number Enter the directory number, up to 24 numerals, for

the primary extension (usually Line 1) for the phone.
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Step 6
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In the “Value for fields to be ignored” box, enter the symbol that you will use to
tell BAT that you want to keep the value that was previously stored in the DC
directory.

To transfer the data from the BAT Excel spreadsheet into a CSV file, click the
Export to BAT format button.

The system saves the file to c:\XIsDataFiles\ (or to your choice of another existing
folder). The filename is

Update_Users#timestamp.txt (or to your choice of filename)

~

Note If you enter acomma in one of the fields, BAT.xIt encloses that field entry
in double quotes when you export to BAT format.

If you enter a blank row in the spreadsheet, the system treats the empty
row as the end of the file. Data that is entered after a blank line does not
get converted to the BAT format.

You must copy the CSV data file to the Cisco CallManager publisher database
server, so BAT can access the CSV data file. Using a floppy disk or a mapped
network drive, copy the CSV data file from C:\XLSDataFiles\ (or the folder in
which you chose to store the file) to this folder on the publisher database server:
C:\BATFiles\Users\Update Users\

~

Note  For information on how to read the CSV data file, click the link to View
Sample File in the Update Users window in BAT.

Additional Information

See the “Related Topics” section on page 4-28.

Updating Users in Cisco CallManager

To update a group of user records in the to Cisco CallManager directory, use this
procedure.
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Step 1
Step 2
Step 3

Step 4

Step 5

Before You Begin

You must have a CSV data file with updated user information. See the “Using the
BAT Spreadsheet to Create a CSV Data File for Updating Users” section on
page 4-11 for instructions.

Procedure

Choose Configure > Users. The User Options window displays.
Choose Update Users and click Next. The Update Users page displays.

From File Name drop-down list box, choose the CSV data file that you created for
this bulk transaction.

In the Value for fields to be ignored box, enter the symbol that you used to tell
BAT that you want to keep the value that was previously stored in the DC
directory. See the “Retaining Stored Values” section on page 4-11 for more
information.

You can check the following check boxes to enable these features. BAT does not
disable these features if the user has already enabled them.

N

Note  The export utility puts all users who have the same settings for the
following features in the same file.

The appended suffix for the export file identifies the settings for this
group of users. Use the appended suffixes as a guide for choosing the
correct settings. For information, see the “Using User Export” section on
page 10-10.

e Enable Authentication Proxy Rights—To allow users to log on to a phone
on behalf of someone else. Users who have authentication proxy rights
enabled act as the single point of authentication through which all users
connect for extension mobility. You must perform further configuration in
Application Administration on the Cisco CRA server.

¢ Enable CTI Application Use—To enable applications such as the
Cisco IP SoftPhone for all users.

e (Call Park Retrieval Allowed—To enable Call Park Retrieval for all users.
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Step 7

Step 8

Step 9
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¢ Enable Calling Party Number Modification—To allow an application such
as Cisco Emergency Responder (CER) to change the calling number when
initiating a feature request.

¢ Set User Device Profile as Default Device Profile—To set the user device
profile as the default profile when logged off the phone.

¢ Reset Password—To reset the password for all users.

e Password—Enter the default password that users use when they log on to the
Cisco IP Phone User Options window. You should only specify a value here
when you want to set the default password for user.

¢ Confirm Password— Reenter the password.
e Reset PIN—To reset the PIN for all users.

¢ PIN—Enter the default PIN for the extension mobility feature that users
should use when they log in to any Cisco IP Phone model that supports
extension mobility.

e Confirm PIN—Reenter the PIN.

In the User Default Values area, in the User Locale drop-down list box, choose
the language and country set that you want to associate with this user. Your choice
determines which cultural-dependent attributes exist for this user and which
language displays in the Cisco CallManager user windows and phones.

~

Note  The values that you entered for User Locale and User Device Profile in
the CSV data file will override the values that you specify in the User
Default Values area of the Update User window.

In the User Device Profile drop-down list box, choose the user information that
you want to associate with this user.

Click Update. A message displays that advises you of approximately how long it
will take to update the records in Cisco CallManager. You can cancel the
transaction or click OK to continue.

When the transaction completes, check the Status message. BAT displays a status
completed or failed message.
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You can click View Latest Log File to see a log file that indicates the number of
records that were updated and the number of records that failed, including an error
code. For more information on log files, see the “BAT Log Files” section on
page 13-1.

Additional Information
See the “Related Topics” section on page 4-28.

Deleting Users from Cisco CallManager

You can delete a group of users from the Cisco CallManager directory. To access
the Delete Users option, choose Configure > Users. In the User Options window,
choose Delete Users and click Next. You can locate existing user records by using
one of these two methods:

e Using Query to Delete Users, page 4-16
e Using a Custom File to Delete Users, page 4-18

Using Query to Delete Users

To delete users when you want to create a query filter to locate the user records,
use the following procedure.

Procedure

Step 1 In the Delete Users Options window, click Use Query and click Next. The Delete
Users window displays.

Step2  To locate the users that you want to delete, define the query filter.

A

Caution  If you do not define a filter, BAT deletes all users.

Step3  In the first drop-down list box, choose a field to query such as User ID,
Department, First Name, or Last Name.
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Step4  In the second drop-down list box, choose contains or is exactly.

Step 5 In the third box, which is the search field, enter the value that you want to locate,
such as a specific user.

~

Note  To choose users from more than one department, enter multiple
departments in this field. For example, to choose users from departments
12 and 24, enter 12, 24 in the third box instead of performing two
operations.

Step6  To add the defined filter to the query, click Add To Query button.

If you make a mistake, click the Clear Query button to remove the query; then,
return to Step 3 and start over.

Step7  To display the records that are going to be affected, click View Query Result .

~

Note  Ensure that you have located the correct records to delete. Because the
delete action is final, you cannot retrieve deleted records.

Step 8 To delete the chosen users, click Delete.

A

Caution  If no information is entered into the query text box, the system deletes all records.
Because the delete action is final, you cannot retrieve deleted records.

A message displays that advises you of approximately how long it will take to
delete the records in the Cisco CallManager directory. You can cancel the
transaction or click OK to continue.

Step9  When the transaction completes, check the Status message. BAT displays a status
completed or failed message.

Step10 To see a log file that indicates the number of records that were deleted and the
number of records that failed, including an error code, you can click View Latest
Log File. For more information on log files, see the “BAT Log Files” section on
page 13-1.
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Additional Information
See the “Related Topics” section on page 4-28.

Using a Custom File to Delete Users

To locate and delete users, you can create a custom file of user IDs by using a text
editor.

Before You Begin

1. Create a text file that lists each user ID that you want to delete on a separate
line.

2. Save the custom file with a <filename.txt> to this folder:
C:\BATfiles\Users\Query\Delete\

To delete phones by using a custom file, use the following procedure .

Procedure

Step 1 In the Delete Users Options window, choose Use Custom File and click Next.
The Delete Users window displays.

Step2  In Select Users where drop-down list box, choose the field that you used in the
custom file, User ID.

Step 3 In the Custom file where drop-down list box, choose the filename for the custom
file.

Step4  To check that the query includes the information that you need, click View Query

Results.
A

Caution  If no information is entered into the query text box, the system deletes all users
records.

Step 5 To delete the records, click Delete.

Step6 A message displays that advises you of approximately how long it will take to
delete the records from the Cisco CallManager directory. You can cancel the
transaction or click OK to continue.
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Resetting Passwords and PINs

To display the log file that BAT generated, you can click the View Latest Log File
link. The log file displays the number of users that were deleted and the number
of records that failed, including an error code. For more information on log files,
see “BAT Log Files” section on page 13-1.

Additional Information
See the “Related Topics” section on page 4-28.

Resetting Passwords and PINs

You can reset the password that users use when they log on to the Cisco IP Phone
User Options window. You can also reset the PINs for the extension mobility
feature that users use when they log in to Cisco IP Phones. Use this action when
you must reset a group of users to a default password or to a default PIN without
updating any other attributes.

To access the Reset User Password/PIN option, choose Configure > Users. In the
User Options window, choose Reset Password/PIN and click Next. You have two
ways to choose users for resetting passwords and PINs:

e Using Query to Reset User Password and PIN, page 4-19
e Using a Custom File to Reset User Password and PIN, page 4-21

Using Query to Reset User Password and PIN

Step 1

Step 2

To use a query to locate users and reset passwords and PINs to a default value, use
the following procedure.

Procedure

In the Reset Password/PIN Options, choose Use Query and click Next. The Reset
Password/PIN window displays.

To locate the users that you want to reset, define the query filter.
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A

Caution

Step 3

Step 4
Step 5

Step 6

Step 7
Step 8

Step 9

Step 10

If you do not define a filter, the system resets the passwords or PINS for all users.

In the first drop-down list box, choose a field to query such as User ID,
Department, First Name, or Last Name.

In the second drop-down list box, choose contains or is exactly.

In the third box, which is the search field, enter the value that you want to locate,
such as a specific user or department number.

~

Note  To choose users from more than one department, enter multiple
departments separated with a comma in this field. For example, to choose
users from departments 12 and 14, enter 12, 14 in the third box instead of
performing two operations.

To add the defined filter to the query, click Add To Query .

If you make a mistake, click the Clear Query button to remove the query; then,
return to Step 3 and start over.

To display the records that are going to be affected, click View Query Result .

Enter the values that you want to update for all the records that you defined in your
query.
e Password—Enter the default password that users use when they log on to the
Cisco IP Phone User Options window.

¢ Confirm Password—Reenter the password.

e PIN—Enter the default PIN for the extension mobility feature that users
should use when they log in to a Cisco IP Phone.

¢ Confirm PIN—Reenter the PIN.
To change passwords or PINs for the chosen users, click Reset .

A message displays that advises you of approximately how long it will take to
update the records in the Cisco CallManager directory. You can cancel the
transaction or click OK to continue.

When the transaction completes, check the Status message. BAT displays a status
completed or failed message.
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Resetting Passwords and PINs

To see a log file that indicates the number of records that were reset and the
number of records that failed, including an error code, you can click View Latest
Log File. For more information on log files, see the “BAT Log Files” section on
page 13-1.

Additional Information
See the “Related Topics” section on page 4-28.

Using a Custom File to Reset User Password and PIN

Step 1
Step 2

Step 3

Step 4

Step 5

To locate users and to reset passwords and PINs to default values, you can create
a custom file of user IDs by using a text editor.

Before You Begin

1. Create a text file that lists each user ID that you want to delete on a separate
line.

2. Save the custom file with a <filename.txt> to this folder:
C:\BATfiles\Users\Query\Update\

To reset user passwords and PINS by using a custom file, use the following
procedure.

Procedure

Choose Configure > Users. The User Options window appears.

Choose Reset Password/PIN and click Next. The Reset Password/PIN Options
window displays.

Click Use Custom File and click Next. The Reset Password/PIN window
displays.

In Select Users where drop-down list box, choose the field that you used in the
custom file, User ID.

In the Custom file where drop-down list box, choose the filename for the custom
file.
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Step 6

A

To check that the query includes the information that you need, click View Query
Results.

Caution

Step 7
Step 8

Step 9

If no information is entered into the query text box, the system updates all users
records.

To change the records, click Reset .

A message displays that advises you of approximately how long it will take to
update the records in the Cisco CallManager directory. You can cancel the
transaction or click OK to continue.

To display the log file that BAT generated, you can click the View Latest Log File
link. The log file displays the number of users that were updated and the number
of records that failed, including an error code. For more information on log files,
see “BAT Log Files” section on page 13-1

Additional Information
See the “Related Topics” section on page 4-28.

Adding New Phones with Users

Step 1

You can use BAT to add a group of users and their phones on a Cisco CallManager
server in one bulk transaction. You have two options for creating a CSV data file
for the phones:

e Use the BAT spreadsheet (BAT.xIt) and export the data to the CSV format.
e Use a text editor to create a text file in CSV format (for experienced users).

You can access the Insert Phones with Users option by choosing
Configure > Phones or Configure > Users from the BAT main menu.

To add a group of phones with users to the Cisco CallManager database, you must
perform these steps:

Choose Insert Phones with Users. The Steps to Insert Phones/Users window
displays.
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Step 2

Step 3
Step 4

Step 5

Step 6

Adding New Phones with Users

Choose Add, view, or modify phone templates and click Next.

The Phone Template Configuration window displays. See the “Using BAT Phone
Templates” section on page 3-3 for information about configuring phone
templates.

Choose Create the CSV data file and click Next.

Choose the option that you will use to create the CSV data file and use the steps
for that option.

BAT Spreadsheet for Phones, CTI Ports and H.323 Clients

Open the BAT spreadsheet and create the CSV data file. See “Using the BAT
Spreadsheet to Add Phones with Users” section on page 4-24

Text Editor to Create the CSV Data File
a. Choose Add, view, or modify file formats and click Next.

The File Format Configuration window displays. See the “Using a Text Editor
to Create the CSV Data File for Phones” section on page 3-50 for information
about configuring file formats for CSV data file.

b. Use a text editor and create the CSV data file for phones with users that
follows the appropriate file format. For more information about creating a
text-based CSV file, see “Phones With Users Combinations File Format”
section on page A-5

c. Choose Associate file format with the CSV data file and click Next.

The Add File to Format window displays. See the “Associating the File
Format with the CSV Data File” section on page 3-54 for information about
associating file formats.

Choose Validate Phones with users records and click Next.

The Validate Phones/Users window displays. See the “Validating Phones and
Users Records” section on page 4-24 for information.

Choose Insert Phones with users records and click Next.

The Insert Phones/Users window displays. See the “Inserting Phones with Users
to Cisco CallManager” section on page 4-25 for information.

Additional Information

See the “Related Topics” section on page 4-28.
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Using the BAT Spreadsheet to Add Phones with Users

Step 1
Step 2
Step 3
Step 4

To create the CSV data file for adding phones and users in bulk, use the following
procedure.

For information about installing and using the BAT spreadsheet, see “Using the
BAT Spreadsheet for Gathering Data” section on page 1-11.

Procedure

Locate and double-click BAT.xlt file to open the BAT spreadsheet.
When prompted, click Enable Macros to use the spreadsheet capabilities.
Click the Phones-Users tab at the bottom of the spreadsheet.

Follow steps 4 through 14 in the Using the BAT Spreadsheet to Create a CSV Data
File for Phones, page 3-39.

When entering values in the user information fields, see Table 4-1 on page 4-3.

After exporting the file to the CSV data format, copy the Phone-User CSV data
file to C:\BATFiles\PhonesUsers\ on the publisher server.

Additional Information
See the “Related Topics” section on page 4-28.

Validating Phones and Users Records

When you choose Validate Phones/Users, the system runs a validation routine to
check that the CSV data file and BAT phone template have populated all required
fields, such as device pool and locations. The validation checks only the device
fields and their dependencies. Users fields are not validated.

Before You Begin

e You must have a BAT phone template for the devices that you are adding. You
can use a master phone template with multiple lines to add phones that have
a single line or several lines. See the “Master Phone Templates” section on
page 1-5 for more information.
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Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Adding New Phones with Users

* You must have a CSV data file that you created by using one of these options:
— Using the BAT Spreadsheet to Add Phones with Users, page 4-24

— Creating a text-based CSV file in the Phones With Users Combinations
File Format, page A-5.

To validate your CSV data file records, use the following procedure.

Procedure

Choose Insert Phones with Users. The Steps to Insert Phones/Users window
displays.

Choose Validate Phones with users records and click Next. The Validate
Phones/Users window displays.

In the File Name field, choose the CSV data file that you created for this specific
bulk transaction.

In the Phone Template Name field, choose the BAT phone template that you
created for this bulk transaction.

To verify the chosen CSV data file with the publisher database, click Validate.
The validation routine records errors in a log file.

When validation completes, click View Latest Log File to see a log file that lists
the devices with discrepancies and the error code. For more information on log
files, see the “BAT Log Files” section on page 13-1.

Additional Information
See the “Related Topics” section on page 4-28.

Inserting Phones with Users to Cisco CallManager

To add a group of phones and users to the Cisco CallManager database and
directory, from the BAT main menu, you can choose Configure > Phones or
Configure > Users.

Before You Begin
¢ You must have a BAT phone template for the phones.
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Step 1

Step 2

Step 3

Step 4

* You must have a CSV data file that you created by using one of these options:
— Using the BAT Spreadsheet to Add Phones with Users, page 4-24

— Creating a text-based CSV file in the Phones With Users Combinations
File Format, page A-5.

e Prior to inserting the records, validate the phones and users records so you
can identify and eliminate errors.

To add a group of phones and users to the Cisco CallManager database and
directory, use the following procedure.

Procedure

Choose Insert Phones with Users and click Next. The Insert Phones/Users
window displays.

In the File Name field, choose the CSV data file that you created for this bulk
transaction.

In the Phone Template field, choose the BAT phone template that you used for this
transaction.

If you did not enter individual MAC addresses in the CSV data file, you must
check the Create Dummy MAC Address check box. If you are adding CTI ports,
the dummy MAC address option provides a unique device name for each CTI port
in the form of dummy MAC addresses.

This field automatically generates dummy MAC addresses in the following
format: BATXXXXXXXXXXXX
where X represents any 12-character, hexadecimal (0-9 and A-F) number.

e If you do not know the MAC address of the phone that will be assigned to the
user, chose this option. When the phone is plugged in, a MAC address
registers for that device.

e If you supplied MAC addresses or device names in the data input file, do not
choose this option .

You can update the phones or devices later with the correct MAC address by
manually entering this information into Cisco CallManager Administration or by
using TAPS. See the“Introducing TAPS” section on page 12-2 for more
information about TAPS.

You can check the following check boxes to enable these features. BAT does not
disable these features if the user has already enabled them.
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Enable Authentication Proxy Rights—To allow users to log on to a phone
on behalf of someone else. Users who have authentication proxy rights
enabled act as the single point of authentication through which all users
connect for extension mobility. You must perform further configuration in
Application Administration on the Cisco CRA server.

Enable CTI Application Use—To enable applications such as the
Cisco IP SoftPhone for all users (for CTI ports).

Call Park Retrieval Allowed—To enable Call Park Retrieval for all users.

Enable Calling Party Number Modification—To allow an application such
as Cisco Emergency Responder (CER) to change the calling number when
initiating a feature request.

Step5  In the User Default Values area, provide the following information if it is not
included in the CSV data file.

Password—Enter the password, up to 20 characters, that users should
provide when they log on to the Cisco IP Phone User Options window. You
should only specify a value here when you want to specify the default
password for access to the Cisco IP Phone User Options window and when
you have not already specified individual passwords for each user in the CSV
data file.

~

Note Password values that are specified in the CSV data file take
precedence over any values that you enter here.

Confirm Password—Reenter the password.

PIN—Enter the PIN, up to 20 characters, that users should provide when they
log in to a Cisco IP Phone for extension mobility. Use this field to specify the
default PIN for extension mobility and when you have not specified
individual PINs for each user in the CSV data file. PIN values in the CSV data
file take precedence over values that you enter here.

Confirm PIN—Reenter the PIN.

S

Note  You must specify PIN and Password values, either in the CSV data
file or during the file insertion process.
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Step 6

Step 7

Step 8

¢ User Locale—Choose the language and country set that you want to
associate with this user. Your choice determines which cultural-dependent
attributes exist for this user and which language displays in the
Cisco CallManager user windows and phones.

e User Device Profile—Enter the user device profile for this user and device.
The User Device Profile must exist in Cisco CallManager Administration for
the Cisco CallManager database to accept this record.

Click Insert. A message displays that advises you of approximately how long it
will take to insert the records to the Cisco CallManager directory. You can cancel
the transaction if you feel it may cause performance degradation.

To insert users, click OK or click Cancel to cancel the transaction.

If you clicked OK, a Transaction Status window displays. To see the transaction
in progress, you can click the Show Latest Status button.

When the transaction completes, check the Status message. BAT displays a status
completed or failed message.

To see a log file that indicates the number of records that are added and the
number of records that failed, including an error code and description of the error,
you can click View Latest Log File. For more information on log files, see the
“BAT Log Files” section on page 13-1.

Additional Information

See the “Related Topics” section on page 4-28.

Related Topics

e Adding Users, page 4-2

e Updating Users, page 4-10

e Deleting Users from Cisco CallManager, page 4-16
e Resetting Passwords and PINs, page 4-19

¢ Adding New Phones with Users, page 4-22

e Exporting User Records, page 10-11

e Generating Reports for Users, page 11-6
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Related Topics W

e BAT Log Files, page 13-1

e Creating a Text-Based CSV File for Users, page A-11
e Users File Format, page A-12

e Updating Users File Format, page A-13
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CHAPTER

Working with Cisco IP Manager
Assistant

You can use BAT to manage the Cisco IP Manager Assistant (IPMA) feature in
Cisco CallManager. BAT allows you to add IP phones for managers and
assistants. See the following sections for information:

¢ Configuring Phones in Proxy Line Mode for Cisco IPMA, page 5-2
¢ Configuring Phones in Shared Line Mode for Cisco IPMA, page 5-10

You can add, update, and delete managers or assistants with their associations in
bulk transactions. See the Creating the CSV Data File for Manager-Assistant
Associations, page 5-13.

The following topics explain the options for managing Cisco IPMA with BAT:
e Inserting Manager-Assistant Associations to Cisco CallManager, page 5-17

e Deleting Manager-Assistant Associations from Cisco CallManager,
page 5-19

e Deleting Managers from Cisco CallManager, page 5-21

e Deleting Assistants from Cisco CallManager, page 5-24

e Generating Reports for IPMA Managers and Assistants, page 11-13
For more information related to Cisco IPMA, refer to this documentation.

e C(Cisco CallManager Features and Services Guide

e Cisco IP Manager Assistant User Guide

[ oL-8661-01

Bulk Administration Tool User Guide ]



Chapter5 Working with Cisco IP Manager Assistant |

M Overview of Phones and Lines for Use with Cisco IPMA

Overview of Phones and Lines for Use with
Cisco IPMA

The Cisco IPMA feature works with several Cisco IP Phone models and device
profiles. Cisco IPMA provides two modes for configuring managers and
assistants lines for use with Cisco IPMA features.

¢ Proxy mode—The manager’s primary line is associated with a proxy line that
has a different directory number on the assistant’s phone. See the
“Configuring Phones in Proxy Line Mode for Cisco IPMA” section on
page 5-2.

e Shared line mode—The manager and assistant have a shared line on their
phones that uses the same directory number and partition. See the
“Configuring Phones in Shared Line Mode for Cisco IPMA” section on
page 5-10.

You can use BAT to set up the manager and assistant phones with either proxy
lines or shared lines.

Configuring Phones in Proxy Line Mode for Cisco IPMA

To prepare for configuring manager and assistant phones with IPMA proxy line
support, you must complete the following tasks:

1. Cisco recommends that you use the Cisco IPMA Configuration Wizard to set
up and configure IPMA requirements for your system. The wizard
automatically creates the phone templates for IPMA manager and assistant,
route points, partitions, translation patterns, and calling search space for the
Cisco IPMA service. To run the Cisco IPMA Configuration Wizard, BAT and
the wizard must be on the same server. Refer to the
Cisco CallManager Features and Services Guide for information about
running the Cisco IPMA Configuration Wizard.

Note  You can use the Cisco IPMA Configuration Wizard only one time to set
up the IPMA configuration requirements for your system. After running
the configuration wizard, you can only view, but not change, your
configuration with the wizard.
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To add new phones and users for managers and assistants, use the IPMA
manager and IPMA assistant phone templates that the Cisco IPMA
Configuration Wizard produced on the BAT server. Use the BAT templates to
configure phones for proxy mode only. For information about the templates,
see the “Default Settings for IPMA Manager and Assistant Phone Templates”
section on page 5-3.

For existing manager and assistant phones, you can change the manager and
assistant phones to correspond to the IPMA phone templates by using either
of these methods:

— You can use the Add Lines feature in BAT to modify existing phones to
resemble the IPMA phone templates. See the Adding Lines to Existing
Phones and UDPs, page 3-78.

— You can delete the original phones and add new phones by using the
IPMA phone templates for managers and assistants. Follow the
procedures for setting up new phones in the “Adding Phones” section on
page 3-2.

After you have configured the phones and lines for managers and assistants,
then you associate the manager and assistant lines for IPMA control. For
information about IPMA line configurations, see the “Manager and Assistant
Proxy Line Configurations” section on page 5-4.

Default Settings for IPMA Manager and Assistant Phone Templates

Table 5-1 lists the default settings for the IPMA manager phone template.

Table 5-1  Default Settings for Manager Phone Templates for Proxy Lines

Field

Default Value

Softkey Template

Standard IPMA Manager

Phone Button Template

Standard Cisco IP Phone model 7960 (2 lines)

Linel

Primary line
e CSS = Generated_IPMA_CSS_I_E
e Partition = Generated_IPMA_Managers
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Table 5-1  Default Settings for Manager Phone Templates for Proxy Lines

Field Default Value
Line 2 Incoming Intercom line

e CSS = Generated_IPMA_CSS_I_E

e Partition = Generated_IPMA_Everyone

e Also configure auto answer with speakerphone or
headset option.

Services IPMA Service

Table 5-2 lists the default settings for the IPMA assistant phone template.

Table 5-2 Default Settings for Assistant Phone Template for Proxy Lines

Field Default Value

Softkey Template Standard IPMA Assistant

Phone Button Template |Standard Cisco IP Phone 7960 Assistant
Expansion Module 1 14-button expansion module

Line 1 - Line 6 Proxy line 1 - 5 with each proxy line defaulted to
(On IP Phone 7960) e CSS=IPMA_CSS_M_E

Line 2 - Line 5 e Partition = Generated_IPMA_Everyone

(On Expansion Module)

Line 7 Intercom line

(On Expansion Module) | ¢ CSS = Generated_IPMA_CSS_I_E
e Partition = Generated_IPMA_Everyone

e Also configure auto answer with speakerphone or
headset option.

Manager and Assistant Proxy Line Configurations
BAT assigns IPMA line configurations by mapping the manager’s primary lines

on the phone to proxy lines on the assistant phone. When you used the IPMA
manager and assistant default templates that the IPMA wizard created, you can

Bulk Administration Tool User Guide
m. 0L-8661-01 |




| Chapter5

Working with Cisco IP Manager Assistant

Overview of Phones and Lines for Use with Cisco IPMA

associate from one to five manager lines on one assistant phone. For phones
configured with the IPMA templates, this example shows the line configurations
when you associate two manager phones to an assistant phone.

Manager 1 Phone:
e Line 1— Primary line

e Line 2— Intercom line

Manager 2 Phone:
e Line 1— Primary line

e Line 2— Intercom line

Assistant Phone:
e Line 1—Primary line
e Line 2—Proxy line for Manager 1
e Line 3—Proxy line for Manager 2
e Lines 4 through 6 are unassigned
¢ Line 7—Intercom line
Lines 4 through 6 are available for other manager associations.

When you associate multiple managers to an assistant phone, BAT creates proxy
lines based on the order in the CSV data file. BAT creates the first
manager-assistant line by assigning all the manager’s primary lines as proxy lines
to the unassigned lines on the assistant phone. BAT continues creating individual
manager-assistant proxy lines based on the order of the CSV record until all lines
on the assistant phone are assigned or all managers in the CSV record are
associated.

When you associate multiple assistants to a manager primary line, BAT assigns
assistants to the manager based on the order in the CSV data file. BAT assigns the
manager’s primary lines based on the first assistant’s number of available lines.
For example, a manager’s phone has two primary lines. The first assistant, who is
listed in the CSV data file, has only one available line. Consequently, BAT
associates only one primary line for the manager and one proxy line on all the
assistant phones that are listed in the CSV record.
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IPMA Manager Phone Configuration

Table 5-3 lists all possible line configurations for a manager phone that BAT can
set up when using manager-assistant associations.

Table 5-3

Manager Phone Line Configuration

Number of Available Lines

Configuration

One line Line 1—Primary line (IPMA controlled)
Intercom line (none)
Two lines Line 1—Primary line (IPMA controlled)

(Default IPMA manager
phone template)

Line 2—Intercom line (optional)

More than two lines

Last line gets configured as the intercom line.

The number of available lines on the assistant
phone determines the number of manager lines

that get associated with proxy lines.

IPMA Assistant Phone Configuration

Table 5-4 lists the default line configuration for the assistant phones that BAT sets
up during manager-assistant associations.

Table 5-4 Assistant Phone Line Configurations

Number of Available Lines

Configuration

One line Line 1—Proxy line
Intercom line (none)
Two lines Line 1—Primary line

Line 2—Proxy line

Intercom line (none)

Three lines

Line 1—Primary line
Line 2—Proxy line

Line 3—Intercom line
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Table 5-4  Assistant Phone Line Configurations (continued)

Number of Available Lines |Configuration

More than three lines Line 1—Primary line
Line 2—Proxy line
Last line gets configured as the intercom line

All other lines get configured as proxy lines

Seven lines Line 1—Primary line

(Default IPMA assistant Line 2 through line 6 can get configured as proxy
phone template) lines to support up to five managers.

Line 7—Intercom line

Proxy Line Example for Cisco IPMA Manager and Assistant Phones

You associate two managers, each with three existing lines, to an assistant phone
with six unassigned lines. BAT sets the following line configurations on the
manager and assistant phones.

Manager 1 Phone:

Line 1—Manager primary line (DN is 2355)
Line 2—Manager primary line (DN is 2366)

Line 3—Manager intercom line

Manager 2 Phone:

Line 1—Manager primary line (DN is 2656)
Line 2—Manager primary line (DN is 2666)

Line 3—Manager intercom line

Assistant Phone:

Line 1—Assistant primary line (DN is 3333)

Line 2—Proxy line 1 for Manager 1 (DN is 3455)
Line 3—Proxy line 1 for Manager 2 (DN is 3656))
Line 4—Proxy line 2 for Manager 1 (DN is 3366)
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e Line 5—Proxy line 2 for Manager 2 (DN is 3666)
e Line 6—Available
e Line 7—Assistant intercom line

When you associate a manager phone that has preexisting primary lines, you must
ensure that the number of unassigned lines on the assistant phone is equal to or
greater than the number of primary lines on the manager phone. For instance, BAT
does not allow you to create an association between a manager that has a phone
with four configured primary lines and an assistant with only three available lines.

Additional Information

See the “Related Topics” section on page 5-27.

Setting Up New Phones for IPMA Managers and Assistants with Proxy Lines

To set up new phones for IPMA managers and assistants that use proxy lines, use
the following procedure.

Before You Begin

1. Run the IPMA Configuration Wizard to create the IPMA templates, partition,
and calling search space.

2. If you want to associate more than five managers to an assistant, you must
access the IPMA Assistant Template and make a copy with a new name. Add
more lines to the template to accommodate the additional managers.

Step1  Choose Configure > Phones. The Phones Options window displays.

Step2  Choose Insert Phones with Users and click Next. The Steps to Insert Phones
window displays.

Step3  In the Steps to Insert Phones window, Choose Add, view, or modify phone
templates and click Next.

The Phone Template Configuration window displays and lists the IPMA Manager
and the IPMA Assistant phone templates in the Phone Templates List.
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S,
Note The BAT IPMA templates are write protected. If you want to make

changes to these templates, you must make a copy of the template and
then edit the template with your changes.

See the “Default Settings for Manager Phone Templates for Proxy Lines” section
on page 5-3 for descriptions of the manager phone template fields.

See the “Default Settings for Assistant Phone Template for Proxy Lines” section
on page 5-4 for descriptions of the assistant phone template fields.

Create the CSV data file for manager phones and another file for assistant phones
by using these options:

e Use the BAT spreadsheet and choose the Phones tab.

e Use a text editor and refer to the manager or assistant template fields as a
guide.

Use the procedure in the “Adding Phones” section on page 3-2 for detailed steps
to insert new phones.

Setting Up IPMA Proxy Lines on Existing Phones

Step 1
Step 2
Step 3

To set up lines on existing phones for managers and assistants, use the following
procedure.

Choose Configure > Phones. The Phones Options window displays.
Choose Add Lines and click Next. The Add Lines (Step 1 of 2) window displays.

If you need to copy and modify the IPMA templates for BAT, see these topics for
reference:

e Default Settings for Manager Phone Templates for Proxy Lines, page 5-3
e Default Settings for Assistant Phone Template for Proxy Lines, page 5-4
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Note  If you changed any of the configuration information (for example,
partition names) when you ran the Cisco IPMA Configuration Wizard,
you must use the same configuration information for the fields when you
edit the template.

Step4  Create the CSV data file for manager phones and another file for assistant phones
by using one of these options:

e Use the BAT spreadsheet and choose the Add Lines tab.
e Use a text editor and use the manager or assistant template fields as a guide.

Step5  To set up manager and assistant lines on existing phones, use the procedure in
“Adding Lines to Existing Phones and UDPs” section on page 3-78.

Additional Information
See the “Related Topics” section on page 5-27.

Configuring Phones in Shared Line Mode for Cisco IPMA

To configure manager and assistant phones with shared line support, you must
perform the following tasks:

1. You must set up the IPMA service parameters for shared line support in
Cisco CallManager. Refer to the Cisco CallManager Features and Services
Guide for information.

2. You need a phone button template with five or more lines for the IP Phone
model 7960.

3. Configure the phones for managers and assistants by using the following
guidelines:

Manager Phones in Shared Line Mode

Use the procedures for setting up new phones by using BAT in the “Adding
Phones” section on page 3-2.
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Create a BAT template to add new or update existing manager phones with the
following phone settings:

¢ Assign the Softkey template: Standard IPMA Shared Mode Manager.
e Add primary lines to share with assistants, if needed.

e Set up the voice-messaging profile on the primary line.

* Add an incoming intercom line (optional).

e Add speed-dial buttons for outgoing intercom targets (optional).

e Set the user locale.

Assistant Phones in Shared Line Mode

Use the procedures for setting up new phones by using BAT in the “Adding
Phones” section on page 3-2.

Create a BAT template to add new or update existing assistant phones with the
following phone settings:

e Assign the Softkey template: Standard IPMA Assistant

e If you are using a Cisco 14-button expansion module (7914) for additional
lines, specify the expansion module type in the BAT template.

N

Note  All Cisco IP Phone model phone button templates include expansion
module lines.

e Add a personal primary line.

e Add shared lines for each associated manager. Use the same directory number
and partition as the primary line on the manager phone.

e Add an incoming intercom line (optional)
e Add speed dials to the managers intercom lines (optional)
e Set the user locale

1. To add lines to existing managers or assistants phones, see the “Adding Lines
to Existing Phones and UDPs” section on page 3-78. Use the line settings as
specified in these sections:

— Manager Phones in Shared Line Mode, page 5-10
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— Assistant Phones in Shared Line Mode, page 5-11

2. After you have configured the phones and lines for managers and assistants,
then you associate the manager and assistant lines for IPMA control. Follow
the procedures in the “Creating the CSV Data File for Manager-Assistant
Associations” section on page 5-13.

Manager and Assistant Shared Line Configurations

BAT associates Cisco IPMA line configurations to shared lines that are assigned
to the manager and the assistant phones.You set the shared line mode in the
manager’s configuration when associating managers with assistants.

In shared line mode, the manager’s line corresponds to a shared line on the
assistant phone. For example, in order to associate two managers with an
assistant, you add two lines to the assistant’s phone that have the same directory
numbers and partitions as the primary lines on the managers phones.

Manager 1 Phone:
e Line 1— Primary line (DN is 2355)

e Line 2— Intercom line (optional)

Manager 2 Phone:
e Line 1— Primary line (DN is 2875)

e Line 2— Intercom line (optional)

Assistant's Phone:
e Line 1—Assistant’s primary line (DN is 3356)
e Line 2—Shared line with Manager 1 (DN is 2355)
e Line 3—Shared line with Manager 2 (DN is 2875)
e Lines 4 through 6 are available
e Line 7—Intercom line (optional)
You can add lines 4 through 6 as shared lines for other managers.

When you add multiple manager lines to an assistant phone, all lines on the
assistant’s phone must use shared line mode. You cannot mix proxy and shared
lines on the assistant phone. Likewise, when a manager has multiple assistants, all
associations must use shared line mode.
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When you associate multiple assistants to a manager who has shared line mode,
BAT assigns IPMA associations only to those assistants that are also using shared
line mode.

Additional Information
See the “Related Topics” section on page 5-27.

Creating the CSV Data File for Manager-Assistant
Associations

When you use BAT to insert manager-assistant associations to the
Cisco CallManager database, you can add new associations or update existing
associations.

You have two options for creating a CSV data file for manager-assistant
associations:

e Using the BAT Spreadsheet to Add or Update Manager-Assistants
Associations, page 5-13

e Using a text editor to create a text file in CSV format by using the Managers
and Assistants File Formats, page A-21.

When you create an association for a new manager, you need to enter a device
name. When you update a manager with an existing IPMA record, consider these
fields optional. See the “Manager and Assistant Proxy Line Configurations”
section on page 5-4 for information about how BAT assigns line configurations on
manager and assistant phones. BAT does not allow you to assign the intercom line
of a manager to a proxy line for an assistant.

Using the BAT Spreadsheet to Add or Update
Manager-Assistants Associations

The BAT spreadsheet includes data file templates with macros to make it easy to
add, update, or delete manager-assistant associations. For information about
installing and using the BAT spreadsheet, see the “Using the BAT Spreadsheet for
Gathering Data” section on page 1-11.
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To use the BAT spreadsheet for adding new IPMA associations, use the following
procedure. You can use two ways to set up the manager-assistant configurations:

e To create manager-assistant associations with the default line configuration,
see the “Creating Default Manager-Assistant CSV Data Files” section on
page 5-14.

For the default line configurations for the manager and assistant phones, see
Table 5-3 and Table 5-4.

e If you want to assign proxy lines that do not follow the default line
configuration, see the “Creating Custom Manager-Assistant CSV Data Files”
section on page 5-16.

Creating Default Manager-Assistant CSV Data Files

To create the CSV data file for inserting or updating manager-assistant association
for both proxy and shared mode by using the default configuration, use the
following procedure.

Procedure

Step1  Locate and double-click the BAT.xIt file to open the BAT spreadsheet.
Step2  When prompted, click Enable Macros to use the spreadsheet capabilities.

Step3  Click the Default Managers-Assistants tab at the bottom of the spreadsheet to
display the manager-assistant association options.

Step4  Scroll to the right side of the template until you see the radio buttons and choose
the type of associations for this transaction:

¢ One manager, multiple assistants
¢ One assistant, multiple managers
Step5  Complete all mandatory fields and any relevant, optional fields.

If you choose the One manager, multiple assistants radio button, enter the
following information in each row:

e Manager ID—Enter the user ID, up to 30 characters, of the manager.

e Assistant ID#—Enter the user IDs, up to 30 characters, for the assistants to
whom the manager will be associated.

The # symbol represents the number of assistants assigned to a manager.
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Note To add more assistants, click Add more Assistants.

If you choose the One assistant, multiple managers radio button, enter the
following information in each row:

¢ Assistant ID—Enter the user ID, up to 30 characters, of the assistant.

e Manager ID#—Enter the user IDs, up to 30 characters, for the managers to
whom the assistant will be associated.

The # symbol represents the number of managers assigned to an assistant.

N

M To add more managers, click Add more Managers.

Choose the operation that you want to perform:
¢ To create new manager-assistant associations, click Insert.

e To delete a manager or an assistant from a manager-assistant association,
click Delete.

To transfer the data from the BAT spreadsheet into a CSV data file, click Export
to BAT Format.

The system saves the file to C:\XLSDataFiles or to your choice of another existing
folder. The filename is

<type of operation>ManagerAssistants#timestamp.txt

where <type of operation> specifies the type of operation that was chosen in
Step 6, and “timestamp” represents the precise date and time that the file was
created.

You must copy the CSV data file to the Cisco CallManager publisher database
server, so BAT can access the CSV data file. Using a floppy disk or a mapped
network drive, copy the CSV data file from C:\XLSDataFiles\ (or the folder that
you chose to store the file) to one of the following folders on the publisher
database server:

e Insert or Updates—C:\BATFiles\ManagersAssistants\Insert\
e Delete—C:\BATFiles\ManagersAssistants\Delete\
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For information on how to read the exported CSV file, in the BAT Insert
Managers/Assistants window, click the link to View Sample File.

Additional Information
See the “Related Topics” section on page 5-27.

Creating Custom Manager-Assistant CSV Data Files

Step 1
Step 2
Step 3

Step 4

When you have existing phones that you want to set up with manager-assistant
associations, you can use the Custom Managers-Assistants tab in the BAT
spreadsheet. To create the CSV data file for inserting or updating
manager-assistant associations for proxy lines on the assistant phones, use the
following procedures.

Procedure

Locate and double-click the BAT.xlt file to open the BAT spreadsheet.
When prompted, click Enable Macros to use the spreadsheet capabilities.

To display the manager-assistant association options, click the Custom
Managers-Assistants tab at the bottom of the spreadsheet.

Scroll to the right side of the template until you see Number of Proxy Lines box.
In that box, enter the number of proxy lines that you are assigning to an assistant.
The spreadsheet adds Proxy Line DN and Manager Line DN Columns based on
the number that you enter.

Complete all mandatory fields and any relevant, optional fields.
e Manager ID—Enter the user ID of the manager.
e Device Name—Enter the device name assigned to the manager’s phone.

e Intercom DN—Enter the directory number for the manager’s intercom line.
(Optional)

¢ Assistant ID—Enter the user IDs for the assistants to whom the manager will
be associated.

¢ Device Name—Enter the device name assigned to the assistant’s phone.
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e Intercom DN—Enter the directory number for the assistant’s intercom line.
(Optional)

¢ Proxy Line DN#—Enter the directory number for the assistant’s proxy line.

¢ Manager Line DN#—Enter the directory number for the manager’s primary
line.

The # symbol represents the number of proxy lines associated to a manager.

To transfer the data from the BAT spreadsheet into a CSV data file, click Export
to BAT Format button.

The system saves the file to C:\XLSDataFiles or to your choice of another existing
folder. The filename is

Custom Managers-Assistants#timestamp.txt.

You must copy the CSV data file to the Cisco CallManager publisher database
server, so BAT can access the CSV data file. Using a floppy disk or a mapped
network drive, copy the CSV data file from C:\XLSDataFiles\ (or the folder that
you chose to store the file) to the server that is running the publisher database in
the folder, C:\BATFiles\ManagersAssistants\Insert\.

For information on how to read the exported CSV file, in the BAT Insert
Managers/Assistants window, click the link to View Sample File.

Additional Information
See the “Related Topics” section on page 5-27.

Inserting Manager-Assistant Associations to
Cisco CallManager

To insert new manager-assistant associations or update existing associations, you
need a CSV data file. See the “Creating the CSV Data File for Manager-Assistant
Associations” section on page 5-13 for information.

When BAT updates manager assistant associations, it does not change existing
Cisco IPMA line configurations for the intercom directory number or associated
devices.
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A

Caution

Step 1

Step 2

Step 3

Step 4

Step 5
Step 6

Step 7

Step 8

The Manager-Assistant association fails when the assistant phone does not have
enough lines to support the minimum Cisco IPMA configuration.

To add or update new manager-assistant associations to Cisco CallManager
database, use the following procedure.

Procedure

Choose Configure > Managers/Assistants. The Manager/Assistant Options
window displays.

Choose Insert Managers/Assistants and click Next. The
Insert/ Managers/Assistants window displays.

In the File Name field, choose the CSV data file that you created for this bulk
transaction.

If the managers use extension mobility to log in, check the Configure managers
as mobile managers check box.

When all the phones have shared lines, check the Uses shared lines check box.
In Insert Options, choose the type of CSV data file that you created:

e Default—If you created a standard CSV data file, choose the type of
associations for this transaction based on the data in the CSV file.

— Associate one or more assistants to a manager
— Associate one or more managers to an assistant
e Custom—If you created a custom CSV data file for proxy mode.

Click Insert. A message displays that tells you how long it takes to insert the
records to the Cisco CallManager database. You can cancel the transaction if it
might cause performance degradation.

To insert the manager-assistant associations, click OK or to cancel the
transaction, click Cancel.

If you clicked OK, a Transaction Status window displays. To see the transaction
in progress, you can click the Show Latest Status button.
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Step9  When the transaction completes, you can click View Latest Log File to see a log
file that indicates the number of records that were added and the number of
records that failed, including an error code. For more information on log files, see
the “BAT Log Files” section on page 13-1.

N

Note  When BAT performs an update to an assistant or manager configuration
and the changes are only partially completed—because there were not
enough available lines—the whole transaction record fails.

Step10  For changes to take effect, you must restart Cisco IPMA service. Use the
following URL to log in to the Tomcat Manager web page using administrator
privileges: http://<IPMA server IP address>/manager/list.

Additional Information
See the “Related Topics” section on page 5-27.

Deleting Manager-Assistant Associations from
Cisco CallManager

You can use BAT to delete a specific manager-assistant association from the
Cisco CallManager database. For example, the assistant with the user ID,
Jjmorgan, is assigned to two managers with user IDs, rcraig and dbaker. If you
want to change the manager-assistant association so the assistant, jmorgan is only
assigned to rcraig, you can delete the jmorgan-dbaker association by creating a
CSV data file with the following entry:

Example

jmorgan, dbaker
If you want to delete a manager or an assistant from all manager-assistant
associations, see the following sections:

e Deleting Managers from Cisco CallManager, page 5-21

e Deleting Assistants from Cisco CallManager, page 5-24

Bulk Administration Tool User Guide
I oLawi g 519



Chapter5 Working with Cisco IP Manager Assistant |

M Deleting Manager-Assistant Associations from Cisco CallManager

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

To delete specific manager-assistant associations from Cisco CallManager, use
this procedure.

Before You Begin

You must have a CSV data file that contains the user IDs for the specific managers
and assistants associations that you want to delete. See the “Creating the CSV
Data File for Manager-Assistant Associations” section on page 5-13.

Procedure

Choose Configure > Managers/Assistants. The Manager/Assistant Options
window displays.

Choose Delete Managers/Assistants and click Next. The Delete
Managers/Assistants window displays.

In the File Name field, choose the CSV file that you created for this type of bulk
transaction.

Choose the type of deletion:
¢ Delete associated assistants for one manager
e Delete associated managers for one assistant

Click Delete. A message displays that tells how long it will take to delete the
records from the Cisco CallManager database. You can cancel the transaction if it
might cause performance degradation.

When the transaction completes, you can click View Latest Log File to see a log
file that indicates the number of records that are deleted and the number of records
that failed, including an error code. For more information on log files, see the
“BAT Log Files” section on page 13-1.

For changes to take effect, you must restart Cisco IPMA service. Use the
following URL to log in to the Tomcat Manager web page using administrator
privileges: http://<IPMA server IP address>/manager/list.

Additional Information
See the “Related Topics” section on page 5-27.
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Deleting Managers from Cisco CallManager

When you delete IPMA managers, Cisco CallManager maintains information on
the manager as a user in the directory. For example, if a manager with the user ID,
rmatinez, has two assistants with user IDs, dbell and jkent, you can disassociate
rmartinez from both assistants by deleting rmartinez as a manager in the Cisco
CallManager database. The directory still shows rmartinez as a user.

You can delete managers with all their manager-assistant associations from the
Cisco CallManager database and LDAP Directory. To access the Delete Managers
option, choose Configure > Managers/Assistants > Delete Managers.

You have two ways for locating existing records to delete:
e Using Query to Delete Manager Associations, page 5-21

e Using a Custom File to Delete Manager Associations, page 5-22.

Using Query to Delete Manager Associations

To delete managers from their associations with assistants from
Cisco CallManager directory, use this procedure.

Procedure

Step 1 In the Delete Managers window, choose Use Query and click Next. The Delete
Managers (Cisco IPMA) window displays.

Step2  To locate the Managers that you want to delete, define the filter.

A

Caution  If you do not define a filter, BAT deletes all managers.

Step3  In the first drop-down list box, choose a field to query such as User ID,
Department, First Name, or Last Name.

Step4  In the second drop-down list box, choose contains or is exactly.

Step 5 In the third box, which is the search field/list box, either choose or enter the value
that you want to locate, such as a specific manager.
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Note  To choose managers from more than one department, enter multiple
departments in this field. For example, to choose managers from
departments 12 and 24, enter 12, 24 in the third box instead of performing
two operations.

Step6  To add the defined filter to the query, click Add To Query button

If you make a mistake, click the Clear Query button to remove the query; then,
return to Step 3 and start over.

Step7  To display the records that are going to be affected, click View Query Result.
Step8  To delete the chosen managers, click Delete.

A message displays that tells how long it takes to delete the records in the
Cisco CallManager directory. You can cancel the transaction or click OK to
continue.

Step9  When the transaction completes, you can click View Latest Log File to see a log
file that indicates the number of records that are deleted and the number of records
that failed, including an error code. For more information on log files, see the
“BAT Log Files” section on page 13-1.

Step10  For changes to take effect, you must restart Cisco IPMA service. Use the
following URL to log in to the Tomcat Manager web page using administrator
privileges: http://<IPMA server IP address>/manager/list.

Additional Information
See the “Related Topics” section on page 5-27.

Using a Custom File to Delete Manager Associations

You can create a custom file by using a text editor to locate manager associations
that you want to delete.

Before You Begin

1. Create a text file that lists user IDs for managers that you want to delete

2. Put each user ID on a separate line.
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Step 4
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Deleting Managers from Cisco CallManager

3. Save the custom file with a <filename.txt> to this folder:
C:\BATfiles\ManagersAssistants\Query\Delete\

To delete managers associations by using a custom file, use the following
procedure.

Procedure

In the Delete Managers window, choose Use Custom File and click Next. The
Delete Managers (Cisco IPMA) window displays.

In Select managers where field, keep the identifier, User ID.

In the second field, in Custom File drop-down list box, choose the name of the
custom file that you created for this transaction.

To add the defined filter to the query, click Add To Query.

If you make a mistake, click Clear Query to remove the query; then, return to
Step 3 and start over.

Caution

Step 5
Step 6

Step 7

Step 8

If no information is entered into the query text box, the system deletes all manager
records.

To display the records that are going to be affected, click View Query Result.
Click Delete to delete the records.

A message displays that tells you how long it takes to delete the records to the
Cisco CallManager database. You can cancel the transaction if it might cause
performance degradation.

To delete the manager-assistant associations, click OK, or to cancel the
transaction, click Cancel.

If you clicked OK, a Transaction Status window displays. To see the transaction
in progress, you can click Show Latest Status.

For changes to take effect, you must restart Cisco IPMA service. Use the
following URL to log in to the Tomcat Manager web page using administrator
privileges: http://<IPMA server IP address>/manager/list.
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Additional Information
See the “Related Topics™ section on page 5-27.

Deleting Assistants from Cisco CallManager

When you delete IPMA assistants, Cisco CallManager maintains information on
the assistant as a user in the directory. For example, Assistant thudson is assigned
to two managers, hart and dstewart. You can disassociate thudson from both
managers by deleting thudson as an assistant in the Cisco CallManager database.
The directory still shows thudson as a user.

You can delete assistants with all their manager-assistant associations from the
Cisco CallManager database and LDAP Directory. To access the Delete
Assistants option, choose Configure > Managers/Assistants > Delete
Assistants.

You have two ways for locating existing records to delete:
e Using Query to Delete Assistants Associations, page 5-24

e Using a Custom File to Delete Assistant Associations, page 5-25.

Using Query to Delete Assistants Associations

To delete assistants from their associations with managers, use this procedure .

Procedure

Step 1 In the Delete Assistants window, choose Use Query and click Next. The Delete
Assistants (Cisco IPMA) window displays.

Step 2 To locate the Assistants that you want to delete, define the filter.

A

Caution If you do not define a filter, BAT deletes all assistants.

Step3  In the first drop-down list box, choose a field to query such as User ID,
Department, First Name, or Last Name.

Step4  In the second drop-down list box, choose contains or is exactly.
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Step 7

Step 8

Step 9

Step 10
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In the third box, which is the search field/list box, either choose or enter the value
that you want to locate, such as a specific assistant.

S

Note  To choose assistants from more than one department, enter multiple
departments in this field. For example, to choose assistants from
departments 12 and 34, enter 12, 34 in the third box instead of performing
two operations.

To add the defined filter to the query, click Add To Query.

If you make a mistake, click Clear Query to remove the query; then, return to
Step 3 and start over.

To display the records that are going to be affected, click View Query Result.
Specify the setting that you want to update for all the records that you defined in
your query.

To delete the chosen assistants, click Delete.

A message displays that tells how long it will take to delete the records in the

Cisco CallManager database. You can cancel the transaction or click OK to
continue.

When the transaction completes, you can click View Latest Log File to see a log
file that indicates the number of records that are added and the number of records
that failed, including an error code. For more information on log files, see the
“BAT Log Files” section on page 13-1.

For changes to take effect, you must restart Cisco IPMA service. Use the
following URL to log in to the Tomcat Manager web page using administrator
privileges: http://<IPMA server IP address>/manager/list.

Additional Information
See the “Related Topics” section on page 5-27.

Using a Custom File to Delete Assistant Associations

You can create a custom file by using a text editor to locate assistant associations
that you want to delete.
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Step 1
Step 2
Step 3

Step 4

A

Before You Begin

1. Create a text file that lists user ID for assistants that you want to delete,
putting each on a separate line.

2. Save the custom file with a <filename.txt> to this folder:
C:\BATfiles\ManagersAssistants\Query\Delete\

To delete assistants associations by using a custom file, use the following
procedure.

Procedure

From the Delete Assistants window, choose Use Custom File and click Next. The
Delete Assistants (Cisco IPMA) window displays.

In Select Assistants where drop-down list box, choose the field that you used in
the custom file, user ID.

In the in Custom File drop-down list box, choose the name of the custom file that
you created for this transaction.

To add the defined filter to the query, click Add To Query.

If you make a mistake, click Clear Query to remove the query; then, return to
Step 3 and start over.

Caution

Step 5
Step 6

Step 7

If no information is entered into the query text box, the system deletes all manager
records.

To display the records that are going to be affected, click View Query Result.
To delete the records, click Delete.

A message displays that tells you how long it takes to delete the records from the
Cisco CallManager directory. You can cancel the transaction or click OK to
continue.

To display the log file that BAT generated, you can click the View Latest Log File
link. The log file displays the number of records that were deleted and the number
of records that failed, including an error code. For more information on log files,
see the “BAT Log Files” section on page 13-1.
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Step8  For changes to take effect, you must restart Cisco IPMA service . Use the
following URL to log in to the Tomcat Manager web page using administrator
privileges: http://<IPMA server IP address>/manager/list.

Additional Information
See the “Related Topics” section on page 5-27.

Related Topics

e Inserting Manager-Assistant Associations to Cisco CallManager, page 5-17

e Deleting Manager-Assistant Associations from Cisco CallManager,
page 5-19

e Deleting Managers from Cisco CallManager, page 5-21

e Deleting Assistants from Cisco CallManager, page 5-24

e Generating Reports for IPMA Managers and Assistants, page 11-13
For more information related to Cisco IPMA, refer to this documentation.

e C(Cisco CallManager Features and Services Guide

e C(Cisco IP Manager Assistant User Guide
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Working with User Device Profiles

The User Device Profiles (UDP) option in BAT allows you to add or delete large
numbers of user device profiles. In addition, you can add or update lines for user
device profiles. The system uses UDPs in conjunction with the extension mobility
feature.

The following topics explain the options for managing user device profiles in
more detail:

Adding User Device Profiles, page 6-1

Generating User Device Profiles for User Devices, page 6-29
Deleting User Device Profiles, page 6-31

Exporting User Device Profile Records, page 10-17
Updating Lines to User Device Profiles, page 6-30

Adding Lines to Existing Phones and UDPs, page 3-78
Generating Reports for User Device Profiles, page 11-8

Adding User Device Profiles

When you use BAT to add user device profiles to the Cisco CallManager database,
you can add multiple lines and other features.

Choose from two options for creating a CSV data file for user device profiles:

Use the BAT spreadsheet (BAT.xIt) and export the data to the CSV format.

Use a text editor to create a text file in CSV format (for experienced users).
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To add user device profiles to the Cisco CallManager database in bulk, use this
procedure.

Procedure

Step 1 Choose Configure > User Device Profiles. The User Device Profiles Options
window displays.

Step2  Choose Insert User Device Profiles and click Next. The Steps to Insert User
Device Profile window displays.

Step3  Choose Add, view, or modify UDP templates and click Next.

The UDP Template Configuration window displays. See the “Creating a BAT
Template for User Device Profiles” section on page 6-3 for information about
configuring UDP templates.

Step4  Create the CSV data file by following the steps for one of these options.
BAT Spreadsheet option

Open the BAT spreadsheet and create the CSV data file. See the “Using the
BAT Spreadsheet to Create User Device Profile CSV Data Files” section on
page 6-7.

Text Editor option
a. Choose Add, view, or modify file formats and click Next.

The File Format Configuration window displays. See the “Using a Text Editor
to Create the User Device Profile CSV File” section on page 6-21 for
information about configuring file formats for CSV data file.

b. Use a text editor and create the CSV data file for user device profiles that
follows the file format that you want to use. For more information about
creating a text-based CSV file, see Appendix A, “Creating a Text-Based CSV
File for User Device Profile.”

c. Choose Associate file format with the CSV data file and click Next.

The Add File to Format window displays. See the “Associating the File
Format with the CSV Data File” section on page 6-25 for information about
file formats.
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Step 6
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Choose Validate User Device Profile records and click Next.

The Validate User Device Profiles window displays. See the “Validating User
Device Profiles” section on page 6-26 for information about validating user
device profile records.

Choose Insert User Device Profiles and click Next.

The Insert User Device Profiles window displays. See the “Inserting User Device
Profiles” section on page 6-27 for information about inserting user device profile
records into the Cisco CallManager database.

Additional Information

See the“Related Topics” section on page 6-32.

Creating a BAT Template for User Device Profiles

Step 1

Step 2

Step 3

Use this procedure to create a template to add user device profiles in bulk.

Procedure

Choose Add, view, or modify UDP templates and click Next. The User Device
Profile Template Configuration window displays.

In the User Device Profile Name field, enter a unique name, which can contain
up to 50 characters.

From the Device Type drop-down list box, choose the model of user device
profile. The window refreshes with additional fields for the user device profile
model. Depending on the model of device, some of the following fields do not
display.

e User Hold Audio Source—Choose the audio source that is played when the
user puts a call on hold.

¢ User Locale—Choose the country and language set for with this profile.

¢ Phone Button Template—Choose a phone button template for this profile.
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Note

You can view a list of phone buttons for a template at any time by
choosing the View button list link next to the phone button template field.
A separate dialog box pops up and displays the phone buttons for that
particular phone template.

Softkey Template—Choose the appropriate softkey template for this profile.

MLPP Indication—To specify whether the device can play precedence tones
when placing an MLPP precedence call, choose one of the following:

— Default—To inherit the MLPP indication from the device pool.
— Off—Does not send MLPP indication tones.
— On—Sends indication of an MLPP precedence call.

MLPP Preemption—To specify whether the device can preempt calls in
progress when placing an MLPP precedence call, choose one of the
following:

— Default—To inherit the MLPP preemption setting from the device pool.

— Disabled—Does not preempt calls when it places an MLPP precedence
call.

— Forceful—preempts calls in progress when it places an MLPP
precedence call.

N

Note Do not configure a device with MLPP Indication set to Off while
MLPP Preemption is set to Forceful.

MLPP Domain—Enter a hexadecimal value for the MLPP domain
associated with this device. Must be blank or a value between 0 and FFFFFF.

Expansion Module Information—Choose the type of expansion module if
installed in the phone or choose <None> for Module 1 and Module 2.

Login User ID—Enter the login user ID for a default profile. After the user
logs out from using the user device profile, the user device profile will
automatically log in to this login user ID and use the default profile.
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Step 5

Step 6

Step 7

Step 8

Step 9
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e

Tip You can obtain help in finding a valid login user ID by choosing the Select
Login User ID link below the Login User ID field. A separate dialog box
pops up. In the Login User ID field, enter the first few characters of the
login user ID that you want to use, and all login user IDs that match the
pattern that you entered will display in the Selected login user ID field.
Choose the desired ID and click OK.

Check the Ignore Presentation Indicators (Internal Calls Only) check box, as
needed.

Click Insert. The template displays in the User Device Profile Templates list in
the left pane.

A popup box displays that asks you to scroll down to insert lines. Click OK and
scroll down.

Depending on the phone button template that you chose, links display to add lines.
Click Add Line 1 or Add Line 2, as appropriate. The Line Details window
displays.

Enter or choose the appropriate values for the line settings that are described in
“Field Descriptions for Adding a Line to a BAT Template” section on page 3-25.

Click Insert.

For some Cisco IP Phone models, you can add Cisco IP Phone services and Speed
Dials to the template. See these topics for the procedures:

e Adding or Updating IP Services in a BAT Template, page 3-5
¢ Adding or Updating Speed Dials in a BAT Template, page 3-6

Modifying a Template

You can modify the properties of a template when you want to change only a few
fields for the same device.

To modify and update details in an existing BAT template, use the following
procedure.
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Procedure

Step1  In Template Configuration window, choose the template that you want to change
from the Templates column. The chosen template details display in the Template
Configuration window.

Step2  Verify that this is the template that you want to modify.

Step3  Modify the details in the template fields as needed.

Step4  Click Update to save the changes to the existing template.
Additional Information
See the“Related Topics” section on page 6-32.

Copying a Template

N

Note

Step 1

Step 2

Step 3

Step 4

You can copy the properties of a template into a new template when you want to
change only a few fields.

The new template that you create must be the same device type as the original
template, such as Cisco IP User Device Profile model 7960.

Use the following procedure to copy an existing BAT template.

Procedure

In Template Configuration window, choose the template that you want to copy
from the Templates column. The chosen template details display in the Template
Configuration window.

Verify that this is the template that you want to copy and click Copy. The template
reproduces and creates a copy. The copy duplicates all the values that were
specified in the original template.

In the Template Name field, enter a new template name, up to 50 alphanumeric
characters.

Update the fields as needed for the new template.
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Click Insert. The template that is added to BAT displays in the Templates column
on the left.

Additional Information
See the“Related Topics” section on page 6-32.

Deleting Templates

Step 1

Step 2

Step 3

Step 4

You can delete BAT templates when you no longer require them. Use this
procedure to delete a template.

Procedure

In the Template Configuration window, locate the name of the template that you
want to delete in the list of templates in the left pane.

Click the template that you want to delete. The chosen template details display in
the Template Configuration window.

Verify that this is the template that you want to delete and click Delete. A message
displays that asks you to confirm the delete operation.

Click OK to delete the template. The template name disappears from the list of
templates in the left pane.

Additional Information
See the“Related Topics” section on page 6-32.

Using the BAT Spreadsheet to Create User Device Profile CSV
Data Files

When you are adding new user device profiles, you can use the BAT spreadsheet.
You can define the file format within the spreadsheet, and the spreadsheet uses the
data file formats to display the fields for the CSV data file.
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Step 1
Step 2
Step 3

Step 4

Step 5

Step 6

Step 7

Step 8

For information about locating and using the BAT spreadsheet, see the “Using the
BAT Spreadsheet for Gathering Data” section on page 1-11.

To create the CSV data file by using the BAT spreadsheet for adding new user
device profiles, use the following procedure.

Procedure

Locate and double-click the BAT.xlt file to open the BAT spreadsheet.
When prompted, click Enable Macros to use the spreadsheet capabilities.

To display the User Device Profiles options, click the User Device Profile tab at
the bottom of the spreadsheet.

To choose the device and line fields that you can define for each user device
profile, click Create File Format. The Field Selection popup window displays.

To choose the device fields, click a device field name in the Device Field box, and
then click the arrow to move the field to the Selected Device Fields box.

A CSV data file must include Number of Lines as the first field, Device Profile
Name, and Description; therefore, these fields always remain selected.

e

ﬁ You can select a range of items in the list by holding down the Shift key.
To select random field names, hold down the Ctrl key and click field
names.

Click a line field name in the Line Field box and click the arrow to move the field
to the Selected Line Fields box.

e

Tip You can change the order of the items in the Selected Line and Device
boxes. Choose an item and use the up arrow to move the field closer to the
beginning of the list or chose the down arrow to move the item to the end
of the list.

To modify the CSV data file format, click Create. A message asks whether you
want to overwrite the existing CSV format.

Click OK. New columns for the selected fields display in the BAT spreadsheet in
the order that you specified.
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Step 10

Step 11

Step 12

Note
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To locate the Number of Phone Lines box, scroll to the right. The number of lines
that you specify here must not exceed the number of lines that are configured in
the BAT template or an error will result when you insert the CSV data file land
UDP template.

You must enter the number of speed-dial buttons in the Number of Speed Dials
box. After you enter the number, columns display for each speed-dial number.

~

Note Do not exceed the number of speed dials that are configured in the User
Device Profile template, or an error will result when you insert the CSV
data file and UDP template.

Enter data for an individual user device profile on each line in the spreadsheet.
Complete all mandatory fields and any relevant optional fields. Each column
heading specifies the length of the field and whether it is required or optional. See
Table 6-1 for descriptions of the fields in the BAT spreadsheet.

To transfer the data from the BAT Excel spreadsheet into a CSV formatted data
file, click Export to BAT Format.

The system saves the file to C:\XLSDataFiles\ or to your choice of another
existing folder on your local workstation. The filename is

<tabname>#<timestamp>.txt

where <tabname> represents the type of input file that you created, such as
phones, and <timestamp> represents the precise date and time that the file was
created.

You must copy the CSV data file to the Cisco CallManager publisher database
server so BAT can access the CSV data file. Using a floppy disk or a mapped
network drive, copy the CSV data file from C:\XLSDataFiles\ (or the folder in
which you chose to store the file) to the following folder in the publisher database
server:

C:\BATFiles\User Device Profiles\

For information on how to read the exported CSV data file, click the link to View
Sample File in the Insert User Device Profiles window in BAT.
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Additional Information
See the“Related Topics” section on page 6-32.

Field Descriptions for User Device Profile Fields in the BAT Spreadsheet

Table 6-1 describes all the user device profile fields in the BAT spreadsheet.

Table 6-1 Field Descriptions for User Device Profile in the BAT Spreadsheet

Field Description

Device Fields (Mandatory Fields)

Number of Lines Enter the number of lines for this phone. The number
can be fewer than the number of lines in the BAT
template, but it cannot exceed the specified number

of lines.
Device Profile Name Enter a unique identifier for the device profile name.
Description Enter a description such as “Conference Room A” or

“John Smith” to help identify the phone or device.

Device Fields (Optional Fields)

User Locale Enter the country and language set that you want to
associate with this group of IP phones.

This choice determines which cultural-dependent
attributes exist for this user and which language
displays for the user in the Cisco CallManager user
windows and phones.

Softkey Template Enter the softkey template to be used for all phones
in this group.

User ID Enter the user ID for the phone user.

Login User ID Enter the login user ID for a default profile.

If the user device profile is used as a logout profile,
specify the login user ID that will be associated with
the phone. After the user logs out from this user
device profile, the phone will automatically log in to
this login user ID.
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Table 6-1 Field Descriptions for User Device Profile in the BAT Spreadsheet

Field

Description

User Hold Audio Source

Enter the user hold audio source that this group of IP
phones or CTI ports should use.

The user hold audio source identifies the audio
source from which music is played when a user
places a call on hold.

Ignore Presentation
Indicators (Internal Calls
Only)

Check this check box to ignore presentation
indicators in an internal call.

Line Fields (Optional Fields)

Directory Number

Enter the directory number for the phone.

Partition

Choose a route partition to which the directory
number belongs.

Note The directory number can appear in more
than one partition.

Voice Mail Profile

Choose this parameter to make the pilot number the
same as the directory number for this line. This
action proves useful if you do not have a
voice-messaging server configured for this phone.

Line Calling Search

Choose partitions that are searched for numbers that

Space are called from this directory number.
Note  Changes cause an update of the call pickup
names that are listed in the Call Pickup
Group field. The setting applies to all
devices that are using this directory number.
AAR Group Choose the automated alternate routing (AAR)

group for this device. The AAR group provides the
prefix digits that are used to route calls that are
otherwise blocked due to insufficient bandwidth.

Set AAR Group to <None> to prevent rerouting
blocked calls.
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Table 6-1

Field Descriptions for User Device Profile in the BAT Spreadsheet

Field

Description

Line User Hold Audio
Source

Choose the music on hold audio source to be played
when the user presses Hold and places a call on hold.

Line Network Hold
Audio Source

Choose the music on hold audio source to be played
when the system places a call on hold while the user
transfers a call or initiates a conference or call park.

Auto Answer

Choose one of the following options to activate the
Auto Answer feature for this directory number:

e Auto Answer Off <Default>
¢ Auto Answer with Headset
e Auto Answer with Speakerphone (Intercom)

Note Make sure that the headset or speakerphone

is not disabled when you choose Auto
Answer with Headset or Auto Answer with
Speakerphone.

Forward All

Enter the directory number to which all calls should
be forwarded. To use the BAT phone template entry,
leave this field blank.

Forward Busy Internal

Enter the directory number to which internal calls
should be forwarded when the phone is busy. To use
the BAT phone template entry, leave this field blank.

Forward Busy External

Enter the directory number to which external calls
should be forwarded when the phone is busy. To use
the BAT phone template entry, leave this field blank.

Forward No Answer
Internal

Enter the directory number to which internal calls
should be forwarded when the phone is not
answered. To use the BAT phone template entry,
leave this field blank.

Forward No Answer
External

Enter the directory number to which external calls
should be forwarded when the phone is not
answered. To use the BAT phone template entry,
leave this field blank.
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Field Descriptions for User Device Profile in the BAT Spreadsheet

Field

Description

Forward No Coverage
Internal

Enter the directory number to which internal calls
should be forwarded when the phone does not have
coverage. To use the BAT phone template entry,
leave this field blank.

Forward No Coverage
External

Enter the directory number to which external calls
should be forwarded when the phone does not have
coverage. To use the BAT phone template entry,
leave this field blank.

Forward Unregistered
Internal Voice Mail

The settings in this row specify the forwarding
treatment for internal calls that are routed to a
directory number with no registered devices.

Check the Voice Mail check box to use settings in the
Voice Mail Profile Configuration window.

Note  When this check box is checked,
Cisco CallManager ignores the settings in
the Coverage/Destination box and Calling
Search Space. When this check box is
checked for internal calls, the system
automatically checks the Voice Mail check
box for external calls. If you do not want
external calls to forward to the
voice-messaging system, you must uncheck
the Voice Mail check box for external calls.

Forward Unregistered
Internal
Coverage/Destination

Enter any dialable phone number, including an
outside destination.

Note  When you enter a coverage/destination value
for internal calls, the system automatically
copies this value to the
Coverage/Destination field for external calls.
If you want external calls to forward to a
different destination, you must enter a
different value in the Coverage/Destination
field for external calls.
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Table 6-1

Field Descriptions for User Device Profile in the BAT Spreadsheet

Field

Description

Forward Unregistered
Calling Search Space

Choose calling search space from the drop-down list
menu. This setting applies to all devices that are
using the directory number chosen above.

Note

When you choose a Calling Search Space for
internal calls, the system automatically
copies this setting to the Calling Search
Space setting for external calls. If you want
external calls to forward to a different calling
search space, choose a different setting in the
Calling Search Space for external calls.

Forward Unregistered
External Voice Mail

The settings in this row specify the forwarding
treatment for external calls that are routed to a
directory number with no registered devices. Specify
the following values:

Check the Voice Mail check box to use settings in the
Voice Mail Profile Configuration window.

Note

When this check box is checked,

Cisco CallManager ignores the settings in
the Coverage/Destination box and Calling
Search Space. When this check box is
checked for internal calls, the system
automatically checks the Voice Mail check
box for external calls. If you do not want
external calls to forward to the
voice-messaging system, you must uncheck
the Voice Mail check box for external calls.
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Table 6-1 Field Descriptions for User Device Profile in the BAT Spreadsheet

Field Description

Forward Unregistered Enter any dialable phone number, including an
External outside destination.

Coverage/Destination

Note  When you enter a coverage/destination value
for internal calls, the system automatically
copies this value to the
Coverage/Destination field for external calls.
If you want external calls to forward to a
different destination, you must enter a
different value in the Coverage/Destination
field for external calls.

Forward Unregistered
External Calling Search
Space

Choose calling search space from the drop-down list
box. This setting applies to all devices that are using
the directory number chosen above.

Note  When you choose a Calling Search Space for
internal calls, the system automatically
copies this setting to the Calling Search
Space setting for external calls. If you want
external calls to forward to a different calling
search space, choose a different setting in the
Calling Search Space for external calls.

No Answer Ring
Duration (CFNA)

Enter the number of seconds to allow the call to ring
before forwarding the call to the Forward No Answer
Destination.

Call Pickup Group

Enter the Pickup Group Name to specify the call
pickup group, which can answer incoming calls to
this line by dialling the appropriate pickup group
number.

Note To use the BAT phone template entry, leave
this field blank.
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Table 6-1 Field Descriptions for User Device Profile in the BAT Spreadsheet

Field Description
Target Destination Enter the number to which MLPP precedence calls
(MLPP) should be directed if this directory number receives

a precedence call and neither this number nor its call
forward destination answers the precedence call.

Values can include numeric characters, pound (#)
,and asterisk (*).

Calling Search Space
(MLPP)

From the drop-down list box, choose the calling
search space to associate with the alternate party
target (destination) number.

No Answer Ring
Duration (MLPP)

Enter the number of seconds (between 4 and 30)
after which an MLPP precedence call will be
directed to this directory number’s alternate party if
this directory number and its call forwarding
destination have not answered the precedence call.

Leave this setting blank to use the value that is set in
the Cisco CallManager enterprise parameter,
Precedence Alternate Party Timeout.

Line Text Label

Enter text that identifies this directory number for a
line/phone combination.

Note  The default text specifies English

External Phone Number
Mask

Enter the phone number (or mask) that is sent for
Caller ID information when a call is placed from this
line.

You can enter a maximum of 30 numbers and “X”
characters. The Xs represent the directory number
and must appear at the end of the pattern. For
example, if you specify a mask of 972813XXXX, an
external call from extension 1234 displays a caller
ID number of 9728131234.
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Table 6-1 Field Descriptions for User Device Profile in the BAT Spreadsheet

Field

Description

Maximum Number of
Calls

You can configure up to 200 calls for a line on a
device in a cluster, with the limiting factor being the
device. As you configure the number of calls for one
line, the calls available for another line decrease.

The default specifies 4. If the phone does not allow
multiple calls for each line, the default specifies 2.

For CTI route points, you can configure up to 10,000
calls for each port. The default specifies 5000 calls.
Use this field in conjunction with the Busy Trigger
field.

Busy Trigger

This setting, which works in conjunction with
Maximum Number of Calls and Call Forward Busy,
determines the maximum number of calls to be
presented at the line. If maximum number of calls is
set for 50 and the busy trigger is set to 40, then
incoming call 41 gets rejected with a busy cause (and
will get forwarded if Call Forward Busy is set). If
this line is shared, all the lines must be busy before
incoming calls get rejected.

Use this field in conjunction with Maximum Number
of Calls for CTI route points. The default specifies
4500 calls.

[ oL-8661-01

Bulk Administration Tool User Guide ]



Chapter 6  Working with User Device Profiles |

W Adding User Device Profiles

Table 6-1 Field Descriptions for User Device Profile in the BAT Spreadsheet

Field Description
Message Waiting Lamp | Use this field to configure the handset lamp
Policy illumination policy. Choose one of the following

options:

e Use System Policy (The directory number refers
to the service parameter “Message Waiting
Lamp Policy” setting.)

e Light and Prompt
e Prompt Only

e Light Only

e None

Setting applies only to the current device unless you
check the check box at right (called Update Shared
Device Settings) and click the Propagate selected
button. (The check box at right displays only if other
devices share this directory number.)

Ring Setting (Phone Idle)

Choose the ring setting for the line appearance when
an incoming call is received and no other active calls
exist on that device. Choose one of the following
options:

e Use system default
e Disable

e Flash only

e Ring once

e Ring
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Table 6-1 Field Descriptions for User Device Profile in the BAT Spreadsheet

Field

Description

Ring Setting (Phone
Active)

Choose the ring setting that is used when this phone
has another active call on a different line. Choose
one of the following options:

e Use system default
e Disable

e Flash only

e Ring once

e Ring

e Beep only

Caller Name

Check this check box to include the caller’s name in
the display when a forwarded call is received.
Default leaves this check box checked.

Caller Number

Check this check box to include the caller’s number
in the display when receiving a forwarded call.

Redirected Number

Check this check box to include the redirected
number in the display when receiving a forwarded
call.

Dialed Number Check this check box to include the dialed number in
the display when a forwarded call is received. The
default setting leaves this check box checked.

Call Pickup Group Audio |From the drop-down list box, choose the type of

Alert Setting (Phone
Idle)

audio notification for call pickup that is provided
when the phone is idle. Select one of the following
options:

e Use System Default
e Disable
e Ring Once
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Table 6-1 Field Descriptions for User Device Profile in the BAT Spreadsheet

Field Description

Call Pickup Group Audio |From the drop-down list box, choose the type of
Alert Setting (Phone audio notification for call pickup that is provided
Active) when the phone is in use. Select one of the following

options:
e Use System Default
e Disable
e Beep Only

AAR Settings

AAR Voice Mail

The settings in this row of fields specify treatment of
calls for which there is insufficient bandwidth to
reach the destination. These calls are handled by
automated alternate routing (AAR) and are routed to
the AAR Destination Mask or Voice Mail.

Check this check box to use settings in the Voice
Mail Profile Configuration window.

Note  When this check box is checked,
Cisco CallManager ignores the settings in
the Coverage/Destination box and Calling
Search Space.

AAR Destination Mask

Use this setting instead of the external phone number
mask to determine the AAR Destination to be dialed.

AAR Group

Choose the automated alternate routing (AAR)
group for this device. The AAR group provides the
prefix digits that are used to route calls that are
otherwise blocked due to insufficient bandwidth.

Set AAR Group to <None> to prevent rerouting
blocked calls.

Additional Information

See the“Related Topics” section on page 6-32.
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Additional Information
See the“Related Topics” section on page 6-32.

Using a Text Editor to Create the User Device Profile CSV File

When you use a text editor to create your CSV data file, you must use a file format
to identify the device and line fields within the CSV data file.You have these
options for the file format:

e Default User Device Profile—Contains a predetermined set of user device
profile device and line fields.

¢ Simple User Device Profile—Contains basic device and line fields for user
device profiles.

e Customized—Contains device and line fields that you choose and order
yourself.

Before creating the CSV file in the text editor, you need to choose an existing file
format or create a new file format. You can then enter the values as specified in
the file format in the text-based CSV data file.

The following topics provide information about configuring file formats for CSV
data files that are created by using a text editor.

e C(Creating a File Format, page 6-21
e Copying a File Format, page 6-23
¢ Modifying a File Format, page 6-24
e Deleting a File Format, page 6-24

Creating a File Format

Step 1

To create your file format for the text-based CSV data file, use the following
procedure.

Procedure

From the Create CSV data file window, choose Add, view, or modify file formats
and click Next. The File Format Configuration window displays.
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Step2  Click Add a new File Format. The File Format Information fields display.
Step 3 In the File Format Name field, enter a name for this customized format.

Step 4 Under Device Fields, choose the device field names that you want to define for
each user device profile. Click a device field name in the Device Field box and
click the arrow to move the field to the Selected Device Fields box.

A CSV data file must include Number of Lines, Device Profile Name, and
Description; therefore, these fields always remain selected.

e

ﬂ You can select several random field names in the list by holding down the
Ctrl key, then clicking the arrow to select them together. You can select a
range of items by using the Shift key.

Step5  Click line field names in the Line Field box and click the arrow to move the fields
to the Selected Line Fields box.

L

Tip You can change the order of the items in the Selected Line Fields and
Selected Device Fields boxes. Select an item and then use the up arrow to
move the field closer to the beginning of the list or use the down arrow to
move it to the end of the list.

Step6  If you want to include the fields for the speed dial details, check the Include
Speed Dials in the CSV Format check box.

Step7  To save your customized file format, click Insert. The name of the file format
displays in the File Format Names list on the left.

Additional Information
See the“Related Topics” section on page 6-32.
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Copying a File Format

Step 1

Step 2

Step 3
Step 4
Step 5

Step 6

To copy an existing format for the CSV data file, use the following procedure.

Procedure

From the Create CSV data file window, choose Add, view, or modify file formats
and click Next. The File Format Configuration window displays.

In the File Format Name list, choose a file format that you want to copy. The file
format details display in the fields.

To make a copy of the chosen file format, click Copy.
In the File Format Name field, enter a new name for the copied format.
Modify the copied format by using one of these methods:

* Add new fields by choosing them from the Device Fields or Line Fields box,
and then clicking the arrow to move the chosen fields into the Selected Device
Field or Selected Line Fields box.

e Remove chosen fields by choosing them from the Selected Device Fields or
Selected Line Fields box, and then clicking the arrow to move the chosen
fields into the Device Field or Line Fields box.

¢ Change the order of the fields by choosing a field name in the Selected Device
Field or Selected Line Fields box and using the up or down arrow to change
its location.

After making your changes, click Insert to save the copied file format with
changes in the list.

Additional Information
See the“Related Topics” section on page 6-32.
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Modifying a File Format

To modify an existing format for the CSV data file, use the following procedure.

Procedure

Step 1 From the Create CSV data file window, choose Add, view, or modify file formats
and click Next. The File Format Configuration window displays.

Step2  In the File Format Name list, choose a file format that you want to modify. The
file format details display in the fields.

Step3  Modify the copied format by using one of these methods:

e Add new fields by choosing them from the Device Fields or Line Fields box,
and then clicking the arrow to move the chosen fields into the Selected Device
Field or Selected Line Fields box.

¢ Remove the chosen fields by choosing them from the Selected Device Fields
or Selected Line Fields box, and then clicking the arrow to move the chosen
fields into the Device Field or Line Fields box.

e Change the order of the fields by choosing a field name in the Selected Device
Field or Selected Line Fields box and using the up or down arrow to change
its location.

Step4  After making your changes, click Update to save the changes to the file format.

Additional Information

See the“Related Topics” section on page 6-32.

Deleting a File Format

To delete an existing file format for the CSV data file, use the following
procedure.

Procedure

Step 1 From the Create CSV data file window, choose Add, view, or modify file formats
and click Next. The File Format Configuration window displays.
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Step 2

Step 3

Adding User Device Profiles W

In the File Format Name list, choose a file format that you want to delete. The file
format details display in the fields. Verify that you want to delete this file.

To remove the file format from the File Format Name list, click Delete. A message
asks you to confirm that you want to delete the file format. Click OK to continue.
The file format name is removed from the list.

Additional Information
See the“Related Topics” section on page 6-32.

Associating the File Format with the CSV Data File

Step 1

Step 2

Step 3

Step 4
Step 5

After you have entered all the values into the text-based CSV data file in the order
that the file format specified, you need to copy the text-based CSV data file to the
folder for user device profiles on the Cisco CallManager publisher at this
location: C:\BATFiles\User Device Profiles\. You must then associate the file
format with the text-based CSV data file.

To associate the file format with the text-based CSV data file, use the following
procedure.

Procedure

From the Create CSV data file window, choose Associate file format with the
CSYV data file and click Next. The Add File Format window displays.

In the File Name field, choose the CSV data file that you created for this bulk
transaction.

In the File Format Name field, choose the file format that you created for this type
of bulk transaction.

To associate the matching file format with the CSV data file, click Add.

To view the CSV data file with the file format as the first record, click the View
File link. Check that the entered values correspond to the field names in your CSV
data file.
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Step 6

To return to the Steps to Insert User Device Profiles window, click Back two
times.

Additional Information
See the“Related Topics” section on page 6-32.

Validating User Device Profiles

Step 1

Step 2

When you choose Validate User Device Profiles, the system runs a validation
routine to check that the CSV data file has all required fields, such as device
profile name and directory number, populated and checks for discrepancies with
the publisher database.

Before You Begin
e You must have a user device profile template for the devices that you are
adding. You can use a user device profile template with multiple lines to add
user device profiles that have a single line. See the “Creating a BAT Template
for User Device Profiles” section on page 6-3.

e You must have a CSV data file that contains the unique details for the user
device profiles. See these options:

— “Using the BAT Spreadsheet to Create User Device Profile CSV Data
Files” section on page 6-7.
“Using a Text Editor to Create the User Device Profile CSV File” section
on page 6-21.

To validate your CSV data file user device profile records, use the following
procedure.

Procedure

From the Steps to Insert User Device Profiles window, choose Validate user
device profiles records and click Next. The Validate User Device Profiles
window displays.

In the File Name field, choose the CSV data file that you created for this specific
bulk transaction.
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Step 3

Step 4

Step 5

Step 6

Step 7

Adding User Device Profiles W

Choose the Insert option that corresponds to your CSV data file:

¢ Specific Details—If you are validating User Device Profile records that use
a file format.

e All Details—If you are validating user device profile records from an export
file that was generated by using the All Details option. Skip to Step 5.

In the User Device Profile Template Name field, choose the BAT User Device
Profile template that you created for this type of bulk transaction.

For the All Details option, you must choose the Model of IP telephony device.
BAT displays only the models that are currently in the Cisco CallManager
database.

To verify the selected CSV data file with the publisher database, click Validate.
The validation routine records errors in a log file.

When validation completes, Click View Latest Log File to see a log file that lists
the records with discrepancies and the error code. For more information on log
files, see the “BAT Log Files” section on page 13-1.

Additional Information

See the“Related Topics” section on page 6-32.

Inserting User Device Profiles

Use the following procedure to insert new user device profile records in bulk.
These User Device Profiles are not associated with a user. You must update users
to associate these new profiles with the user. See the “Updating Users in

Cisco CallManager” section on page 4-13 for this procedure.

Before You Begin

e You must have a BAT User Device Profile template for the devices.

e You must have a CSV data file that contains the unique details for the User
Device Profiles.

e Before you insert the user device profiles, validate the records.
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Procedure

Step 1 From the Steps to Insert User Device Profiles window, choose Insert User Device
Profiles and click Next. The Insert User Device Profiles window displays.

Step2  In the File Name field, choose the CSV data file that you created for this specific
bulk transaction.

Step3  Choose the Insert option that corresponds to your requirements:

¢ Specific Details—If you are inserting user device profile records that use a
file format and template. A Specific Details CSV file format does not contain
user information. You must associate the user device profiles to the users in
another BAT transaction.

e All Details—If you are inserting user device profile records from a file that
was generated with the export utility by using the All Details option. The file
that is generated with the export All Details option includes information that
BAT will use to associate a user with a user device profile during the insert
operation. Skip to Step 5.

e Based on devices controlled by users—If you want BAT to generate and
insert a user device profile record that is based on the user’s current IP user
device profile. This transaction requires no template or CSV data file. See the
“Generating User Device Profiles for User Devices” section on page 6-29 for
this procedure.

Step4  In the User Device Profile Template Name field, choose the user device profile
template that you created for this bulk transaction.

Step5  In the Model list box, choose the type of device or specific model when you have
selected the All Details option.

Step6  If you chose the “Based on devices controlled by users” option, you can check the
Set User Device Profile as Log Out Profile for the device check box to use the
generated user device profile as the logout profile.

Step7  Click Insert.

A message displays that tells you the approximate time required to insert the
records into the Cisco CallManager database. You can cancel if the transaction
might cause performance degradation.

Step 8 To insert the phones, click OK or to cancel the transaction, click Cancel.

If you clicked OK, a Transaction Status window displays. To see the transaction
in progress, click the Show Latest Status button.

Bulk Administration Tool User Guide
m. 0L-8661-01 |




| Chapter6 Working with User Device Profiles

Step 9

Generating User Device Profiles for User Devices

~

Note If any detail for a record fails, BAT does not insert that user device profile
record.

When the transaction completes, click View Latest Log File to see a log file that
shows the number of records that were added and the number of records that
failed, including an error code and description of the error. For more information
on log files, see the “BAT Log Files” section on page 13-1.

Additional Information
See the“Related Topics” section on page 6-32.

Generating User Device Profiles for User Devices

Note

Step 1

You can use BAT to set up extension mobility quickly by generating and inserting
profiles for all IP phone users. BAT generates user device profiles for all phones,
regardless of the number of devices that the user controls. For example, if a user
controls two devices, BAT generates two separate user device profiles, one for
each device and associates them to the same user. BAT sets one of the generated
user device profiles as the default user device profile for the user. BAT generates
user device profiles for all IP phones based on the phone button template for each
phone model.

You do not use a user device profile template or a CSV data file to perform this
action. When BAT generates these user device profiles, they are associated with
the user.

To generate user device profiles for all users, use the following procedure.

Procedure

Choose Configure > User Device Profiles. The User Device Profile Options
window displays.
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Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

Choose Generate User Device Profiles and click Next. The Insert User Device
Profiles window displays.

If you want BAT to generate and insert user device profile records for all phones
based on the user’s current IP Phone, choose Based on devices controlled by
users radio button.

If you want the device to use the generated user device profile as the logout
profile, check the Set User Device Profile as Log Out Profile for the device
check box.

Click Insert.

A message displays that tells you the approximate time that is required to insert
the records into the Cisco CallManager database. You can cancel if the transaction
might cause performance degradation.

To insert the phones, click OK or to cancel the transaction, click Cancel.

If you clicked OK, a Transaction Status window displays. To see the transaction
in progress, click the Show Latest Status button.

N

Note If any information for a record fails, BAT does not insert that user device
profile record.

When the transaction completes, click View Latest Log File to see a log file that
shows the number of records that were added and the number of records that
failed, including an error code. For more information on log files, see the “BAT
Log Files” section on page 13-1.

Additional Information
See the“Related Topics” section on page 6-32.

Updating Lines to User Device Profiles

You can update line attributes for user device profiles and phones at the same time
with your query results.

To update lines, use the following procedure.

Bulk Administration Tool User Guide
m. 0L-8661-01 |




| Chapter6 Working with User Device Profiles

Deleting User Device Profiles

Procedure

Step 1 Choose Configure > User Device Profiles. The User Device Profile Options
window displays.

Step2  Choose Update Lines and click Next. The Update Lines (Step 1 of 2) window
displays. To locate the records that you want to update, you must define a query
filter.

Follow the steps in the “Updating Lines” section on page 3-69.

Additional Information
See the“Related Topics” section on page 6-32.

Deleting User Device Profiles

To locate the records that you want to delete, you must define a query filter. To
delete user device profiles from Cisco CallManager, use the following procedure.

Procedure

Step 1 Choose Configure > User Device Profiles. The User Device Profile Options
window displays.

Step2  Choose Delete User Device Profiles and click Next. The Delete User Device
Profiles window displays.

The Delete User Device Profiles window displays. To locate the user device
profiles that you want to delete, define the filter.

A

Caution  If you do not define a filter, BAT deletes all user device profiles.

Step3  In the first drop-down list box, choose a field to query such as Model, Device
Name, or Description.

Step 4 In the second drop-down list box, choose one of these limiters: contains, is
exactly, not equal to, begins with, ends with, is empty, or is not empty.
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Step 5
Step 6

Step 7

Step 8

A

In the third box, which is the search field/list box, either choose or enter the value
that you want to locate, such as the name of a specific user.

You can click AND or OR to add multiple filters and repeat Step 3 through Step
6 to further define your query.

To add the defined filter to the query, click Add To Query button.

If you make a mistake, click the Clear Query button to remove the query; then,
return to Step 3 and start over.

To display the records that are going to be affected, click View Query Result.

Caution

Step 9

Step 10
Step 11

Step 12

If no information is entered into the query text box, the system deletes all user
device profile records.

To delete autogenerated device profiles that satisfy the query criteria, check the
Include Auto Generated Device Profiles check box.

To delete the records, click Delete.

A message displays that advises you of approximately how long it will take to
delete the records from the Cisco CallManager database. You can cancel the
transaction or click OK to continue.

You can click the View Latest Log File link to display the log file that BAT
generated. The log file displays the number of phones that were deleted and the
number of records that failed, including an error code. For more information on
log files, see the “BAT Log Files” section on page 13-1.

Additional Information

See the“Related Topics” section on page 6-32.

Related Topics

e Adding User Device Profiles, page 6-1
e Generating User Device Profiles for User Devices, page 6-29

e Updating Lines to User Device Profiles, page 6-30
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e Deleting User Device Profiles, page 6-31

¢ Adding Lines to Existing Phones and UDPs, page 3-78
e Exporting User Device Profile Records, page 10-17

e BAT Log Files, page 13-1
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Working with Gateways and Ports

You can use BAT to configure some Cisco gateways and ports in the
Cisco CallManager database in batches, rather than to add each gateway and port
individually. Use BAT to work with the following types of gateways:

e To add, update, or delete Cisco VG200 Voice Gateways with trunks and ports,
see the “Working with Cisco VG200 Gateways and Ports” section on
page 7-2.

e To add, update, and delete FXS ports on Cisco Catalyst 6000 24 Port FXS
Analog Interface Modules, see the “Adding Cisco Catalyst 6000 FXS Analog
Interface Module Ports” section on page 7-18.

Gateway Directory Numbers for FXS Ports

A Gateway Directory Number template allows you to specify directory number
configuration for POTS port types on Cisco VG200 gateways or Cisco Catalyst
6000 FXS analog interface modules.

The following topics provide information and procedures for these tasks:
¢ Working with Cisco VG200 Gateways and Ports, page 7-2
e Working with Cisco Catalyst 6000 FXS Analog Interface Modules, page 7-17
e Creating a Gateway Directory Number Template for FXS Ports, page 7-3
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Working with Cisco VG200 Gateways and Ports

You can use BAT to add the Cisco VG200 gateways to the Cisco CallManager
database. Before adding the VG200 gateways, you must first configure the
gateway by using the Cisco IOS software command line interface (CLI). For
gateway configuration procedures and commands, refer to the configuration
documentation that is supplied with the gateway.

When using BAT to add the Cisco VG200 gateways to the Cisco CallManager
database, you can configure the following types of trunks or ports:

e Foreign Exchange Station (FXS) ports for analog devices
e Foreign Exchange Office (FXO) for loopstart or groundstart trunks
e TI1 Primary Rate Interface (PRI) trunks for ISDN services in North America
e El Primary Rate Interface (PRI) trunks for ISDN services in Europe
e T1 Channel Associated Signaling (CAS) protocol trunks
The following topics provide information and procedures for these tasks:
e Adding Cisco VG200 Gateways, page 7-2
e Deleting Cisco VG200 Gateways, page 7-16
e Generating Reports for Cisco VG200 Gateways, page 11-11

Adding Cisco VG200 Gateways

To add Cisco VG200 gateways to Cisco CallManager, you must access the Steps
to Insert VG200 Gateways window by choosing Configure > Gateways >
VG200. In the VG200 Gateway Options window, choose Insert VG200
Gateways and perform the following tasks:

1. When you are adding FXS ports, create a Gateway Directory Number
template. See the “Creating a Gateway Directory Number Template for FXS
Ports” section on page 7-3.

2. Create a Cisco VG200 gateway template to define common values for a set of
gateways and ports. See the “Creating a Cisco VG200 Gateway Template”
section on page 7-4.
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3. Create a CSV data file to define individual values for each gateway and port
that you want to add. See the “Creating CSV Data Files for Cisco VG200
Gateways” section on page 7-10.

4. Insert gateways and ports in the Cisco CallManager database. See the
“Inserting Cisco VG200 Gateways to Cisco CallManager” section on
page 7-15.

Additional Information
See the “Related Topics” section on page 7-62.

Creating a Gateway Directory Number Template for FXS Ports

Note

Step 1

Step 2

Step 3

You use the Gateway Directory Number template when you add directory
numbers to FXS ports on Cisco VG200 gateways or Cisco Catalyst 6000 (FXS)
analog interface modules.

You can create a BAT template that has common directory number details such as
partition, calling search space, and so on, for POTS port types.

If you are adding ports other than FXS to the Cisco VG200 gateway (such as FXO
ports), go to the “Creating a Cisco VG200 Gateway Template” section on
page 7-4.

Use this procedure to create a Gateway Directory Number template. Treat all
fields as optional unless otherwise noted.

Procedure

Choose Add, view, or modify Gateway Directory Number template for FXS
ports and click Next. The Gateway Directory Number Template Configuration
window displays.

In the Gateway Directory Number Template Name field, enter a unique name, up
to 50 alphanumeric characters, for this template.

Enter settings for the fields. See the “Field Descriptions for Gateway Directory
Number Template” section on page 7-25, for more information.
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Step 4

Step 5

To add the new template, click Insert. The template appears in the list of
templates.

To return to the Steps to Insert Gateways window, click Back.

Additional Information
See the “Related Topics” section on page 7-62.

Creating a Cisco VG200 Gateway Template

Step 1

Step 2

Step 3

You must create a Cisco VG200 template and then add endpoint identifiers for the
network modules. If you already created the gateway template but did not add
endpoint identifiers, skip to the “Updating the Endpoint Identifiers for Cisco
VG200 Gateway Template” section on page 7-9.

You must use a BAT template to configure the following endpoint identifiers:
e Foreign Exchange Station (FXS) ports
e Foreign Exchange Office (FXO) trunks
e TI1 PRI trunks
e EI1 PRI trunks
e T1 CAS trunks

Before You Begin
Use the following procedure to add a VG200 Gateway template.

Procedure

In the Steps to Insert VG200 Gateways window, choose Insert Gateways and
click Next.

Choose Add, view, or modify VG200 template and click Next. The VG200
Gateway Template Configuration window displays.

Enter values for the following fields:

e VG200 Gateway Template Name—Enter a unique name, up to 50
alphanumeric characters for this BAT template.
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Cisco CallManager Group—Choose the Cisco CallManager Group for this
gateway.

Step 4 In the Module in Slot 1 field in the Installed Voice Interface Cards area, choose
the type of network module that is installed in slot 1:

NM-1V—Network Module-1Voice has one voice interface card (VIC) in
Sub-Unit 0 for FXS or FXO.

NM-2V—Network Module-2Voice has two VICs, one in Sub-Unit O and one
in Sub-Unit 1 for either FXS or FXO.

NM-HDV—Network Module-High Density Voice has one VIC in Sub-Unit 0
either for T1 CAS or T1 PRI, or for E1 PRI.

None—No network modules are installed.

Step5  In the Product Specific Configuration area, enter values for the following fields:

Switchback Timing—Choose the timing mechanism that is used to switch
back to a primary Cisco CallManager.

Switchback Uptime-Delay—Choose the delay, in minutes, that applies when
delayed switchback is used. You must make an entry in this field if you chose
“Delayed” in the Switchback Timing field.

Switchback Schedule—Designate the schedule, in hours and minutes, that
applies when scheduled switchback is used. You must make an entry in this
field if you chose “Scheduled” in the Switchback Timing field.

Type of DTMF Relay—Choose the type of DTMF (Dual-tone
multifrequency) that you want to use from the following options.

— Out of Band

- Cisco

- NSE

- NTE-CA

- NTE-GW

— Current GW Config

Step6  Click Insert. When the Status indicates that the insert completed, a new field
displays on the pane.

Step7  In the Sub-Unit field(s), choose the appropriate type for each sub-unit field:

VIC-2FXS—Foreign Exchange Station (FXS) voice interface card
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e VIC-2FXO—Foreign Exchange Office (FXO) voice interface card

e VWIC-1MFT-T1—Voice WAN interface card with one endpoint for T1 CAS
or T1 PRI

e VWIC-2MFT-T1—Voice WAN interface card with two endpoints for T1 CAS
or T1 PRI

e VWIC-1MFT-E1—Voice WAN interface card with one endpoint for E1 PRI
e VWIC-2MFT-E1—Voice WAN interface card with two endpoints for E1 PRI
Step8  Click Update. When the Status indicates that the update completed, the endpoint

identifiers display as links to the right of the subunit drop-down list boxes.

N

Note  Continue to the “Adding Endpoint Identifiers in a Cisco VG200 Gateway
Template” section on page 7-6 to complete the VG200 gateway template.

Adding Endpoint Identifiers in a Cisco VG200 Gateway Template

Use the following procedure to add endpoints for FXS ports, FXO trunks, and
T1 PRI or E1 PRI trunk interfaces to the template. If you are configuring T1 CAS
endpoints, you must also configure ports by using the Port Configuration window.

You must use a BAT template to configure all ports that you want to add. For
example, if you want to add ports 1, 2, and 3 on endpoint identifier (1/0), you must
first configure ports 1, 2, and 3 in the BAT template before attempting to add these
ports by using the CSV data file.

Procedure

Step 1 In the VG200 Gateway Template Configuration window, click the link for the
endpoint identifier that has a small question mark above the endpoint icon. The
question mark indicates that the endpoint is not configured.

The Cisco VG200 Gateway Template Endpoint Configuration window displays
with settings for the endpoints.

Step2  Complete one of the following options for the trunk or port type that you are
configuring for this endpoint:
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Step 3

Step 4

Step 5

Adding Cisco VG200 Gateways I

e If you are configuring FXS ports for POTS devices, enter the appropriate
settings. See the “Field Descriptions for FXS Ports on Cisco VG200
Gateways” section on page 7-35 for more information. You must specify the
Gateway Directory Number template that you are using with these ports.

e If you are configuring FXO trunks, enter the appropriate trunk settings. See
the “Field Descriptions for FXO Trunks on a Cisco VG200 Gateway” section
on page 7-37 for more information.

e If you are configuring T1 trunks, choose either T1 CAS or T1 PRI signaling
protocol:

— TI1 PRI trunk interface protocol—Enter the appropriate settings. See the
“Field Descriptions for T1 PRI or E1 PRI Trunks on a
Cisco VG200 Gateway” section on page 7-45 for more information.

— T1 CAS trunk interface protocol—Go to the “Adding T1 CAS Endpoints
and Ports to the Cisco VG200 Gateway Template” section on page 7-7

e Ifyouare configuring E1 trunks, enter the appropriate settings. See the “Field
Descriptions for T1 PRI or E1 PRI Trunks on a Cisco VG200 Gateway”
section on page 7-45 for more information.

After entering the endpoint settings, click Update. When the Status indicates that
the update completed, the endpoint identifier icon shows the interface type instead
of a question mark.

To configure additional endpoints, repeat Step 1 through Step 3 until all endpoints
are configured.

Click Back to VG200 Template Configuration and then click Back to return to
the Steps to Insert VG200 Gateways window.

Additional Information
See the “Related Topics” section on page 7-62.

Adding T1 CAS Endpoints and Ports to the Cisco VG200 Gateway Template

Use the following procedure to add T1 CAS endpoints to the VG200 Gateway
template. You must also configure the E&M ports for T1 CAS by using the Port
Configuration window. You can configure any number of ports between 1 through
24 for each T1 CAS trunk interface endpoint.
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Note

Step 1

Step 2

Step 3

Step 4

Step 5

You must use a BAT template to configure all ports that you want to add. For
example, if you want to add ports 1, 2, and 3 on endpoint identifier (1/0), you must
first configure ports 1, 2, and 3 in the BAT template before attempting to add these
ports by using the CSV data file.

The three-digit port identifier represents the combination of endpoint identifier
number and port number, where the first digit specifies the endpoint, and the last
two digits indicate the port number. For example, for endpoint 0 and port number
7, the port identifier specifies 007.

Procedure

In the VG200 Endpoint Configuration window for T1 CAS trunks, enter the
appropriate settings. See the “Field Descriptions for T1 CAS Trunks on a Cisco
VG200 Gateway” section on page 7-39 for more information.

After entering the endpoint settings, click Update. When the Status indicates that
the update completed, the endpoint identifier icon shows the interface type instead
of a question mark.

To configure the E&M ports for T1 CAS, click Add a New Port in the left pane.
The Port Configuration popup window displays.

Choose values for the following fields:

e Beginning Port Number—Choose All Ports or individual ports numbered 1
through 24.

¢ End Port Number—Choose All Ports or individual ports numbered 1 through
24.

¢ Enter the port settings. See the “Field Descriptions for E & M Ports for T1
CAS” section on page 7-42, for more information.

If you have more ports to configure, click Insert and repeat Step 3 through Step 5.

If you have configured all the E&M ports for the T1 CAS endpoints, choose
Insert and Close. The popup window closes, and the ports display in the left
column on the VG200 Gateway Template window as Port: <number>.

¢ You can modify port attributes in a template by clicking a port identifier in
the left pane to open the Port Configuration window. Make changes to the
details and then click Update or Update and Close.
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e You can delete ports in a template by clicking a port identifier in the left pane
to open the Port Configuration window. Click Delete to remove the port.

Click Back to VG200 Template Configuration.

Additional Information
See the “Related Topics” section on page 7-62.

Updating the Endpoint Identifiers for Cisco VG200 Gateway Template

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

If you already created the Cisco VG200 gateway template, but did not add the
endpoint identifiers, you can use the following steps to complete the template. To
access the endpoint identifier option, choose Configure > Gateways > VG200.

Procedure

In the VG200 Options window, choose Insert Gateways and click Next. The
Steps to Insert VG200 Gateways window displays.

Choose Add, view, or modify VG200 template and click Next. The VG200
Gateway Template Configuration window displays.

In the list of VG200 Gateway Templates, choose the BAT template to which you
want to add endpoint identifier attributes.

In the Installed Voice Interface Cards area, choose the appropriate voice interface
card for the Sub-Unit(s).

Click Update. When the Status indicates that the update completed, the endpoint
identifiers display on the left pane.

Choose the endpoint identifier that you want to configure.You can tell which
endpoint identifiers need to be configured because the endpoint icon displays with
a question mark to indicate that it is not configured.

The Cisco VG200 Endpoint Configuration window displays with settings for the
endpoints. See the “Adding Endpoint Identifiers in a Cisco VG200 Gateway
Template” section on page 7-6 for complete instructions.

Repeat Step 4 through Step 6 until all endpoint identifiers are configured.
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Step8  Click Back to VG200 Template Configuration and then click Back to return to
the Steps to Insert VG200 Gateways window.

Additional Information
See the “Related Topics” section on page 7-62.

Creating CSV Data Files for Cisco VG200 Gateways

When you use BAT to insert VG200 gateways and ports to the Cisco CallManager
database, you can add new ports or update existing ports.

You can use the BAT spreadsheet to create a CSV data file for VG200 gateways
and ports. See the following sections:

e Using the BAT Spreadsheet for CSV Data Files for Cisco VG200 FXS or
FXO Gateways, page 7-10

e Using the BAT Spreadsheet for CSV Data Files for Cisco VG200 T1 CAS, T1
PRI, or E1 PRI Gateways and Ports, page 7-12

You can use a text editor to create a text file in CSV format for VG200 gateways
and ports. See the following sections:

¢ Creating a Text-Based CSV File for Cisco VG200 Gateways, page A-22

Using the BAT Spreadsheet for CSV Data Files for Cisco VG200 FXS or FX0
Gateways

Use the BAT spreadsheet to create the CSV data file that contains the details for
each individual FXS or FXO port, such as directory number, description of port,
and partition.

For information about installing and using the BAT spreadsheet, see the “Using
the BAT Spreadsheet for Gathering Data” section on page 1-11.

To create a text-based CSV data file for VG200 gateways, see the “FXO or FXS
Trunks CSV File Format” section on page A-23 for information and examples.
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Procedure

Step1  To open the BAT spreadsheet, locate and double-click BAT.xIt file.

Step2  When prompted, click Enable Macros to use the spreadsheet capabilities.

Step3  To add gateway attributes, click the VG200 FXS FXO tab at the bottom of the
spreadsheet.

Step4  In each row, provide the information for the following fields:

¢ MGCP Domain Name—Enter a name, from 1 to 64 characters, that
identifies the gateway. Use the Domain Name System (DNS) host name if it
is configured to resolve correctly; otherwise, use the host name as defined on
the Cisco MGCP gateway.

The host name must match exactly the host name that is configured on the
Cisco IOS gateway. For example, if the host name is configured on the
gateway to resolve to vg200-1 and the IP domain name is not configured,
enter the host name in this field (in this case, vg200-1). If the host name is
configured on the gateway as vg200-1 and the IP domain name is configured
on the gateway as cisco.com, enter vg200-1.cisco.com in this field.

e Description—Enter a description, up to 100 characters for the gateway. Use
a specific description that helps you locate the gateway.

¢ Port 1 Description—Enter a description for port 1, up to 50 characters. Use
a description to help identify the port in a list of ports. This applies to the
description field for port 2 through port 4.

e Port 1 Directory Number—Enter the directory number, up to 24 numerals
and special characters, for this port. This applies to the directory number field
for port 2 through port 4.

~
Note  Port 1 Directory Number and Partition fields are required for FXS ports
only. For FXO ports, leave these fields blank.

e Port 1 Partition— Enter the name of the route partition, up to 50 characters,
to which you want this port to belong. Make sure that the route partition is
already configured in Cisco CallManager Administration. This applies to the
partition field for port 2 through port 4.

Step5  To transfer the data from the BAT Excel spreadsheet into a CSV file, click Export
to BAT Format.
Bulk Administration Tool User Guide
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Tip

Note

The system saves the file to C:\XLSDataFiles (or to your choice of another
existing folder) as

VG200Gateways#timestamp.txt

where “timestamp” represents the precise date and time that the file was created.

If you enter a comma in one of the fields, BAT.xIt encloses that field entry in
double quotes when you export to BAT format.

If you enter a blank row in the spreadsheet, the system treats the empty row as the
end of the file. Data that is entered after a blank line does not get converted to the
BAT format.

You must copy the CSV data file to the Cisco CallManager publisher database
server, so BAT can access the data input file. Using a floppy disk or a mapped
network drive, copy the CSV file from C:\XLSDataFiles to the
C:\BATFiles\VG200Gateways folder on the server that is running the publisher
database for Cisco CallManager.

For information on how to read the exported CSV file, click the link to View
Sample File in the Insert Gateways window in BAT.

Additional Information
See the “Related Topics” section on page 7-62.

Using the BAT Spreadsheet for CSV Data Files for Cisco VG200 T1 CAS, T1 PRI, or
E1 PRI Gateways and Ports

Use the BAT spreadsheet to create the CSV data file that contains the details, such
as domain name, MGCP description, and port identifier, for individual T1 CAS,
T1 PRI, or E1 PRI ports.

For information about installing and using the BAT spreadsheet, see the “Using
the BAT Spreadsheet for Gathering Data” section on page 1-11.
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Step 2
Step 3
Step 4

Step 5

Adding Cisco VG200 Gateways I

To create a text-based CSV data file for VG200 gateways, see the “T1 CAS, T1
PRI, or E1 PRI Trunks File Format” section on page A-24 for information and
examples.

Procedure

To open the BAT spreadsheet, locate and double-click BAT.xIt file
When prompted, click Enable Macros to use the spreadsheet capabilities.
Click the VG200 T1-Pri T1-Cas E1-Pri tab.

For T1 CAS endpoints only, scroll to the right until you see the Number of Port
Identifiers field. Enter the number of port identifiers that you want to add for each
Cisco VG200 gateway. If you want only one port identifier, skip this step.

In each row, provide the information for the following fields:

¢ MGCP Domain Name—Enter a name, from 1 to 64 characters that identifies
the gateway. Use the Domain Name System (DNS) host name if it is
configured to resolve correctly; otherwise, use the host name as defined on
the Cisco MGCP gateway.

The host name must match exactly the host name that is configured on the
Cisco IOS gateway. For example, if the host name is configured on the
gateway to resolve to vg200-1 and the IP domain name is not configured,
enter the host name in this field (in this case, vg200-1). If the host name is
configured on the gateway as vg200-1 and the IP domain name is configured
on the gateway as cisco.com, enter vg200-1.cisco.com in this field.

¢ MGCP Description—Enter a description, up to 100 characters for the
gateway. Use a specific description that helps you locate the gateway.

¢ Port Identifier 1—Enter the numerical representation, up to three numerals,
for the port identifier. Make the first digit either O or 1 (signifying either
endpoint identifier O or endpoint identifier 1) followed by the port number, 01
to 24. Acceptable values range from 001 through 024 or 101 through 124.

[ oL-8661-01
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~

Note For T1 CAS only, the ports that you specify here must be the same ports
that you specified in the VG200 template. In the CSV data file, you can
specify none, some, or all ports that were configured in the template. Do
not configure any ports in the CSV data file that were not also configured
in the template, or an error will result when you attempt to insert the BAT
VG200 template and the CSV file.

For example, if you configured ports 1,2,3, and 4 in the template, you
could configure none of the ports, or ports 1, 2, 3, and 4, or only ports 1
and 2 in the CSV file, and the insertion would be accepted. But if you
configured ports 5 and 6 in the CSV file when they are not configured in
the template, you will receive an insertion error in BAT.

Step6  To transfer the data from the BAT Excel spreadsheet into a CSV file, click Export
to BAT Format.

The system saves the file to C:\XLSDataFiles (or to your choice of another
existing folder) as

VG200Gateways#timestamp.txt

where “timestamp” represents the precise date and time that the file was created.

e

ﬂ If you enter a comma in one of the fields, BAT.xlt encloses that field entry
in double quotes when you export to BAT format.

If you enter a blank row in the spreadsheet, the system treats the empty
row as the end of the file. Data that is entered after a blank line does not
get converted to the BAT format.

You must copy the CSV data file to the Cisco CallManager publisher database
server, so BAT can access the data input file. Using a floppy disk or a mapped
network drive, copy the CSV file from C:\XLSDataFiles to the
C:\BATFiles\VG200Gateways folder on the server that is running the publisher
database for Cisco CallManager.
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Note

Adding Cisco VG200 Gateways I

For information on how to read the exported CSV data file, click the link
to View Sample File in the Insert Gateways window in BAT.

Additional Information

See the “Related Topics” section on page 7-62.

Inserting Cisco VG200 Gateways to Cisco CallManager

To add Cisco VG200 gateways and ports to Cisco CallManager, use this
procedure.

Before You Begin

You must have a Cisco VG200 gateway template for the trunks or ports. See
the “Creating a Cisco VG200 Gateway Template” section on page 7-4.

If you want to insert directory number details for FXS ports, you must have a
Gateway Directory Number template. See the “Creating a Gateway Directory
Number Template for FXS Ports” section on page 7-3.

You must have a CSV data file for the VG200 gateway ports. See the Creating
CSV Data Files for Cisco VG200 Gateways, page 7-10:

Procedure

Step1  In the Steps to Insert VG200 Gateways window, choose Insert Gateways and
click Next. The Insert Gateways window displays.

Step 2 In the File Name field, choose the name of the CSV data file that contains the
Cisco VG200 gateway information to be added.

Step3  In the VG200 Gateway Template Name field, choose the name of the VG200
gateway template that you created for this type of bulk transaction.

Step4  Click Insert.
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Step 5

Step 6

A message displays that advises you of approximately how long it will take to
insert the records to the Cisco CallManager directory. You can cancel the
transaction if it might cause performance degradation.

To insert VG200 gateways, click OK or click Cancel to cancel the transaction.

If you clicked OK, a Transaction Status window displays. To see the transaction
in progress, you can click Show Latest Status.

When the transaction completes, check the Status message. BAT displays a status
completed or failed message.

You can click View Latest Log File to see a log file that indicates the number of
records that are added and the number of records that failed, including an error
code. For more information on log files, see the “BAT Log Files” section on
page 13-1.

Additional Information
See the “Related Topics” section on page 7-62.

Deleting Cisco VG200 Gateways

Step 1

Step 2

Step 3

Step 4

You can delete some or all Cisco VG200 gateway records from the Cisco
CallManager database. To access VG200 Options, choose

Configure > Gateways > VG200. To delete Cisco VG200 gateways, use this
procedure.

Procedure

In the VG200 Options window, choose Delete VG200 Gateways and click Next.
The Delete Gateways window displays

In the Select VG200 gateways where area, choose the field that you want to
search, such as MGCP Domain Name or Description, from the drop-down list.

From the drop-down list box, choose the search criteria, such as begins with,
contains, or is empty.

In the search field, enter the value that you want to locate, such as the name for
MGCP domain or the description of the gateway.

] Bulk Administration Tool User Guide
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Step 5
Step 6
Step 7

A

Working with Cisco Catalyst 6000 FXS Analog Interface Modules

To add the defined filter to the query, click Add to Query.
To add multiple filters to the query, click AND or OR.
To verify the records that are going to be deleted, click View Query Results.

Caution

Step 8

If you have not specified a query (as described in Step 2 through Step 5), clicking
Delete removes all Cisco VG200 gateways.

To delete the records, click Delete.

After the Cisco VG200 gateways are deleted from Cisco CallManager, BAT
generates a log file that indicates the number of records that were deleted and the
number of records that failed, including an error code. For more information on
log files, see the “BAT Log Files” section on page 13-1.

Additional Information
See the “Related Topics” section on page 7-62.

Working with Cisco Catalyst 6000 FXS Analog
Interface Modules

Before using BAT to add the FXS ports for the analog interface modules, you must
install the Cisco Catalyst 6000 gateway by performing these tasks:

1. Configure the gateway by using Cisco IOS software command line interface.
See the documentation that was supplied with your gateway for configuration
instructions.

2. Use Cisco CallManager Administration to add the Cisco Catalyst 6000
gateway in the Cisco CallManager database. In Cisco CallManager
Administration, choose Device > Add a New Device > Gateway > Next.
Choose the Cisco Catalyst 6000 24 Port FXS Gateway and device protocol
and then click the Next.
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You can use BAT to add FXS ports on the Cisco Catalyst 6000 (FXS) analog
interface modules for analog devices. You must configure a Gateway Directory
Number template to associate with these FXS ports and a Catalyst 6000 (FXS)
ports template before adding these ports to the Cisco CallManager database.

The following topics provide information and procedures for these tasks:
e Adding Cisco Catalyst 6000 FXS Analog Interface Module Ports, page 7-18
e Updating Cisco Catalyst 6000 FXS Ports in Cisco CallManager, page 7-23
e Deleting Ports for Cisco Catalyst 6000 FXS Gateway, page 7-24

Adding Cisco Catalyst 6000 FXS Analog Interface
Module Ports

To insert Cisco Catalyst 6000 (FXS) ports to Cisco CallManager, you must access
the Catalyst 6000 (FXS) Options window by choosing Configure > Gateways >
Catalyst 6000 (FXS). In the Catalyst 6000 Options window, choose Insert
Catalyst 6000 (FXS) ports, and perform the following tasks:

1. Create a Gateway Directory Number template for adding FXS ports that
require directory number details. See the “Creating a Gateway Directory
Number Template for FXS Ports” section on page 7-3.

2. To define common values for a set of FXS ports, create a Cisco Catalyst 6000
(FXS) ports template. See the “Creating a Cisco Catalyst 6000 (FXS) Ports
Template” section on page 7-19.

3. To define individual values for the FXS ports that you want to add, create a
CSV data file. See the Creating the CSV Data File for Cisco Catalyst 6000
(FXS) Ports, page 7-19.

4. To insert the FXS ports in the Cisco CallManager database, see the “Inserting
Cisco Catalyst 6000 (FXS) Ports to Cisco CallManager” section on
page 7-21.

Additional Information
See the “Related Topics” section on page 7-62.
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Creating a Cisco Catalyst 6000 (FXS) Ports Template

Step 1

Step 2

Step 3

Step 4

Step 5

The port template and comma separated values (CSV) files work together in bulk
transactions. You can create a template that has the common analog details for all
the ports in the batch, such as the port direction, and port level.

To create a Cisco Catalyst 6000 FXS ports template, use this procedure. You must
complete all fields unless otherwise noted.

Procedure

In the Steps to Insert Catalyst 6000 (FXS) Gateways window, choose Add, view,
or modify Catalyst 6000 (FXS) Ports template and click Next. The Catalyst
6000 (FXS) Ports Template Configuration window displays.

In the Catalyst 6000 (FXS) Ports Template Name field, enter a unique name for
this template.

Enter the settings for the fields. See the “Field Descriptions for FXS Ports on
Cisco Catalyst 6000 Gateway” section on page 7-61 for more information.

Click Insert. When the Status indicates that the update completed, the template
displays on the left pane.

To return to the The Steps to Insert Catalyst 6000 (FXS) Gateways window, click
Back.

Additional Information

See the “Related Topics” section on page 7-62.

Creating the CSV Data File for Cisco Catalyst 6000 (FXS) Ports

To create the CSV data file that contains the details for each individual Cisco
Catalyst 6000 (FXS) port, such as directory number, description of port, and
partition, use the BAT spreadsheet.

For information about installing and using the BAT spreadsheet, see the “Using
the BAT Spreadsheet for Gathering Data” section on page 1-11.
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Step 1
Step 2
Step 3
Step 4

A

To create a text-based CSV data file for Catalyst 6000 (FXS) ports, see the
“Creating a Text-Based CSV File for Cisco Catalyst 6000 FXS Ports” section on
page A-25 for information and examples.

Procedure

To open the BAT Spreadsheet, locate and double-click BAT.xIt file.
When prompted, click Enable Macros to use the spreadsheet capabilities.
Click the Catalyst 6000 (FXS) Ports tab.

Enter information for each port record in a row. Complete all mandatory fields and
any relevant, optional fields. Each column heading specifies the length of the
field.

e MAC Address—Enter the 12-character MAC address for the gateway.

e Port Number—Enter the numeric port number (1 through 24) that you want
to add to the gateway.

¢ Directory Number—Enter a directory number, up to 24 numerals and
special characters, for this port. You must enter a directory number if you
have specified a partition.(Optional)

e Partition—Enter the route partition, up to 50 characters, to which you want
this port to belong. Do not specify a partition unless you also have specified
a directory number. (Optional)

Caution

Step 5

The system treats blank rows in the spreadsheet as End of File and discards
subsequent records.

To transfer the data from the BAT Excel spreadsheet into a CSV file, click Export
to BAT Format.

The system saves the file to C:\XLSDataFiles\ (or to your choice of another
existing folder) as

Catalyst6000_24PortsFXSGateway#timestamp.txt

where “timestamp” represents the precise date and time that the file was created.
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You must copy the CSV data file to the Cisco CallManager publisher database
server, so BAT can access the data input file. Using a floppy disk or a mapped
network drive, copy the CSV file from C:\XLSDataFiles to the
C:\BATFiles\Catalyst6000_24PortsFXSGateway folder on the server that is
running the publisher database for Cisco CallManager.

S

Note  For information on how to read the exported CSV data file, click the link
to View Sample File in the Insert Gateways window in BAT.

Additional Information
See the “Related Topics” section on page 7-62.

Inserting Cisco Catalyst 6000 (FXS) Ports to Cisco CallManager

To insert ports on Cisco Catalyst 6000 FXS analog interface modules to
Cisco CallManager, use this procedure.

Before You Begin

* You must have a Cisco Catalyst 6000 Ports template for this bulk transaction.
See the “Creating a Cisco Catalyst 6000 (FXS) Ports Template” section on
page 7-19.

¢ You must have a CSV data file that contains port details for this bulk
transaction. See the “Creating the CSV Data File for Cisco Catalyst 6000
(FXS) Ports” section on page 7-19.

e If you want to add or update Directory Number details, you need a Gateway
Directory Number template. See the “Creating a Gateway Directory Number
Template for FXS Ports” section on page 7-3.

Procedure

In the Steps to Insert Catalyst 6000 (FXS) Gateways window, choose Insert FXS
Ports. The Insert Ports window displays.
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Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

In the File Name field, choose the CSV data file for Cisco Catalyst 6000 ports that
you created for this bulk transaction.

In the Catalyst 6000 (FXS) Ports Template field, choose the BAT template that
you created for adding Cisco Catalyst 6000 FXS ports.

In the Gateway Directory Number Template Name, choose the BAT template that
you created for adding directory numbers to Cisco Catalyst 6000 FXS
ports.(Optional)

N

Note If you have not specified directory number details on the CSV data file,
BAT inserts only analog details for that port. The port will have no
directory number.

Click Insert.

A message displays that advises you of approximately how long it will take to
insert the records to the Cisco CallManager directory. You can cancel the
transaction if it might cause performance degradation.

To insert Cisco Catalyst 6000 FXS ports, click OK or click Cancel to cancel the
transaction.

If you clicked OK, a Transaction Status window displays. To see the transaction
in progress, you can click Show Latest Status.

When the transaction completes, check the Status message. BAT displays a status
completed or failed message.

To see a log file that indicates the number of records that are added and the
number of records that failed, including an error code, you can click View Latest
Log File. For more information on log files, see the “BAT Log Files” section on
page 13-1.

Additional Information
See the “Related Topics” section on page 7-62.
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Updating Cisco Catalyst 6000 FXS Ports in
Cisco CallManager

Step 1

Step 2

Step 3

Step 4

Step 5

To update existing ports for Cisco Catalyst 6000 FXS analog interface modules to
Cisco CallManager, use this procedure. To access the update ports option, choose
Configure > Gateways > Catalyst 6000 FXS.

Before You Begin

¢ You must have a Cisco Catalyst 6000 Ports template for this bulk transaction.
See the “Creating a Cisco Catalyst 6000 (FXS) Ports Template” section on
page 7-19.

¢ Youmust have a CSV data file that contains modified port details for this bulk
transaction. See the “Creating the CSV Data File for Cisco Catalyst 6000
(FXS) Ports” section on page 7-19.

e If you want to update Directory Number details, you need a Gateway
Directory Number template. See the “Creating a Gateway Directory Number
Template for FXS Ports” section on page 7-3.

Procedure

In the Catalyst 6000 (FXS) Options window, choose Update Catalyst 6000 FXS
ports and click Next. The Steps to Update Catalyst 6000 (FXS) Gateways
window displays.

Choose Update FXS Ports. The Update Ports window displays.

In the File Name field, choose the CSV data file for the Catalyst 6000 ports for
this bulk transaction.

In the Catalyst 6000 (FXS) Ports Template field, choose the BAT template for
updating FXS ports.

(Optional) In the Gateway Directory Number Template Name, choose the BAT
template that you created for updating directory numbers to Cisco Catalyst 6000
FXS ports.

A

Note  If you have not specified directory number details on the CSV data file,
you do not need a Gateway Directory Number Template.
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Step 6

Step 7

Step 8

Click Update.

A message displays that advises you of approximately how long it will take to
update the records in the Cisco CallManager database. You can cancel the
transaction if it might cause performance degradation.

To update Cisco Catalyst 6000 FXS ports, click OK or click Cancel to cancel the
transaction.

If you clicked OK, a Transaction Status window displays. To see the transaction
in progress, you can click Show Latest Status.

When the transaction completes, check the Status message. BAT displays a status
completed or failed message.

To see a log file that indicates the number of records that are updated and the
number of records that failed, including an error code, you can click View Latest
Log File. For more information on log files, see the “BAT Log Files” section on
page 13-1.

Additional Information

See the “Related Topics” section on page 7-62.

Deleting Ports for Cisco Catalyst 6000 FXS Gateway

Step 1

Step 2

To delete all ports from a Cisco Catalyst 6000 24 Port FXS gateway, use this
procedure. To access the delete ports option, choose Configure > Gateways >
Catalyst 6000 FXS.

Procedure

In the Catalyst 6000 (FXS) Options window, choose Delete Catalyst 6000 FXS
ports and click Next. The Delete Ports window displays.

Choose the name of the Cisco Catalyst 6000 Gateway(s) for which you want to
delete all ports and click the arrow buttons to move the gateways between the
Available Gateways and Selected Gateways lists.

BAT deletes all the ports for only the gateways shown in the Selected Gateways
list box.
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Step3  Click Delete All Ports.

A message displays that indicates the time that it will take to perform the
transaction.

BAT generates a log file that indicates the number of gateways for which the
Delete All operation was successful and the number of gateways for which it
failed, including an error code.

Step4  You can click View Latest Log File link to open the log file for this transaction.
See the “BAT Log Files” section on page 13-1 for more information about errors.

Additional Information
See the “Related Topics™ section on page 7-62.

Field Descriptions for Gateway Templates

This section provides descriptions of the fields that are used in the following
gateway templates.

e Field Descriptions for Gateway Directory Number Template, page 7-25

e Field Descriptions for FXS Ports Template on a Cisco VG200 Gateway,
page 7-35

e Field Descriptions for FXO Trunks on a Cisco VG200 Gateway, page 7-37
¢ Field Descriptions for T1 CAS Trunks on a Cisco VG200 Gateway, page 7-39
e Field Descriptions for E & M Ports for T1 CAS, page 7-42

¢ Field Descriptions for T1 PRI or E1 PRI Trunks on a Cisco VG200 Gateway,
page 7-45

e Field Descriptions for FXS Ports on Cisco Catalyst 6000 Gateway, page 7-61

Field Descriptions for Gateway Directory Number Template

Use the following field descriptions when you are adding or updating values for
a Gateway Directory Number template.
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Some fields display the values that were configured in Cisco CallManager
Administration.

In the BAT user interface, field names that have an asterisk require an entry.
Consider an entry in fields without an asterisk as optional.

Table 7-1  Field Descriptions for Gateway Directory Number Template

Field Description

Line Details

Partition Choose the partition to which the directory number will be
added.

Directory Number Settings

Voice Mail Profile Check this check box to default the voice message box field for
a directory number to the same value as the directory number.
This means that the call will only ring the directory number and
not roll to voice messaging.

Calling Search Space Choose the calling search space to which this group of directory
numbers should belong.

A calling search space specifies the collection of route
partitions that are searched to determine how a dialed number
should be routed.

AAR Settings

AAR Voice Mail The settings in this row of fields specify treatment of calls for
which there is insufficient bandwidth to reach the destination.
These calls are handled by automated alternate routing (AAR)
and are routed to the AAR Destination Mask or Voice Mail.

Check this check box to use settings in the Voice Mail Profile
Configuration window.

Note  When this check box is checked, Cisco CallManager
ignores the settings in the Coverage/Destination box
and Calling Search Space.

AAR Destination Mask Use this setting instead of the external phone number mask to
determine the AAR Destination to be dialed.
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Table 7-1 Field Descriptions for Gateway Directory Number Template (continued)

Field Description

AAR Group Choose the automated alternate routing (AAR) group for this
device. The AAR group provides the prefix digits that are used
to route calls that are otherwise blocked due to insufficient
bandwidth.

Set AAR Group to <None> to prevent rerouting blocked calls.

AAR Keep Call History This field determines if the AAR part of the call will be present
in the Call Forwarding History.

— If you choose “Remove this destination from the call
forwarding history,” then the AAR leg of the call is not
present in the call history.

— If you choose “Retain this destination in the call
forwarding history,” then the AAR leg of the call will
be present in the Call History.

Network Hold Audio Source Choose the music on hold audio source that plays when the
system places a call on hold (such as when user transfers a call
or initiates a conference or call park).

Call Forward and Pickup Settings

Forward All Voice Mail Check this check box if you want calls to forward to the number
that you chose in the voice-mail profile.

If you check this box, the Forward All Destination field and
Forward All Calling Search Space box have no relevance.

Forward All Destination Enter the directory number to which all calls are forwarded.

Note The setting applies to any dialable phone number,
including an outside destination unless restricted, and
to all devices that are using this directory number.

Forward All Calling Search Space Choose the calling search space to use when calls are forwarded
to the specified destination.

Note This setting applies to all devices that are using this
directory number.
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Table 7-1 Field Descriptions for Gateway Directory Number Template (continued)

Field

Description

Forward Busy Internal Voice Mail

Check this check box to forward calls from an internal number
to the number that you chose in the voice-mail profile.

Checking this check box signifies that the values in the Forward
Busy Internal Destination field and Calling Search Space check
box are not relevant.

Forward Busy Internal Destination

Enter the directory number to which an internal call is
forwarded when the line is in use.

Note This setting applies to any internal dialable phone
number and to all devices that are using this directory
number.

Forward Busy Internal Calling
Search Space

Choose the calling search space to use when internal calls are
forwarded to the specified destination.

Note This setting applies to all devices that are using this
directory number.

Forward Busy External Voice Mail

Check this check box to forward calls from an external number
to the number that you chose in the voice-mail profile.

Checking this check box signifies that the values in the Forward
Busy External Destination field and Calling Search Space
check box are not relevant.

Forward Busy External Destination

Enter the directory number to which an external call is
forwarded when the line is in use.

Note This setting applies to any dialable, external phone
number, including an outside destination unless
restricted, and to all devices that are using this directory
number.

Forward Busy External Calling
Search Space

Choose the calling search space to use when external calls are
forwarded to the specified destination.

Note This setting applies to all devices that are using this
directory number.
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Field Descriptions for Gateway Directory Number Template (continued)

Field

Description

Forward No Answer Internal Voice
Mail

Check this check box to forward calls from an internal number
to the number that you chose in the voice-mail profile.

Checking this check box signifies that the values in the Forward
No Answer Internal Destination field and Calling Search Space
check box are not relevant.

Forward No Answer Internal
Destination

Enter an internal directory number to which a call is forwarded
when the phone is not answered.

Note This setting applies to any internal dialable phone
number and to all devices that are using this directory

number.

Forward No Answer Internal Calling
Search Space

Choose the calling search space to use when internal calls are
forwarded to the specified destination. The setting displays
only if it is configured in the system.

Note This setting applies to all devices that are using this

directory number.

Forward No Answer External Voice
Mail

Check this check box to forward external calls to the number
that you chose in the voice-mail profile.

Checking this check box signifies that the values in the Forward
No Answer External Destination field and Calling Search
Space check box are not relevant.

Forward No Answer External
Destination

Enter an directory number to which an external call is
forwarded when the phone is not answered.

Note  This setting applies to any external, dialable phone
number, including an outside destination unless
restricted, and to all devices that are using this directory

number.

Forward No Answer External Calling
Search Space

Choose the calling search space to use when eternal calls are
forwarded to the specified destination. The setting displays
only if it is configured in the system.

Note This setting applies to all devices that are using this

directory number.
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Table 7-1

Field Descriptions for Gateway Directory Number Template (continued)

Field

Description

Forward No Coverage Internal Voice
Mail

Check this check box to forward calls from an internal number
to the number that you chose in the voice-mail profile.

Checking this check box signifies that the values in the Forward
No Coverage Internal Destination field and Calling Search
Space check box are not relevant.

Forward No Coverage Internal
Destination

Enter an directory number to which an internal call is forwarded
when the phone has no coverage.

Note  This setting applies to any internal, dialable phone
number and to all devices that are using this directory

number.

Forward No Coverage Internal
Calling Search Space

Choose the calling search space to use when internal calls are
forwarded to the specified destination. The setting displays
only if it is configured in the system.

Note This setting applies to all devices that are using this

directory number.

Forward No Coverage External Voice
Mail

Check this check box to forward external calls to the number
that you chose in the voice-mail profile.

Checking this check box signifies that the values in the Forward
No Coverage External Destination field and Calling Search
Space check box are not relevant.

Forward No Coverage External
Destination

Enter a directory number to which an external call is forwarded
when the phone has no coverage.

Note  This setting applies to any dialable phone number,
including an outside destination unless restricted, and

to all devices that are using this directory number.

Forward No Coverage External
Calling Search Space

Choose the calling search space to use when external calls are
forwarded to the specified destination. The setting displays
only if it is configured in the system.

Note This setting applies to all devices that are using this

directory number.
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Table 7-1 Field Descriptions for Gateway Directory Number Template (continued)

Field

Description

Forward Unregistered Internal Voice
Mail

The settings in this row specify the forwarding treatment for
internal calls that are routed to a directory number with no
registered devices.

Check the Voice Mail check box to use settings in the Voice
Mail Profile Configuration window.

Note  When this check box is checked, Cisco CallManager
ignores the settings in the Coverage/Destination box
and Calling Search Space. When this check box is
checked for internal calls, the system automatically
checks the Voice Mail check box for external calls. If
you do not want external calls to forward to the
voice-messaging system, you must uncheck the Voice
Mail check box for external calls.

Forward Unregistered Internal
Coverage/Destination

Enter any dialable phone number, including an outside
destination.

Note  When you enter a coverage/destination value for
internal calls, the system automatically copies this
value to the Coverage/Destination field for external
calls. If you want external calls to forward to a different
destination, you must enter a different value in the
Coverage/Destination field for external calls.

Forward Unregistered Calling Search
Space

Choose calling search space from the drop-down list menu.
This setting applies to all devices that are using the directory
number chosen above.

Note When you choose a Calling Search Space for internal
calls, the system automatically copies this setting to the
Calling Search Space setting for external calls. If you
want external calls to forward to a different calling
search space, choose a different setting in the Calling
Search Space for external calls.
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Table 7-1 Field Descriptions for Gateway Directory Number Template (continued)

Field Description

Forward Unregistered External Voice |The settings in this row specify the forwarding treatment for
Mail external calls that are routed to a directory number with no
registered devices. Specify the following values:

Check the Voice Mail check box to use settings in the Voice
Mail Profile Configuration window.

Note  When this check box is checked, Cisco CallManager
ignores the settings in the Coverage/Destination box
and Calling Search Space. When this check box is
checked for internal calls, the system automatically
checks the Voice Mail check box for external calls. If
you do not want external calls to forward to the
voice-messaging system, you must uncheck the Voice
Mail check box for external calls.

Forward Unregistered External Enter any dialable phone number, including an outside
Coverage/Destination destination.

Note  When you enter a coverage/destination value for
internal calls, the system automatically copies this
value to the Coverage/Destination field for external
calls. If you want external calls to forward to a different
destination, you must enter a different value in the
Coverage/Destination field for external calls.

Forward Unregistered External Choose calling search space from the drop-down list box. This
Calling Search Space setting applies to all devices that are using the directory number
chosen above.

Note When you choose a Calling Search Space for internal
calls, the system automatically copies this setting to the
Calling Search Space setting for external calls. If you
want external calls to forward to a different calling
search space, choose a different setting in the Calling
Search Space for external calls.

No Answer Ring Duration Enter the number of seconds to allow the call to ring before
forwarding the call to the Forward No Answer Destination.
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Table 7-1 Field Descriptions for Gateway Directory Number Template (continued)

Field Description

Call Pickup Group Choose a Pickup Group Name to specify the call pickup group,
which can answer incoming calls to this directory number by
dialing the appropriate pickup group number.

Multilevel Precedence and Preemption Alternate Party Settings

Target (Destination) Enter the number to which MLPP precedence calls should be
directed if this directory number receives a precedence call and
neither this number nor its call forward destination answers the
precedence call.

Values can include numeric characters, pound (#), and asterisk
).

Calling Search Space From the drop-down list box, choose the calling search space to
associate with the alternate party target (destination) number.

No Answer Ring Duration Enter the number of seconds (between 1 and 300) to allow the
call to ring before forwarding the call to the Forward No
Answer Destination.

Leave this setting blank to use the value that is set in the
Cisco CallManager enterprise parameter, Precedence Alternate
Party Timeout.

Line Settings for This Device

Display (Internal Caller ID) Use this field only if you do not want the directory number to
show on the line appearance. Enter text that identifies this
directory number for a line/phone combination.

Suggested entries include boss’s name, department’s name, or
other appropriate information to identify multiple directory
numbers to secretary/assistant who monitors multiple directory
numbers.

External Phone Number Mask Enter the phone number (mask), up to 24 digits, that is used to
send Caller ID information when a call is placed from this
directory number.

Alerting Name Enter the name that must display during an alert to a shared
directory number. For non-shared directory numbers, during
alerts, the system uses the name entered in the Display field.
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Table 7-1 Field Descriptions for Gateway Directory Number Template (continued)

Field Description

Maximum Number of Calls You can configure up to 200 calls for a line on a device in a
cluster, with the limiting factor being the device. As you
configure the number of calls for one line, the calls available for
another line decrease.

The default specifies 4. If the phone does not allow multiple
calls for each line, the default specifies 2.

For CTI route points, you can configure up to 10,000 calls for
each port. The default specifies 5000 calls. Use this field in
conjunction with the Busy Trigger field.

Busy Trigger This setting, which works in conjunction with Maximum
Number of Calls and Call Forward Busy, determines the
maximum number of calls to be presented at the line. If
maximum number of calls is set for 50 and the busy trigger is
set to 40, then incoming call 41 gets rejected with a busy cause
(and will get forwarded if Call Forward Busy is set). If this line
is shared, all the lines must be busy before incoming calls get
rejected.

Use this field in conjunction with Maximum Number of Calls
for CTI route points. The default specifies 4500 calls.

Forwarded Call Information Display for this Device

Caller Name Check this check box to include the caller’s name in the display
when a forwarded call is received. Default leaves this field
enabled (checked).

Redirected Number Check this check box to include the redirected number in the
display when a forwarded call is received.

Caller Number Check this check box to include the caller’s number in the
display when a forwarded call is received.

Dialed Number Check this check box to include the dialed number in the
display when a forwarded call is received. Default leaves this
field enabled (checked).

Additional Information
See the “Related Topics” section on page 7-62.

Bulk Administration Tool User Guide
m. 0L-8661-01 |




| Chapter7 Working with Gateways and Ports

Field Descriptions for Gateway Templates W

Field Descriptions for FXS Ports Template on a
Cisco VG200 Gateway

Use the following field descriptions when you are adding or updating values for
FXS ports on a Cisco VG200 gateway template.

Some fields display the values that were configured in Cisco CallManager
Administration.

In the BAT user interface, field names that have an asterisk require an entry.
Consider an entry in fields without an asterisk as optional.

Table 7-2  Field Descriptions for FXS Ports on Cisco VG200 Gateways

Field Description

Device Information

Device Pool Choose the device pool for this group of gateways/ports.

A device pool defines sets of common characteristics for devices,
such as region, date/time group, Cisco CallManager group, and
calling search space for auto-registration.

Common Profile Choose the Common Profile from the drop-down list box. For more
configuration information, refer to Cisco CallManager
Administration Guide.

Calling Search Space Choose the calling search space for this group of gateways/ports.

A calling search space specifies the collection of route partitions
that are searched to determine how a dialed number should be
routed.

AAR Calling Search Space Choose the appropriate calling search space for the device to use
when it performs automated alternate routing (AAR). The AAR
calling search space specifies the collection of route partitions that
are searched to determine how to route a collected (originating)
number that is otherwise blocked due to insufficient bandwidth.
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Table 7-2  Field Descriptions for FXS Ports on Cisco VG200 Gateways (continued)

Field Description
Media Resource Group List Choose the media resource group list (MRGL) for this group of
gateways/ports.

An MRGL specifies a list of prioritized media resource groups. An
application can choose required media resources from among the
available ones according to the priority order that is defined in the
MRGL.

Network Hold Audio Source Choose the music on hold audio source that plays when the system
places a call on hold (such as when user transfers a call or initiates
a conference or call park).

Location Choose the location for this group of gateways/ports.

A location indicates the remote location that is accessed by using
restricted bandwidth connections.

AAR Group Choose the automated alternate routing (AAR) group for this
device. The AAR group provides the prefix digits that are used to
route calls that are otherwise blocked due to insufficient bandwidth.
An AAR group setting of None specifies that no rerouting of
blocked calls will be attempted.

Network Locale Choose the network locale that you want to associate with this
gateway.

The Network Locale provides a set of tones and cadences that Cisco
gateways and phones use when communicating with the PSTN and
other networks in a specific geographical area.

Gateway Directory Number When you are adding a POTS port type and want to assign a
Template Name directory number to that port, you must have configured a Gateway
Directory Number template.

Choose the Gateway Directory Number template to be used for
these ports.

Multilevel Precedence and Preemption (MLPP) Information

MLPP Domain (e.g., “0000FF”) |Enter a hexadecimal value for the MLPP domain associated with
this device. Must be blank or a value between 0 and FFFFFF.

MLPP Indication Not available on this device.

MLPP Preemption Not available on this device
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Table 7-2  Field Descriptions for FXS Ports on Cisco VG200 Gateways (continued)

Field Description

Port Information

Prefix DN For this optional field, specify the prefix digits that are appended to
the digits that are received on incoming calls.

Num Digits Specify the number of digits, from O to 32, to collect.
Cisco CallManager counts significant digits from the right (last
digit) of the number called.

Expected Digits Specify the number of digits that are expected on the inbound side
of the trunk. Use the default value (zero) if you are unsure.

SMDI Port Number (0-4096) Use this field for analog access ports that connect to a voice-mail
system.

Set the SMDI Port Number equal to the actual port number on the
voice-mail system to which the analog access port connects.

Note  Voice-mail logical ports typically must match physical ports
for the voice-mail system to operate correctly.

Additional Information
See the “Related Topics” section on page 7-62.

Field Descriptions for FXO Trunks on a Cisco VG200 Gateway

Use the following field descriptions when you are adding or updating values in
the template for FXO trunks on a Cisco VG200 gateway.

Some fields display the values that were configured in Cisco CallManager
Administration.

In the BAT user interface, field names that have an asterisk require an entry.
Consider an entry in fields without an asterisk as optional.

Table 7-3  Field Descriptions for FXO Trunks on Cisco VG200 Gateways

Field Description

Device Information
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Table 7-3  Field Descriptions for FXO Trunks on Cisco VG200 Gateways (continued)

Field

Description

Port Type

Choose the type of port, either Ground Start or Loop Start.

Device Pool

Choose the device pool for this group of gateways/ports.

A device pool defines sets of common characteristics for devices, such
as region, date/time group, Cisco CallManager group, and calling
search space for auto-registration.

Common Profile

Choose the Common Profile from the drop-down list box. For more
configuration information, refer to Cisco CallManager
Administration Guide.

Calling Search Space

Choose the calling search space for this group of gateways/ports.

A calling search space specifies the collection of route partitions that
are searched to determine how a dialed number should be routed.

AAR Calling Search Space

Choose the appropriate calling search space for the device to use when
automated alternate routing (AAR) is performed. The AAR calling
search space specifies the collection of route partitions that are
searched to determine how to route a collected (originating) number
that is otherwise blocked due to insufficient bandwidth.

Media Resource Group List

Choose the media resource group list (MRGL) for this group of
gateways/ports.

An MRGL specifies a list of prioritized media resource groups. An
application can select required media resources from among the
available ones according to the priority order that is defined in the
MRGL.

Location Choose the location for this group of gateways/ports.
A location indicates the remote location that is accessed by using
restricted bandwidth connections.

AAR Group Choose the automated alternate routing (AAR) group for this device.

The AAR group provides the prefix digits that are used to route calls
that are otherwise blocked due to insufficient bandwidth. An AAR
group setting of None specifies that no rerouting of blocked calls will
be attempted.
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Table 7-3  Field Descriptions for FXO Trunks on Cisco VG200 Gateways (continued)

Field Description
Network Locale Choose the network locale that you want to associate with this
gateway.

The Network Locale provides a set of tones and cadences that Cisco
gateways and phones use when communicating with the PSTN and
other networks in a specific geographical area.

Multilevel Precedence and Preemption (MLPP) Information

MLPP Domain (e.g., Enter a hexadecimal value for the MLPP domain associated with this
“0000FF”) device. Must be blank or a value between 0 and FFFFFF.

Port Information

Port Direction Specify the direction of calls that are passing through this port:
e Inbound—Use for incoming calls only.
¢ Outbound—Use for outgoing calls.

e Both Ways—Use for inbound and outbound calls. This choice
represents the default value.

Attendant DN Enter the directory number to which you want incoming calls routed;
for example, zero for an attendant.

Product-Specific Configuration for Loop-Start or Ground-Start Trunks

The gateway manufacturer specifies the model-specific fields under product-specific configuration. To
view field descriptions and help for product-specific configuration items, click the i information icon
to the right of the Product Specific Configuration heading to display help in a popup window. If you
need more information, refer to the documentation for the specific gateway that you are configuring.

Additional Information

See the “Related Topics” section on page 7-62.

Field Descriptions for T1 CAS Trunks on a Cisco VG200 Gateway

Use the following field descriptions when you are adding or updating values for
the E&M ports for T1 CAS trunks on a Cisco VG200 gateway.

Some fields display the values that were configured in Cisco CallManager
Administration.
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In the BAT user interface, field names that have an asterisk require an entry.
Consider an entry in fields without an asterisk as optional.

Table 7-4  Field Descriptions for T1 CAS Trunks on Cisco VG200 Gateways

Field Description

Device Information

Device Pool Choose the device pool to which this group of gateways/ports
should belong.

A device pool defines sets of common characteristics for devices,
such as region, date/time group, Cisco CallManager group, and
calling search space for auto-registration.

Common Profile Choose the Common Profile from the drop-down list box. For more
configuration information, refer to Cisco CallManager
Administration Guide.

Call Classification From the drop-down list box, choose an option to configure the
device as on net, off net, or system default.

If you chose ‘Use System Default’ at the device level, the system
uses the value of the service parameter to determine if the device is
internal (on net) or external (off net).

Calling Search Space Choose the calling search space for this group of gateways/ports.

A calling search space specifies the collection of route partitions
that are searched to determine how a dialed number should be
routed.

AAR Calling Search Space Choose the appropriate calling search space for the device to use
when automated alternate routing (AAR) is performed. The AAR
calling search space specifies the collection of route partitions that
are searched to determine how to route a collected (originating)
number that is otherwise blocked due to insufficient bandwidth.

Media Resource Group List Choose the media resource group list (MRGL) for this group of
gateways/ports.

An MRGL specifies a list of prioritized media resource groups. An
application can chose required media resources from among the
available ones according to the priority order that is defined in the
MRGL.
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Table 7-4  Field Descriptions for T1 CAS Trunks on Cisco VG200 Gateways (continued)

Field Description

Location Choose the location for this group of gateways/ports.

A location indicates the remote location that is accessed by using
restricted bandwidth connections.

AAR Group Choose the automated alternate routing (AAR) group for this
device. The AAR group provides the prefix digits that are used to
route calls that are otherwise blocked due to insufficient bandwidth.
An AAR group setting of None specifies that no rerouting of
blocked calls will be attempted.

MLPP Domain (e.g., “0000FF”) |Enter a hexadecimal value for the MLPP domain associated with
this device. Must be blank or a value between 0 and FFFFFF.

Handle DTMF Precedence Check this box to enable this gateway to interpret special DTMF
Signaling signals as MLPP precedence levels.
Load Information Enter the appropriate load information for the custom software for

gateway. The values that you enter here override the default values
for this gateway.

To use the default load, leave this field blank.

Port Selection Order Choose the order in which ports are chosen. If you are not sure
which port order to use, choose TOP_DOWN:

e TOP_DOWN—Chooses ports in descending order, from first
port (port 1) to the last port.

e BOTTOM_UP—Chooses ports in ascending order, from the
last port to the first port (port 1).

Digit Sending Choose one of the following digit sending types for out-dialing:

e DTMF—Dual-tone multifrequency as normal touchtone
dialing, this choice represents the default value.

e MF—Multifrequency

Network Locale Choose the network locale that you want to associate with this
gateway. The Network Locale provides a set of tones and cadences
that Cisco gateways and phones use when communicating with the
PSTN and other networks in a specific geographical area.
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Table 7-4  Field Descriptions for T1 CAS Trunks on Cisco VG200 Gateways (continued)

Field Description

SMDI Base Port Enter the first SMDI port number of the T1 span.
Product-Specific Configuration

The gateway manufacturer specifies the model-specific fields under product-specific configuration. To
view field descriptions and help for product-specific configuration items, click the i information icon
to the right of the Product Specific Configuration heading to display help in a popup window. If you
need more information, refer to the documentation for the specific gateway that you are configuring.

Additional Information

See the “Related Topics” section on page 7-62.

Field Descriptions for E & M Ports for T1 CAS

Use the following field descriptions when you are adding or updating values for
E&M ports for the T1 CAS trunks on a Cisco VG200 gateway.

Some fields display the values that were configured in Cisco CallManager
Administration.

In the BAT user interface, field names that have an asterisk require an entry.
Consider an entry in fields without an asterisk as optional.
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Field

Description

Port Details

Port Direction

Choose the direction of calls that are passing through this port:

Inbound—~Use for incoming calls only.
Outbound—Use for outgoing calls.

Bothways—Use for inbound and outbound calls. This
choice represents the default value.

Calling Party Selection

Because any outbound call on a gateway can send directory
number information, choose which directory number to send:

Originator—Send the directory number of the calling
device. This choice represents the default value.

First Redirect Number—Send the directory number of the
redirecting device.

Last Redirect Number—Send the directory number of the
last device that redirected the call.

First Redirect Number (External)—Send the external
directory number of the redirecting device.

Last Redirect Number (External)—Send the external
directory number of the last device that redirected the call.

Caller ID Type

Choose the type of caller ID that displays to the called party:

ANI—Automatic number identification displays the
number of the calling party and provides the default value.

DNIS—Dialed number identification service displays the
number that the caller dialed.
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Table 7-5 Field Descriptions for E&M Ports for T1 CAS (continued)

Field Description

Port Details

Caller ID DN Enter the pattern, from 0 to 24 digits, that you want to use for
caller ID.

For example, in North America

e 555XXXX = Variable caller ID, where X equals an
extension number. The CO appends the number with the
area code if you do not specify it.

e 5555000 = Fixed caller ID, for when you want the
Corporate number to be sent instead of the exact extension
from which the call is placed. The CO appends the number
with the area code if you do not specify it.

Prefix DN Enter the prefix digits that are appended to the called party
number on incoming calls.

The Cisco CallManager adds prefix digits after first truncating
the number in accordance with the Num Digits setting.

Num Digits Enter the number of significant digits, from O to 32 to collect.
Cisco CallManager counts significant digits from the right (last
digit) of the number called. The default specifies 4.

Expected Digits Enter the number of digits expected on the inbound side of the
trunk. Use zero if you are unsure. The default specifies 4.

Product Specific Configuration

Signaling Type Choose the type of signaling for E and M protocol on the trunk
interface: Wink Start or Delay Dial.

Additional Information
See the “Related Topics” section on page 7-62.
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Field Descriptions for T1 PRI or E1 PRI Trunks on a
Cisco VG200 Gateway

Use the following field descriptions when you are adding or updating values for
T1 PRI or E1 PRI trunks on a Cisco VG200 gateway.

Some fields display the values that were configured in Cisco CallManager
Administration.

In the BAT user interface, field names that have an asterisk require an entry.
Consider an entry in fields without an asterisk as optional.

Table 7-6  Field Descriptions for T1 PRI or E1 PRI Trunks

Field Description

Device Information

Device Pool Choose the device pool for this group of
gateways/ports.

A device pool defines sets of common
characteristics for devices, such as region,
date/time group, Cisco CallManager group,
and calling search space for auto-registration.

Common Profile Choose the Common Profile from the
drop-down list box. For more configuration
information, refer to Cisco CallManager
Administration Guide.

Call Classification From the drop-down list box, choose an
option to configure the device as on net, off
net, or system default.

If you chose ‘Use System Default’ at the
device level, the system uses the value of the
service parameter to determine whether the
device is internal(on net) or external (off net).
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Table 7-6  Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field

Description

Network Locale

Choose the network locale that you want to
associate with this gateway.

The Network Locale comprises a set of tones
and cadences that Cisco gateways and phones
use when communicating with the PSTN and
other networks in a specific geographical
area.

Media Resource Group List

Choose the media resource group list
(MRGL) for this group of gateways/ports.

An MRGL specifies a list of prioritized media
resource groups. An application can choose
required media resources from among the
available ones according to the priority order
that is defined in the MRGL.

Location

Choose the location for this group of
gateways/ports.

A location indicates the remote location that
is accessed by using restricted bandwidth
connections.

AAR Group

Choose the automated alternate routing
(AAR) group for this device. The AAR group
provides the prefix digits that are used to
route calls that are otherwise blocked due to
insufficient bandwidth. An AAR group
setting of None specifies that no rerouting of
blocked calls will be attempted.

Load Information

Enter the appropriate load information for the
custom software for gateway. The values that
you enter here override the default values for
this gateway.

To use the default load, leave this field blank.
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Table 7-6  Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field Description

Interface Information

PRI Protocol Type Choose the communications protocol for the
span:

For E1 PRI spans, you have these options:
e PRI AUSTRALIAN—Australian ISDN
e PRI EURO—European ISDN

e PRIISO QSIG E1—European inter-PBX
signaling protocol

For T1 PRI spans you have several options,
depending on the carrier or switch:

e PRI4ESS —AT&T interexchange
carrier, Lucent Definity switch

e PRI 5E8 Custom—Cisco IP Phone,
Nortel Meridian switch, Lucent Definity
switches

e PRI 5E8 Teleos—Madge Teleos box
e PRI 5E8 Intecom—Intecom PBX

e PRISE9—AT&T family local exchange
switch or carrier

e PRI NI2—Sprint local exchange switch
or carrier

e PRI DMS-100—Sprint local exchange
switch or carrier

e PRI DMS-250—MCI and Sprint local
exchange switch or carrier

e PRI ETSI SC—European local exchange
carrier on T1; also, Japanese local
exchange.

e PRIISO QSIG T1—Inter-PBX signaling
protocol
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Table 7-6  Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field Description

Protocol Side Choose the appropriate protocol side. This
setting specifies whether the gateway
connects to a Central Office/Network device
or to a User device.

Make sure that the two ends of the PRI
connection use opposite settings. For
example, if you connect to a PBX and the
PBX uses User as its protocol side, choose
Network for this device. Typically, use User
for Central Office (CO) connections.

Channel Selection Order Choose the order in which channels or ports
are enabled from first (lowest number port) to
last (highest number port) or from last to first.

Valid entries include TOP_DOWN (last to
first) or BOTTOM_UP (first to last). If you
are not sure which port order to use, choose
TOP_DOWN. The default specifies
BOTTOM_UP.

Channel IE Type Choose one of the following values to specify
whether channel selection is presented as a
channel map or a slot map:

e Number—B-channel usage always
presents a channel map format.

e Slotmap—B-channel usage always
presents a slotmap format.

e Use Number When 1B—Channel usage
presents a channel map for one B-channel
but presents a slotmap if more than one
B-channel exists. This represents the
default value.
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Table 7-6  Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field Description

PCM Type Specify the digital encoding format. Choose
one of the following formats:

e a-law: Use for Europe and the rest of the
world.

e mu-law: Use for North America,
Hong Kong, Taiwan, and Japan.

Delay for First Restart For this optional field, enter the rate, in
1/8-second increments, at which the spans are
brought in service. The delay occurs when
many PRI spans are enabled on a system and
the Inhibit Restarts at PRI Initialization check
box is unchecked. The default value specifies
32.

For example, set the first five cards to O and
set the next five cards to 16. (Wait 2 seconds
before bringing them in service.)

Delay Between Restarts Enter the time, in 1/8-second increments,
between restarts. The delay occurs when a
PRI RESTART is sent if the Inhibit Restarts
check box is unchecked. The default value
specifies 4.

Inhibit Restarts at PRI Initialization A restart message confirms the status of the
ports on a PRI span. If RESTARTS are not
sent, Cisco CallManager assumes that the
ports are in service. By default, the box gets
checked.

When the D-channel successfully connects
with another PRI trunk D-channel, it sends
restarts when this box is unchecked.
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Table 7-6  Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field Description

Enable Status Poll Check the check box to enable the Cisco
CallManager advanced service parameter,
"Change B-Channel Maintenance Status."
This service parameter allows you to take
individual B-channels out of service while the
B-channels are active.

Uncheck this check box to disable the service
parameter "Change B-Channel Maintenance
Status."

Default leaves this field unchecked.

Multilevel Precedence and Preemption (MLPP) Information

MLPP Domain (e.g., “0000FF”) Enter a hexadecimal value for the MLPP
domain that is associated with this device.
Ensure that the value is blank or a value
between 0 and FFFFFF.

Call Routing Information - Inbound Calls

Significant Digits This field represents the number of final
digits that a PRI span should retain on
inbound calls. A trunk with significant digits
enabled truncates all but the final few digits
of the address that is provided on an inbound
call.

Enable or disable this check box depending
on whether you want to collect significant
digits:
e If you do not check the check box,
Cisco CallManager does not truncate the
inbound number.

e If you check the check box, you also need
to choose the number of significant digits
to collect. By default, the box remains
checked.
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Table 7-6  Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field

Description

Calling Search Space

Choose the calling search space for this group
of phones/ports.

A calling search space specifies the collection
of Route Partitions that are searched to
determine how a dialed number should be
routed.

AAR Calling Search Space

Choose the appropriate calling search space
for the device to use when it performs
automated alternate routing (AAR). The AAR
calling search space specifies the collection
of route partitions that are searched to
determine how to route a collected
(originating) number that is otherwise
blocked due to insufficient bandwidth.

Prefix DN

For this optional field, enter the prefix digits
that are appended to the digits that this trunk
receives on incoming calls.

Cisco CallManager adds prefix digits after
first truncating the number in accordance with
the Num Digits setting.

Call Routing Information - Outhound Calls

Calling Line ID Presentation

Choose whether you want the
Cisco CallManager to transmit or block the
caller’s phone number.

Choose Default if you do not want to change
calling line ID presentation. Choose Allowed
if you want Cisco CallManager to send
“Calling Line ID Allowed.” Choose
Restricted if you want Cisco CallManager to
send “Calling Line ID Restricted.”
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Table 7-6  Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field Description

Calling Party Selection Any outbound call on a gateway can send
directory number information. Choose which
directory number is sent:

e Originator—Send the directory number
of the calling device. This number serves
as the default value.

e First Redirect Number—Send the
directory number of the redirecting
device.

e Last Redirect Number—Send the
directory number of the last device that
redirected the call.
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Table 7-6  Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field Description

Calling Party Number Type IE Unknown Choose the format for the type of number in
calling party directory numbers.

Cisco CallManager sets the calling directory
number (DN) type. Cisco recommends that
you do not change the default value unless
you have advanced experience with dialing
plans, such as NANP or the European dialing
plan. You may need to change the default in
Europe because Cisco CallManager does not
recognize European national dialing patterns.
You can also change this setting when you are
connecting to PBXs that are using routing as
a non-national type number.

Choose one of the following options:

e (allManager—The Cisco CallManager
sets the directory number type. This
option represents the default value.

¢ International—Use when you are dialing
outside the dialing plan for your country.

e National—Use when you are dialing
within the dialing plan for your country.

¢ Unknown—This option specifies that the
dialing plan is unknown.
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Table 7-6  Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field Description

Called Party IE Number Type Unknown Choose the format for the type of number in
called party directory numbers.

Cisco CallManager sets the called directory
number (DN) type. Cisco recommends that
you do not change the default value unless
you have extensive experience with dialing
plans, such as NANP or the European dialing
plan. You may need to change the default in
Europe because Cisco CallManager does not
recognize European national dialing patterns.
You can also change this setting when you are
connecting to PBXs that use routing as a
non-national type number.

Choose one of the following options:

e (CallManager—For the default setting,
the Cisco CallManager sets the directory
number type.

¢ International—Use when you are dialing
outside the dialing plan for your country.

e National—Use when you are dialing
within the dialing plan for your country.

¢ Unknown—This option specifies that the
dialing plan is unknown.
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Table 7-6  Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field Description

Called Numbering Plan Choose the format for the numbering plan in
called party directory numbers.

Cisco CallManager sets the called DN
numbering plan. Cisco recommends that you
do not change the default value unless you
have extensive experience with dialing plans,
such as NANP or the European dialing plan.
You may need to change the default in Europe
because Cisco CallManager does not
recognize European national dialing patterns.
You can also change this setting when you are
connecting to PBXs that are using routing as
a non-national type number.

Choose one of the following options:

e (allManager—For the default setting,
the Cisco CallManager sets the
Numbering Plan in the directory number.

e ISDN—Use when you are dialing outside
the dialing plan for your country.

e National Standard—Use when you are
dialing within the dialing plan for your
country.

e Private—Use when you are dialing
within a private network.

e Unknown—This option specifies that the
dialing plan is unknown.
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Table 7-6  Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field Description

Calling Numbering Plan Choose the format for the numbering plan in
calling party directory numbers.

Cisco CallManager sets the calling DN
numbering plan. Cisco recommends that you
do not change the default value unless you
have extensive experience with dialing plans,
such as NANP or the European dialing plan.
You may need to change the default in Europe
because Cisco CallManager does not
recognize European national dialing patterns.
You can also change this setting when you are
connecting to PBXs that are using routing as
a non-national type number.

Choose one of the following options:

e (allManager—For the default setting,
the Cisco CallManager sets the
Numbering Plan in the directory number.

e ISDN—Use when you are dialing outside
the dialing plan for your country.

e National Standard—Use when you are
dialing within the dialing plan for your
country.

e Private—Use when you are dialing
within a private network.

e Unknown—This option specifies that the
dialing plan is unknown.

Number of Digits to Strip Choose the number of digits, from 0 to 32, to
strip on outbound calls. The default value
specifies 0.

For example, 8889725551234 is dialed; the
number of digits to strip is 3. In this example,
Cisco CallManager strips 888 from the
outbound number.
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Table 7-6  Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field

Description

Caller ID DN

Enter the pattern, from 0 to 24 digits, that you
want to use for caller ID.

For example, in North America

e 555XXXX = Variable caller ID, where X
equals an extension number. The CO
appends the number with the area code if
you do not specify it.

e 5555000 = Fixed caller ID, for when you
want the Corporate number to be sent
instead of the exact extension from which
the call is placed. The CO appends the
number with the area code if you do not
specify it.

SMDI Base Port

Enter the first SMDI port number of the T1
span.

PRI Protocol Type Specific Information

Display IE Delivery

For this optional field, check the check box to
enable delivery of the display information
element (IE) in SETUP and CONNECT
messages for the calling and called party
name delivery service. By default, the box
remains unchecked.

Redirecting Number IE Delivery—Outbound

For this optional field, check the check box to
include the Redirecting Number IE in the
SETUP message to indicate the first
redirecting number and the redirecting reason
of the call when a call is forwarded. By
default, the box remains unchecked.

This setting applies to the SETUP message
only on all protocols for digital access
gateways.
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Table 7-6  Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field Description

Redirecting Number IE Delivery—Inbound |For this optional field, check the check box to
include the Redirecting Number IE in the
SETUP message to indicate the first
redirecting number and the redirecting reason
of the call when a call is forwarded. By
default, the box remains unchecked.

This setting applies to the SETUP message
only on all protocols for digital access
gateways.

Send Extra Leading Character in DisplayIE  |Check this check box to include a special
leading character byte (non ASCII,
nondisplayable) in the DisplaylE field.

Uncheck this check box to exclude this
character byte from the DisplaylE field.

This check box only applies to the DMS-100
protocol and the DMS-250 protocol.

Default leaves this setting disabled
(unchecked).
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Table 7-6  Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field Description

Setup of Non-ISDN Progress Indicator IE For this optional field, you may need to
Enable specify a value in this field to force ringback
on some PBXs.

The default specifies unchecked. Check this
check box only if users are not receiving
ringback tones on outbound calls.

When this setting is enabled,

Cisco CallManager sends Q.931 setup
messages out digital (that is, non-H.323)
gateways with the Progress Indicator field set
to non-ISDN.

This message notifies the destination device
that the Cisco CallManager gateway is
non-ISDN and that the destination device
should play inband ringback.

This problem usually associates with
Cisco CallManagers that connect to PBXs
through digital gateways.

MCDN Channel Number Extension Bit Set to |This field applies to DMS-100 protocol only.
Zero Check the check box to indicate that an
Interface Identifier is present. By default, the
box remains unchecked.

Send Calling Name in Facility IE This field applies to DMS-100 protocol only.
Enter the value that you obtained from the

PBX provider. Valid values range from 0 to
255.

Interface Identifier Present This field applies to DMS-100 protocol only.
Check the check box to indicate that an
Interface Identifier is present. By default, the
box remains unchecked.

Interface Identifier Value This field applies to DMS-100 protocol only.
Enter the value that you obtained from the
PBX provider. Valid values range from O to
255.
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Table 7-6  Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field

Description

Connected Line ID Presentation

Choose whether you want the
Cisco CallManager to allow or block the
connected party’s phone number.

Choose Default if you do not want to change
the connected line ID presentation. Choose
Allowed if you want Cisco CallManager to
send “Connected Line ID Allowed.” Choose
Restricted if you want Cisco CallManager to
send “Connected Line ID Restricted.”

Connected PBX Model

Choose the type and model of the private
branch exchange (PBX) or VoIP switch with
which this gateway communicates.

This field applies only to gateways that are
using QSIG protocol.

Options include:
¢ Siemens Hicom
e Ericsson MD-110
e Alcatel PBX
e Meridian Option 11C
e Lucent Definity G3
e [PC MX
¢ Cisco CallManager (CCM)

UUIE Configuration

Passing Precedence Level Through UUIE

Check this check box to enable passing MLPP
information through the PRI 4ESS UUIE
field. This box is used for working along with
DRSN switch.

The system makes this check box available
only if the PRI Protocol Type value of
PRI 4ESS is specified for this gateway.

The default value specifies unchecked.
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Table 7-6  Field Descriptions for T1 PRI or E1 PRI Trunks (continued)

Field Description

Security Access Level Enter the value for the security access level.
Valid values include 00 through 99. The
system makes this field available only if the
Passing Precedence Level Through UUIE
check box is checked. The default value
specifies 2.

Product-Specific Configuration

The gateway manufacturer specifies the model-specific fields under product-specific
configuration. To view field descriptions and help for product-specific configuration items,
click the i information icon to the right of the Product Specific Configuration heading to
display help in a popup window. If you need more information, refer to the documentation for
the specific gateway that you are configuring.

Additional Information
See the “Related Topics” section on page 7-62.

Field Descriptions for FXS Ports on Cisco Catalyst 6000 Gateway

Use the following field descriptions when you are adding or updating values for
FXS ports on a Cisco Catalyst 6000 gateway analog interface module.

Some fields display the values that were configured in Cisco CallManager
Administration.

In the BAT user interface, field names that have an asterisk require an entry.
Consider an entry in fields without an asterisk as optional.
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Table 7-7  Field Descriptions for FXS Ports on Cisco Catalyst 6000 Modules

Field Description

Catalyst 6000 (FXS) Ports Template |Enter a name, up to 50 alphanumeric characters, for the
Name template.

Port Direction Choose the direction of calls that pass through this port:
¢ Inbound—Use for incoming calls only.
e Outbound—Use for outgoing calls.

e Both Ways—Use for inbound and outbound calls. This
choice represents the default value.

Prefix DN Enter the prefix digits to be appended to the digits that are
received on incoming calls.

Num Digits Enter the number of digits, from 0 to 32, to collect.
Cisco CallManager counts significant digits from the right (last
digit) of the number called.

Expected Digits Enter the number of digits that are expected on the inbound side
of the trunk. Use zero if you are unsure.

SMDI Port Number Enter the SMDI port number. Use the same number as the actual
port number on the voice-messaging system to which the analog
access port connects.

Product Specific Configuration

The gateway manufacturer specifies the model-specific fields under product-specific configuration. To
view field descriptions and help for product-specific configuration items, click the i information icon
to the right of the Product Specific Configuration heading to display help in a popup window. If you
need more information, refer to the documentation for the specific gateway that you are configuring.

Additional Information
See the “Related Topics” section on page 7-62.

Related Topics

¢  Working with Cisco VG200 Gateways and Ports, page 7-2
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¢ Adding Cisco VG200 Gateways, page 7-2

e Deleting Cisco VG200 Gateways, page 7-16

¢  Working with Cisco Catalyst 6000 FXS Analog Interface Modules, page 7-17
e Adding Cisco Catalyst 6000 FXS Analog Interface Module Ports, page 7-18
e Updating Cisco Catalyst 6000 FXS Ports in Cisco CallManager, page 7-23

e Deleting Ports for Cisco Catalyst 6000 FXS Gateway, page 7-24

e Field Descriptions for Gateway Templates, page 7-25

e Generating Reports for Cisco VG200 Gateways, page 11-11
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CHAPTER

Working with Client Matter Codes and
Forced Authorization Codes

Forced Authorization Codes (FAC) and Client Matter Codes (CMC) allow you to
manage call access and accounting. CMC assists with call accounting and billing
for billable clients, while Forced Authorization Codes regulate the types of calls
that certain users can place.

Client Matter Codes force the user to enter a code to specify that the call relates
to a specific client matter. You can assign client matter codes to customers,
students, or other populations for call accounting and billing purposes. The
Forced Authorization Codes feature forces the user to enter a valid authorization
code before the call completes.

The CMC and FAC features require that you make changes to route patterns and
update your dial plan documents to reflect that you enabled or disabled FAC
and/or CMC for each route pattern.

This chapter contains information on the following topics:
e CMC and FAC Configuration Checklist, page 8-2
e Important BAT Considerations, page 8-3
e Creating a CSV File by Using BAT.xlt, page 8-4

e Using a Text Editor to Create the CSV Data File for Client Matter Codes and
Forced Authorization Codes, page 8-5

e Editing an Existing CMC or FAC CSV File, page 8-6
e Deleting Code Settings, page 8-7
e CMC and FAC CSV File Settings, page 8-10
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e Using BAT to Update the Cisco CallManager Database, page 8-12

CMC and FAC Configuration Checklist

Table 8-1 provides steps in the order in which you should use BAT to implement
CMC and FAC.

Table 8-1 Cisco CMC and FAC Configuration Checklist

Configuration Steps Related Procedures and Topics
Step 1 Review important BAT information and e Important BAT Considerations,
general information about the CMC and page 8-3

FAC features. e Cisco CallManager Features and

Services Guide

Step 2 Create a CSV file for CMC or FAC and e Creating a CSV File by Using BAT.xIt,
enter the CMC and FAC configuration page 8-4
information.

e Using a Text Editor to Create the CSV
Data File for Client Matter Codes and
Forced Authorization Codes, page 8-5

e CMC and FAC CSV File Settings,

page 8-10
Step 3 To update the Cisco CallManager database, | ® Using BAT to Update the
insert the CSV file in BAT. Cisco CallManager Database,
page 8-12

e BAT Settings for Updating the
Cisco CallManager Database,

page 8-14
Step 4 Enable FAC or CMC by adding or updating | ® Cisco CallManager Administration
route patterns in Cisco CallManager Guide

Administration. e Cisco CallManager Features and

Services Guide
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Important BAT Considerations Il

Table 8-1 Cisco CMC and FAC Configuration Checklist (continued)

Configuration Steps Related Procedures and Topics

Step 5 Update your dial plan documents or keep a |Refer to your dial plan documents.
printout of the BAT CSV file with your dial
plan documents.

Step 6 Provide all necessary information, for Cisco CallManager Features and Services
example, codes, to users and explain how |Guide
the features work.

Important BAT Considerations

Before you use BAT to configure CMC or FAC, review the following information:

e Create separate CSV files for CMC and FAC. Do not mix the two features in
a single CSV file.

e When you add CMC or FAC settings for the first time, you can create a CSV
file through BAT.xlt or create a custom text-based CSV file.

e To update, delete, or add more CMC or FAC settings (not first time), you can
edit an existing CSV file or create a custom text-based CSV file.

¢ In the file/spreadsheet, do not enter two or more codes (and corresponding
settings) on a single line. Designate a single line for each code (and
corresponding setting). For example, use the following format when you
enter codes for Forced Authorization Codes:

(Authorization Code, Authorization Code Name, Authorization Level)
1234,John Smith,20

1235,Lisa Mendez,10

5551,Debbie Dunn,30

e To add new codes at the same time that you update codes in an existing CSV
file, you must enter all required information. When you add new codes, you
must complete all required fields; for example, forced authorization code,
authorization code name, authorization level, or client matter code. If the
procedure specifies an entry as mandatory, you must provide the information
in file.
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e Deleting information from a file and leaving the information blank does not
remove the information from the Cisco CallManager database; in other
words, a blank value does not overwrite an existing value in the database.
Updating the values overwrites the existing value in the database.

¢ On the publisher database server, BAT provides separate directories for CMC
and FAC; for example, C:\BATFiles\CMC\Insert or C:\BATFiles\FAC\Insert.
Make sure that you copy the appropriate CSV files to the correct directory.

¢ You must save CSV files to the directory that BAT designates for the specific
operation; for example, if you want to delete authorization code settings, you
must copy the CSV file to C:\BATFiles\FAC\Delete on the publisher database
server.

¢ Any time that you create or change a CSV file, you must insert the CSV file
in BAT, as described in “Using BAT to Update the Cisco CallManager
Database” section on page 8-12.

Additional Information

See the “Related Topics” section on page 8-15.

Creating a CSV File by Using BAT.xIt

Step 1

Step 2
Step 3
Step 4

To create a CSV file for CMC or FAC by using BAT.xlt, perform the following
procedure:

Procedure

The BAT.xIt file exists on the publisher database server; however, you normally
do not have Microsoft Excel installed on the publisher database server. In that
case, you must copy the file from the publisher database server and move it to the
local machine, which must have Microsoft Excel installed.

Browse to C:\CiscoWebs\BAT\ExcelTemplate on the publisher database server.
Copy BAT.xIt to a local machine where Microsoft Excel is installed.

In Microsoft Excel, open BAT.xIt.
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Step 5

Step 6
Step 7
Step 8

Step 9

Step 10

Using a Text Editor to Create the CSV Data File for Client Matter Codes and Forced Authorization Codes

e

ﬁ Remember that you must create two separate CSV files, one for CMC and
one for FAC.

Click one of the following tabs:

e Insert CMC—If you are creating a CMC CSV file

¢ Insert FAC—If you are creating a FAC CSV file
Use Table 8-2 to enter CMC or FAC settings in the columns.
Repeat Step 6 until you enter all codes.

To transfer the Excel spreadsheet format to a CSV file, click Export to BAT
Format.

The system automatically saves CSV files to C:\XIsDatafiles on the local
machine. Click Browse to choose a different location.

Copy the CSV file to the following directory on the publisher database server.
¢ For CMC—C:\BATFiles\CMC\Insert\
¢ For FAC—C:\BATFiles\FAC\Insert\

You must add the CSV file to BAT. To insert the CSV file in BAT, see the “Using
BAT to Update the Cisco CallManager Database” section on page 8-12.

Additional Information
See the “Related Topics” section on page 8-15.

Using a Text Editor to Create the CSV Data File for
Client Matter Codes and Forced Authorization Codes

You can create the CSV data file by using lines of ASCII text with values
separated by commas. The comma separated values (CSV) file provides textual
information in tabular form. For more information about text-based CSV files for
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client matter codes and forced authorization codes, see the “Creating a Custom
Text-Based CSV Files for Client Matter Codes and Forced Authorized Codes”
section on page A-28.

Additional Information
See the “Related Topics” section on page 8-15.

Editing an Existing CMC or FAC CSV File

You update existing codes by manually updating an existing CSV file in Notepad
or by creating a new file in Notepad.

Perform the following procedure:

Procedure

Step 1 To edit an existing CSV file where you previously inserted codes, browse to the
following directory on the publisher database server:

e For CMC—C:\BATFiles\CMC\Insert
e For FAC—C:\BATFiles\FAC\Insert

Step2  In Notepad, open and edit the existing CSV file; delete existing settings, add new
codes, or update existing settings by using the text-based representation in
Table 8-2.

If you are updating a CMC CSV file, for example, you may enter 5555,Acme
Toys, where 5555 equals the mandatory client matter code, and Acme Toys equals
the description.

If you are updating a FAC CSV file, for example, you may enter 1234,John
Smith,20, where 1234 equals the forced authorization code, John Smith equals the
authorization code name, and 20 equals the authorization level.

A

Caution  If you add new codes at the same time that you update them, make sure that you
enter all required information. You can change any part of an existing record, but
you must include the code; for example, the forced authorization code or client
matter code. Deleting information and leaving it blank does not remove the
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Step 3

Step 4

Deleting Code Settings W

information from the database; a blank value does not overwrite an existing value
in the database, but, updating the value, for example, to Acme Toys, Inc. or John
L. Smith from the preceding examples, overwrites the existing value in the
database.

Copy the CSYV file to the following directory on the publisher database server:
e For CMC additions/updates—C:\BATFiles\CMC\Insert
¢ For CMC deletions—C:\BATFiles\CMC\Delete
¢ For FAC additions/updates—C:\BATFiles\FAC\Insert
¢ For FAC deletions—C:\BATFiles\FAC\Delete

You must add the CSV file to BAT. To insert the CSV file in BAT, see the “Using
BAT to Update the Cisco CallManager Database” section on page 8-12.

Additional Information
See the “Related Topics” section on page 8-15.

Deleting Code Settings

You can delete codes from the system by using a custom file that contains the
codes that you want to delete. You can edit a custom file where you previously
inserted or updated authorization codes, or you can create a new CSV file where
you manually enter the codes that you want to delete.

If you plan to edit an existing CSV file, you must update the file, so only the lines
that contain the codes that you want to delete remain in the file.

Example for CMC (Existing CSV File)

You obtain a file that contains the following information, and you decide to delete
the client matter codes, 5550, 5551, and 5555:

e 5550,Phil Jones DDS

e 5551,Southwest Shades

e 5552 ,Happy Pharmaceuticals
e 5553,Weddings by Joyce
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Deleting Code Settings

e 5554 Peterson Plumbing
e 5555,Acme Toys
e 5556,Chicago Paralegals
Before you delete the entries, the file must contain only the following entries:
e 5550,Phil Jones DDS
e 5551,Southwest Shades
e 5555,Acme Toys

Example for CMC (New CSV File)

If you create a new file to delete the codes, list only the codes, separated by lines,
as shown in the following example:

5550
5551
5555

Example for FAC (Existing CSV File)

You obtain a file that contains the following information, and you decide to delete
the authorization codes that are assigned to John, Dave, and Bill:

e 1233,Sandy Brown,30

e 1234,John Smith,20

e 1235 Dave Green,30

e 1236,John David,20

e 1237 Alex Anderson,30

e 1238,Bill Jones,20

e 1239 Jennifer Summers,20

Before you can delete the entries for John, Dave, and Bill, the file must contain
only the following entries:

e 1234 John Smith,20
e 1235 Dave Green,30
e 1238,Bill Jones,20
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Step 5
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Example for FAC (New File)

If you create a new file to delete the codes, list only the codes, separated by lines,
as shown in the following example:

1234
1235
1238

To delete batches of codes, perform the following procedure:

Procedure

Perform one of the following tasks:

¢ Create a new file for codes that you want to delete, as described in the
“Example for CMC (New CSV File)” section on page 8-8 and “Example for
FAC (Existing CSV File)” section on page 8-8; after you insert the CSV file
into BAT, see Step 4 through Step 11.

e To delete existing codes from existing CSV file, see Step 2 through Step 11.
On the publisher database server, browse to the following directory:

e For CMC—C:\BATFiles\CMC\Insert

¢ For FAC—C:\BATFiles\FAC\Insert
In Notepad, open and edit the existing CSV file to delete the entries.

Save the CSV file and copy it to the following directory on the publisher database
server:

e For CMC—C:\BATFiles\CMC\Delete\
e For FAC—C:\BATFiles\FAC\Delete\

In BAT, choose one of the following options, depending on whether you plan to
delete client matter codes or forced authorization codes:

¢ For CMC—Configure > Client Matter Codes
¢ For FAC—Configure > Forced Authorization Codes

Choose one of the following options depending on whether you plan to delete
client matter codes or forced authorization codes:

e For CMC—Delete Client Matter Codes
e For FAC—Delete Forced Authorization Codes
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Step 7
Step 8

Step 9
Step 10

Step 11

Choose a custom file from the drop-down list box and click Add to Query.

To view which records the system will delete, click View Query Result. If the file
does not contain the expected records, click Clear Query and return to Step 1.

If the file contains the records that you want to delete, click Delete.

A confirmation dialog box indicates the time that it takes to complete the
operation. Click OK.

e

ﬂ To see the progression of the operation, click the Show Latest Status
button.

After the transaction completes, click View Latest Log File to view a log file that
indicates whether the system added all files successfully.

Additional Information
See the “Related Topics” section on page 8-15.

CMC and FAC CSV File Settings

Use Table 8-2 in conjunction with the following sections:
e Creating a CSV File by Using BAT .xlt, page 8-4

e Using a Text Editor to Create the CSV Data File for Client Matter Codes and
Forced Authorization Codes, page 8-5

e Editing an Existing CMC or FAC CSV File, page 8-6
e Deleting Code Settings, page 8-7
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Table 8-2 Configuration Settings for CMC and FAC

Setting/Column Description
For CMC CSV file
Client Matter Code Enter a unique code of no more than 16 digits that the

user will enter when placing a call. The client matter
code displays in the CDRs for calls that use this
code.

Description Enter a name of no more than 50 characters. You can
also use the & (ampersand) character in this field.
This optional field helps you associate a client code
with a client.

For FAC CSV File

Authorization Code Enter a unique authorization code that is no more
than 16 digits. The user enters this code when the
user places a call through a FAC-enabled route
pattern.
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Table 8-2 Configuration Settings for CMIC and FAC

Setting/Column Description
Authorization Code Enter a unique name that is no more than 50
Name characters. The authorization code name ties the

authorization code to a specific user or group of
users; this name displays in the CDRs for calls that
use this code.

Tip If you plan to assign an authorization code to
every user in the system, make sure that the
code name includes an identifier for the user,
such as the user name or another unique,
non-sensitive identifier; for example, an
email alias or employee/student number. Do
not use identifiers such as a social security
number because the authorization code name
writes to CDRs, which are not secure.

Authorization Level Enter a three-digit authorization level that exists
within the range of 0 to 255; the default equals 0. The
level that you assign to the authorization code
determines whether the user can route calls through
FAC-enabled route patterns. To successfully route a
call, the user authorization level must equal or be
greater than the authorization level that is specified
for the route pattern for the call.

Additional Information
See the “Related Topics” section on page 8-15.

Using BAT to Update the Cisco CallManager
Database

To update the Cisco CallManager database, you must insert the CMC or FAC CSV
file in BAT. To update the database, perform the following procedure:
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Before You Begin

Before you can update Cisco CallManager, you must create or edit a CMC or FAC
CSV file.

Procedure

In BAT, choose one of the following options, depending on whether you used a
CMC or FAC CSV file:

e For CMC—Configure > Client Matter Codes
e For FAC—Configure > Forced Authorization Codes

Choose one of the following options, depending on whether you used a CMC or
FAC CSV file:

e For CMC—Insert Client Matter Codes
e For FAC—Insert Forced Authorization Codes

In the File Name drop-down list box, choose the CSV file that contains the
updated codes.

e

Tip To view the contents of the file that you want to insert, click View File.

If you updated an existing list of codes, check the Override the existing
configuration check box, as described in Table 8-3.

Click Insert.

A confirmation dialog box indicates the that time it takes to complete the
operation. Click OK.

e

ﬁ To see the progression of the operation, click the Show Latest Status
button.

After the transaction completes, click View Latest Log File to view a log file that
indicates whether the system added all files successfully.
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Additional Information
See the “Related Topics” section on page 8-15.

BAT Settings for Updating the Cisco CallManager
Database

Use Table 8-3 in conjunction with the “Using BAT to Update the
Cisco CallManager Database” section on page 8-12.

Table 8-3 Settings in BAT for Inserting CSV Files

Setting in BAT Description

Field Name From the drop-down list box, choose the CMC or
FAC file that you want to insert.

Override the existing This check box applies if you are updating code for

configuration existing settings.

Checking this check box overwrites the existing
authorization code name (FAC), authorization level
(FAC), or description (CMC) with the information
that is contained in the file that you want to insert
(existing authorization and client matter codes do not
change). If you do not check the check box, an error,
which writes to the log file, indicates that the
authorization or client matter code already exists;
therefore, no updates occur.

Note The system inserts new codes that are
included in the updated file, even if you

check the Override the existing configuration
check box.

Additional Information

See the “Related Topics” section on page 8-15.
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Related Topics

e CMC and FAC Configuration Checklist, page 8§-2
e Important BAT Considerations, page 8-3
e Creating a CSV File by Using BAT .xlt, page 8-4

e Using a Text Editor to Create the CSV Data File for Client Matter Codes and
Forced Authorization Codes, page 8-5

e Editing an Existing CMC or FAC CSYV File, page 8-6
e Deleting Code Settings, page 8-7

e CMC and FAC CSV File Settings, page 8-10

e Cisco CallManager Administration Guide

e Cisco CallManager Features and Services Guide
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CHAPTER

Working with Call Pickup Groups

Call pickup groups allow you to pick up incoming calls within your own groups
or in other groups when you dial the appropriate pickup group number.

This chapter contains information on the following topics:

Important BAT Considerations, page 9-1
Creating a CSV File by Using BAT.xlt, page 9-2

Using a Text Editor to Create the CSV Data File for Call Pickup Groups,
page 9-3

Editing an Existing Call Pickup Group CSV File, page 9-4

Using Query to Delete Call Pickup Groups, page 9-5

Call Pickup Group CSV File Settings, page 9-6

Using BAT to Update the Cisco CallManager Database, page 9-7
BAT Settings for Updating the Cisco CallManager Database, page 9-9

Important BAT Considerations

Before you use BAT to configure call pickup groups, review the following
information:

When you add call pickup group settings for the first time, you can create a
CSV file through BAT.xIt or create a custom, text-based CSV file.

To update call pickup group settings, you can edit an existing CSV file or
create a custom, text-based CSV file.
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In the file/spreadsheet, do not enter two or more pickup group names (and
corresponding settings) on a single line. Designate a single line for each
pickup group name (and corresponding setting). For example, use the
following format when you enter information for pickup groups:

— (Pickup Group Name, Pickup Group Number, Partition, Other Pickup
Group Name-Memberl... Other Pickup Group Name-Member10)

— Marketing,7815,Part]l , Marketing,Managers, Training

When you add new pickup groups, you must complete all required fields like
the pickup group name, pickup group number, and partition. If the procedure
specifies an entry as mandatory, you must provide the information in the file.

Deleting information from a file and leaving the information blank does not
remove the information from the Cisco CallManager database; in other
words, a blank value does not overwrite an existing value in the database.
Updating the values overwrites the existing value in the database.

On the publisher database server, BAT provides directory for call pickup
groups, C:\BatFiles\CPG\Insert\. Make sure that you copy the appropriate
CSV files to the correct directory.

Any time that you create or change a CSV file, you must insert the CSV file
in BAT, as described in “Using BAT to Update the Cisco CallManager
Database” section on page 9-7.

Additional Information
See the “Related Topics” section on page 9-10.

Creating a CSV File by Using BAT.xIt

Step 1

To create a CSV file for call pickup groups by using BAT.xIt, perform the
following procedure:

Procedure

The BAT.xIt file exists on the publisher database server; however, you normally
do not have Microsoft Excel installed on the publisher database server. In that
case, you must copy the file from the publisher database server and move it to the
local machine, which must have Microsoft Excel installed.
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Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8

Step 9

Step 10

Using a Text Editor to Create the CSV Data File for Call Pickup Groups

Browse to C:\CiscoWebs\BAT\ExcelTemplate on the publisher database server.
Copy BAT.xlt to a local machine where Microsoft Excel is installed.

In Microsoft Excel, open BAT.xIt.

Click the Call Pickup Group tab.

Use Table 9-1 to enter call pickup group settings in the columns.

Repeat Step 6 until you enter all pickup groups.

To transfer the Excel spreadsheet format to a CSV file, click Export to BAT
Format.

The system automatically saves CSV files to C:\XIsDatafiles on the local
machine. To choose a different location to save the CSV file, click Browse and
select the desired location.

Copy the CSYV file to the C:\BatFiles\CPG\Insert\ directory on the publisher
database server.

You must add the CSV file to BAT. To insert the CSV file in BAT, see the “Using
BAT to Update the Cisco CallManager Database” section on page 9-7.

Additional Information
See the “Related Topics” section on page 9-10.

Using a Text Editor to Create the CSV Data File for
Call Pickup Groups

You can create the CSV data file by using lines of ASCII text with values
separated by commas. The comma separated values (CSV) file provides textual
information in tabular form. For more information about text-based CSV files for
call pickup groups, see the “Creating a Text-Based CSV File for Call Pickup
Groups” section on page A-31.

Additional Information
See the “Related Topics” section on page 9-10.
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Editing an Existing Call Pickup Group CSV File

Step 1

Step 2

A

You update existing codes by manually updating an existing CSV file in Notepad
or by creating a new file in Notepad.

Perform the following procedure:

Procedure

To edit an existing CSV file where you previously inserted call pickup groups
information, browse to the C:\BatFiles\CPG\Insert\ directory on the publisher
database server:

In Notepad, open and edit the existing CSV file; delete existing settings, add new
call pickup groups, or update existing settings by using the text-based
representation in Table 9-1.

To update a call pickup group CSV file, for example, you may enter
Marketing,7815,Part1,Marketing,Managers, Training, where Marketing is the
mandatory pickup group name, 7815 is the mandatory pickup group number.
Part] is the partition, Marketing, Managers, and Training are the other pickup
group names associated to the pickup group Marketing.

Caution

Step 3

Step 4

If you add new call pickup groups at the same time that you update them, make
sure that you enter all required information. You can change any part of an
existing record, but you must include the pickup group name and the pickup group
number. Deleting information and leaving it blank does not remove the
information from the database; a blank value does not overwrite an existing value
in the database, but, updating the value, for example, to Sales from Marketing,
from the preceding examples, overwrites the existing value in the database.

Copy the CSYV file to the C:\BatFiles\CPG\Insert\ directory on the publisher
database server:

You must add the CSV file to BAT. To insert the CSV file in BAT, see the “Using
BAT to Update the Cisco CallManager Database” section on page 9-7.
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Using Query to Delete Call Pickup Groups

Additional Information
See the “Related Topics” section on page 9-10.

Using Query to Delete Call Pickup Groups

Step 1
Step 2

Step 3

Step 4

Step 5

Step 6
Step 7

Step 8

You can delete Call pickup groups by creating a query to locate the pickup group
records you want to delete.

Use the following procedure to delete call pickup groups.

Procedure

In BAT, choose Configure > Pickup Group

In the Pickup Group Options window, choose Delete Pickup Groups and click
Next. The Delete Pickup Groups window displays.

In first Select Pickup Groups Where drop-down list box, choose the field to query
such as Pickup Group Number, Pickup Group Name, or Partition.

In the second drop-down list box, choose the search criteria such as begins with,
contains, ends with, is exactly, not equal to, is not empty, or is empty.

In the search field text box, choose or enter the value that you want to locate, such
as the call pickup group name from the list.

To add the defined filter to the query, click Add To Query.

To add multiple filters, you can click AND or OR, and to further define your
query, repeat Step 3 through Step 6.

To check that the query gives the results that you need, click View Query Results.

N

Note  Ensure that you have located the correct call pickup groups to delete.
Because the delete action is final, you cannot retrieve deleted records.

If you make a mistake, click the Clear Query button to remove the query; then,
return to Step 3 and restart.
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A

Caution

Step 9
Step 10

Step 11

If you do not enter any information in the query text box, the system deletes all
pickup group records. Because the delete action is final, you cannot retrieve
deleted records.

To delete the records, click Delete.

A message displays that advises you of approximately how long it will take to
delete the records from the Cisco CallManager database. You can cancel the
transaction or click OK to continue.

To display the log file that BAT generated, you can click the View Latest Log File
link. The log file displays the number of phones that were deleted and the number
of records that failed, including an error code. For more information on log files,
see the “BAT Log Files” section on page 13-1.

Additional Information

See the “Related Topics™ section on page 9-10.

Call Pickup Group CSV File Settings

Use Table 9-1 in conjunction with the following sections:
e Creating a CSV File by Using BAT.xIt, page 9-2

e Using a Text Editor to Create the CSV Data File for Call Pickup Groups,
page 9-3

e Editing an Existing Call Pickup Group CSV File, page 9-4
e Using Query to Delete Call Pickup Groups, page 9-5

Table 9-1 Configuration Settings for Call Pickup Group

Setting/Column Description

For CPG CSV file

Pickup Group Name For this mandatory field, enter a unique call pickup
group name of no more than 50 alphanumeric
characters.
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Table 9-1 Configuration Settings for Call Pickup Group

Setting/Column

Description

Pickup Group Number

For this mandatory field, enter a pickup group
number of no more than 24 digits that the user will
enter to pick up incoming calls.

Partition

Choose a route partition to which the directory
number belongs.

Note The directory number can appear in more
than one partition.

Note The combination of Pickup Group Number
and Partition should be unique.

This field is optional.

Other Pickup Group
Name-Member(x)

Enter the name of the other pickup group to be
associated with the new pickup group. This optional
field allows each pickup group to be associated with
ten other pickup groups.

Note  While associating this pickup group with
other pickup groups, make sure that this
pickup group is specified in the other Pickup
groups list

Additional Information

See the “Related Topics” section on page 9-10.

Using BAT to Update the Cisco CallManager
Database

To update the Cisco CallManager database, you must insert the call pickup group
CSV file in BAT. To update the database, perform the following procedure:
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I Using BAT to Update the Cisco CallManager Database

Step 1
Step 2

Step 3

Step 4

Step 5
Step 6

Step 7

Before You Begin

Before you can update Cisco CallManager, you must create or edit a call pickup
group CSV file and save to the following location on the publisher database server:
C:\BATFiles\CPG\Insert\

Procedure

In BAT, choose Configure > Pickup Group

In the Pickup Group Options window, choose Insert Pickup Groups and click
Next. The Insert Pickup Groups window displays.

In the File Name drop-down list box, choose the CSV file that contains the
updated pickup groups.

e

Tip To view the contents of the file that you want to insert, click View File.

If you updated an existing list of pickup groups, check the Override the existing
configuration check box, as described in Table 9-2.

Click Insert.

A confirmation dialog box indicates that the time it takes to complete the
operation. Click OK.

e

ﬂ To see the progression of the operation, click the Show Latest Status
button.

After the transaction completes, click View Latest Log File to view a log file that
indicates whether the system added all files successfully.

Additional Information
See the “Related Topics” section on page 9-10.
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BAT Settings for Updating the Cisco CallManager Database

BAT Settings for Updating the Cisco CallManager

Database

Use Table 9-2 in conjunction with the “Using BAT to Update the
Cisco CallManager Database” section on page 9-7.

Table 9-2  Settings in BAT for Inserting CSV Files

Setting in BAT

Description

Field Name

From the drop-down list box, choose the call pickup
file that you want to insert.

Override the existing
configuration

This check box applies if you are updating code for
existing settings.

Checking this check box overwrites the other pickup
group name- members with the information that is
contained in the file that you want to insert. If you do
not check the check box, an error, which writes to the
log file, indicates that the other pickup group name
already exists; therefore, no updates occur.

Note  For each pickup group, ensure the
combination of Pickup Group Number and
Partition is unique.

Note = While updating pickup groups, Pickup Group
Number and Partition values will be ignored
and existing Other Pickup Groups will be
disassociated.

Call Pickup Group Notificatio

n Settings

Call Pickup Group
Notification Policy

From the drop-down list box, choose one of the
following notification types:

e No Alert

e Audio Alert

e Visual Alert

e Audio and Visual Alert
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Table 9-2  Settings in BAT for Inserting CSV Files (continued)

Call Pickup Group Enter the seconds of delay (integer in the range of 1
Notification Timer to 300) between the time that the call first comes into
the original called party and the time that the
notification to the rest of the call pickup group is to
occur.

Additional Information
See the “Related Topics” section on page 9-10.

Related Topics

e Creating a CSV File by Using BAT.xlt, page 9-2

e Using a Text Editor to Create the CSV Data File for Call Pickup Groups,
page 9-3

e Editing an Existing Call Pickup Group CSV File, page 9-4

e (Call Pickup Group CSV File Settings, page 9-6

e Using Query to Delete Call Pickup Groups, page 9-5

e BAT Settings for Updating the Cisco CallManager Database, page 9-9
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Working with the Export Utility

System administrators need the ability to move large numbers of phone records to
another Cisco CallManager database due to department moves, reorganizations,
or equipment upgrades.The export utility in BAT gives you the ability to export
large numbers of phone, user, and user device profile records from a

Cisco CallManager database to a data file in CSV format. Then you can import
the records into a different Cisco CallManager database. You can edit the CSV
data file with a text editor, but you must use care because the file is very complex.

When BAT exports phones from the Cisco CallManager database, the phone
model and number of lines on the models are the basis for organizing the data.
Keep in mind that a BAT data file must contain records for one phone model only.
When you are using the Export Specific Details option, BAT generates separate
data files for a phone model with one line and another data input file for the same
model phone with two lines.

To assist the administrator with the export function, a Device Summary Report
provides a snapshot view of all phone models and configured lines in the
Cisco CallManager database.

Additional Information

See the “Related Topics™ section on page 10-19.
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Bl Moving Records from one Cisco CallManager Server to Another

Moving Records from one Cisco CallManager Server
to Another

You can use the export utility to merge records from multiple Cisco CallManager
servers onto one Cisco CallManager server. Use this procedure to move records
from one Cisco CallManager server to another. Only export the records that you
are interested in moving. Perform the following procedures:

1. Exporting User Records, page 10-11
Exporting Phone Records, page 10-7
Exporting User Device Profile Records, page 10-17

& w DN

(Optional) Edit the CSV file with a text editor. The record format must follow
the format that is specified for that file format. For example, records for
phones need to follow the phone file format.

A

Caution  Use extreme care when editing the CSV file. Phones might not work if you insert
records that are in the wrong format.

5. Copy the CSV file to the appropriate folder on the publisher database server:
— Phone files to the C:\BATFiles\Phones\ Insert\ folder.
— User files to the C:\BATFiles\Users\Insert Users\ folder
— User device profile files to the C:\BATFiles\User Device Profiles\ folder.

A

Caution  Because the order in which the records are inserted is important, you must insert
user records first. This ensures that devices properly associate with existing users.

6. Insert User Records. Configure attributes that were not exported.
— Enable authentication proxy rights
— Enable CTI Application usage
- Call Park Retrieval allowed
— Enable Calling Party Number modification

1. Insert Phone Records.
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8. Insert User Device Profile Records.
9. Check the log files for errors. See the “Viewing Export Log Files” section on
page 10-18.

Additional Information
See the “Related Topics™ section on page 10-19.

Using Phone Export

You can choose between two file format options when you are exporting phone
records:

Default Phone—For phones that have similar configurations.

All Phone Details—For phones that have different line configurations, such as
multiple partitions or calling search spaces.

Default Phone File Format

Choosing Default phone file format allows you to export records by using a
defined query. You can only export phone records for specific phone type with a
fixed number of lines when you choose to export by using a defined query. For
example, if you want to export some records for a Cisco IP Phone model 7960
with one line and some records for a Cisco IP Phone model 7960 with two lines,

you will need to use two different queries, and you will get two different CSV
files.

Table 10-1 lists the fields that are exported when you choose the Default Phone
file format.

Table 10-1 Exported Fields in the Default Phone File Format

Field Types Exported Fields
Device Fields MAC Address, Description, Location
Line Fields Directory Number, Display, Line Text Label, Forward

Busy External, Forward Busy Internal, Forward No
Answer Internal, Forward No Answer External, Forward
No Coverage Internal, Forward No Coverage External,
Call Pickup Group
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Table 10-1 Exported Fields in the Default Phone File Format (continued)

Field Types Exported Fields
User Fields User ID
Speed Dials Speed Dials

All Phone Details File Format

When you export phone records by using All Phone Details option, you export
phone records for a particular model of phone along with all the device field
information, different line attributes, and services that are associated with the
phone. You cannot use the query to limit the number of records.

Table 10-2 lists the fields that are exported when you choose the All Phone Details
file format.

~

Note  The device name, not the MAC Address, gets saved when you choose to
export by using the All Phone Details file format.

Table 10-2 Exported Fields in the All Phone Details File Format

Field Types Exported Fields

Device Fields Device Name, Description, Owner User ID, Device Pool,
CSS, AAR CSS, Media Resource Group List, User Hold
Audio Source, Network Hold Audio Source, Location,
User Locale, Network Locale, Phone Button Template,
Expansion Module type I, Expansion Module type 11,
Softkey Template, Phone Load Name, Module 1 Load
Name, Module 2 Load Name, Login user ID, Built in
Bridge, MLPP Indication, MLPP Preemption, MLPP
Domain, Retry Video call as Audio, Privacy, Security
Mode, Ignore Presentation Indicators, Single Packet
Capture mode, Packet Capture Duration, Certificate
Operation, Authentication Mode, Authentication String,
Key Size (bits), Operation Completes By,
CommonProfile, DeviceMobilityMode, AAR
Neighborhood, Logged to Hunt Group.
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Table 10-2 Exported Fields in the All Phone Details File Format (continued)

Field Types Exported Fields
Model Specific Information, Directory, Messages, Services,
Device Fields Authentication Server, Proxy Server, Idle, Idle Timer,

Enable Extension Mobility, Logout Profile, Login User
ID, Login Time, Logout Time, Product Specific XML
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Table 10-2 Exported Fields in the All Phone Details File Format (continued)

Field Types Exported Fields

Line Fields Directory Number, Partition, Voice Mail Profile, Line
CSS, AAR Group, Line User Hold Audio Source, Line
Network Hold Audio Source, Auto Answer, Forward All
to Voice Mail, Forward All Destination, Forward All
CSS, Forward Busy External to Voice Mail, Forward
Busy External Destination, Forward Busy External CSS,
Forward No Answer External to Voice Mail, Forward No
Answer External Destination, Forward No Answer
External CSS, Forward On Failure to Voice Mail,
Forward On Failure Destination, Forward on Failure
CSS, Call pickup group, Forward Busy Internal to Voice
Mail, Forward Busy Internal Destination, Forward Busy
Internal CSS, Forward No Answer Internal to Voice
Mail, Forward No Answer Internal Destination, Forward
No Answer Internal CSS, Forward No Call Coverage
External to Voice Mail, Forward No Call Coverage
External Destination, Forward No Call Coverage
External CSS, Forward No Call Coverage Internal to
Voice Mail, Forward No Call Coverage Internal
Destination, Forward No Call Coverage Internal CSS,
Display, External Phone Number Mask, Message
Waiting Lamp Policy, Ring Setting When Idle, Line Text
Label, Ring Setting When Active, No Answer Ring
Duration, MLPP Target Destination, MLPP Calling
Search Space, MLPP No Answer Ring Duration, Max
Num Calls, Busy Trigger, Call Info Display Mask,
Alerting Name, AARVoiceMailEnabled,
AARDestinationMask, AARKeepCallHistory, Call
forward Unregistered Internal Voice Mail Enabled, Call
forward Unregistered Internal Destination, Call forward
Unregistered Internal CallingSearchSpace, Call forward
Unregistered External VoiceMailEnabled, Call forward
Unregistered External Destination, Call forward
Unregistered External CallingSearchSpace, Call Pickup
Group Audio Alert Setting(Phone Idle), Call Pickup
Group Audio Alert Setting(Phone Active).
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Table 10-2 Exported Fields in the All Phone Details File Format (continued)

Field Types Exported Fields

User Fields User ID

Speed Dials Speed Dial Number, Speed Dial Label

Services Service Name, Subscribed Service Name, Parameter
Name, Parameter Value

Additional Information
See the “Related Topics™ section on page 10-19.

Exporting Phone Records

To export phone records from Cisco CallManager, use this procedure.

Procedure

Step1  Choose Configure > Phones. The Phones Options window displays.

Step2  Click the Export Phones radio button and click Next. The Export Phones window
displays.

Step3  In the Export file name field, enter your file name.

Step 4 In the File Format Name field, choose either the Default Phone or All Phone

Details file format. Your choice determines the export option and sets the
appropriate export option radio button.

¢ For All Phone Details file format, choose the type of device or specific model
in the Model list box under the All Details radio button. See Table 10-1 for
the list of exported fields in this format. Skip to Step 6.

e For Default Phone file format, choose the type of device or specific model in
the Model list box under the Specific Details radio button. See Table 10-2 for
the list of exported fields in the default phone format.

Step5  You can customize the export file by choosing which set of phones to export, but
the phone details are not configurable. Choose from the following fields:

a. Enter the number of lines for this phone model.
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Step 6
Step 7

Step 8

b. Inthe first drop-down list box, choose the field to query such as Device Name
or Location.

c. In the second drop-down list box, choose the search criteria such as begins
with, contains, or is empty.

d. In the search field/list box, either choose or enter the value that you want to
locate, such as a device name.

e. To add the defined filter to the query, click Add To Query. You can click
AND or OR to add multiple filters and repeat Substep b. through Substep d.
to further define your query.

f. If you make a mistake, click the Clear Query button to remove the query;
then, return to Substep b. and restart.

g. To verify that the exported records are correct, click View Query Result.
To export the records, click Export, at the top left of the page.

A message advises you of approximately how long it will take to export the
records from the Cisco CallManager database. You can cancel the transaction or
click OK to continue.

When the transaction completes, BAT displays either an Export Completed or
Export Failed status. If BAT failed to export all the records, BAT displays an
Export Failed message.

To display the log file that was generated by BAT, click on the View Latest Log
File link. The log file indicates the number of phone records that were exported,
the number of phone records that failed to export, including the error code, the
number of export files that were created, and the location of the files.

You can also view or download the exported file by choosing the View/Download
Exported File link. The link does not display if BAT creates more than one export
file.

Additional Information

See the “Related Topics™ section on page 10-19.
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Locating the Exported Phone Records

BAT saves the exported file at C:\BatFiles\Export\Phones\ on the publisher server.

Use the file name to guide you in reconfiguring the lines when you are inserting
phones. When you export files by using the specific detail option, the export
utility appends a numerical suffix _n to the export file name to indicate the
number of lines that are configured on a phone. For example, if you entered the
export file name as “sales,” and you have two-line phones with lines 1 and 3
configured, the name of the file will be sales_1I_3.txt.

When you export phones with dummy MAC addresses, the export utility appends
“bat” and a numerical suffix _n to the export file name. For example, if you
entered “newsales” as the export file name for phones with dummy MAC
addresses, the name of the file will be newsales_bat_1.txt.

Additional Information

See the “Related Topics™ section on page 10-19.

Exporting and Importing Phones with More Than One User

When you export phone records that have multiple users who control a phone, the
export utility generates a unique phone record for each user. The phone
information remains the same, but each record has a different user ID.

When you import the exported file that has phones with multiple users, the first
phone record inserts with the associated user. Be aware that subsequent phone
records fail to insert, but BAT attempts to insert all records and does accept the
user association to the phone.

The log file for the import transaction will show that the phone insertions failed
for all users except the first user that is associated with the phone.

Additional Information
See the “Related Topics™ section on page 10-19.
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Using User Export

When you use BAT to export user records, the export utility sorts users according
to the organizational hierarchy in the directory. The export utility examines the
value that was entered in the manager user ID field and puts users that are on the
same reporting level into the same file. The Export utility modifies the file name
by appending the suffix “_user” or “_MgrLevel#,” where # represents a number 1
through 20.

The user ID for a manager must exist in the directory prior to its use in the
manager user ID field in the user record. Insert the files in descending order based
on the manager level numeral suffix. Insert the file with the user suffix last to
ensure that the user records for managers exist prior to using them.

For Active Directory users, passwords do not get exported. PINs get exported in
cleartext. You must use Active Directory to set passwords for users after
importing the records.

The export utility only exports the default user device profile that is associated
with a user. You must insert the other user device profiles for that user separately
by using Cisco CallManager Administrator.

Export puts the following settings in the same file:
e CTI application use
e (Call park retrieval allowed
e Enable authentication proxy rights
e (Calling party number modification

The export utility appends the suffix _t (enabled) or _f (disabled) for each
different setting to the file name. The order of the suffix flags in the file name
specifies authentication proxy rights, CTI application use, call park retrieval, and
Calling party number modification.

For example, you create an export file Test.txt by using the export utility.

Cisco CallManager database has user TomT with manager MarieA, and Marie A
has manager JamesM. If TomT has Proxy Authentication rights enabled, CTI
application use and Call Park Retrieval disabled, and MarieA and JamesM have
Proxy Authentication rights and CTI application usage enabled call park retrieval
disabled, and calling party number modification enabled, the Export utility saves
the user information in three different files. You will find TomT in the CSV
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fileTest_user_t_f_f_t.txt, MarieA in the CSV file test_MgrLevell_t_t_f_t, and

JamesM in the CSV file Test_MgrLevel2_t_t_f_t. Table 10-3 illustrates this
example.

Table 10-3 Example

Initial File Name Test

Proxy Calling Party

Authentica |CTI Call Park |Number
UserID |Manager tion Rights |Application |Retrieval |Modification |Resulting File Name
TomT MariaA |Enable Disable Disable Enable Test_user_t f f t.txt
MariaA |JamesM |Enable Enable Disable Enable Test_MgrLevell_t_t_f_t.txt
JamesM Enable Enable Disable Enable Test_MgrLevel2_t_t_f_t.txt

Use the suffix to guide you in choosing the correct settings for Proxy
Authentication rights, CTI application use, Call Park Retrieval, and Calling Party
Number Modification when you insert users.

Additional Information
See the “Related Topics™ section on page 10-19.

Exporting User Records

When you export user records, some users might have a blank PIN because these
user records were created prior to Cisco CallManager 3.1. If this is the case, you
must specify a default PIN before reinserting the user records in the BAT user
interface.

Use this procedure to export User records from Cisco CallManager.

Procedure

Step1  Choose Configure > Users. The User Options windows displays.
Step2  Click the Export Users radio button and click Next.
The Export Users window displays.
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Step 3

Step 4

Step 5

Step 6
Step 7

Step 8

Step 9
Step 10

Step 11

Step 12

In the Export file name field, enter your file name for the export file.

In the File Format Name field, choose the file format. The current default specifies
Default Users.

In the first drop-down list box, choose a field to query such as User ID,
Department, First Name, or Last Name.

In the second drop-down list box, choose contains or is exactly.

In the third box, which is the search field/list box, enter the value that you want
to locate, such as a specific name or User ID.

A

Note  To choose users from more than one department, enter multiple
departments in this field. For example, to choose users from departments
12 and 34, enter 12, 34 in the third box instead of performing two
operations.

To add the defined filter to the query, click Add To Query button.

If you make a mistake, click the Clear Query button to remove the query; then,
return to Step 5 and start over.

To display the records that are going to be exported, click View Query Result.
To export the chosen user records, click Export.

A message displays that advises you of approximately how long it will take to
export the records from the Cisco CallManager database. You can cancel the
transaction or click OK to continue.

When the transaction completes, BAT displays either an Export Completed or
Export Failed status. If BAT failed to export all the records, BAT displays an
Export Failed message.

To display the log file that was generated by BAT, click on the View Latest Log
File link. The log file indicates the number of phone records that were exported,
the number of phone records that failed to export, including the error code, the
number of export files that were created, and the location of the files.

You can view or download the exported file by choosing the View/Download
Exported File link. The link does not display if BAT creates more than one export
file.
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BAT saves the exported file at C:\BatFiles\Export\Users\ on the publisher server.

Additional Information
See the “Related Topics™ section on page 10-19.

Using User Device Profile Export

You can choose between two file format names when you are exporting user
device profile records:

e All User Device Profile Details

e Default User Device Profile Details

All User Device Profile Details Format

For phones that have different line configurations, such as multiple partitions or
calling search spaces, use the All User Device Profile Details format.

Table 10-4 lists the fields that are exported when you choose the All User Device
Profile Details file format.
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Table 10-4 Exported Fields in the All User Device Profile Details File Format

Field Types

Exported Fields

Device Fields

User Device Profile Name, Description, Device Pool,
Calling Search Space, AAR Calling Search Space, Media
Resource Group List, User Hold Audio Service, Network
Hold Audio Source, Login User ID, User Locale,
Network Locale, Phone Button Template, Expansion
Module Type I, Expansion Module Type II, Softkey
Template, Phone Load Name, Module 1 Load Name,
Module 2 Load Name, MLPP Indication, MLPP
Preemption, MLPP Domain

Model Specific
Device Fields

Information, Directory, Messages, Services,
Authentication Server, Proxy Server, Idle, Idle Timer,
Enable Extension Mobility, Logout Profile, Login User
ID, Login Time, Logout Time
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Table 10-4 Exported Fields in the All User Device Profile Details File Format

Field Types Exported Fields

Line Fields Directory Number, Partition, Voice Mail Profile, Line
CSS, AAR Group, Line User Hold Audio Source, Line
Network Hold Audio Source, Auto Answer, Forward All
to Voice Mail, Forward All Destination, Forward All
CSS, Forward Busy External to Voice Mail, Forward
Busy External Destination, Forward Busy External CSS,
Forward No Answer External to Voice Mail, Forward No
Answer External Destination, Forward No Answer
External CSS, Forward On Failure to Voice Mail,
Forward On Failure Destination, Forward on Failure
CSS, Call pickup group, Forward Busy Internal to Voice
Mail, Forward Busy Internal Destination, Forward Busy
Internal CSS, Forward No Answer Internal to Voice
Mail, Forward No Answer Internal Destination, Forward
No Answer Internal CSS, Forward No Call Coverage
External to Voice Mail, Forward No Call Coverage
External Destination, Forward No Call Coverage
External CSS, Forward No Call Coverage Internal to
Voice Mail, Forward No Call Coverage Internal
Destination, Forward No Call Coverage Internal CSS,
Display, External Phone Number Mask, Message
Waiting Lamp Policy, Ring Setting When Idle, Line Text
Label, Ring Setting When Active, No Answer Ring
Duration, MLPP Target Destination, MLPP Calling
Search Space, MLPP No Answer Ring Duration, Max
Num Calls, Busy Trigger, Call Info Display Mask,
Alerting Name, AARVoiceMailEnabled,
AARDestinationMask, AARKeepCallHistory, Call
forward Unregistered Internal Voice Mail Enabled, Call
forward Unregistered Internal Destination, Call forward
Unregistered Internal CallingSearchSpace, Call forward
Unregistered External VoiceMailEnabled, Call forward
Unregistered External Destination, Call forward
Unregistered External CallingSearchSpace, Call Pickup
Group Audio Alert Setting(Phone Idle), Call Pickup
Group Audio Alert Setting(Phone Active).
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Table 10-4 Exported Fields in the All User Device Profile Details File Format

Field Types Exported Fields

User Fields User ID

Speed Dials Speed Dial Number, Speed Dial Label

Services Service Name, Subscribed Service Name, Parameter
Name, Parameter Value

Default User Device Profile Format

To export a limited set of details that are associated with the user device profile,
use the Default User Device Profile format. You can choose specific query options
to customize the export file.

Table 10-5 lists the fields that can be exported when you choose the Default User
Device Profile format.

Table 10-5 Exported Fields in the Default User Device Profile File Format

Field Types Exported Fields
Device Fields MAC Address, Description, Login User ID
Line Fields Directory Number,Display,Line Text Label,Forward

Busy External,Forward Busy Internal,Forward No
Answer External,Forward No Answer Internal, Forward
No Coverage External,Forward No Coverage
Internal,Call pickup group

Speed Dials Speed Dials

Additional Information

See the “Related Topics™ section on page 10-19.
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Exporting User Device Profile Records

Step 1

Step 2

Step 3
Step 4

To export user device profiles from Cisco CallManager, use this procedure.

Procedure

From BAT, choose Configure > User Device Profiles. The User Device Profile
Options window displays.

Choose Export User Device Profiles. The Export User Device Profiles window
displays.

In the Export File Name field, enter the file name that you want to use.

In the File Format Name field, choose one of these options. Your file format
selection sets the appropriate export option radio button.

All User Device Profiles Details—To export all the line attributes, services and
User IDs that are associated with the user device profile, you must complete the
following fields:

e Choose the type of device or specific model in the Model list box under the
All Details radio button.

e Specify the number of lines and click Add to Query.
e Skip to Step 5.

Default User Device Profile Details—To export a limited set of details that are
associated with the user device profile, use this option.

To customize the export file, you can set any of the following detail options or
choose None.

e In the first drop-down list box, choose one of the query options: Device
Name, Description, or Directory Number.

e In the second drop-down list box, choose one of the query conditions:
contains, is exactly, not equal to, begins with, ends with, is empty, or is not
empty.

e In the third box, which is the search field/list box, enter the value that you
want to locate, such as a specific directory number.

e To add the defined filter to the query, click Add To Query.
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Step 5

Step 6

Step 7

Step 8

e To display the records that are going to be exported, click View Query
Result.

¢ If you make a mistake, click the Clear Query button to remove the query and
start over.

After making choices for the Export Options, click Export, at the top of the
window, to export the chosen user device profile records.

A message advises you of approximately how long it will take to export the
records in the Cisco CallManager database.

You can cancel the transaction or click OK to continue.

BAT displays either an Export Completed or Export Failed in the Status area
above the Export button.

To display the log file that indicates the number of user device profile records that
were exported and the number of user device profile records that failed to export,
including the error code, click the View Latest Log File link.

View or download the exported file by choosing the View/Download Exported
File link.

BAT saves the exported file at C:\BatFiles\Export\User Device Profiles\ on the
publisher server.

Additional Information
See the “Related Topics™ section on page 10-19.

Viewing Export Log Files

BAT generates log files for each export transaction and stores them on the
publisher database server in the following location: C:\Program
Files\Cisco\Trace\BAT\Export directory.

Clicking View Latest Log File link displays the summary view for the export
transaction as well as the detail view for the failures.

To view the log file for the export operation, click View Latest Log File link in
the export window or go to the following location:

C:\Program Files\Cisco\Trace\BAT\Export directory
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The log file name uses the following format:
<Type of Record export>_<The chosen file name>#timestamp

The timestamp format for the log file name specifies mmddyyyyhhmmss.

Additional Information
See the “Related Topics™ section on page 10-19.

Related Topics

e Moving Records from one Cisco CallManager Server to Another, page 10-2
e Using Phone Export, page 10-3

e Using User Export, page 10-10

e Using User Device Profile Export, page 10-13

e Viewing Export Log Files, page 10-18

¢ Inserting Phones into Cisco CallManager, page 3-56

e Inserting Users to Cisco CallManager, page 4-6

e Inserting User Device Profiles, page 6-27

e BAT Log Files, page 13-1
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Generating Reports

BAT provides reports to help you manage records effectively. You can create and
save reports that provide information about phones, users, user device profiles,
managers and assistants, and gateway records. You can save these reports with a
filename and store them in a folder on the publisher server to review and print.

You can customize BAT reports for phones and for user device profiles to meet
your particular needs by choosing items from a list of device fields and line fields.
You can also choose how to arrange the fields in the report. The system generates
the report in the CSV file format. Because reports for users, managers, assistants,
and gateways have a fixed format, you cannot customize them.

Example

You need to have a list of all the directory numbers with their forwarding
destinations by phone model. You can generate a Phone Report for the Cisco IP
Phone model 7960 and choose these query details: Device Name, Directory
Number, Forward Busy Destination, Forward No Answer Destination, and Label.
You can arrange the report fields, so the Label field follows the Directory Number
field and precedes the two forward destination numbers.

Additional Information
See the “Related Topics” section on page 11-15.

Generating Reports for Phones

To generate reports for phones and other IP telephony devices, use this procedure.
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Step 1

Step 2

Step 3

Step 4
Step 5

Step 6

Procedure

From the Phone Options window, choose Generate Phones Reports and click
Next. The Phones Reports (Step 1 of 2) window displays.

You can generate a report for all phones by not specifying a query, or you can
generate a report for a specific phone model or phone attribute by using following
steps:

a. In Select Phones to Query drop-down list box, choose the field to query such
as Model or Directory Number.

b. In the second drop-down list box, choose the search criteria such as begins
with, contains, or is empty.

c. In the search field/list box, either choose or enter the value that you want to
locate, such as the model name from the list or directory number range.

d. To add the defined filter to the query, click Add To Query.

e. To add multiple filters, you can click AND or OR and repeat substep a.
through substep d. to further define your query.

f. To check that the report includes the information that you need, click View
Query Results.

If you make a mistake, click the Clear Query button to remove the query;
then, return to substep a. and restart.

Click Next to choose details for your type of report. The Phone Reports
Step 2 of 2 window displays and shows the Query that you chose. If you want to
change the type of query, click Back.

In the Report File Name field, enter your name for this report (required).

In the Available Device Fields drop-down list box, choose a device item and click
the arrow to move the item into the Selected Fields for this Report list. You can
choose one or more fields to include in your report. For a list of device and live
fields, see the “Reports for Phones and IP Telephony Devices” section on

page 11-3.

Arrange the order of the items in the Selected Device Fields for this Report list by
choosing an item and clicking the Up arrow or Down arrow to move the item to
another position in the list.
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Step 7

Step 8

Step 9
Step 10

Step 11

Step 12

Note

Generating Reports for Phones W

In the Available Line Fields drop-down list box, choose a line item and click the
arrow to move the item into the Selected Fields for this Report list. You can
choose one or more fields to include in your report.

Arrange the order of the line items in the Selected Line Fields for this Report list
by choosing an item and clicking the Up arrow or Down arrow to move the item
to another position in the list.

~

Note  You must specify at least one device or line field to generate a report.

To create the report, click Generate.

A message advises you of approximately how long it will take to generate the
report from the Cisco CallManager database. You can cancel the transaction or
click OK to continue.

BAT displays either a Report Completed or Report Failed in the Status area of the
first window.

To display the log file for this report, click View Latest Log File. The log file
indicates the type of query and the resulting number of phone records that passed
successfully in the report.It also shows the number of phone records that failed to
to generate in the report.

To display results for this report, click View Latest Report File. The type of
query displays at the top and the header displays the field names in the order that
you specified for the report. The report shows the query results in CSV format.

BAT saves the report file at C:\BatFiles\Reports\Phones\ on the publisher server.

Additional Information
See the “Related Topics™ section on page 11-15.

Reports for Phones and IP Telephony Devices

You can produce phone reports for all phones and IP telephony devices or limit
the report to one of these options:
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Phone Model—Choose one from the list of models that are configured in the
cluster.

Device Name—Specify a filter or use exact name.
Description—Specify a filter or use exact description.
Phone Load Name—Specify a filter or use exact name.

Device Pool—Choose one from a list of device pools that are configured in
the cluster.

Calling Search Space—Choose one from a list of CSS that are configured in
the cluster.

Location—Choose one from a list of locations that are configured in the
cluster.

Directory Number—Specify a filter or use exact number.

After choosing the phone report type, you can choose the device and line details
to include in the report.

You can choose from these Device fields:

Model

Device Name

Description

Device Pool

Calling Search Space
Location

Extension Mobility

User Hold Audio Source
Network Hold Audio Source
Media Resource Group List
User Locale

Network Locale

You can choose from these Line fields:

Directory Number

Partition
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e (CSS (Line)

e User Hold Audio Source

e Network Hold Audio Source

e (CSS (Forward All)

e CSS (Forward Busy External)

e CSS (Forward Busy Internal)

e (CSS (Forward No Answer External)

e CSS (Forward No Answer Internal)

e (CSS (Forward On Failure)

e CSS (Forward No Coverage External)

e CSS (Forward No Coverage Internal)

e Forward All Destination

e Forward Busy Destination External

e Forward Busy Destination Internal

e Forward No Answer Destination External
e Forward No Answer Destination Internal
e Forward on Failure Destination

e Forward No Coverage Destination External
e Forward No Coverage Destination Internal
e Display

e Label

Additional Information
See the “Related Topics™ section on page 11-15.
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Producing a List of Phones with Dummy MAC Addresses

Step 1

Step 2
Step 3
Step 4

Step 5

Step 6
Step 7

To generate a list of phones that are using dummy MAC addresses, use the
following procedure.

Procedure

From the Phone Options window, choose Generate Phone Reports. The Phone
Reports Step 1 of 2 window displays.

In the first drop-down list box, choose Device Name.
In the second drop-down list box, choose begins with.

In the field, enter BAT. All phones that are added with a dummy MAC address
have device names that begin with BAT.

Click Add To Query. The text Device Name begins with ‘BAT’ and displays in
the query text box.

Click Next. The Phone Reports Step 2 of 2 displays.

Complete the report by going to Step 4 in the procedure for Generating Reports
for Phones.

Additional Information
See the “Related Topics” section on page 11-15.

Generating Reports for Users

Reports for users have a fixed format. You can generate a report for all users by
not specifying any query options, or you can specify a limited set of query
options.

To generate a report for users, use this procedure.
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Step 1

Step 2
Step 3

Step 4
Step 5

Step 6

Step 7

Generating Reports for Users Il

Procedure

From the User Options window, choose Generate User Reports and click Next.
The User Reports window displays.

In the Report File Name field, enter your name for this report (required).

You can generate a report for all users by not specifying a Query, or you can
generate a report for specific users by using following steps:

a. In Select Users Where scroll box, choose from these query options: User ID,
Department, First Name, Last Name.

b. Inthe second drop-down list box, choose between the search criteria contains
or is exactly.

c. In the search field box, enter the value that you want to locate, such as the
exact user ID or the last name of a user.

You can add multiple values to the search field box by separating them with
a comma as shown in this example: JohnJ, PaulP, SueS, JoeJ

d. To add the defined filter to the query, click Add To Query.

e. To check that the report includes the information that you need, click View
Query Results.

If you make a mistake, click the Clear Query button to remove the query;
then, return to substep a. and restart.

To create the report, click Generate.

A message advises you of approximately how long it will take to generate the
report from the Cisco CallManager database. You can cancel the transaction or
click OK to continue.

BAT displays either Report Completed or Report Failed in the Status area of the
first window.

To display the log file for this report, click View Latest Log File. The log file
indicates the type of query and the resulting number of user records that passed
successfully in the report. It also shows the number of user records that failed to
generate in the report.
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Step 8

Note

Click View Latest Report File to display results for this report. The type of query
displays at the top and the header displays the field names. The report shows the
query results in CSV format.

BAT saves the report file at C:\BatFiles\Reports\Users\ on the publisher server.

Additional Information
See the “Related Topics” section on page 11-15.

Generating Reports for User Device Profiles

Step 1

Step 2

To produce reports for user device profiles, follow this procedure.

Procedure

From the User Device Profile Options window, choose Generate User Device
Profiles Report and click Next. The User Device Profiles Report Step 1 of 2
window displays.

You can generate a report for all user device profiles by not specifying a query, or
you can generate a report with specific attributes by using following steps:

a. In Select User Device Profiles where drop-down list box, choose the field to
query: Model, Device Name, or Description.

b. In the second drop-down list box, choose the search criteria such as begins
with, contains, or is empty.

¢. Inthe search field/list box, either choose the model name from the list or enter
the value that you want to locate.

d. Click Add To Query to add the defined filter to the query.

e. You can click AND or OR to add multiple filters and repeat substep a.
through substep d. to further define your query.

f. Click View Query Results to check that the report includes the information
that you need.
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Step 3

Step 4

Step 5
Step 6

Step 7

Step 8

Step 9

Step 10
Step 11

Step 12

Generating Reports for User Device Profiles W

If you make a mistake, click the Clear Query button to remove the query;
then, return to substep a. and restart.

To add these profiles to the report, click the Include Autogenerated Device
Profiles check box.

To choose details for your type of report, click Next. The User Device Profiles
Reports Step 2 of 2 window displays showing the Query that you chose. If you
want to change the type of query, click Back.

In the Report File Name field, enter your name for this report (required).

In the Available Device Fields drop-down list box, choose a device item and click
the arrow to move the item into the Selected Fields for this Report list. You can
choose one or more fields to include in your report.

Arrange the order of the items in the Selected Device Fields for this Report list by
choosing an item and clicking the Up arrow or Down arrow to move the item to
another position in the list.

In the Available Line Fields drop-down list box, choose a line item and click the
arrow to move the item into the Selected Fields for this Report list. You can
choose one or more fields to include in your report.

Arrange the order of the line items in the Selected Line Fields for this Report list
by choosing an item and clicking the Up arrow or Down arrow to move the item
to another position in the list.

N

Note  You must specify at least one device or line field to generate a report.

To create the report, click Generate.

A message advises you of approximately how long it will take to generate the
report from the Cisco CallManager database. You can cancel the transaction or
click OK to continue.

BAT displays either a Report Completed or Report Failed in the Status area of the
first window.

To display the log file for this report, click View Latest Log File. The log file
shows the type of query for the report and the number of user device profile
records that are included in the report.It also shows the number of user device
profile records that failed to generate in the report.
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Step13  To display results for this report, click View Latest Report File. The type of
query displays at the top and the header displays the field names in the order that
you specified for the report. The report shows the query results in CSV format.

BAT saves the report file at C:\BatFiles\Reports\UserDeviceProfiles\ on the
publisher server.

Additional Information
See the “Related Topics™ section on page 11-15.

Reports for User Device Profiles

You can produce reports for all user device profiles or limit the report to one of
these options:

¢ Model—Choose one from the list of models that are configured in the cluster
e Device Name—Specify a filter or use exact name
e Description—Specify a filter or use exact description

After choosing the report type, you can choose the device and line details to
include in the report.

You can choose from these Device fields:
e Model
e Device Profile Name
e Description
e User Hold Audio Source
e User Locale
You can choose from these Line fields:
e Directory Number
e Partition
e (CSS (Line)
e User Hold Audio Source
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Network Hold Audio Source

CSS (Forward All)

CSS (Forward Busy External)

CSS (Forward Busy Internal)

CSS (Forward No Answer External)

CSS (Forward No Answer Internal)

CSS (Forward on Failure)

CSS (Forward No Coverage External)
CSS (Forward No Coverage Internal)
Forward All Destination

Forward Busy Destination External
Forward Busy Destination Internal
Forward No Answer Destination External
Forward No Answer Destination Internal
Forward on Failure Destination

Forward No Coverage Destination External
Forward No Coverage Destination Internal
Display

Label

Additional Information
See the “Related Topics” section on page 11-15.

Generating Reports for Cisco VG200 Gateways

Reports for VG200 Gateways have a fixed format. You can generate a report for
all VG200 Gateways or for a limited set of gateways.

The system does not make reports available for the Catalyst 6000 (FXS) gateway.
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Step 1

Step 2
Step 3

Step 4
Step 5

Step 6

To generate a report for VG200 Gateways, use this procedure.

Procedure

From the VG200 Options window, choose Generate VG200 Gateway Reports
and click Next. The VG200 Gateway Reports window displays.

In the Report File Name field, enter your name for this report (required).

You can generate a report for all VG200 gateways by not specifying a query, or
you can generate a report for specific VG200 gateways by using following steps:

a. In Select VG200 Gateways where drop-down list box, choose from these
query options: MGCP Domain Name or Description.

b. In the second drop-down list box, choose one of the search criteria such as
contains, is exactly, or is empty.

c. In the search field box, enter the value that you want to locate, such as the
exact MGCP Domain Name or a letter that the name or descriptions contains.

d. To add the defined filter to the query, click Add To Query.

e. To add multiple filters, you can click AND or OR and repeat substep a.
through substep d. to further define your query.

f. To check that the report includes the information that you need, click View
Query Results.

If you make a mistake, click the Clear Query button to remove the query;
then, return to substep a. and restart.

To create the report, click Generate.

A message advises you of approximately how long it will take to generate the
report from the Cisco CallManager database. You can cancel the transaction or
click OK to continue.

BAT displays either Report Completed or Report Failed in the Status area of the
VG200 Gateway Report window.

To display the log file for this report, click View Latest Log File. The log file
shows the date and time, the type of query, and the number of records that are
included in the report. It also shows the number of records that failed to generate
in the report.
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Step 7

Generating Reports for IPMA Managers and Assistants 1l

To display results for this report, click View Latest Report File. The report name,
date and time of the report, and the type of query display at the top. The report
header displays the field names. The report shows the query results in CSV
format.

BAT saves the report file at C:\BatFiles\Reports\VG200Gateways\ on the
publisher server.

Additional Information
See the “Related Topics™ section on page 11-15.

Generating Reports for IPMA Managers and

Assistants

Step 1

Step 2
Step 3

Reports for Cisco IPMA managers and assistants have a fixed format. You can
generate a report by specifying a set of query options for either managers or
assistants.

To generate reports for managers or assistants, use this procedure.

Procedure

From the Manager/Assistant Options window, choose one of these options:

¢ Generate IPMA Manager Reports and click Next. The Manager Reports
window displays.

¢ Generate IPMA Assistant Reports and click Next. The Assistant Reports
window displays.
In the Report File Name field, enter your name for this report.
You can generate a report for all managers or assistants by not specifying a query,

or you can generate a report for specific managers or assistants by using following
steps:

a. In Select managers (or assistants) where scroll box, choose from these query
options: User ID, Department, First Name, Last Name.
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Step 4
Step 5

Step 6

Step 7

Note

b. In the second drop-down list box, choose between the search criteria:
contains or is exactly.

c. In the search field box, enter the value that you want to locate, such as the
exact user ID or the last name of a user.

You can add multiple values to the search field box by separating them with
a comma as shown in this example: JohnJ, PaulP, SueS, JoeJ

d. To add the defined filter to the query, click Add To Query.

e. To check that the report includes the information that you need, click View
Query Results.

If you make a mistake, click the Clear Query button to remove the query;
then, return to substep a. and restart.

To create the report, click Generate.

A message advises you of approximately how long it will take to generate the
report from the Cisco CallManager database. You can cancel the transaction or
click OK to continue.

BAT displays either Report Completed or Report Failed in the Status area of the
first window.

To display the log file for this report, click View Latest Log File. The log file
indicates the type of query and the resulting number of records that passed
successfully in the report.It also shows the number of records that failed to
generate in the report.

To display results for this report, click View Latest Report File. The type of
query displays at the top and the header displays the field names. The report
shows the query results in CSV format.

BAT saves the report file at C:\BatFiles\Reports\ManagesAssistants\ on the
publisher server.

Additional Information

See the “Related Topics™ section on page 11-15.
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Viewing Report Log Files

Viewing Report Log Files
BAT generates log files for each report transaction and stores them on the
publisher database server in the following location:
C:\Program Files\Cisco\Trace\BAT

Click the View Latest Log File link to display the summary view for the report
transaction as well as the detail view for the failures.

To view the log file for the report operation, click View Latest Log File link in
the report window or go to the following location:

C:\Program Files\Cisco\Trace\BAT
The log file name uses the following format:
Generate<item>#timestamp

The timestamp format for the log file name specifies mmddyyyyhhmmss.

Additional Information
See the “Related Topics™ section on page 11-15.

Related Topics

e Generating Reports for Phones, page 11-1

¢ Generating Reports for Users, page 11-6

e Generating Reports for User Device Profiles, page 11-8

e Generating Reports for Cisco VG200 Gateways, page 11-11

e Generating Reports for IPMA Managers and Assistants, page 11-13
e Viewing Report Log Files, page 11-15

e BAT Log Files, page 13-1
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Working with the Tool for
Auto-Registered Phones Support

The Tool for Auto-Registered Phone Support (TAPS) application enables phone
users to call the TAPS directory number and download the preconfigured phone
settings for the user's directory number. TAPS works in conjunction with

Cisco CallManager Administration to provide these capabilities:

Configure TAPS—Allows you to enable TAPS usage for all phones that use
auto-registration or to limit TAPS to only phones that are added through BAT with
dummy MAC addresses. See the “Configuring Auto-Registration Options for
TAPS” section on page 12-12.

Secure TAPS—Allows you to keep some directory numbers from being updated
through TAPS. See the “Setting Secure Directory Numbers” section on
page 12-13

User Locales for TAPS—Allows you to choose the languages for TAPS prompts.
See the “Setting User Locales for TAPS” section on page 12-16.

The following topics provide information about using, installing, and configuring
TAPS:

e Introducing TAPS, page 12-2

¢ Installing TAPS, page 12-5

e Configuring TAPS in Cisco CallManager, page 12-7
e Uninstalling TAPS, page 12-9

e Starting TAPS, page 12-10

e Stopping TAPS, page 12-11
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e Setting TAPS Options, page 12-11
e TAPS Information for End Users, page 12-18

Introducing TAPS

To work with auto-registration, you must install some TAPS components on the
Cisco CallManager publisher server. You must enable auto-registration in
Cisco CallManager Administration for TAPS to function.

The TAPS application also gets installed on the Cisco Customer Response
Solutions (Cisco CRS) server. TAPS requires the Cisco IP Interactive Voice
Response (IP IVR) application that runs on the Cisco CRS server for the user
interface and prompts.

Administrators need to provide instructions to tell end users how to use TAPS to
configure their new phones. For end user instructions, see the “TAPS Information
for End Users” section on page 12-18

Note Cisco recommends that you stop the TAPS service when you are not using TAPS
to add phones to Cisco CallManager database. See the “Stopping TAPS” section
on page 12-11.

Additional Information
See the “Related Topics™ section on page 12-19.

Auto-registration Options for TAPS

You can set the following options for using TAPS to update auto-registering
phones.

e Update MAC addresses and download a predefined configuration for new
phones.

e Reload the configuration for replacement phones.
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~

Note

Note

Introducing TAPS W

Make sure that the range of auto-registered phones on Cisco CallManager is
greater than or equal to the number of phones you want to use TAPS for. For more
information on configuring auto-registration information, see Cisco CallManager
Administration Guide.

Cisco recommends that you delete unassigned directory numbers that get created
after you use TAPS option. This will ensure that you do not need to increase
auto-registration range to use TAPS on more phones.

Using TAPS with New Phones

After BAT has added the new phone configurations with dummy MAC addresses
in Cisco CallManager Administration, you can plug the phones into the network.
You or the phone user can dial a TAPS directory number that causes the phone to
download its configuration. At the same time, the phone gets updated in

Cisco CallManager Administration with the correct MAC address. You must
make sure that Auto-registration is enabled in Cisco CallManager Administration
(System > Cisco CallManager) for TAPS to function.

~

Note It takes around 20-25 seconds for downloading phone profile and to make
necessary updates in publisher and directory.

Example

You have 100 new-hire employees starting on Monday. You must add these users
and their new phones to Cisco CallManager Administration. You can use BAT to
create a phone template for these 100 phones and a CSV data file for phones and
users. By using the dummy MAC address option in the CSV data file, you do not
need to add the individual MAC addresses for the new phones. With
auto-registration enabled in Cisco CallManager, you can plug the phones directly
into the network. You or the new employee can load the configuration by dialing
the TAPS directory number and following the voice-prompt instructions.
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Using TAPS for Reloading Configurations

When you must replace an existing phone that is not functioning, you can use
TAPS to download the existing phone configuration to the new phone. After the
user receives the new phone and plugs the phone into the network, the user dials
the TAPS directory number to download configuration for the previous phone.
The user makes no configuration changes during this process.

~

Note It takes around 20-25 seconds for downloading phone profile and to make
necessary updates in publisher and directory.

In Cisco CallManager Administration, you must enable auto-registration. You
must ensure that you configure TAPS usage for all phones to enable a user to
download an existing phone configuration. See the “Configuring
Auto-Registration Options for TAPS” section on page 12-12.

Example

John’s Cisco IP Phone 7940 gets short-circuited during a lightning storm. He
receives a new Cisco IP Phone 7940 and plugs it into the network. John can dial
the TAPS directory number, and the new phone will download the configuration
that was previously used for the damaged phone. TAPS automatically updates
device information in Cisco CallManager Administration.

Additional Information

See the “Related Topics™ section on page 12-19.

Secured Directory Numbers

Because TAPS can replace a directory number, you can protect certain directory
numbers from being overwritten. To protect important directory numbers, you can
use the Secure TAPS option. See the“Setting Secure Directory Numbers” section
on page 12-13 for more information.
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Example

The directory number 5000 provides voice-messaging access for your system.
You do not want a new user to mistakenly configure 5000 on the new phone. The
Secure TAPS option allows you to specify that TAPS cannot access directory
number “5000.”

Additional Information
See the “Related Topics™ section on page 12-19.

Language Prompts for TAPS Users

You can configure user prompts for TAPS to play in several languages.
Administrators can choose the languages to make available to users. See the
“Setting User Locales for TAPS” section on page 12-16.

If you need to use language prompts other than English prompts, make sure that
you installed the Cisco IP Telephony Locale Installer on every Cisco CallManager
and Cisco CRS server in the cluster before you install, upgrade, or configure
TAPS. Using the locale installer ensures that you have the latest translated text,
translated voice prompts, country-specific phone tones, and country-specific
gateways tones available for the phones. For more information on the Cisco IP
Telephony Locale Installer, refer to the specific locale installer documentation.

Additional Information
See the “Related Topics™ section on page 12-19.

Installing TAPS

This section provides information about installing, reinstalling, and uninstalling
TAPS. TAPS interfaces with both Cisco CallManager publisher server and
Cisco Customer Response Solution (CRS) 3.5(2) server; therefore, the
installation involves both of these servers.

During TAPS installation or reinstallation on the publisher database server, the
setup program halts the following services:

e IS Administration

¢ World Wide Web publishing
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Step 1

Step 2
Step 3
Step 4

e FTP publishing
These services restart when the installation is finished.

You cannot use Windows Terminal Services to install TAPS. You must install
TAPS directly from the Cisco CallManager publisher server and the Cisco CRS
server.

Before You Begin

The following prerequisites apply to the TAPS installation for BAT Release
5.2(1):

e Make sure that the publisher database for Cisco CallManager is configured
and running. The publisher database can reside on its own server or on the
same server as Cisco CallManager.

e Before installing TAPS, ensure that the latest BAT release is installed on the
publisher database server for Cisco CallManager.

¢ Have the IP address for the Cisco CallManager publisher server and the
private phrase for the installation procedure.

e Ensure the Cisco CRS server is configured. The Cisco CRS 3.5(2)
application can reside on its own dedicated server or can be co-located on the
same server as Cisco CallManager.

¢ Be sure to use the locale installer to create the country-specific TAPS
prompts.

e Ensure that the Windows 2000 Services window is closed.

To install TAPS, use this procedure.

Procedure

Log on with administrator privileges to the system that is running the publisher
database for Cisco CallManager (where you installed BAT).

Access Cisco Bulk Administration Tool.
Choose Applications > Install Plugins.

Find TAPS (Tool for Auto-Registered Phone Support) and double-click the setup
icon.
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Step 5

Step 6

Step 7

Step 8

Step 9

Installing TAPS W

The Welcome window for the installation wizard opens. This installation program
installs TAPS on the Cisco CallManager publisher server and the CRS
applications server at the same time, if applications are co-located on the same
server. Click Next.

N

Note  When you are installing TAPS in a network with a dedicated CRS server,
you must run the TAPS installation program again on the CRS server. Use
CRS online help for assistance with installation and configuration.

Enter the Cisco CallManager publisher server IP address in the IP Address field,
and click Next.

Enter the Private Phrase for the Cisco CallManager publisher server in the
Installing Cisco CallManager Components window and click Next.

The Installing TAPSonCCM and TAPSonAppsServer window displays a progress
bar that shows the status of the installation. Click Next to begin the installation.

The Installation Completed window displays when the installation ends. Click
Finish.

Additional Information

See the “Related Topics™ section on page 12-19.

Configuring TAPS in Cisco CallManager

Like other applications in the Cisco IP telephony system, TAPS has some
configuration requirements. You must add a CTI route point, CTI ports, and users
in Cisco CallManager Administration. You need only one CTI route point for the
TAPS application. You will need at least one CTI port to make TAPS available to
users, but you can configure more CTI ports for users if desired.

Use Cisco CallManager Administration for the following tasks:
e Create a CTI route point and assign it a unique directory number.

e Set call forward busy, call forward no answer, and call forward on failure to
the operator number on the TAPS CTI route point.
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e Create one or more CTI ports with directory numbers. You can create CTI
ports in BAT or in Cisco CallManager Administration.

TAPS supports a maximum number of sessions equal to the number of CTI
ports that are configured for TAPS. For example, if you have configured five
CTI ports, up to five users can dial into TAPS at same the time. The sixth
caller cannot connect to TAPS.

e Create a user. The TAPS route point and ports should be in the user’s control
devices list. Set “Enable CTI applications use” for the user.

¢ (Create an auto-registration partition/calling search space to prevent phones
that have auto-registered from dialing any directory number other than the
directory number that is assigned to the TAPS CTI route point. Restricting
access to this directory number ensures that users download the proper
configuration information for their phones.

For information about how to add or assign these values, see the
Cisco CallManager Administration Guide.

To start Cisco TAPS Service, you must use the Services window in Windows
2000.

Additional Information
See the “Related Topics™ section on page 12-19.

Configuring the TAPS Application in CRS Applications Server

You can review the Cisco CRS 3.5(2) Application Server documentation by
browsing to Cisco Voice Applications and Tools at http://www.cisco.com. Refer
to the Cisco Customer Response Administration Guide for instructions on how to
configure an application.

>
Note  When you are installing TAPS in a network with a dedicated CRS server,

you must run the TAPS installation program again on the CRS server. Use
CRS online help for assistance with installation and configuration.

Additional Information
See the “Related Topics” section on page 12-19.
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Uninstalling TAPS

Note

Step 1

Step 2

Step 3

The uninstall program removes the TAPS applications from the system when both
CRS and Cisco CallManager are running on the same server (co-located).

If Cisco CallManager publisher and CRS are installed on different servers, you
must remove TAPS from both servers. After completing the following steps on the
server that is running the publisher database for Cisco CallManager, you must
complete the uninstallation of TAPS on the Cisco CRS server.

If you uninstall BAT, the TAPS components remain installed on the server.You
cannot open the TAPS user interface because you must use the BAT Configure
menu to access the TAPS user interface. The TAPS directory number remains
available to users for updating phones

To uninstall TAPS by using the Add/Remove Programs in the Control Panel, use
the following procedure.

Procedure

On the server that is running the publisher database for Cisco CallManager,
choose Start > Settings > Control Panel> Add/Remove programs.

Choose TAPS and click the Change/Remove button. A message displays that
confirms the uninstall operation.

To uninstall TAPS, click Yes or No to cancel. The IIS Admin service stops, files
are deleted, and the IIS Admin service restarts.

Solution To exit the uninstallation, click OK.

For co-located systems, you have removed both the Cisco CallManager and CRS
components of TAPS.

If TAPS is also running on a dedicated CRS server, you must also complete the
steps in the “Completing TAPS Uninstallation” section on page 12-10.

Additional Information
See the “Related Topics” section on page 12-19.
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Completing TAPS Uninstallation

Step 1

Step 2

Step 3

Step 4

To uninstall TAPS from the Cisco CRS server, perform the following steps. This
procedure completes the TAPS uninstallation.

Procedure

On the Cisco CRS server, choose Start > Settings > Control Panel >
Add/Remove Programs.

Choose TAPS and click the Change/Remove button. A message displays that
confirms the uninstall operation.

To uninstall TAPS, click Yes or No to cancel. If you clicked Yes, TAPS uninstalls
from the Cisco CRS server.

To exit the uninstallation, click OK.

Additional Information
See the “Related Topics™ section on page 12-19.

Starting TAPS

Step 1

Step 2

You must manually start the TAPS service. Use this procedure to start TAPS.

Procedure

On the server that is running the publisher database for Cisco CallManager,
choose Start > Programs > Administrative Tools > Services.

The Services window displays.
Double-click or right-click Cisco TAPS and click Start.

The TAPS service now runs. If the service should fail, you must manually start
TAPS again.
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Note

Stopping TAPS W

Cisco recommends that you stop the TAPS service when you are not using TAPS
to add phones to Cisco CallManager database. See the “Stopping TAPS” section
on page 12-11.

Additional Information
See the “Related Topics™ section on page 12-19.

Stopping TAPS

Step 1

Step 2

Cisco recommends that you stop the TAPS service when you are not using TAPS
to add phones to Cisco CallManager database. Stop the TAPS service from the
Services window on the publisher server where BAT is installed.

Procedure

On the server that is running the publisher database for Cisco CallManager,
choose Start > Programs > Administrative Tools > Services. The Services
window displays.

In the list of services, double-click or right-click Cisco TAPS and click Stop.

Additional Information

See the “Related Topics™ section on page 12-19.

Setting TAPS Options

Administrators can choose how to use TAPS in their Cisco CallManager system.
These TAPS feature options provide more flexibility when allowing users to
update phones or download phone profiles. The TAPS options include:

e Configuring Auto-Registration Options for TAPS, page 12-12
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e Setting Secure Directory Numbers, page 12-13
e Setting User Locales for TAPS, page 12-16

To access TAPS Options, on the machine that is running BAT, choose Start >
Programs > Cisco CallManager 4.2> Bulk Admin Tool. The BAT main
window displays.

Choose Configure>TAPS and the TAPS Options window displays.

Configuring Auto-Registration Options for TAPS

Step 1

Step 2

Step 3

The Configure TAPS option provides two ways to use TAPS to update phones that
auto-register with the Cisco CallManager database.

e For phones that are added by using BAT and have a dummy MAC address.
e For existing phones in Cisco CallManager Administration

The default setting limits use of TAPS to phones that have a dummy MAC address
with a device name that starts with the prefix “BAT.”

You can set the Configure TAPS option to allow any phone to auto-register in the
Cisco CallManager system, including phones that have a standard MAC address.

To set the Configure TAPS option, use this procedure.

Procedure

In the TAPS Options window, choose Configure TAPS and click Next. The
Configure TAPS window displays.

Choose one of these two options:

¢ Allow Auto-Registered phones to reset with a profile with a dummy MAC
address.

TAPS updates only the phones that have the dummy MAC address option.
e Allow Auto-Registered phones to reset with any profile.
TAPS updates any phone that auto-registers.
Click Update. A status message indicates that the update completed.
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To return to the TAPS Options page, click Back.

Additional Information
See the “Related Topics™ section on page 12-19.

Setting Secure Directory Numbers

The Secure TAPS options let you specify directory numbers that TAPS cannot
access. Use this capability when you want to protect directory numbers from
being accidentally assigned to another phone.

To access TAPS Options, on the machine that is running BAT, choose Start >
Programs > Cisco CallManager 4.2> Bulk Admin Tool. The BAT main
window displays.

Choose Configure>TAPS and the TAPS Options window displays.

Additional Information
See the “Related Topics” section on page 12-19.

Restricting Directory Numbers

Step 1

Step 2

Step 3

Step 4

To block TAPS from using directory numbers that you specify, use this procedure.
TAPS cannot use any directory number that you include in the list of secured
directory numbers.

Procedure

In the TAPS Options window, choose Secure TAPS and click Next. The Secure
Directory Numbers window appears.

In the Directory Number field, enter the number that you want to protect from
TAPS.

Click Secure. A prompt tells you that the directory number was added to the list
of secured numbers.

Click OK.
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Step5  Continue to add directory numbers by repeating Step 2 through Step 4. When you
finish adding directory numbers, click View Secured DN.

A list box displays the directory numbers that you have protected. TAPS cannot
use the directory numbers that are shown in this list. If a user tries to update a
device profile by entering one of the directory numbers in this list, TAPS will
refuse the request.

A
Note  The View Secure DN list box does not automatically refresh. If you want

to see the latest list of secured directory numbers, click Refresh List to
redisplay an updated list.

Step6  To return to the TAPS Options page, click Back.

Additional Information
See the “Related Topics™ section on page 12-19.

Lifting the Restriction on a Directory Number

To remove a directory number from the list of directory numbers that TAPS
cannot access, use this procedure.

Procedure

Step 1 In the TAPS Options window, choose Secure TAPS and click Next. The Secure
Directory Numbers window appears.

Step2  In the field, enter the directory number that you want to unprotect from TAPS.

Step3  Click Remove. A prompt indicates that the directory number has been removed
from the list of secured directory numbers.

Step4  Click OK.

Step5  Continue to remove directory numbers by repeating Step 2 through Step 4. When
you finish removing directory numbers, click View Secured DN.

A list box displays the directory numbers that are protected. If a user tries to
update a device profile by entering one of the directory numbers in this list, TAPS
will refuse the request.
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S,
Note The View Secure DN list box does not automatically refresh. If you want

to see the latest list of secured directory numbers, click Refresh List to
display an updated list.

To return to the TAPS Options page, click Back.

N

Note If two or more phones lines share an unrestricted directory number, and
you are trying to update any of these phones, then you will be prompted
to enter the external phone mask of your phone.

Additional Information
See the “Related Topics™ section on page 12-19.

Removing All Directory Numbers

Step 1

Step 2

Step 3

Step 4
Step 5

To remove all the secured directory numbers from the list, use this procedure.

Procedure

In the TAPS Options window, choose Secure TAPS and click Next. The Secure
Directory Numbers window appears.

Click Remove All. A prompt indicates that no directory numbers will be secured
from TAPS.

Click OK to clear all directory numbers or click Cancel to cancel the clear
operation. A prompt advises you that the list of directory numbers that are
protected from TAPS has been cleared.

Click OK.
To return to the TAPS Options page, click Back.
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Additional Information
See the “Related Topics™ section on page 12-19.

Viewing a List of Restricted Directory Numbers

Step 1

Step 2

Step 3
Step 4

To view a list of directory numbers that TAPS cannot access, use this procedure.

Procedure

In the TAPS Options window, choose Secure TAPS and click Next. The Secure
Directory Numbers window appears.

Click View Secured DN.

A list box displays. TAPS cannot use the directory numbers that are shown in this
list. If a user tries to update a device profile by entering one of the directory
numbers in this list, TAPS will refuse the request.

Close the list box.

To return to the TAPS Options page, click Back.

Additional Information
See the “Related Topics” section on page 12-19.

Setting User Locales for TAPS

Administrators can specify the languages for TAPs voice prompts by using the
User Locales for TAPS option. You can configure user prompts for TAPS in
several languages. Before you install or upgrade TAPS, make sure that you
installed the Cisco IP Telephony Locale Installer on every Cisco CallManager and
Cisco CRS server in the cluster. Using the locale installer ensures that you have
the latest translated text, translated voice prompts, country-specific phone tones,
and country-specific gateways tones that are available for the phones. For more
information on the Cisco IP Telephony Locale Installer, refer to the specific locale
installer documentation.
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To access TAPS Options, on the machine that is running BAT, choose Start >
Programs > Cisco CallManager 4.2> Bulk Admin Tool. The BAT main
window displays.

Choose Configure>TAPS and the TAPS Options window displays.

Adding Languages for TAPS Prompts

Step 1

Step 2

Step 3

Step 4

Step 5

To set the languages for TAPS prompts, use this procedure.

Procedure

In the TAPS Options window, choose User Locales for TAPS and click Next. The
Select User Locales window displays.

In the User Locales list box, which is the list of languages that are installed on
Cisco CallManager, choose the languages that you want to use for user prompts.
Click the arrow to move the chosen language to the Selected User Locales list box.

You can choose as many languages as you need for user prompts and move them
to the Selected User Locales list box.

After you have chosen the languages for user prompts, click Update. A status
message indicates that the update completed.

To return to the TAPS Options page, click Back.

Additional Information
See the “Related Topics™ section on page 12-19.

Removing Languages for TAPS Prompts

Step 1

To remove the languages for TAPS prompts, use this procedure.

Procedure

In the TAPS Options window, choose User Locales for TAPS and click Next. The
Select User Locales window displays.

[ oL-8661-01

Bulk Administration Tool User Guide ]



Chapter 12 Working with the Tool for Auto-Registered Phones Support |

M TAPS Information for End Users

Step 2

Step 3

Step 4
Step 5

In the Selected User Locales list box, which is the list of languages that is chosen
for user prompts, choose the language that you want to remove.

Click the arrow to move the chosen language to the User Locales list box.

You can choose one or many languages from user prompts and move them to the
User Locales list box.

Click Update. A status message indicates that the updated is completed.
To return to the TAPS Options page, click Back.

Additional Information
See the “Related Topics™ section on page 12-19.

TAPS Information for End Users

Step 1

Step 2

Step 3
Step 4

Step 5

To configure your new phone, use this procedure.

Procedure

Plug the phone into a port.

The phone automatically registers and displays a number.

N

Note It takes around 20-25 seconds for downloading phone profile and to make
necessary updates in publisher and directory.

Dial the CTI Route Point number provided by your system administrator and
follow the prompts.

Dial the TAPS extension that your system administrator provided.

A voice prompts you to choose the language that you want to use. Choose
appropriately.

Dial your personal extension number, that your system administrator provided,
followed by #.
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Note  You may be instructed to enter the complete telephone number (including
area code).

Step6  To confirm, enter your personal extension number again, followed by #.
You will hear a confirmation prompt.

Step7  Hang up the phone.
The phone resets and displays your extension number.

If you experience any problems, contact your system administrator.

Additional Information
See the “Related Topics™ section on page 12-19.

Related Topics

¢ Introducing TAPS, page 12-2

e Installing TAPS, page 12-5

e Configuring TAPS in Cisco CallManager, page 12-7
e Uninstalling TAPS, page 12-9

e Starting TAPS, page 12-10

e Stopping TAPS, page 12-11

e Setting TAPS Options, page 12-11

e TAPS Information for End Users, page 12-18
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Troubleshooting BAT and TAPS

For information about problems and error messages that you might encounter
when you are using BAT or TAPS, use the following topics.

e BAT Log Files, page 13-1

e Viewing BAT Log Files, page 13-2
e Troubleshooting BAT, page 13-3

e Troubleshooting TAPS, page 13-7

e Viewing TAPS Log Files, page 13-8

BAT Log Files

BAT generates log files for each bulk transaction and stores the files on the
publisher database server in the following location:
C:\Program Files\Cisco\Trace\BAT.

The log file also shows the key value of a record, so the administrator may
reexamine the record. The MAC address of the phone serves as the key value
when you are adding, updating, or modifying phones. When users are added, the
User ID serves as the key value.

Clicking View Latest Log File link displays the summary view for the bulk
transaction as well as the detail view for the failures.
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A

Caution

Do not change screens while a transaction is processing. Doing so prevents the log
file or status messages from displaying.

Additional Information
See the “Related Topics” section on page 13-9.

Viewing BAT Log Files

To view the log file for the bulk operation, click View Latest Log File link on the
BAT interface or go to the following location:

C:\Program Files\Cisco\Trace\BAT directory
You can find the log files for the export utility at
C:\Program Files\Cisco\Trace\BAT\Export directory

For BAT insert transactions, you can view the detailed transaction trace files at
C:\Program Files\Cisco\Trace\BAT directory.

The log file names designate the operation that was performed and the time that
the operation ended.

¢ Log File Names—File name shows the name of the CSV file that is used for
the insert transaction, or the transaction type for other actions.

e TimeStamp—The timestamp format that is included in the log file name is
mmddyyyyhhmmss.

e Example—Shows examples of log file names and timestamps.

Table 13-1 Log File Names

Operation |Log File Name Example

Insert File name#TimeStamp.log File1#05022000133431

Update UpdatePhone#TimeStamp.log UpdatePhone#05022000133431
Delete DeletePhone#TimeStamp.log DeletePhone#05022000133431
Validate Validate_File name_TimeStamp.txt |Validate_batphones_0502200013343
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Additional Information
See the “Related Topics” section on page 13-9.

Troubleshooting BAT

When you install BAT, you must install the application on the Cisco CallManager
server console. If you attempt to use Windows Terminal Services to install BAT,
an error message appears and states that BAT installation is not supported over
Terminal Services.

The following list describes some scenarios that could occur and provides
possible resolutions.

Symptom Export to BAT Format button does not work in BAT.xIt file.

Explanation Clicking the Export to BAT Format button in the BAT .xlt file
does not appear to do anything.

Recommended Action Click a blank cell. The button can appear to be disabled
if the cursor is on the text in a cell or in the text box.

Symptom BAT Excel spreadsheet gives a compilation error while exporting data
to the CSV format.

Explanation Check the version of Microsoft Excel that you are using.
Customers have reported problems with BAT.xIt when they were using
Excel 97.

Recommended Action Use Microsoft Excel 2000 version or higher.
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Symptom The page cannot be displayed.

Explanation Message can occur because of an unexpected termination of IIS
Administrative service.

Recommended Action This indicates a display problem only. The process
continues in the background. You can refer to the log file for transaction
details.

Symptom Data files (CSV) format do not match Phone Template/Sample File.

Explanation The number of lines in the data file should be less than or equal
to the number of lines that are configured in the BAT phone template, but are
not. For example, the phone template has three lines, and, of these, Lines 1,
2, and 3 are configured. You should use a phone data file with up to three
configured lines. 1111, 2222, 4444 results in Linel-1111, Line2-2222,
Line3-none, Line4-4444.

Recommended Action Check the BAT phone template that you intend to use.
The number of lines that are specified on the CSV data file should not exceed
the number of lines that are configured in the BAT phone template. Also, the
number of speed dials that the CSV data file specifies should not exceed the
maximum possible number of speed dials for the BAT phone template that
you plan to use.

Symptom Errors occur when the dummy MAC address option is used.
Explanation Errors occur in the records for the dummy MAC addresses.

Recommended Action To map this symptom to the records that actually had the
problem, you can see another generated file with the name <Modified +
DataFileName>#<TimeStamp>.dat that shows the actual record with dummy
MAC address. Access this file in the C:\BAT\LogFiles folder.

Bulk Administration Tool User Guide
m. 0L-8661-01 |




| Chapter13  Troubleshooting BAT and TAPS

Troubleshooting BAT W

Symptom When inserting FXS ports for a VG200 gateway, the selected template
does not contain DN details for directory number.

Explanation The Cisco VG200 template for FXS ports must specify a
Gateway Directory Number template when the CSV file specifies directory
numbers.

Recommended Action Identify a Gateway Directory Number template for FXS
endpoint identifier(s) as specified in the VG200 Gateway Template
configuration, FXS port configuration steps.

Symptom Port identifier contains invalid endpoint prefix.

Explanation The port identifier value contains an invalid endpoint prefix or
has not been configured in the BAT template. You must configure port
identifier(s) in the BAT template before it can be specified in the CSV file. In
the CSV file, the first digit of the endpoint prefix can be either O or 1
(signifying either sub-unit O or sub-unit 1), followed by the port number, 01
to 24. Acceptable values include 001 through 024 (for sub-unit 0) or 101
through 124 (for sub-unit 1).

Recommended Action Correct the port identifier value in the CSV file or check
the BAT template to be sure that ports have been configured.

Symptom Port identifier contains invalid port number.

Explanation The last two digits of the port identifier represent the port
number. Port number must be between 01 and 24.

Recommended Action Correct the port number in the CSV file.

Symptom Port number not configured in the template.

Explanation The CSV file specified the port number, but no corresponding
ports are configured in the BAT template.

Recommended Action In the BAT template, configure the ports that you have
specified in the CSV file.
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Symptom MAC address values are not allowed in the file if dummy MAC address
values are desired.

Explanation The CSV file contains MAC addresses. You cannot provide
dummy MAC addresses when MAC addresses are present in any row in the
CSV file.

Recommended Action If you want to use dummy MAC addresses, create a new
CSV file that contains only those records for which you have not specified
MAC addresses. Alternatively, you can specify MAC addresses in the CSV
file and not check the Create Dummy MAC Address check box.

Symptom The BAT.xIt spreadsheet will not work with Microsoft Excel XP (Office
XP)

Explanation In Microsoft Excel packaged with Office XP, macro security is
set to high by default. Due to this setting, macros in BAT.xIt cannot run
rendering BAT.xIt unusable.
Recommended Action To enable macros in BAT.xIt use the following steps:

a. Open BAT.xlt.

b. Go to Menu >Tools >Macro > Security.

c. Set the Security Level to Medium.

d. Close BAT.xlt and open it again. When prompted, choose Enable Macros.

Additional Information
See the “Related Topics” section on page 13-9.

Troubleshooting BAT Performance

Keep in mind that it is best to send bulk transactions during low traffic periods.
When you insert BAT files to the publisher database during the time when Cisco
CallManager is processing a high volume of calls, the BAT transactions can be
slow. In fact, you can adversely affect how Cisco CallManager processes calls.
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Step 1
Step 2
Step 3
Step 4

Note

Troubleshooting TAPS

You can improve BAT performance by stopping the TFTP service before you
insert the BAT files to the publisher database. You must restart the TFTP service
when the insert transaction is completed.

Use the following procedure to stop the TFTP service on the Cisco CallManager
Publisher server.

Procedure

Access the publisher server for Cisco CallManager.

Click Start > Programs > Administrative Tools > Services.
Locate and right-click CTFTP Services.

Choose Stop and click OK.

You must restart the TFTP service when the insert transaction is complete. Use
the same procedure, and choose Start to restart the service.

Additional Information
See the “Related Topics” section on page 13-9.

Troubleshooting TAPS

When you install TAPS, you must install the application on the

Cisco CallManager server console and CRS server console. If you attempt to use
Window Terminal Services to install TAPS, you receive an error message
indicating that TAPS installation is not supported over Terminal Services.

As a general rule, Cisco recommends that you stop Cisco TAPS service when
TAPS is not in use. You can prevent undesired TAPS usage by stopping the
service, and you can save some CPU time.

Additional Information

See the “Related Topics™ section on page 13-9.
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Viewing TAPS Log Files

For troubleshooting information, you can use the following files:

e TAPS generates log files for transactions and stores them at this location:
C:\Program Files\Cisco\Trace\TAPS\.

e When TAPS service fails to start, collect the following log file:
C:\Program Files\Cisco\Trace\TAPS\

e When you activate trace files for TAPS, they are stored at this location:
C:\Program Files\Cisco\Trace\TAPS\

TAPS Error Messages

You may receive the following messages while running TAPS on the Cisco CRS
server.

Symptom When dialing the TAPS route point number, the caller hears a busy tone.

Explanation The busy tone indicates that the maximum number of
simultaneous sessions for TAPS has been reached. The maximum number of
sessions for TAPS is equal to the number of ports assigned to the TAPS
application in CRS configuration.

Recommended Action You must increase the number of ports assigned to TAPS
in CRS configuration to prevent this situation.

Symptom When the Cisco CRS server starts, the JTAPI subsystem shows partial
service or out of service

Explanation Message occurs because of configuration problems in the
Cisco CallManager or the Cisco CRS server.

Recommended Action Perform one or all of the following steps until the
problem has been corrected:

e Verify that Cisco CallManager is started.
e Make sure that JTAPI is installed on the Cisco CRS server.
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e Make sure that the JTAPI version on the CRS server is the same as the
JTAPI version installed on Cisco CallManager. If the version is not the
same, install the JTAPI client from the Cisco CallManager plugins page
on the CRS server.

e Verify that the CRS engine configuration has a valid application engine
host name. You can use the IP address to eliminate name resolution
issues.

e Make sure that the Route Points and CTI ports are properly configured
on the Cisco CallManager.

e Verify that the Enable CTI Application Use check box is checked for the
JTAPI user; you can verify this in the user page in Cisco CallManager
Administration.

e Verify that the CTI Manager service is started.

e Verify that the ports and the route point are associated to the user in the
Cisco CallManager user configuration.

For further troubleshooting, collect and review MIVR log files for Cisco CRS
server. You can find these files on the CRS server in the following folder:
C:\program files\wfavvid\log\.

Additional Information
See the “Related Topics” section on page 13-9.

Related Topics

e BAT Log Files, page 13-1

e Viewing BAT Log Files, page 13-2

e Troubleshooting BAT, page 13-3

e Troubleshooting BAT Performance, page 13-6
e Troubleshooting TAPS, page 13-7

e Viewing TAPS Log Files, page 13-8
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Text-Based CSV Files

BAT uses data that is entered in a comma separated values (CSV) file format to
provide information for insert transactions to the Cisco CallManager database on
the publisher server. By using the CSV data format, you can build a textual file
that contains data records in a tabular format.

You can create a CSV data file by using a text editor, such as Microsoft Notepad.
You must use a separate line to enter data for each record. Separate each data field
with a comma and include comma separators for blank fields. Enter data on every
line in the data file because an error occurs during the insert transaction if you
enter a blank line in a CSV file.

When you insert the data records to the Cisco CallManager database, BAT
accesses a set of designated folders that reside on the server that is running the
publisher database. For BAT to access the appropriate CSV data file for the
transaction, you must save or copy the CSV data file to the folder for the specific
data content. For example, you would save a phone CSV data file to the
C:\BATFiles\Phones\ Insert\ folder on the server that is running the publisher
database for Cisco CallManager. BAT cannot access CSV data files that are saved
anywhere except in the proper folder.

The following topics provide information and file formats for the following
text-based CSV files:

e C(Creating a Text-Based CSV File for Phones, page A-2
e Creating a Text-Based CSV File for Users, page A-11
e Creating a Text-Based CSV File for User Device Profile, page A-15

¢ Creating a Text-Based CSV File for Cisco IPMA Manager-Assistant
Associations, page A-20
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e C(Creating a Text-Based CSV File for Cisco VG200 Gateways, page A-22

e C(Creating a Text-Based CSV File for Cisco Catalyst 6000 FXS Ports,
page A-25

¢ Creating a Custom Text-Based CSV Files for Client Matter Codes and Forced
Authorized Codes, page A-28

¢ Creating a Text-Based CSV File for Call Pickup Groups, page A-31

Creating a Text-Based CSV File for Phones

Step 1

Step 2

Instead of using the BAT spreadsheet for data input when you are adding phones,
you can create the comma separated values (CSV) file by using lines of ASCII text
with values separated by commas.

Use the following procedure to create a CSV text file for phones, IP telephony
devices, and user combinations.

Procedure

Open a text editor (such as Microsoft Notepad) or any application that allows you
to export or create a CSV file.

Use a separate line to enter the values for each phone, IP telephony device, or user
combination that you want to add to Cisco CallManager. You must create separate
CSV files for each type of device. Keep in mind the following rules when you
create the CSV data file.

e Specify all checkbox values with the Boolean values of True or False.
e Always include comma separators, even if a field is blank.

e If a route partition restricts the access to the call pickup group, you must
specify Call Pickup Group as a combination of Directory Number/Route
Partition Name, for example 9725557121 /Tol1ByPass. If the call pickup group
has no associated partition, then specify only the directory number.

e Specify the user ID if the phone is to be associated to a user.

e Directory Number fields are optional only when you are creating the CSV file
for use with a BAT template that has no lines. If lines are configured on the
BAT phone template, you must supply directory numbers in the CSV file for
each device.
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e An error occurs when you insert a CSV file with blank lines.

See the “Phone CSV Data File Formats” section on page A-3 for information
about the CSV data file formats that you must use for different phone types.

Save or copy the completed file to the BATFiles directory in the folder named for
the type of CSV file that you are creating (phones, CTI port-users, users) on the
server that is running the publisher database for Cisco CallManager.

~
Note  BAT accesses only the C:\BATFiles\Phones\ folder (or the proper folder
for the type IP telephony device) for the appropriate transaction.

For information about CSV file formats for other phone types, see these topics:
e Phone CSV Data File Formats, page A-3
e Export File Fields for All Phone Details Option, page A-7
e Phone CSV File Examples, page A-9

Phone CSV Data File Formats

Different types of phones require specific data formats. Keep in mind that fields
labeled as optional in the phone file format become mandatory fields when certain
conditions are met.

e Password and PIN fields are optional in the CSV file because you can specify
them in the BAT user interface window when you insert the CSV file.

e Directory number field becomes mandatory if the corresponding phones or
phones-users BAT template has one or more lines that are configured. The
number of directory number fields that you supply in the CSV file must not
exceed the number of lines that are configured in the BAT template.

The following topics provide the formats and samples for these phone types:
e [P Phones, VGC Phones, and VGC Virtual Phones File Format, page A-4
e Phones With Users Combinations File Format, page A-5
e CTI Ports/H.323 Clients File Format, page A-5

[ oL-8661-01

Bulk Administration Tool User Guide ]




Appendix A Text-Based CSV Files |

M Creating a Text-Based CSV File for Phones

e CTI Ports-Users and H.323 Client-Users Combinations File Format,
page A-6

IP Phones, VGC Phones, and VGC Virtual Phones File Format

The following format and sample shows the fields, field length, and whether the
field is optional or mandatory for a text-based CSV file for phones. You can adjust
the phone format by using a file format that defines the order of the device and
line details in the CSV data file.

Be aware that the format for the MAC address differs depending on the type of
VGC phone.

e The Cisco VGC phone uses a combination of the MAC address for the
gateway and the port number. Enter the first 10 digits of the MAC address of
the Cisco VGC phone and the last two digits of the port to be configured.(The
last two digits should be 01 through 24.)

e The Cisco VGC virtual phone MAC address comprises the first 10 digits of
the VGC gateway with the last two digits being 00.

Number of Lines (Mandatory, 1 to 2 numbers),MAC Address (Mandatory, 12
characters),Description (Optional, up to 50 characters),Location (Optional, up to
50 characters),User ID (Optional, up to 30 characters),Directory Number
(Optional, up to 24 numerals and special characters),Display(Optional, up to 30
characters),Line Text Label(Optional, up to 30 characters),Forward Busy
External(Optional, up to 50 numerals and special characters),Forward No
Answer External(Optional, up to 50 numerals and special characters),Forward
No Coverage External(Optional, up to 50 numerals and special
characters),Forward Busy Internal(Optional, up to 50 numerals and special
characters),Forward No Answer Internal(Optional, up to 50 numerals and
special characters),Forward No Coverage Internal(Optional, up to 50 numerals
and special characters),Call Pickup Group (Optional, up to 50/50
characters),Speed Dial (Optional, up to 50 numerals and special
characters),Speed Dial Label(Optional, up to 30 characters)

Sample

1,1231123245AB, SEP1231123245AB,Dallas, johns, 9728437154,9728437154,Mike
,9728437172,9728437196,9728437127,9728437154,9728437178,9728437189,972
8437121/TollByPass, 1230000000, Helpdesk
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Phones With Users Combinations File Format

The following sample shows the field length, and whether the field is optional or
mandatory for a text-based CSV file for phones and the fixed user format.

First Name(Mandatory, 1 to 50 characters), Last Name(Mandatory, 1 to 50
characters), User ID(Mandatory, up to30 characters), Password(Optional, up to
20 characters), Manager(Optional, up to 30 characters), Department(Optional,
up to 50 characters), PIN(Optional up to 20 numerals), User Device
Profile(Optional, up to 50 characters), User Locale (Optional, up to 50
characters), Number of Lines (Mandatory, 1 to 2 numbers), MAC Address
(Mandatory, 12 characters), Description (Optional, up to 50 characters),
Location (Optional, up to 50 characters), Directory Number (Optional, up to 24
numerals and special characters), Display (Optional, up to 30 characters), Line
Text Label(Optional, up to 30 characters), Forward Busy External(Optional, up
to 50 numerals and special characters), Forward No Answer External(Optional,
up to 50 numerals and special characters), Forward No Coverage
External(Optional, up to 50 numerals and special characters), Forward Busy
Internal(Optional, up to 50 numerals and special characters), Forward No
Answer Internal(Optional, up to 50 numerals and special characters), Forward
No Coverage Internal(Optional, up to 50 numerals and special characters), Call
Pickup Group (Optional, up to 50/50 characters), Speed Dial (Optional, up to 50
numerals and special characters), Speed Dial Label(Optional, up to 30
characters)

Sample

John, Smith, johns, abcde, Daviss, 12,12345, johnProfile, English United
States,1,1231123245AB,Dallas, 9725557154,9725557154,Mike, 9725557172,972
5557196,9725557112,9725557127,9725557158,9725557189, 9725557121/ Tol1ByP
ass, 1230000000, Helpdesk

CTI Ports/H.323 Clients File Format

The following sample shows the field length, and whether the field is optional or
mandatory for a text-based CSV file for CTI ports and H.323 clients format.

Number of Lines (Mandatory, 1 to 2 numbers),Device Name (Mandatory, up to
15 characters for CTI ports and up to 50 characters for H.323

Clients),Description (Optional, up to 50 characters) Location (Optional, up to 50
characters),User ID(Optional, 1 to 30 characters),Directory Number(Optional,
up to 24 numerals and special characters),Display (Optional, up to 30 characters),
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Line Text Label(Optional, up to 30 characters),Forward Busy
External(Optional, up to 50 numerals and special characters),Forward No
Answer External(Optional, up to 50 numerals and special characters),Forward
No Coverage External(Optional, up to 50 numerals and special
characters),Forward Busy Internal(Optional, up to 50 numerals and special
characters),Forward No Answer Internal(Optional, up to 50 numerals and
special characters),Forward No Coverage Internal(Optional, up to 50 numerals
and special characters),Call Pickup Group (Optional, up to 50/50 characters)

Sample

1,TAPS Port 1,CTI TAPS Port 1,Dallas,johns,9728437154,9728437154,
Mike, 9728437172,9728437196,9728437127,9728437154,9728437178,
9728437189,9728437121/TollByPass, 1230000000, Helpdesk

CTI Ports-Users and H.323 Client-Users Combinations File Format

The following sample shows the field length, and whether the field is optional or
mandatory for a text-based CSV file for CTI ports with users and H.323 clients
with users format.

First Name(Mandatory, 1 to 50 characters) Last Name(Mandatory, 1 to 50
characters),User ID(Mandatory, up to30 characters),Password(Optional, up to 20
characters),Manager(Optional, up to 30 characters),Department(Optional, up to
50 characters),PIN(Optional up to 20 numerals),User Device Profile(Optional,
up to 50 characters),User Locale(Optional, up to 50 characters),Number of
Lines (Mandatory, 1 or 2 numbers),Device Name(Mandatory, up to 15 characters
for CTI ports-users combination and up to 50 characters for H.323client-users
combinations),Description(Optional, up to 50 characters),Location (Optional,
up to 50 characters),Directory Number (Optional, up to 24 numerals and special
characters),Display (Optional, up to 30 characters),Line Text Label(Optional, up
to 30 characters),Forward Busy External(Optional, up to 50 numerals and
special characters),Forward No Answer External(Optional, up to 50 numerals
and special characters),Forward No Coverage External(Optional, up to 50
numerals and special characters),Forward Busy Internal(Optional, up to 50
numerals and special characters),Forward No Answer Internal(Optional, up to
50 numerals and special characters),Forward No Coverage Internal(Optional,
up to 50 numerals and special characters),Call Pickup Group (Optional, up to
50/50 characters)
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Sample

John, Smith, johns, abcde, Daviss, 12,12345, johnProfile, English United
States,1l,TAPS Port 1,CTI TAPS Port

1,9725557154,9725557154,Mike, 9725557172,9725557196,9725557112,97255571
27,9725557158,9725557189,9725557121/TollByPass, 1230000000, Helpdesk

If you use a comma or double quotes as part of the value in one of the fields, you
must enclose the entire text value with double quotation marks to designate it as
a single value.

For example, if you entered John, Bill as a text value, then you must enter the
value as “John,Bill”.

If you entered a double quote in a value, then you must replace the double quote
with two consecutive double quotes and enclose the value with double quotes. For
example you must enter John “Chief as “John”“Chief”.

Additional Information
See the “Related Topics” section on page A-34.

Export File Fields for All Phone Details Option

A

When you are using the export utility to generate a file containing all the details
for the phone records, the export file has the following format. The sample shows
the length and type of fields in the export all details file.

Caution

Cisco does not recommend editing the file that is generated with the export utility.
The system dynamically generates fields, such as Logout time and Login time,
that must not be edited at all. You must ensure that the login user ID and Product
Specific XML fields are accurate for them to work properly, and you must not edit
them. Use BAT to update the product specific configurations.

<<DEVICE>>MAC Address(Mandatory),Description(Optional, up to 50
characters),Device Pool (Mandatory, up to 50 characters),Calling Search
Space(Optional, up to 50 characters),AAR Calling Search Space(Optional, up to
24 characters),Media Resource Group List(Mandatory, up to 50
characters),User Hold Audio Service(Optional, up to 50 characters),Network
Hold Audio Source(Optional, up to 50 characters),Location (Optional, up to 50
characters),User Locale(Optional, up to 50 characters),Network
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Locale(Optional, up to 100 characters),Phone Button Template(Mandatory, up
to 50 characters),Expansion Module Type I(Optional, up to 50
characters),Expansion Module Type II(Optional, up to 50 characters), Softkey
Template(Optional, up to 50 characters),Phone Load Name(Optional, up to 32
characters),Module 1 Load Name(Optional, up to 32 characters),Module 2 Load
Name(Optional, up to 32 characters),Login User ID(Optional, 1 to 30
characters),Built in Bridge (Optional, up to 32 characters), MLPP Indication
(Optional, up to 32 characters), MLPP Preemption (Optional, up to 32
characters), MLPP Domain (Optional, up to 32 characters), Retry Video Call as
Audio (Optional),Privacy(Optional), Security Mode(Optional),Ignore
presentation Indicators(Optional),Single Packet Capture
Mode(Optional),Packet Capture Duration(Optional),Certification Operation,
Authentication Mode(Optional),Authentication String,Key Size(bits),
Operation Completes By(Optional)

<<MODEL SPECIFIC>> Information(Optional, up to 255
characters),Directory(Optional, up to 255 characters),Messages(Optional, up to
255 characters),Services(Optional, up to 255 characters),Authentication
Server(Optional, up to 255 characters),Proxy Server(Optional, up to 255
characters),Idle(Optional, up to 255 characters),Idle Timer(Optional, up to 5
numerals),Enable Extension Mobility(Optional, boolean),Logout
Profile(Optional,1 to 50 characters),Login User ID(Optional, 1 to 30
characters),Login Time (Written by login service),Logout Time (Written by
login service),Disable Speaker Phone(Optional),Disable Speaker Phone and
Headset(Optional), Forwarding Delay,(Optional) PC Port(Optional), SRS
Telephony Enable(Optional)

<<LINE>>Directory Number(Optional, up to 24 numerals and special
characters),Partition(Optional, up to 50 characters),Voice Mail
Profile(Optional, up to 50 characters),Calling Search Space(Optional, up to 50
characters),AAR Group(Optional, up to 20 characters),Line User Hold Audio
Source(Optional, up to 50 characters), Line Network Hold Audio
Source(Optional, up to 50 characters),Auto Answer(Mandatory, up to 50
characters),Forward All to Voice Mail (Optional),Forward All
Destination(Optional, up to 50 numerals), Forward All CSS (Optional, up to 24
numerals),Forward Busy External to Voice Mail (Optional),Forward Busy
External Destination(Optional, up to 50 numerals), Forward Busy External
CSS (Optional, up to 24 numerals), Forward No Answer External to Voice Mail
(Optional),Forward No Answer External Destination(Optional, up to 50
numerals),Forward No Answer External CSS (Optional, up to 24 numerals),
Forward on Failure to Voice Mail (Optional, up to 50 numerals), Forward on
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Failure destination(Optional, up to 50 numerals),Forward on Failure CSS
(Optional, up to 24 numerals),Call Pickup Group(Optional, up to 50/50
characters),Forward Busy Internal to Voice Mail (Optional),Forward Busy
Internal Destination(Optional, up to 50 numerals), Forward Busy Internal CSS
(Optional, up to 24 numerals), Forward No Answer Internal to Voice Mail
(Optional),Forward No Answer Internal Destination(Optional, up to 50
numerals),Forward No Answer Internal CSS (Optional, up to 24
numerals),Forward NoCall Coverage External to Voice Mail
(Optional),Forward No Call Coverage External Destination(Optional, up to 50
numerals),Forward No Call Coverage External CSS (Optional, up to 24
numerals),Forward NoCall Coverage Internal to Voice Mail
(Optional),Forward No Call Coverage Internal Destination(Optional, up to 50
numerals),Forward No Call Coverage Internal CSS (Optional, up to 24
numerals),Display(Optional, for internal Caller ID, up to 30 characters),
External Phone Mask (Optional, up to 30 numerals or Xs, where the Xs
represents the mask),Message Waiting Lamp Policy (Optional, up to 50
characters),Ring Setting when idle (Optional, up to 50 characters),Line Text
Label(Optional, up to 30 characters),Ring Setting when Active (Optional, up to
50 characters),No Answer Ring Duration (Optional, up to 3 numbers), MLPP
Target Destination(Optional, up to 50 characters), MLPP Calling Search
Space(Optional, up to 50 characters),MLPP No Answer Ring Duration
(Optional, up to 3 numbers), Max Num Calls (Optional, up to 3 numbers), Busy
Trigger (Optional, up to 3 numbers), Call Info Display Mask, Alerting Name

<<USER>>User ID(Optional, 1 to 30 characters)

<<SPEEDDIALS>>Speed Dial Number 1(Optional, up to 50 numerals and
special characters),Speed Dial Label 1(Optional, up to 30 characters)

<<SERVICES>>Service Name 1(Optional, up to 100 characters),Subscribed
Service Name 1(Optional, up to 50 characters),Parameter Name 1(Optional, up
to 50 characters),Parameter Value 1(Optional, up to 100 characters)

Additional Information

See the “Related Topics” section on page A-34.

Phone CSV File Examples

The following list provides examples of commonly used phone CSV data files:
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Using a Template Attribute-Forward Busy Destination

If Forward Busy Destination is 3001 on a phone template, all records in a CSV
file that have no value for Forward Busy Destination use 3001.

1,1231123245AB, SEP1231123245AB,Dallas, johns, 9728437154,9728437154,Mike
,,9728437196,9728437127,9728437154,9728437178,9728437189,9728437121/To
11ByPass, 1230000000, Helpdesk

No Phone Description Entry
If the description for a phone is blank, use this format:

1,1231123245AB, ,Dallas, johns, 9728437154,9728437154,Mike, 9728437172,972
8437196,9728437127,9728437154,9728437178,9728437189,9728437121/TollByP
ass, 1230000000, Helpdesk

No Active Line or Location Entry
If no active line is required and the location is also blank, use this format:

0,1231123245AB, SEP1231123245AB,,,1230000000, HelpDesk

Two Active Lines
If two active lines are required, use this format:

1,1231123245AB,SEP1231123245AB,Dallas, johns, 9725557154,9725557154,Mike
,9725557172,9725557196,9728437127,9728437154,9728437178,9728437189,972
5557121 /TollByPass, 9725557155,9725557155,Kelvin, 9725557133,9725557196,
9728437112,9728437145,9728437187,9728437198,9725557112/TollByPass, 1230
000000, Helpdesk

Note  For the MAC Address, enter MAC address values or check the option for creating
dummy MAC addresses.

Mandatory Phone Entries

If one line is required and you want to include only the required values and none
of the optional values, use this format:

1,1231123245AB,,,,9725557154,,,,,

Using Dummy MAC Address Option
If the option is checked for a dummy MAC address and you want one line

1,,SEP1231123245AB,Dallas, 9725557154,9725557154,Mike, 9725557172 ,972555
7196,9728437127,9728437154,9728437178,9728437189,9725557121/Tol1lByPass
,Jjohns, 1230000000, Helpdesk
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Additional Information
See the “Related Topics” section on page A-34.

Creating a Text-Based CSV File for Users

Step 1

Step 2

Step 3

Instead of using the BAT spreadsheet for data input when you are adding users,
you can create the comma separated values (CSV) file by using lines of ASCII text
with values separated by commas.

Use this procedure to create a CSV text file for users.

Procedure

Open a text editor (such as Microsoft Notepad) or any application that allows you
to export or create a CSV file.

Using a separate line for each user, enter the values for each user that you want to
add to Cisco CallManager. See Users File Format, page A-12, for detailed
information about the formatting that you must use in the text-based CSV file.

You can associate any number of existing devices to a new user by entering the
device name of all the devices separated by a comma at the end of the record.

You can associate a directory number to a user, even if that user does not control
any device.

~

Note  An error occurs if any blank lines exist in the CSV file.

Save or copy the file to the C:\BATFiles\Users\Insert Users\ folder on the
publisher server for Cisco CallManager.

~
Note  BAT uses only the C:\BATFiles\Users\Insert Users\ folder to access the
CSV files.
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Additional Information
See the “Related Topics” section on page A-34.

Users File Format

L

Tip

You must specify PIN and Password values, either on the CSV file or when using
BAT for file insertion. If you want to apply individual PINs or passwords for each
user or group of users, specify the PIN and password information in the CSV file.
If you want to use a default PIN and password that all users can use, do not specify
PIN or password values in the CSV file and instead provide this information when
you use BAT to insert the CSV file in Cisco CallManager.

The following sample format and examples show the fields, field length, and
whether the field is optional or mandatory for a text-based CSV file for users.

First Name(Mandatory, 1 to 50 characters),Last Name(Mandatory, 1 to 50
characters),User ID(Mandatory, up to 30 characters),Password(Optional, up to
20 characters),Manager(Optional, up to 30 characters),Department(Optional,
up to 50 characters),PIN(Optional, up to 20 numerals),User Device
Profile(Optional, up to 50 characters),User Locale(Optional, up to 50
characters),Controlled Device Name 1(optional, 50 characters),Directory
Number (Optional, up to 24 numerals and special characters),Controlled Device
Name 2(Optional, 50 characters)

Keep in mind that you cannot enter values for Device Name2 without entering
values for Device Namel.

Sample
John, Smith, johns, abcl23de, karend, 0012055, 9989, johns profile, English
United States,SEP1231123245AB, 9725557154, SEP0010EB001234

You must specify delimiters even if a field is blank. Refer to the following
examples and sample CSV records when you are creating CSV files.

Example 1
If the manager for a user is blank, use this format:

John, Smith, johns, abcl23de,,0012055,9989, johns profile,English United
States, SEP1231123245AB, 9725557154, SEPO010EB001234
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Example 2
When you want to complete only the mandatory fields, use this format:

John, Smith, johns, ,,,,,,,

Example 3

When you want to complete only the mandatory fields and associate the user to a
phone, use this format:

John, Smith, johns,,,,,,,SEP1231123245AB,

Example 4
A user can control more than one device. You can add device names for additional
devices at the end of the record.
e If the user controls only one device, use this format:
John, Smith, johns, abcl23de, karend, 0012055,9989, johns profile, English
United States,SEP1231123245AB, 9725557154
e If the user controls three devices, use this format:

John, Smith, johns, abcl23de, karend, 0012055,9989, johnsprofile, English
UnitedStates, SEP1231123245AB, 9725557154, SEPO010EB001234, SEP0010EB4
32101

Updating Users File Format

Use a text editor to create the CSV text file for updating users. Save or copy the
file to C:\BATFiles\Users\Update Users on the publisher server.

When you are updating a record, you need to supply all mandatory fields for a file.
If you have stored values in the optional fields, and you update a record with blank
optional fields, you will reset the values to blank. See the “Retaining Stored
Values” section on page 4-11 for information about keeping previously stored
values.

The following sample format shows the field length and string types followed by
examples of CSV files for updating users.
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UserID(Mandatory, 1 to 30 characters),Manager(Optional, up to 30characters,
must use existing ID in global directory),Department (Optional, up to 50
characters),User Device Profile(Optional, up to 50 characters),User Locale
(Optional, up to 50 characters),MAC Address (Optional, up to 12
characters),Directory Number (Optional, up to 24 numerals and special
characters)

Sample

johns,Daviss, 123, johnProfile, English United
States, SEP8612113425AC, 9725557154

Note  You must specify delimiters even if a field is blank. Refer to the following
examples and sample CSV records when you are creating CSV files.

Example 1
If the manager for a user is blank. use this format:

johns, , 123, johnProfile, English United
States, SEP8612113425AC, 9725557154

Example 2

Enter your preferred language first, followed by the country. Use the following
three examples as a guide:

English United States, French France, German Germany

Example 3
Mandatory fields include the following:

John,Daviss, 123, johnProfile, ,,

Additional Information

See the “Related Topics” section on page A-34.
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Creating a Text-Based CSV File for User Device
Profile

Note

Step 1
Step 2

Step 3

Instead of using the BAT spreadsheet for data input when you are adding user
device profiles, you can create the comma separated values (CSV) file by using
lines of ASCII text with values separated by commas.

If you use comma or double quotes as part of string in one of the fields, you must
enclose the entire text string with double quotes.

To create a CSV text file for user device profiles, use this procedure.

Procedure

Open Microsoft Notepad to create the CSV file.

Using a separate line for each user device profile, enter the values for each user
device profile that you want to add to Cisco CallManager. See User Device
Profiles File Format, page A-16, for detailed information about the formatting
that you must use in the text-based CSV file.

~

Note  An error occurs if any blank lines exist in the CSV file.

Save or copy the file to the C:\BATFiles\User Device Profiles\ on the publisher
server for Cisco CallManager.

>
Note  BAT uses only the C:\BATFiles\User Device Profiles\ folder to access the
CSV files.

Additional Information

See the “Related Topics” section on page A-34.
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User Device Profiles File Format

The following sample format shows the field length and string types followed by
examples of a CSV files for user device profiles.

Number of Lines (Mandatory, 1 to 2 numbers),Device Profile Name(Mandatory,
1 to 50 characters),Description(Optional, 1 to 50 characters),Login UserID
(Optional, 4 to 30 characters),Directory Number(Optional, up to 24 numerals
and special characters),Display(Optional, for internal Caller ID, up to 30
characters),Line Text Label(Optional, up to 30 characters),Forward Busy
External Destination(Optional, up to 50 numerals),Forward No Answer
External Destination(Optional, up to 50 numerals),Forward No Coverage
External(Optional, up to 50 numerals),Forward Busy Internal
Destination(Optional, up to 50 numerals),Forward No Answer Internal
Destination(Optional, up to 50 numerals),Forward No Coverage
Internal(Optional, up to 50 numerals),Call Pickup Group(Optional, up to 50/50
characters),Speed Dial Number(Optional, up to 50 numerals),Speed Dial
Label(optional, up to 30 characters)

Sample

1,John Profile,John's

Profile,Johns, 9725557154,9725557154,Mike, 9725557172,9725557196, 9725557
126,9725557154,9725557178,9725557189,9725557121/Tol1ByPass, 1230000000,
Helpdesk

Example 1

You must specify delimiters even if a field is blank. The following example shows
the correct format for not specifying a Display setting:

1,John Profile,John's
Profile,Johns, 9725557154, ,Mike, 9725557172,9725557196,9725557126,972555
7154,9725557178,9725557189,9725557121/Tol1ByPass, 1230000000, Helpdesk

Example 2

If it is a O-line profile and only mandatory fields are added, use the following
example:

John Profile,,,,
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Example 3

If only the mandatory fields are completed and you want to associate the user
device profile to only one directory number, use this format:

John Profile,,,9725557154,,,,,

User Device Profile with Two Lines and Two Speed Dials

The following example format shows the field length and string types of a CSV
file for user device profiles with two lines.

Number of Lines (Mandatory, 1 to 2 numbers),User Device Profile
Name(Mandatory, 1 to 50 characters),Description(Optional, 1 to 50
characters),Login UserID (Optional, 4 to 30 characters),Directory
Number1(Optional, up to 24 numerals and special
characters),Display1(Optional, for internal Caller ID, up to 30 characters),Line
Text Labell(Optional, up to 30 characters),Forward Busy External
Destination1(Optional, up to 50 numerals),Forward No Answer External
Destination1(Optional, up to 50 numerals),Forward No Coverage External
Destination1(Optional, up to 50 numerals),Forward Busy Intermal
Destination1(Optional, up to 50 numerals),Forward No Answer Internal
Destination1(Optional, up to 50 numerals),Forward No Coverage Internal
Destination1(Optional, up to 50 numerals),Call Pickup Group1(Optional, up to
50/50 characters),Directory Number2(Optional, up to 24 numerals and special
characters),Display2(Optional, for internal Caller ID, up to 30 characters),Line
Text Label2(Optional, up to 30 characters),Forward Busy External
Destination2(Optional, up to 50 numerals),Forward No Answer External
Destination2(Optional, up to 50 numerals),Forward No Coverage External
Destination2(Optional, up to 50 numerals),Forward Busy Intermal
Destination2(Optional, up to 50 numerals),Forward No Answer Internal
Destination2(Optional, up to 50 numerals),Forward No Coverage Internal
Destination2(Optional, up to 50 numerals),Call Pickup Group2(Optional, up to
50/50 characters),Speed Dial Number1(Optional, up to 50 numerals),Speed Dial
Labell(optional, up to 30 characters),Speed Dial Number2(Optional, up to 50
numerals),Speed Dial Label2(optional, up to 30 characters)

Example

1,John Profile,John's
Profile,John’s, 9725557154,9725557154,Mike, 9725557172,9725557196,972555
7126,9725557154,9725557178,9725557189,9725557121/Tol1lByPass, 9725557155
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,9725557155,Kelvin, 9725557133,9725557196,9725557113,9725557145,9725557
187,9725557198,9725557112/TollByPass, 1230000000, Helpdesk, 2149523460, Ke
ith

Export File Fields for User Device Profile with All Details Option

When you are using the export utility to generate a file containing all the details
for the user device profiles, the export file will have the following format. The
example shows the length and type of fields in the export all details file.

The export utility does not generate model specific fields for user device profiles.

A

Caution  Cisco does not recommend editing the file that is generated with the export utility.
The system dynamically generates some fields, such as Logout time and Login
time, that must not be edited at all. You must ensure that the login user ID and
Product Specific XML fields are accurate for them to work properly and you must
not edit them. Use BAT to update the product specific configurations.

<<DEVICE>>User Device Profile name(Mandatory, 1 to 50 characters),
Description (Optional, 1 to 50 characters),Device Pool (Mandatory, up to 50
characters),Calling Search Space(Optional, up to 50 characters),AAR Calling
Search Space(Optional, up to 24 characters),Media Resource Group
List(Mandatory, up to 50 characters),User Hold Audio Service(Optional, up to
50 characters), Network Hold Audio Source (Optional, up to 50
characters),Login UserID (Optional, up to 30 characters),User Locale(Optional,
up to 50 characters),Network Locale(Optional, up to 100 characters),Phone
Button Template(Mandatory, up to 50 characters), Expansion Module Type
I(Optional, up to 50 characters),Expansion Module Type II(Optional, up to 50
characters),Softkey Template(Optional, up to 50 characters),Phone Load
Name(Optional, up to 32 characters),Module I Load Name(Optional, up to 32
characters),Module II Load Name(Optional, up to 32 characters), MLPP
Indication (Optional, up to 32 characters), MLPP Preemption (Optional, up to
32 characters), MLPP Domain(Optional, up to 32 characters)

<<MODEL SPECIFIC>>Information (Optional, up to 255
characters),Directory(Optional, up to 255 characters), Messages (Optional, up to
255 characters), Services (Optional, up to 255 characters), Authentication
Server(Optional, up to 255 characters), Proxy Server(Optional, up to 255
characters),Idle(Optional, up to 255 characters),Idle Timer(Optional, up to 5
numerals), Enable Extension Mobility(Optional, boolean),Logout
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Creating a Text-Based CSV File for User Device Profile

Profile(Optional,1 to 50 characters),Login User ID(Optional, 1 to 30
characters-),Login Time (Written by login service),Logout Time (Written by
login service), Product Specific XML

<<LINE>>Directory Number(Optional, up to 24 numerals and special
characters), Partition (Optional, up to 50 characters),Voice Mail
Profile(Optional, up to 50 characters),Line Calling Search Space(Optional, up
to 50 characters), AAR Group(Optional, up to 20 characters),Line User Hold
Audio Source(Optional, up to 50 characters), Line Network Hold Audio
Source(Optional, up to 50 characters),Auto Answer(Mandatory, up to 50
characters), Forward All to Voice Mail (Optional), Forward All
Destination(Optional, up to 50 numerals), Forward All CSS (Optional, up to 24
numerals), Forward Busy External Destination(Optional, up to 50

numerals), Forward Busy External CSS (Optional, up to 24 numerals), Forward
No Answer External Destination(Optional, up to 50 numerals),Forward No
Answer External CSS (Optional, up to 24 numerals),Forward on Failure
destination(Optional, up to 50 numerals),Forward on Failure CSS (Optional, up
to 24 numerals),Call Pickup Group(Optional, up to 50/50 characters),Forward
Busy Internal Destination(Optional, up to 50 numerals), Forward Busy
Internal CSS (Optional, up to 24 numerals), Forward No Answer Internal
Destination(Optional, up to 50 numerals),Forward No Answer Internal CSS
(Optional, up to 24 numerals),Forward No Call Coverage External
Destination(Optional, up to 50 numerals),Forward No Call Coverage External
CSS (Optional, up to 24 numerals),Forward No Call Coverage Internal
Destination(Optional, up to 50 numerals),Forward No Call Coverage Internal
CSS (Optional, up to 24 numerals),Display (Optional, for internal Caller ID, up
to 30 characters),External Phone Mask (Optional, up to 30 numerals or Xs,
where the Xs represent the mask), Message Waiting Lamp Policy (Optional, up
to 50 characters),Ring Setting When Idle (Optional, up to 50 characters),Line
Text Label(Optional, up to 30 characters),Ring Setting When Active (Optional,
up to 50 characters),No Answer Ring Duration (Optional, up to 3
numbers),MLPP Target Destination(Optional, up to 50 characters), MLPP
Calling Search Space(Optional, up to 50 characters), MLPP No Answer Ring
Duration (Optional, up to 3 numbers), Max Num Calls (Optional, up to 3
numbers), Busy Trigger (Optional, up to 3 numbers),Call Info Display
Mask,Alerting Name

<<USER>>User ID(Optional, 1 to 30 characters).

<<SPEEDDIALS>>Speed Dial Number 1(Optional, up to 50 numerals and
special characters), Speed Dial Label 1(Optional, up to 30 characters)
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M Creating a Text-Based CSV File for Cisco IPMA Manager-Assistant Associations

Note

<<SERVICES>>Service Name 1(Optional, up to 100 characters),Subscribed
Service Name 1(Optional, up to 50 characters),Parameter Name 1(Optional, up
to 50 characters), Parameter Value 1(Optional, up to 100 characters)

True and False are used for settings with Boolean values.

Additional Information
See the “Related Topics” section on page A-34.

Creating a Text-Based CSV File for Cisco IPMA
Manager-Assistant Associations

Step 1

Step 2

Step 3

Instead of using the BAT spreadsheet for data input when you are adding IPMA
managers and assistants, you can create the comma separated values (CSV) file
by using lines of ASCII text with values separated by commas.

To create a CSV text file for IPMA manager and assistants, use this procedure.

Procedure

Open a text editor (such as Notepad) or any application that allows you to export
or create a CSV file.

Using a separate line for each manager-assistants association, enter the values for
each manager-assistant that you want to add to Cisco CallManager. See Managers
and Assistants File Formats, page A-21, for detailed information about the
formatting that you must use in the text-based CSV file.

N

Note  An error occurs if any blank lines exist in the CSV file.

You can assign multiple assistants to a manager by entering the user IDs of the
manager and assistants separated by a comma at the end of the record.

Save or copy the file in one of the following folders on The server that is running
the publisher database for Cisco CallManager :

e For Inserts or Updates—C:\BATFiles\ManagersAssistants\Insert\.
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Creating a Text-Based CSV File for Cisco IPMA Manager-Assistant Associations

e For Deletes—C:\BATFiles\ManagersAssistants\Delete\.

N

Note  BAT accesses files for manager assistant transactions only in the
designated folders for the appropriate operation.

Additional Information
See the “Related Topics” section on page A-34.

Managers and Assistants File Formats

The following sample formats and examples show the field length and string types
for IPMA manager and assistant associations. Use the user ID of the manager for
the Manager ID and the user ID of the assistant for the Assistant ID. You can also
associate many managers to one assistant by putting the Assistant ID first,

followed by a list of Manager IDs. When you insert the CSV file, you select the

type of association.

Default Manager-Assistant Association

ManagerID (Mandatory, 1 to 30 characters),AssistantID 1 (Mandatory, 1 to 30
characters),AssistantID 2 (Mandatory, 1 to 30 characters)...AssistantID #
(Mandatory, 1 to 30 characters)

Sample
Johns, Mikeh, Larryh

Default Assistant-Manager Association

AssistantID (Mandatory, 1 to 30 characters),ManagerID 1(Mandatory, 1 to 30
characters),ManagerID 2 (Mandatory, 1 to 30 characters)...ManagerID #
(Mandatory, 1 to 30 characters)
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Sample
Larryh, Johns,Mikeb, Karend

Custom Manager-Assistant Association
For proxy line configurations, you can build a CSV data file that specifies the
proxy lines on assistant phones by using this format.

ManagerID (Mandatory, 1 to 30 characters),Device Name (Optional, 15
characters),Intercom DN (Optional, 1 to 24 characters),Assistant User ID
(Mandatory, 1 to 30 characters),Device Name (Optional, 15 characters),Intercom
DN (Optional, 1 to 24 characters),Proxy Line DN (Mandatory, 1to 24
characters),Manager Line DN (Mandatory, 1 to 24 characters)

Example
Johns, SEP1231123245AB, 90001, Mikeh, SEP2342342342AB,20001,20002, 90002

Additional Information
See the “Related Topics” section on page A-34.

Creating a Text-Based CSV File for
Cisco VG200 Gateways

Instead of using the BAT spreadsheet for data input when you are adding
Cisco VG200 gateways, you can create the comma separated values (CSV) file by
using lines of ASCII text with values separated by commas.

To create a CSV text file for VG200 gateways, use this procedure.

Procedure

Step1  Open a text editor (such as Notepad) or any application that allows you to export
or create a CSV file.

Step2  Using a separate line for each gateway, enter the values for each gateway and port
that you want to add to Cisco CallManager.
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Step 3

Creating a Text-Based CSV File for Cisco VG200 Gateways W

The sections, FXO or FXS Trunks CSV File Format, page A-23, and T1 CAS, T1
PRI, or E1 PRI Trunks File Format, page A-24, provide descriptions and
examples.

S

Note  An error occurs if any blank lines exist in the CSV file.

Save or copy the file to C:\BATFiles\VG200Gateways\ folder on the server that is
running the publisher database for Cisco CallManager.

~
Note  BAT uses only the C:\BATFiles\VG200Gateways\ folder to access the
CSV files.

Additional Information
See the “Related Topics” section on page A-34.

FXO0 or FXS Trunks CSV File Format

The following sample format shows the required field length and string types
followed by s of CSV files for a Cisco VG200 gateway.

MGCP Domain Name(Mandatory, 1 to 64 characters),Description(Optional, up
to 100 characters),Port 1 Description (Optional, up to 50 characters),Port 1
Directory Number(Optional, up to 24 numerals and special characters),Port 1
Partition (Optional, up to 50 characters),Port 2 Description (Optional, up to 50
characters),Port 2 Directory Number(Optional, up to 24 numerals and special
characters),Port 2 Partition (Optional, up to 50 characters),Port 3 Description
(Optional, up to 50 characters),Port 3 Directory Number(Optional, up to 24
numerals and special characters),Port 3 Partition (Optional, up to 50
characters),Port 4 Description (Optional, up to 50 characters),Port 4 Directory
Number(Optional, up to 24 numerals and special characters),Port 4 Partition
(Optional, up to 50 characters)

Sample

MGCPTest,VG200 Lab Gateway,Port 1,97255572001,Partitionl,
Port 2,97255572002, Partition2, Port 3,97255572003, Partition3,
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W Creating a Text-Based CSV File for Cisco VG200 Gateways

Note

Port 4,97255572004,Partition4

You must include comma separators even if a field is blank. Specify the directory
number and route partition only if the port type in the Cisco VG200 gateway
template is POTS.

Example 1
If the Description for a Cisco VG200 gateway is blank, use this format.

MGCPTest, ,Port 1,97255572001,Partitionl, Port 2,97255572002,Partition2,
Port 3,97255572003,Partition3,Port 4,97255572004,Partition4

Example 2

If the Cisco VG200 gateway template has only Port 1 and Port 2 as POTS type,
use this format.

MGCPTest,VG200 Lab Gateway,Port 1,97255572001,Partitionl,
Port 2,97255572002,Partition2,,,,,,

Additional Information
See the “Related Topics” section on page A-34.

T1 CAS, T1 PRI, or E1 PRI Trunks File Format

The following sample format shows the required field length and string types
followed by examples of CSV files for the Cisco VG200 gateway.

T1 CAS Trunks

MGCP Domain Name (Mandatory, 1 to 64 characters),MGCP Description
(Optional, up to 100 characters),Port Identifier 1 (Optional, up to 3 numerals)

Sample 1
MGCPTest,VG200 Lab Gateway, 001
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Note

Creating a Text-Based CSV File for Cisco Catalyst 6000 FXS Ports 1

T1 PRI or E1 PRI

MGCP Domain Name (Mandatory, 1 to 64 characters),MGCP Description
(Optional, up to 100 characters)

Sample 2
MGCPTest,VG200 Lab Gateway

You must include comma separators even if a field is blank.

Example for Both Trunk Options
If you provide only the mandatory value, use this format.

MGCPTest,

T1 CAS Examples
If the Description for a Cisco VG200 gateway is blank, use this option.

MGCPTest,, 001

For port identifiers, the first digit is either 0 or 1 (signifying either Sub-Unit O or
Sub-Unit 1), followed by the port number, 01 to 24. Acceptable values include 001
through 024 or 101 through 124. If the Cisco VG200 gateway template has three
port identifiers

MGCPTest,VG200 Lab Gateway, 001,002,003

Additional Information

See the “Related Topics” section on page A-34.

Creating a Text-Based CSV File for
Cisco Catalyst 6000 FXS Ports

Instead of using the BAT spreadsheet for data input when you are adding
Cisco Catalyst 6000 FXS ports, you can create the comma separated values (CSV)
file by using lines of ASCII text with values separated by commas.
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H Creating a Text-Based CSV File for Cisco Catalyst 6000 FXS Ports

Step 1

Step 2

Step 3

Use this procedure to create a CSV text file for Cisco Catalyst 6000 FXS ports.

Procedure

Open a text editor (such as Notepad) or any application that allows you to export
or create a CSV file.

Using a separate line for each port, enter the values for each port that you want to
add to Cisco CallManager. See Cisco Catalyst 6000 (FXS) Ports File Format,
page A-26, for detailed information about the formatting that you must use in the
text-based CSV file.

N

Note  An error occurs if any blank lines exist in the CSV file.

Save or copy the file to C:\BATFiles\Catalyst6000_24PortsFXSGateway on the
server that is running the publisher database for Cisco CallManager.

A
Note  BAT uses only the C:\BATFiles\Catalyst6000_24PortsFXSGateway\
folder to access the CSV files.

Additional Information
See the “Related Topics” section on page A-34.

Cisco Catalyst 6000 (FXS) Ports File Format

Note

The CSV file contains information about each port as a record. Each record
specifies the gateway MAC address and port number on that gateway to which
you want to add or update the port details.

BAT does not add Cisco Catalyst 6000 (FXS) gateways. It only adds or updates
ports to an existing gateway.
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Note

Creating a Text-Based CSV File for Cisco Catalyst 6000 FXS Ports 1

For the MAC address, enter MAC address values for an existing Cisco Catalyst
6000 (FXS) gateway. This MAC address uses the last 12 characters in the
Gateway Name.

If you provide no values for Partition for any record on the CSV file, the system
uses values from the BAT template for these fields.

If you specify a directory number in the CSV file, you must also create a Gateway
Directory Number template. See the “Creating a Gateway Directory Number
Template for FXS Ports” section on page 7-3, for more information.

The following sample format shows the required field length and string types
followed by examples of CSV files for Catalyst 6000 (FXS) ports.

MAC Address (Mandatory, 12 characters) ,Port Number (Mandatory, 2
numerals) ,Directory Number(Optional, up to 24 numerals and special
characters),Partition(Optional, up to 50 characters)

Sample
1231123245AB,23, 9725557250, Partitionl

You must include comma separators even if a field is blank.
Do not specify a partition unless you have also specified a directory number.

Examples
If the directory number for a port is blank, use this format.

1231123245AB, 23, ,

If you want to add only the mandatory values, use this format.

1231123245AB, 23, ,

Additional Information
See the “Related Topics” section on page A-34.
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W Creating a Custom Text-Based CSV Files for Client Matter Codes and Forced Authorized Codes

Creating a Custom Text-Based CSV Files for Client
Matter Codes and Forced Authorized Codes

Step 1

Step 2

Step 3

Step 4

To create a custom text-based CSV file, perform the following procedure:

Procedure

Open a text editor (such as Notepad) or any application that allows you to export
or create a CSV file.

Using a separate line for each code, create a custom Client Matter Codes (CMC)
CSYV file or a Forced Authorized Codes (FAC) CSV file, as described in the
following steps:

e For CMC—Step 3, Step 4 and Step 5
e For FAC—Step 4, Step 4 and Step 5

L

Tip Remember that you must create two separate CSV files, one for CMC and
one for FAC.

To create a CMC CSV file, enter the corresponding information, where x, y
represent the following fields:

e x—The client matter code (mandatory entry for all additions, updates, and
deletions)

e y—The description (optional if you update the entry)

For example, you may enter 5555,Acme Toys, where 5555 equals the mandatory
client matter code, and Acme Toys equals the description.

To create a FAC CSV file, enter the corresponding information, where X,y,z
represent the following fields:

e x—The forced authorization code (mandatory entry for all additions, updates,
and deletions)

e y—The authorization code name (optional if you update the entry)

e 7—The authorization level (optional if you update the entry)
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A

Creating a Custom Text-Based CSV Files for Client Matter Codes and Forced Authorized Codes Tl

For example, you may enter 1234,John Smith,20, where 1234 equals the forced
authorization code, John Smith equals the authorization code name, and 20 equals
the authorization level.

Caution

Step 5

Step 6

If you add new codes at the same time that you update them, make sure that you
enter all required information. You can change any part of an existing record, but
you must include the code; for example, the forced authorization code or client
matter code. Deleting information and leaving it blank does not remove the
information from the database; a blank value does not overwrite an existing value
in the database, but, updating the value, for example, to Acme Toys, Inc. or John
L. Smith from the preceding examples, overwrites the existing value in the
database.

Save the CSV file to the following directory on the publisher database server,
depending on what you want to accomplish:

e For CMC additions/updates—C:\BATFiles\CMC\Insert
¢ For FAC additions/updates—C:\BATFiles\FAC\Insert
Perform one of the following tasks:

e If you made additions or updates, insert the file in BAT, as described in
“Using BAT to Update the Cisco CallManager Database” section on
page 8-12.

e If you plan to delete code settings, see the “Deleting Code Settings” section
on page 8-7.

Additional Information
See the “Related Topics” section on page A-34.

CMC File Format

The following sample format and examples show the fields, field length, and
whether the field is optional or mandatory for a text-based CSV file for client
matter codes.
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Client Matter Code(Mandatory, 1 to 16 numerals),Description(Optional, 1 to 50
Characters and the & character)

Sample
1234567890123456, Marketing

Example

If the value of the field includes a comma, then that field must be enclosed in
double quotes. Use this format for fields with commas:

1234567890123456, "Marketing, team”

Updating CMC File Format

Use a text editor to create the CSV text file for updating client matter codes.

The following sample format shows the field length and string types followed by
examples of CSV files for updating client matter codes.

Client Matter Code(Mandatory, 1 to 16 numerals),Description(Optional, 1 to 50
Characters and the & character)

Sample
1234567890123456, Marketing

Example
If the description is empty use this format:

1234567890123456,

FAC File Format

The following sample format and examples show the fields, field length, and
whether the field is optional or mandatory for a text-based CSV file for forced
authorization codes.

Forced Authorization Code(Mandatory, 1 to 16 numerals),Authorization Code
Name (Mandatory, 1 to 50 Characters),Authorization Level(Mandatory,values
range from 0O to 255)
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Creating a Text-Based CSV File for Call Pickup Groups

Sample
1234567890123456, John FAC, 251

Examples

If the value of the field includes a comma, then that field must be enclosed in
double quotes. Use this format for fields with commas:

1234567890123456, "John, FAC",251

Updating FAC File Format

Use a text editor to create the CSV text file for updating client matter codes.

The following sample format shows the field length and string types followed by
examples of CSV files for updating forced authorization codes.

Forced Authorization Code(Mandatory, 1 to 16 numerals),Authorization Code
Name (Mandatory, 1 to 50 Characters),Authorization Level(Mandatory,values
range from 0O to 255)

Sample
1234567890123456,John FAC, 251

Example

Values you do not want to update must still include the delimiter. If only the
Authorization Code Name has to be updated use the following format:

1234567890123456,John FAC,

If only the Authorization level has to be updated, use the following format:

1234567890123456,John FAC,

Creating a Text-Based CSV File for Call Pickup
Groups

To create a custom text-based CSV file, perform the following procedure:
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M Creating a Text-Based CSV File for Call Pickup Groups

Step 1
Step 2

Step 3

A

Procedure

Open a text editor (such as Notepad) or any application that allows you to export
or create a CSV file.

Using a separate line for each call pickup group name, create a custom call pickup
group CSV file as described in the following steps:

Enter the Pickup Group Name, Pickup Group Number, Partition, Other Pickup
Group Name-Memberl... Other Pickup Group Name-Member10.

For example, you may enter
Marketing,7815,Part1,Marketing,Managers, Training, where Marketing is the
mandatory pickup group name, 7815 is the mandatory pickup group number.
Part] is the partition, Marketing, Managers, and Training are the other pickup
group names that are associated to the pickup group Marketing.

Caution

Step 4

Step 5

Deleting information and leaving it blank does not remove the information from
the database; a blank value does not overwrite an existing value in the database,
but updating the value, for example, to Sales from Marketing, from the preceding
examples, overwrites the existing value in the database.

Save the CSV file to the C:\BatFiles\CPG\Insert\ directory on the publisher
database server.

Perform one of the following tasks:

e If you made additions or updates, insert the file in BAT, as described in
“Using BAT to Update the Cisco CallManager Database” section on
page 9-7.

e If you plan to delete call pickup groups settings, see the “Using Query to
Delete Call Pickup Groups” section on page 9-5.

Additional Information

See the “Related Topics” section on page A-34.
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Creating a Text-Based CSV File for Call Pickup Groups

CPG File Format

The following sample format and examples show the fields, field length, and
whether the field is optional or mandatory for a text-based CSV file for call pickup
groups.

Pickup Group Name(Mandatory, 1 to 50 characters),Pickup Group
Number(Mandatory, 1 to 24 numerals),Partition(Optional, 1 to 50
Characters),Other Pickup Group Name-Memberl... Other Pickup Group
Name-Member10(Optional, 1 to 50 Characters)

Sample

Marketing, 7815, Partl,Marketing, Managers, Training

Example

Optional values which you do not want to specify at this time must still include
the delimiter (a comma) except for Other Pickup Group members.

If the Partition for a Pickup Group is blank, use the following format:

Marketing, 7815,

Additional Information
See the “Related Topics” section on page A-34.

Updating CPG File Format

Use a text editor to create the CSV text file for updating client matter codes.

The following sample format shows the field length and string types followed by
examples of CSV files for updating call pickup groups.

Pickup Group Name(Mandatory, 1 to 50 characters),Pickup Group
Number(Mandatory, 1 to 24 numerals),Partition(Optional, 1 to 50
Characters),Other Pickup Group Name-Memberl... Other Pickup Group
Name-Member10(Optional, 1 to 50 Characters)

Sample

Marketing, , ,Marketing,Managers, Training
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M Related Topics

Example

If you do not want to update Other Pickup Group member, do not include the
delimiter (a comma). Use the following format:

Marketing, , ,Managers,Marketing, Training

Additional Information

See the “Related Topics” section on page A-34.

Related Topics

¢ Creating a Text-Based CSV File for Phones, page A-2
e Creating a Text-Based CSV File for Users, page A-11
e Creating a Text-Based CSV File for User Device Profile, page A-15

e C(Creating a Text-Based CSV File for Cisco IPMA Manager-Assistant
Associations, page A-20

¢ Creating a Text-Based CSV File for Cisco VG200 Gateways, page A-22

e C(Creating a Text-Based CSV File for Cisco Catalyst 6000 FXS Ports,
page A-25

¢ Creating a Custom Text-Based CSV Files for Client Matter Codes and Forced
Authorized Codes, page A-28

e Creating a Text-Based CSV File for Call Pickup Groups, page A-31
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adding lines

field descriptions for BAT spreadsheet 3-81

field descriptions for template 3-24
to existing phones 3-78

to existing phones using BAT
spreadsheet 3-80

to existing user device profiles 3-78

to phone template 3-4

associating file format for text-based CSV

file 3-54,6-25
authentication proxy rights
adding phones with users 4-27
enable when adding users 4-7

updating users 4-14

auto-registration, enabled for TAPS 12-3

auto-registration options, configuring 12-12

BAT
application overview 1-1
browser requirements 1-16
configuration process overview 1-3

error messages 13-3

INDEX

installation overview 2-1
installing 2-2
location of export log files 10-18
location of report log files 11-15
log files location 13-1
logging on 1-17
online help 1-18
specifications 1-15
starting 1-16
stopping transactions 1-19
troubleshooting 13-3
troubleshooting performance 13-6
uninstalling 2-4
upgrading 2-2
user interface, navigating 1-17
using the menus 1-17
version 1-18
BAT.xlt, see BAT spreadsheet
BAT export utility, see exporting
BAT spreadsheet
adding lines to existing phones 3-80
BAT xlt file location 2-3
Catalyst 6000 FXS ports 7-19
field descriptions

adding lines 3-81
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updating users 4-12
user device profile 6-10
installing BAT .x1t 2-3

IPMA custom manager assistant for proxy
mode 5-16

IPMA default manager assistant 5-14
IP telephony devices 3-39

manager assistant associations 5-13
overview 1-11

phones 3-39

phones with users 4-24

user device profile 6-7

users 4-2

using for CSV data file 1-11

VG200 gateway (FXS or FXO) 7-10

VG200 gateway for T1 CAS or TI/EI
PRI 7-12

BAT spreadsheet (BAT.xIt) file location 2-3

browser requirements 1-16

C

calling party number modification
adding phones with users 4-27
enable when adding users 4-7
updating users 4-15

call park retrieval
adding phones with users 4-27
enable when adding users 4-7

updating users 4-14

Call Pickup Groups
BAT considerations 9-1

BAT settings for inserting CSV file
(table) 9-9

creating a CSV file (BAT.xIt) 9-2
creating custom CSV file (text-based) A-31
CSV file settings (table) 9-6
inserting CSV file in BAT 9-7
updating existing CSV file 9-4
using query to delete call pickup groups 9-5
Catalyst 6000 FXS ports
creating CSV data file 7-19
creating template 7-19
deleting ports 7-24
field descriptions for template 7-61
inserting to Cisco CallManager 7-21
overview 7-17,7-18
text-based CSV file, creating A-25
text-based CSV file format A-26
updating 7-23
Cisco CallManager
configuring TAPS 12-7
enable auto-registration for TAPS 12-3
inserting
Catalyst 6000 FXS ports 7-21
CTI ports 3-56
H.323 clients 3-56
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